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Chapter 1. IBM SPSS Data Collection\Dimensions What's New
Information

IBM SPSS Data Collection\Dimensions What's New for Previous
Versions Overview
This guide provides a comprehensive What's New overview for the previous IBM® SPSS® Data
Collection\Dimensions product versions.

Follow the links below to see the What's New topic for each IBM SPSS Data Collection\Dimensions
product.
v Chapter 2, “What's New in IBM SPSS Data Collection Interviewer Server Administration,” on page 3.
v

v Chapter 4, “What's New in IBM SPSS Data Collection Survey Tabulation,” on page 75.
v Chapter 5, “What's New in IBM SPSS Data Collection Author,” on page 89.
v Chapter 6, “What's New in IBM SPSS Data Collection Survey Reporter,” on page 101.
v Chapter 7, “What's New in IBM SPSS Data Collection Professional,” on page 111. This section includes

data management scripting, interview scripting, and table scripting.
v Chapter 8, “What's New in IBM SPSS Data Collection Interviewer,” on page 155.
v Chapter 9, “What's New in IBM SPSS Data Collection Paper,” on page 159.
v Chapter 10, “What's New in IBM SPSS Data Collection Paper - Scan Add-on,” on page 169.
v Chapter 11, “What's New in IBM SPSS Translation Utility,” on page 175.
v Chapter 12, “What's New in IBM SPSS Data Collection Survey Reporter Developer Kit,” on page 177.
v Chapter 13, “What's New in IBM SPSS Data Collection Data Model Scripting,” on page 181. This

section includes the mrScriptBasic and mrScriptMetadata scripting languages, and the IBM SPSS Data
Collection Function Library.

v Chapter 14, “What's New in IBM SPSS Data Collection Data Model,” on page 189.

© Copyright IBM Corp. 2000, 2015 1
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Chapter 2. What's New in IBM SPSS Data Collection
Interviewer Server Administration

This section summarizes changes in the various IBM SPSS Data Collection Interviewer Server
Administration product versions.

What's New in IBM SPSS Data Collection Interviewer Server
Administration 7
This topic summarizes changes in IBM SPSS Data Collection Interviewer Server Administration 7.

Password policy enhancements. The default password policy has been changed to the following:
v Must be eight characters in length.
v Must contain a mix of alphanumeric and non-alphanumeric characters (punctuation or special

characters), or a combination of at least two types of non-alphanumeric characters.
v Cannot contain user ID information (default setting).
v Must be changed every 90 days (default setting).
v Can only be changed once every 24 hours (default setting).
v Cannot be reused for at least eight password intervals (default setting).
v The user must change their password at next login when the user in imported into IBM SPSS Data

Collection Interviewer Server Administration.
v The following DPM properties were created to support the new password enhancements:

MinimumPasswordAge - The minimum age a password must be before it can be changed.
PasswordCanContainUserName - Controls whether the password can include the user name.
PasswordExpiryTime - The password age in days. Users are required to change their password based on
this property's value.
PasswordExpiredPrompt - The number of days, before a password expires, to prompt the user regarding
the impending password expiration.
PasswordDisallowPrevious - Defines the password reuse interval.
PasswordRegex - Defines the regular expression that is used when validating passwords.

Improved audit logging in User Administration. The DMN*.tmp log file now logs the following audit
information:
v new users
v modified users
v new roles
v modified roles
v users assigned to roles
v roles assigned to users
v new customer accounts
v modified customer accounts
v locked and unlocked users

Distributed Property Management (DPM) security enhancements. The following DPM security
enhancements have been implemented:

© Copyright IBM Corp. 2000, 2015 3



v Improved DPM property access. Administrator users are allowed to edit DPM properties without
additional feature verification. When a non-administrator user attempts to read or write DPM
properties, the system determines whether the user is connecting from a clustered server. If the user is
not connecting from a clustered server, the system determines if the user has access to the Interviewer
Server Administration canViewDpmRemotely (read-only access) and canEditDpmRemotely (read and edit
access) features. If the user is connecting from a clustered server, the user can edit the assigned DPM
properties without additional feature verification.

v Improved DPM property access in the IBM SPSS Data Collection Interviewer Server
Administration Project Editor. When a user attempts to edit project properties via the Project Editor,
the system verifies that the properties exist in Project Editor's EditablePropertiesList list.
Non-administrator users can only edit project properties that exist in the EditablePropertiesList list.
Administrator users can edit all project properties, regardless if they are present in the
EditablePropertiesList.

Logging in with domain name. You can now login with a user name in the format of UserName,
DomainName\UserName, DomainName.com\UserName, or UserName@DomainName.com by creating a user name in
the format of DomainName\UserName.

Activation Settings. This new feature now provides options for editing and validating the client and
server-side activation scripts.

Support for personal interviewing. Additional project settings are required in order for the project to be
considered for personal interviewing. These settings are setup using Activate/Launch and the
Interviewing Options activity and do not need to be manually set.

New roles and activities. New roles and activities support personal interviewing (CAPI) tasks:

New roles:
v Field Manager - this role is for personal supervisors.
v Field Interviewer - this role is for personal interviewers

New activities:
v Can delete contact outcomes

v Can edit contact outcomes

v Can edit personal interview settings

v Can view contact outcomes

v Can view personal interview settings

v Allow allocate quota targets

v Allow import/export quota allocation

v Can reject

v Can bulk reject

Publish Data activity. This new activity provides options for publishing live data (case data and
metadata) to reporting applications, namely IBM Cognos Business Intelligence.

Interview Services. The new Interview Services features provide options for defining and configuring
external web services that can be used in the routing script. The IBM(r) SPSS(r) Collaboration and
Deployment Services service type provides advanced real-time scoring and text analytics capabilities and
can greatly improve respondent interactions. The Salesforce service type is a COM-callable proxy for the
Salesforce.com web service. Some examples of how these services can be used are:
v Allow for a more natural and engaging use of text responses, basing survey logic on concepts and

sentiment captured in open-ended questions.
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v During the survey, automatically ask follow-up questions as a result of scoring against existing
attitudinal and transactional data.

v Based on scoring results, ask the most respondent-pertinent questions. Asking the right questions,
instead of all the questions, is increasingly important as survey response rates continue to fall.

v Centralize complex routing logic in models stored in IBM(r) SPSS(r) Collaboration and Deployment
Services (segmentation, for example).

You can also configure custom services to further take advantage of third-party web services. External
services must first be configured via the authoring application's Interview Services Options.. feature.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > >About IBM SPSS Data Collection... > >Details...

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

What's New in IBM SPSS Data Collection Interviewer Server
Administration 6.0.1
This topic summarizes changes in IBM SPSS Data Collection Interviewer Server Administration 6.0.1.

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to and for more information. Refer to the Reserved Keywords and Keyword Summary topics in the IBM
SPSS Data Collection Developer Library for more information.

Concurrent Usage report

The new Concurrent Usage report provides information on the number of users who have used the
various IBM SPSS Data Collection Interviewer Server Administration activities during a particular time
period.

User Administration

The following User Administration features and enhancements were implemented in version 6.0.1.

Export Data activity feature. The following activity feature is new:
v Export Data > Can alter data link connection properties This feature allows you to provide inputs for

custom properties, allowing you to define the mr Init Custom portion of both the input and output
connection strings. Refer to the Features Element topic in the IBM SPSS Data Collection Interviewer
Server Administration User's Guide for more information.

Customer accounts enhancements. You are now provided more customization options when working
with customer accounts. You can now specify the following attributes:
v Product name images
v Logo images
v Default page picture images
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v Banner images
v Banner background tile images
v Tab images .zip files
v Rounded table images .zip file

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Author... > Details...

Help > About IBM SPSS Data Collection... > Details...

Help > About IBM SPSS Data Collection... > Details...

Help > About IBM SPSS Data Collection Survey Reporter... > Details...

Help > About IBM SPSS Data Collection Interviewer... > Details...

Help > About IBM SPSS Data Collection Paper... > Details...

Help > About IBM SPSS Data Collection Paper - Scan Add-on... > Details...

Help > About IBM SPSS Data Collection Professional... > Details...

Help > About IBM SPSS Data Collection Survey Tabulation... > Details...

Help > About IBM SPSS Data Collection Interviewer... > Details...

What's New in IBM SPSS Data Collection Interviewer Server
Administration 6
This topic summarizes changes in IBM SPSS Data Collection Interviewer Server Administration 6.

Interviewer Server Administrator is now Interviewer Server Administration. Starting with version 6,
the product formerly known as Interviewer Server Administrator is now called Interviewer Server
Administration. The new name is reflected in the interface and many installed elements of the product,
such as files and folders.

Single Sign-on. IBM SPSS Data Collection applications now support LDAP single sign-on (SSO). This
functionality uses Integrated Windows Authentication (SSPI). Single sign-on can be used to authenticate
and manage users in a multi-user, multi-repository environment and to store and retrieve the credentials
that are used for logging into various content and workflow repositories. For more information, see the
Configuring for Single Sign-on topic in the IBM SPSS Data Collection Developer Library.

Centralized database for multiple clusters. You can now implement a single UserAdministration database
configuration for multiple clusters via the Centralize User Database utility. After installation, you can run
the utility on all accessory servers to set the database connection to a centralized database. The utility
also provides options for copying user role assignments. For more information, see the Centralizing the
User and Activity Databases Configuration Utility topic in the IBM SPSS Data Collection Developer Library.
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Download Accessories. The Tools menu provides the link Download Accessories. This allows you to
download the following desktop utilities to your workstation:
v IBM SPSS Data Collection Quota
v IBM SPSS Translation Utility
v IBM SPSS Data Collection WordCapture

User Administration activity

The following User Administration features and enhancements were implemented in version 6.

Customer accounts User, roles, projects, and activities can now be grouped into customer accounts,
allowing administrators to:
v Group user, role and activity user projects and system projects by customer accounts.
v Manage users in hierarchy structure.
v Provide tailored branding options for IBM SPSS Data Collection products by customer account.

Branding information, such as company logos, default page pictures, home page site links and CSS
files can be set for each customer by users who are assigned the CanEditCustomerAccount activity
feature. System account users can modify branding information for all customers; customer account
users can only modify branding information for specified customer accounts. Common users in a
customer account can only view branding information for their customer account. This allows users
from specific customer accounts to view tailored branding information in all of the IBM SPSS Data
Collection Web activities.

v Track the number of concurrent users for all activities.

IBM SPSS Data Collection Interviewer Server Administration activity features. The following activity
features are new:
v Activation > Can activate restricted script

v Interviewer Server Administration > Allow user download accessories

IBM SPSS Data Collection Author roles and activities. The following roles and activities support
role-based access to IBM SPSS Data Collection Author features.

New roles

v Analyst. Allows analysts to define the way each question should be reported (change the analysis
context) but not add or remove questions.

v ProjectManager. Allows project managers to run surveys at any time. Project managers cannot add or
change any survey element.

v SampleManager Allows sample managers to create and upload samples to IBM SPSS Data Collection
Interviewer Server Administration.

v SurveyCreator Allows survey creators to create surveys using a combination of library items and new
questions. Library items can be added to the survey but cannot be changed. Survey creators can create
and change new items, but they cannot write scripts.

v SurveyCreatorAdvanced Allows survey creators to enhance surveys by changing standard questions,
adding new questions, and writing scripts.

v SurveyLauncher Allows users to activate surveys.
v Translator Allows translators to add translations to existing questions.

New activity features

The new activities can be used to build custom roles for IBM SPSS Data Collection Author users. They
also can be added to existing roles to provide cross-functionality with IBM SPSS Data Collection Author.
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New activity features added in IBM SPSS Data Collection 6 Patch 1

New roles were added in IBM SPSS Data Collection 6 Patch 1. As a result, the roles have been grouped in
IBM SPSS Data Collection Interviewer Server Administration based on their function. The migration
behavior of these new roles is as follows:
1. For split features, the deprecated feature is replaced with the new corresponding features. The

following features have been split:
v Can activate project is replaced with the Can activate in test mode, Can activate in go-live mode, Can view

advanced activation settings, and Can edit advanced activation settings features.
v Can manage context and language is replaced with the Can manage context and Can manage language

features.
v Can insert/edit script items is replaced with the Can edit script item, Can insert script item, and Can

delete script item features.
2. For new features, a IBM SPSS Data Collection Interviewer Server Administration administrator will

need to manually add the features to the appropriate roles.
3. Users or roles who have access to IBM SPSS Data Collection Author will be automatically granted the

newly added features; users or roles who have access to the Can Manage Context And Language or Can
Activate Project features will be automatically granted the associated split features.

4. Some of the new features are not intended for every user or role. You can manually remove any
unneeded permissions by utilizing the provided InitializeRoleBase.mrs script. The script allows you to
batch add or remove the feature permissions for existing users and roles. The script is located at:
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\Interviewer Server Administration\\RoleBasedAccess.
There are two files in the RoleBasedAccess directory:

v InitializeRoleBase.mrs - Run this script to add or remove feature permissions for users and roles
defined in the InitializeRoleBase.xls file. Before you run the script, you will will need to specify the
ExcelFilePath parameter in the script.

v InitializeRoleBase.xls - Identifies the feature permissions to add or remove for existing users or roles.
For example:

Activity Feature Roles Action

Author SampleManager;SurveyLauncher Remove

Author CanManageContext SurveyCreator;Translator;ProjectManager Remove

Author CanManageLanguage Translator;Analyst;ProjectManager Remove

Activity - Identifies the activity.
Feature - Identifies the corresponding activity feature.
Roles - Specifies users or roles for the activity feature. Users and roles are separated via semicolons.
Action - Specifies whether to Add or Remove the defined activity features for the specified users and
roles.
Configure the spreadsheet to define the custom access levels for any user-created users or roles.
Note: Running InitializeRoleBase.mrs with the predefined InitializeRoleBase.xls spreadsheet will restore the
default activity feature permissions for the existing Data Collection roles.

Refer to the Assigning users or roles to activity features section in the IBM® SPSS® Interviewer Server
Administration User's Guide for more information.

Displaying a multiple-level application feature tree. By default, each application feature tree displays
features at two levels. IBM SPSS Data Collection 6 Patch 1 provides support for configuring activity
feature trees to display in multiple-levels. Refer to the Displaying a multiple-level application feature tree
topic in the IBM SPSS Data Collection Developer Library for more information.
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What's New in Interviewer Server Administrator 5.6
This topic summarizes changes in Interviewer Server Administrator 5.6.

DimensionNet is now Interviewer Server Administrator. Starting with version 5.6, the product formerly
known as DimensionNet is now called Interviewer Server Administrator. The new name is reflected in
the interface and many installed elements of the product, such as files and folders.

In addition, many other products have been renamed. For more information, see the What's New in Data
Collection Developer Library 5.6 topic in the Data Collection Developer Library.

Cluster Single Sign-on. A single sign-on implementation for clustered environments improves user and
role administration. Cluster single sign-on allows a DimensionNet user to perform activities on each
clustered mrInterview without signing onto each server. For more information, see the Single Sign-on in a
Cluster Environment topic.

Run any DimensionNet activity with a non-DPMAdmin user. Users can now run any activity without
the need for DPMAdmin authority. For more information, see the Who can Run User Administration topic
in the Data Collection Developer Library.

User Administration Activity. The new User Administration activity takes the place of the Manage Users
and Manage Access activities. The new activity provides all features provided by the former two
activities. The User Administration activity provides the following new features for the 5.6 release:
v Can ONLY view weighted data – this new option allows you to restrict user access to unweighted

data in Reporter. To prevent a user from viewing unweighted data in survey data files on the server,
select the Can ONLY view weighted data option. For more information, see the Assigning Users or
Roles to Activities topic in the Data Collection Developer Library.

v No Choice No Action – this new DimensionNet activity feature eliminates the need for users to take
action (click) when there are no actionable projects or activities. When a user or role has access to only
one project or activity, and is assigned the No Choice No Action option, the user directly enters the
project or activity after logging in. For more information, see the No Choice No Action topic in the Data
Collection Developer Library.

DPM Explorer. The DPM Explorer tool was updated as follows:
v Remove orphaned quota objects – when DPM Explorer cannot match a quota object to a project, it

places the object in an orphaned list. When all checks have been completed, DPM Explorer displays the
list of orphans and prompts you to choose those you want to remove. For more information, see the
Adding and Removing Items topic in the Data Collection Developer Library.

v Impersonate user – allows users with administrator rights to login, without a password, as another
user. For more information, see the Impersonating other Users topic in the Data Collection Developer
Library.

v List projects by group – to improve project loading performance, the Projects list now displays
projects by their appropriate grouping.

v IsUploadSample property. IsUploadSample is used to prevent multiple users from uploading samples,
for the same project, at the same time. Resource conflicts can occur when multiple users access the
same table. For more information, see the Table of Project and Interview Properties topic in the Data
Collection Developer Library.

Global Filters. Global Filters are no longer handled as a project property. Global Filters are now
controlled via the mrInterviewData database's GlobalFilters table. For more information, see the
mrInterview Databases topic in the Data Collection Developer Library.
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Load Balancing. The process for distributing DimensionNet users evenly between the Accessories servers
in a cluster has changed. For more information, see the DimensionNet Load Balancing topic in the Data
Collection Developer Library.

Activation Settings. This new feature provides options for defining how projects that are activated to the
mrInterview are handled. For more information, see the Activation Settings topic in the DimensionNet
User's Guide.

What's New in DimensionNet 5.5
This topic summarizes changes in DimensionNet 5.5.

Exporting data. You can now export data to compressed Dimensions Data File format. Compressed
Dimensions Data Files are smaller and more portable than uncompressed files.

The new format has a file extension of .dzf. To export data to the new format, start the Export Data
activity, select Dimensions Data File from the Export to menu, and then select Dimensions Data
File(compressed) (*.dzf) from the File type menu.

What's New in DimensionNet 5.0
This topic summarizes changes in DimensionNet 5.0.

Uploading files. The following changes have been made to the Files activity:
v You can now upload up to 10 files at a time.
v If you upload an .mdd file that already exists in your user folder, you may now choose to merge the

two copies of the file rather than just overwriting the file or cancelling the upload.
v You cannot upload a .mdd file that was created with a version of Dimensions later than the version you

are currently using.

See “Uploading Files from your Computer into your User Folder” in the Manage Files chapter of the
DimensionNet User's Guide for details.

Interviewer qualifications. The concept of interviewer qualifications as a means of allocating sample
records to interviewers with appropriate skills has been extended to cater for sample segmentation.
Sample segmentation divides sample records into groups by, say, region or occupation, so that different
segments of the sample may be called at different times or by different interviewers. By setting up
interviewer qualifications that correspond to sample segments, you can set up projects that allow
interviewers to specify which segments they have been asked to call.

Sample segmentation requires that interviewers should be able to select no qualifications for a particular
segment, and for default settings to be defined. The Edit User Properties screen now has an additional
Default column and a Matches Any option that can be set when none of the other segment qualifications
apply. See “Adding Properties to User Property Groups” in the Manage Users chapter of the
DimensionNet User's Guide for details.

Global filters. Global filters restrict access to case data for users or roles working on particular projects.
For example, you could create a filter that restricts all members of the Eastern Group role to seeing only
case data for respondents in the east, or a filter that restricts the manager of health care products to
seeing data supplied by companies in that market. You can set the filters manually using Manage Access
(see “Setting Up Global Filters” in the Manage Access chapter of the DimensionNet User's Guide), or you
can import them from a spreadsheet using Manage Users (see “Setting Up the Spreadsheet” in the
Manage Users chapter of the DimensionNet User's Guide).

Licensing checks. The following changes have been made to the Usage Report activity.
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v The standard report for this activity is now the License report. This shows the number of licenses that
are available as well as the number of users who have run each application, and highlights occasions
when all licenses are in use. The report can be run for one or all of the following: Phone Participants,
mrInterview, mrTables, and Reporter.

v The original counter-based reports are no longer displayed by default but can be requested by
changing a setting in the activity's configuration file. Speak to your Dimensions administrator if you
require this functionality.

See “Usage Report” in the DimensionNet User's Guide for details.

Changed feature names. In Manage Access, the “Can view other settings” and “Can edit other settings”
features for the Phone Surveys activity have been renamed “Can view dialer settings” and “Can edit
dialer settings” as this more accurately reflects the features' purpose. The internal feature names used by
DimensionNet remain unchanged. See “Assigning Users or Roles to Activity Features” in the Manage
Access chapter of the DimensionNet User's Guide for details.

What's New in DimensionNet 4.5
This topic summarizes changes in DimensionNet 4.5.

Hierarchical project list. This feature allows you to manage the appearance of the project list by
grouping similar or otherwise related projects into folders. Suitably qualified users may place new
projects in folders as they create the projects, move projects between folders, and rename and delete
folders. Refer to “The Project List” and “Creating a New Questionnaire Project” in the DimensionNet
User's Guide for details.

Exporting users and roles. You can now export the current user and roles definitions as a spreadsheet.
The spreadsheet has the same name and format as the one that you use for importing these definitions.
See “Exporting Users, Roles, and Permissions” in the DimensionNet User's Guide for details.

Assigning user properties. The following changes have been made to the Manage User Properties
window.
v The drop-down list of roles ("define a group of properties for") now lists roles in alphabetical order.
v The Property Groups frame lists properties in the order they are added. Click the Group Name column

header to sort the list in alphabetical order. Click again to sort in reverse order.

Managing project folders. Users who need to be able to create, rename, or delete folders, or move
projects between folders in the hierarchical project list must have the “Allow user to manage project
folders” activity feature set. See “Assigning Users or Roles to Activity Features” in the DimensionNet
User's Guide for details.

Managing access to Review Interviews features. The Review Interviews activity that is installed as part
of mrInterview lets supervisors review completed interviews. Hearing recordings of respondents' answers
is an optional feature that is controlled by the canSetUpSupervisorStations activity feature. Supervisors
who have this feature set will be prompted to enter their position name and will hear recordings;
supervisors who do not have this feature set will not be prompted for a position name and will not be
able to listen to respondents' recorded answers.

Project properties. The following properties have been added to “Project Properties” in the DimensionNet
User's Guide: AutoDialTimeout, CallerID, HiddenCodesList, MonitoringAllowed, NoAnswerTimeout,
PercentCallsRecorded, RaisePositionError, RunningCodesList, and SilentAudioFile. Most are related to the
use of an autodialer and were added as part of release 4.0. Only SilentCallAudioFile is new in version
4.5.
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Resizing text on tabs. You can now resize the text on tabs within DimensionNet activities using your
browser's text resizing options. (In Internet Explorer, select View, Text Size and then choose from a
dropdown list of sizes.)

Cookies must be enabled. DimensionNet has for some time required cookies to be enabled in your
browser. This information has now been added to the documentation. See “Recommended Browser
Settings for DimensionNet” in the DimensionNet User's Guide for details.

What's new in DimensionNet 4.0
There were no changes to DimensionNet activities in this version.

What's New in DimensionNet 3.5
This topic summarizes changes in DimensionNet 3.5.

Monitoring interviewers. A new activity, Interviewer Monitoring, is available in the DimensionNet Phone
menu. It allows supervisors to watch telephone interviews for Dimensions projects as they are being
conducted. The default permissions for the CATIsupervisor role have been updated to grant permission
to use this activity. For more information, see “Interviewer Monitoring” in the mrInterview User's Guide.

Managing access to new Participants features. The Participants activity that is installed as part of
mrInterview provides facilities for uploading and downloading participant records into a project's sample
database, and also allows users to view and edit those records. Users who need to perform these tasks
must be given permission to do so by setting the appropriate activity features in Manage Access. These
are: Can upload participants, Can download participants, Can view participants, Can edit participants,
Can delete participants, and Can view summary. The default permissions for the CATIsupervisor role
have been updated to grant permission to use all of these features except Can delete participants. If
required, this permission can be set manually.

Managing access levels in mrTables. mrTables now has three different access levels, to allow
administrators to restrict access to a subset of the functionality available in mrTables. To set the access
levels for users, assign one of the Tabulation access level features in Manage Access. These are:
FullAccess, MediumAccess, and MinimumAccess. Note: Users who have none of the three tabulation
access level features automatically have full access to mrTables functionality. If users have access to more
than one access level, the least restrictive level applies. In addition, three new roles, TabulationFullAccess,
TabulationMediumAccess, and TabulationMinimumAccess, are now created when you install mrTables.
Each role is assigned access to a different set of features in DimensionNet and mrTables. You can assign
these roles to users as required, or you can create your own roles.

Permission to set up interviewer stations. The canSetUpInterviewerStation activity feature for Phone
Participants allows supervisors to configure interviewers' machines to work with an autodialer.
(mrInterview 3.5 does not support autodialing so this feature is provided for future use.)

Browser support

v You can now run DimensionNet using the Firefox browser.
v Manage Users and Manage Access can be run using Firefox.
v Activities that appear in the activities list and that do not support the current browser are flagged.

Unlocking projects. The Unlock Project feature no longer warns about checking in files if there are no
files in the User folder for that project.
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What's New in DimensionNet 3.1
Uploading Files. The following changes have been made to the Files activity:
v You can upload larger files without the activity timing out.
v You now have a Temp folder within your User folder, which is used by the DimensionNet File

Manager when you upload files and activate projects. When you upload a file (or activate a project),
the file is uploaded into a project-specific subfolder in your Temp folder rather than being held in
memory, and a progress bar is displayed while the upload is running. When a file is fully uploaded it
is moved to its final location in the appropriate folder in FMRoot.

What's New in DimensionNet 3.0
About box. The DimensionNet About box now provides more information about the version of
DimensionNet that you are running.

Activities list. Filtering of the activities list has been improved in relation to mrTables and analysis
projects. Activities (such as Launch) that are inappropriate for analysis projects are no longer shown
when you select an analysis project, and Tables no longer appears in the activities list if the project has no
metadata.

Users and roles. The following changes have been made to Manage Users.
v You can give individual users access to projects and activities in the same way that you assign roles to

projects and activities.
v It is now possible to create users and roles, set up user properties, and assign roles to activities, activity

features, and projects by importing the details from an Excel spreadsheet.
v It is no longer possible to create a user with the same name as an existing role, or a role with the same

name as an existing user.
v User properties may now be defined only as categoric or boolean properties. The text and numeric

data types were not seen to be useful and have been withdrawn.

Creating projects. The following changes have been made to Edit Project.
v Questionnaires for mrInterview 3.0 must be written in the Interview Scripting language. To create a

new project that accepts this type of questionnaire, select New questionnaire (Dimensions) on the New
Project dialog box.

v Edit Project now uses the name that you enter in the Name field as the default value for the Project ID
field, provided that the name satisfies the requirements for project IDs.

File management. The following changes have been made to the Files activity.
v The activity now supports subfolders. You can create subfolders and upload files into them, and can

navigate into subfolders and download their contents.
v Zipped files are supported. If a zipped file contains a folder structure, the structure is preserved when

the files are uploaded. If you download a folder, Files creates a zipped file that preserves the folder's
structure.

v When you upload an .mdd file from your User folder to the Shared folder and the Shared folder
already contains a version of that file, the contents of the uploaded file are always merged into the
existing file. In earlier versions a dialog box was displayed even though the only option was to merge
the files. Version 3.0 does not display the dialog box.

Usage reports. The following changes have been made to what was previously the View Monitoring
Reports activity.
v The activity has been renamed Usage Report so that the name more accurately reflects the activity's

function, and has been moved from the activity list into the Tools menu.
v The option to produce a site total has been removed: you can choose only a single server or all servers.
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What's New in DimensionNet 2.3
Internationalization. DimensionNet 2.3 is fully internationalized and contains English and Japanese texts.
The default is English.

Project list opens much faster. There is a 200% performance improvement in opening the DimensionNet
project list. The results of tests run on a Quad 500MHz machine are as follows:

Number of projects Time taken in version 2.2 Time taken in version 2.3 % Improvement

100 4.156 1.703 144.04

200 7.812 2.640 195.91

300 11.094 3.672 202.12

400 15.469 4.456 247.15

500 21.235 4.813 341.20

1000 42.453 10.50 304.31

Average 239.12

Roles for CATI supervisors and interviewers. If mrInterview is installed, special roles are created for
CATI supervisors and interviewers. The CATIinterviewer and CATIsupervisor roles are configured to
allow access to the appropriate activities which reduces the amount of manual work required to set up
these users.

User properties. Manage Users now supports the definition of user properties. This allows you to set up
interviewer qualifications which the Sample Management script can use for assigning records to the
interviewers who are best qualified to call them. For a general description of how interviewer
qualifications work, refer to "Interviewer Qualifications" in the Sample Management section of the
Dimensions Development Library.

Monitoring DimensionNet usage. The new View Monitoring Reports displays information about
DimensionNet usage over a chosen period and on a chosen server.

Browser settings. A new topic has been added to the documentation giving recommended settings for
your browser when using DimensionNet.

Working with files created by desktop activities. The documentation for the Files activity now includes
information on uploading files that have been created using mrInterview desktop activities. It deals in
particular with how to avoid problems that can occur when mixing desktop and DimensionNet activities
for creating, compiling, and activating projects.

Japanese characters in user names and pathnames. DimensionNet does not support Japanese characters
in pathnames or filenames. Since each user's working folder and project folder names are based on the
user name, using Japanese characters in user names will result in invalid pathnames. Also, if you want to
upload files with Japanese characters in their names, you should rename them before uploading them.

Performance improvements. DimensionNet 2.3 comes with a new Distributed Property Management
system (DPM) which provides a number of performance improvements over earlier versions.

What's New in DimensionNet 2.2
Usability changes. The DimensionNet pages have been radically redesigned to improve usability, and a
number of descriptive and instructional texts have been reworded.
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Creating new projects. The layout of the New Project dialog box has been changed to make it easier to
use. Key changes are as follows:
v The old Label text box is now called Name and the old Project Name text box is now called Project

ID. These are changes to the GUI only and do not affect the way that the dialog box works or the
names by which the underlying project properties are known to DPM. The Project Name (formerly
Label) is the name of the project as it appears in DimensionNet. The Project ID (formerly Project
Name) is the unique identifier by which the project is know to DPM and which is used in the naming
of files associated with the project.

v The Connection button has been replaced by an Advanced button which takes you to a tabbed dialog.
The Project tab allows you to set the project ID and the project folder; the Permissions tab lets you
specify which roles may access the project.

v When creating a new data analysis project for non-mrInterview data, the Connections tab is no longer
available for setting the Connections properties. This has been replaced by a Test Connection button
that tests the connection to the data files using the default properties. If the test fails, you may edit the
connection properties using EditProject in the normal way.

User and role assignment. The procedures for assigning users to roles and for assigning roles to projects,
activities, and activity features have been streamlined as follows:
v EditProject now has a Permissions tab that allows you to specify which roles may use a project that

you have created. The Permissions tab in EditProject is the same as the one that you see when
assigning roles to a new project. Roles that currently have permission are checked. To change
permissions, select or cancel the relevant checkboxes.

v In Manage Users, you can specify the roles that the new user belongs to as part of the user creation
process, or the users that belong to the new role as part of the role creation process.

v In Manage Access, when you assign a role to an activity that has features, the features are displayed so
that you can select the ones that should be made available to the role. The same is true when you
assign activities to roles.

Checking files in and out. A new topic in the Files (formerly ManageFiles) documentation gives
recommendations on when to check files in and out.

Unlocking other people's projects. A new Activity Feature called canUnlockProject has been added to
Manage Access. When a role has this feature set, any member of that role can unlock any projects to
which they have access, even if the project as been locked by another user.

Changing passwords. Administrators and users who may change their passwords have a Change
Password option available in the Tools menu.
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Chapter 3. What's New in IBM SPSS Data Collection
Interviewer Server\IBM SPSS Data Collection Interviewer
Server

This section summarizes changes in the various IBM SPSS Data Collection Interviewer Server product
versions.

What's New in IBM SPSS Data Collection Interviewer Server 7
This topic lists all changes and enhancements available in IBM SPSS Data Collection Interviewer Server 7.
It includes all the information for end-users from the various What's New sections in mrInterview User's
Guide as well as details of more technical changes that are documented only in the IBM SPSS Data
Collection Developer Library.

General

Dialing provider changes. The dialing provider's implementation for the Return method, defined in
ISampleManagementProvider, was updated to support project chaining. The old behavior was to always
disconnect the call as Return. The new behavior checks if a chained survey is present after the sample is
returned. When a chained survey is present, the call connection is retained. When a chained survey is not
present, the call is disconnected.

Also, the interview property EnableChaining must to be set false for all canceled or failed auto-dialing
samples that are returned in dialing provider.

HTML Player enhancements. The following updates have been made to the HTML Player component:
v The HTML Player can now optionally export the Player XML for the Question node directly into the

HTML output, instead of simply rendering the XML as HTML. When submitting question responses to
the HTML Player, the responses can now be submitted as Player XML within the HTTP POST.

HTMLOptions update. The new ApplySubTemplatesInNestedBlocks, UseGlobalTemplate, and
ApplySubTemplatesInGrids features provide the following options:
v ApplySubTemplatesInNestedBlocks - applies question sub-templates to questions in nested blocks.
v ApplySubTemplatesInGrids - enables and disables custom controls in sub-templates for grid and loop

questions.
v UseGlobalTemplate - searches for templates from the global location before checking the project location.

Sample Management changes.

v Disconnected samples. Sample management has been updated to support disconnected samples for
IBM SPSS Data Collection Interviewer. The sample table's InterviewMode field is used to record in
which mode the sample was interviewed (Web, Personal, or Phone). In previous release Phone mode was
recorded as Web CATI. The InterviewMode field is also used to filter samples, for sample reports, in the
IBM SPSS Data Collection Interviewer Server Interviewing Activity.

v Support for project chaining. Chaining is defined as using a primary project to start off a chain of
projects without the respondent (or interviewer) being aware of the switch between projects. Chaining
can be used to provide the best projects for a particular user or to setup omnibus style interviews
where a single respondent is interviewed for several clients.

Interview Web Service. The existing mrIWeb component has been updated to support the new RESTful
compliant interview web service. The new web service allows users to use AJAX to implement web
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interviews within a web page, and provides support for HTML, XML, and JSON protocols. This added
functionality provides enhanced support for deploying surveys to additional devices such as smart
phones and tablets.

Debug symbol server. Microsoft debug symbol server technology is used to improve the serviceability of
IBM SPSS Data Collection products.

IBM SPSS Data Collection Interviewer Server Activities

Interviewer Monitoring. The activity includes the following enhancements:
v Real-time monitoring performance has been improved via the adoption of long polling.
v Create and edit project messages for each project. Project messages provide specific project information

to each interviewer.
v Create and send immediate messages to specific interviewers. You can choose the have the message

queue in the interviewers' message window, or display immediately on their screen.
v View interviewer status. Interviewers can set their status (for example, Situation normal or Need a

break). Supervisors can view the current status for each interviewer while monitoring.
v Filter the Real Time Display field information.
v Highlight selected interviewers on the Real Time Display list. Highlighted interviewers are placed at

the top of the Real Time Display list.
v Display the call history for selected interviewers.
v Display the session history for selected interviewers.
v The Monitor tab now provides options for displaying interviewer call history, session history, and

comments.

Interviewing Options. Formerly the Phone Surveys activity, the activity includes the following
enhancements:
v The activity's feature navigation structure has been changed from a tab-based model to a hierarchical

tree model.
v The Introduction page includes an editor that provides options for modifying a project's introductory

text via HTML or plain text, and provides a method for switching between available languages.
v The new History Reports page provides options for defining which fields will display in the contact

and session history reports.
v The new Project Message page provides options for creating and editing project messages. Project

messages provide specific project information to each interviewer.
v The Phone Interview Settings page provides a Display status messages in Phone Participants option

that enables status messages during interviewing.
v The new Project page provides options for defining a project expiry date and for specifying whether or

not reviewers can reject interviews.
v The Fields page now provides sub-pages for Participants (previously named Define Fields) and Project

(new). The Participants page provides information on the fields that are present in the participant
database table; the Project page allows you to select which fields will be visible when the questionnaire
is opened in IBM SPSS Data Collection Interviewer.

v The Call Outcomes tab information has been moved to the Interviewing section and provides separate
sub-pages for Call Outcomes (for phone interviews) and Contact Outcomes (for personal interviews).

v The Interview Settings page now provides separate sub-pages for Phone Interviews and Personal
Interviews.

v The default password policy has been changed to the following:
- Must be eight characters in length.
- Must contain a mix of alphanumeric and non-alphanumeric characters (punctuation or special
characters), or a combination of at least two types of non-alphanumeric characters.
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- Cannot contain user ID information (default setting).
- Must be changed every 90 days (default setting).
- Can only be changed once every 24 hours (default setting).
- Cannot be reused for at least eight password intervals (default setting).
- The user must change their password at next login when the password is reset, or when the user in
imported into IBM SPSS Data Collection Interviewer Server Administration. Refer to the "Changing
your password" and "Importing users and roles" topics for more information.

v The following DPM properties were created to support the new password policy:
MinimumPasswordAge - The minimum age a password must attain before it can be changed.
PasswordCanContainUserName - Controls whether the password can include the user name.
PasswordExpiryTime - The password age in days. Users are required to change their password based on
this property's value.
PasswordExpiredPrompt - The number of days, before a password expires, to prompt the user regarding
the impending password expiration.
PasswordDisallowPrevious - Defines the password reuse interval.
PasswordRegex - Defines the regular expression that is used when validating passwords.

Launch. The activity includes the following enhancements:
v The new Use Personal Interviewing option, on the Project Info tab, allows you to flag a survey as

available for personal interviewing.
v The Sample Management tab provides a Personal option in the Script field drop-down menu. The

Personal script provides support for web and personal interviewing.
v The Quota tab now allows you to set the quota allocation percentage value for each personal

interviewer.
v The activation process has been updated to support user customization. For example, the following

options are available for project activation:
- Enforce company-specific project rules prior by validating the .mdd file prior to activation.
- Manipulate the .mdd file, images, templates, or other related files prior to activation. For example, you
can retrieve images from a central repository and convert them to an appropriate size.
- After activation, cleanup the temporary data that was created prior to activation.
- Send notifications by updating a RSS feeds, updating social media sites when a project is available, or
informing third-party systems.
Refer to the Activation topic in the IBM SPSS Data Collection Developer Library for more information.
- The new personal_sample.mrs sample management script is available during project activation and is
suitable for personal face to face interviews conducted by interviewers in homes or other locations.
Refer to the Scripts in the IBM SPSS Data Collection Sample Management Folder topic in the IBM SPSS
Data Collection Developer Library for more information.

Participants. The activity includes the following enhancements:
v The new Use sample for personal interviewing option, on the Required Fields tab, allows you to flag

participants as available for personal interviewing.
v You can now search for users who are assigned to a specific project when modifying the

AssignedInterviewerId field value.
v When deleting all participant records, you are now presented with the option of deleting all records on

the current page or all records on all pages.
v When editing all participant records, you are now presented with the option of editing all records on

the current page or all records on all pages.

Phone. The Phone activity has been renamed to Interviewing. In addition to being renamed, the activity
now provides support for the following features:
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v Appointment Distribution per Interviewer report - this new report shows a frequency table of
appointments, per interviewer, arranged for the next two days.

v Contact History report- this new report provides the project's full contact history.
v Call Outcome report - has been renamed Contact Outcome Status and shows a frequency table of contact

outcomes.
v Call Outcomes by Segment report - has been renamed Contact Outcome by Segment and displays the

contact outcomes by queue and segment.
v Call by Segment report - has been renamed Contacts by Segment and displays the number of contacts by

queue and segment.
v Interviewer Statistics Across Projects report - has been renamed Interviewer Statistics Across Phone

Projects and shows interviewer productivity information for each interviewer and each CATI project.
v Interviewer Statistics Across Personal Projects report - this new report shows interviewer productivity

information for each interviewer and each personal project.
v Overall Disposition Across Projects report - as been renamed Overall Disposition Across Phone Projects

and displays the last contact outcome for each participant record, organized by project, and always
includes both real and test data for CATI projects.

v Overall Disposition Across Personal Projects report - this new report displays the last contact outcome
for each participant record, organized by project, and always includes both real and test data for
personal projects.

v Queue Status by Interviewer report - this new report displays the queue status for each interviewer.
v Review Calls report - has been renamed Review Contacts and displays cross-tabulated contact

information.
v Review Percentage by Interviewer report - this new report displays the percentage of the total

interviews conducted by each interviewer.
v Sample Usage Across Projects report - has been renamed Sample Usage Across Phone Projects and

displays the number of records in each queue across CATI projects.
v Sample Usage Across Personal Projects report - this new report displays the number of records in each

queue across personal projects.

Phone Participants. The activity includes the following enhancements:
v The main screen has been updated and provides the following tabs:

Contact Details - displays various details about the current participant
Call History - displays the call history for selected interviewers.
Session History - display the session history for selected interviewers.
Comments - provides a field for entering interviewer comments regarding the current participant.

v Each interviewer can now set their status (for example, Situation normal or Need a break).
Supervisors can view the current status for each interviewer while monitoring.

v You can now select in which language the survey introduction text displays.
v Project messages provide specific project information to each interviewer.
v Create and send immediate messages to specific interviewers. Message queue in the interviewers'

message window, or display immediately on their screen.

Promote Project. The activity now provides the option for logging into the destination server via the
Microsoft Windows account credentials.

Quota. The activity includes the following enhancements:
v Quota provides features that support personal interviewing, such as assigning quota percentages to

personal interviewers.
v The activity now recognizes when quotas are being reviewed and automatically avoids re-pending

quotas. This results in no longer needing to script around quotas using IsReview. The system also
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automatically returns a pend result that matches the original pend result, including the list of pended
quotas for all quota types including least full and random in reviewing.

v Quotas can now be automatically updated when an interview is rejected during review.
v Calculate completes are performed for new quota cells (based on existing data).
v You can now cross matrix queries and bulk edit quotas.
v Complete counts are now easier to reset.

Review Interviews. The activity includes the following enhancements:
v You can now review interviews that are completed in any interview mode (Phone, Web, and Personal).

You can select interviews by their sample and case data fields. If more than one matching interview is
found, all matching interviews are displayed, allowing you to select the appropriate one to review. You
can also review the contact, case data, and comment details.

v You can now view the rejected synchronization data, and other related data, in the server database.
You can select to promote or permanently delete the rejected synchronization data.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > >About IBM SPSS Data Collection... > >Details...

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

What's New in IBM SPSS Data Collection Interviewer Server 6.0.1
This topic lists all changes and enhancements available in IBM SPSS Data Collection Interviewer Server
6.0.1. It includes all the information for end-users from the various What's New sections in mrInterview
User's Guide as well as details of more technical changes that are documented only in the IBM SPSS Data
Collection Developer Library.

Installation

Virtual directory, session engine, and Web service registration. During the product installation, you are
presented the option for configuring multiple virtual directories, session engines, and Web services.

Configuring multiple virtual directories, that run simultaneously, provides for optimum load balancing
within a cluster. When any of the following features are selected during installation, you are presented
with the Interviewer Server Administration Virtual Directory Configuration dialog during installation:
v Accessories Service
v Phone Interviews
v Remote Administration
v Survey Tabulation
v Survey Reporter Server Edition
v Author Server Edition

Configuring multiple session engines allows you to better utilize the memory on each IBM SPSS Data
Collection Interviewer Server machine. When you select to install the Interview Service feature, the
Interview Session Engine Configuration dialog displays during installation.

Configuring multiple Web services to run on a single machine allows you to better utilize the memory on
each Web server machine. When you select to install the Web Service feature, the Interview Web Service
Configuration dialog displays during installation.
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Refer to the Virtual directory, session engine, and Web service registration section in the IBM SPSS Data
Collection Server Installation Guide for more information.

General

IBM SPSS Data Collection Load Tool. The Load Tool utility has been updated to support more robust
auto answer playback capabilities, including working with auto answer data sources connections, number
of cases, and so on. The new features are available via the new Data Generation tab, available from the
Load Tool's Test Configuration dialog. Refer to for general Load Tool information; refer to for information
pertaining to the Load Tool's auto-answer playback capabilities.

Performance counters. The following performance counters enhancements are now available:
v The Maximum Response Time performance counter is now available for both the IBM SPSS Data

Collection Interviewer Server Web Service and IBM SPSS Data Collection Interviewer Server
Interviewer Session Engine. The counter tracks the maximum time spent handling a request. Refer to
and for more information.

v Performance counters for IBM SPSS Data Collection Interviewer Server projects. You can now monitor
various Web and Telephone interviewing performance counters for specific projects.

Synchronization Web Service Object Model. When using IBM SPSS Data Collection Interviewer,
configurations and project information must be updated on the client machine and case data should be
uploaded to the server. The Synchronization Web Service manages the communication between the IBM
SPSS Data Collection Interviewer client and the IBM SPSS Data Collection Interviewer Server.

MaxRecordsInBatch property. This new CATI parameter defines the maximum number of records to pass
to the sample management script. The maximum value defaults to 25 when the property is not defined.

IBM SPSS Data Collection Interviewer Server Activities

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to and for more information. Refer to the Reserved Keywords and Keyword Summary topics in the IBM
SPSS Data Collection Developer Library for more information.

Export Data. The activity has been updated to support the following new features.
v You can calculate and then generate two extra data columns that contain the start and finish times for

each case. The start and finish times are based on the selected time zone of your choosing.
v You can include only records that relate to a specific filter condition (such as time period or survey

status). Export Data provides several filters that you can modify to suit your requirements. You can
also create your own filters, or delete filters that are no longer needed. These new features are
supported via the new Set Filters dialog.

v You can choose to export data gathered before or after a specific date/time, or select a date/time
range.

v The Export Data advanced dialog includes a new Connection Properties tab that allows you to provide
inputs for custom properties, allowing you to define the mr Init Custom portion of both the input and
output connection strings.

Launch. The activity includes the following enhancements:
v You can now define the expiration date and time (UTC time) for each project, prior to activation.

22 IBM SPSS Data Collection\Dimensions What's New Guide



Phone. The activity includes the following enhancements:
v You can now filter phone reports on a project's sample information or data, in addition to filtering by

date and time. Refer to the "Filtering Reports" topic for more information.
v You can now specify a date and time range when working with date filters. Refer to the "Running

Reports" topic for more information.
v You can now specify a report's data source with the Table property in DPM Explorer (Site > Servers >

[ServerName] > Applications > CatiReports-> [Report] > Table). The Table property is not set for
sample base reports; the sample table is used as the default. For call history based reports, the default
is set as dbo.<ProjectName>_SampleOverview_Inner.

v There is a new Sample Usage Across Projects report that shows a frequency table of the number of
participant records in each queue, across projects, for each project.

Phone Surveys. You can now specify answering machine detection settings on the Dialer Settings tab.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Author... > Details...

Help > About IBM SPSS Data Collection... > Details...

Help > About IBM SPSS Data Collection... > Details...

Help > About IBM SPSS Data Collection Survey Reporter... > Details...

Help > About IBM SPSS Data Collection Interviewer... > Details...

Help > About IBM SPSS Data Collection Paper... > Details...

Help > About IBM SPSS Data Collection Paper - Scan Add-on... > Details...

Help > About IBM SPSS Data Collection Professional... > Details...

Help > About IBM SPSS Data Collection Survey Tabulation... > Details...

Help > About IBM SPSS Data Collection Interviewer... > Details...

What's New in IBM SPSS Data Collection Interviewer Server 6
This topic lists all changes and enhancements available in IBM SPSS Data Collection Interviewer Server 6.
It includes all the information for end-users from the various What's New sections in mrInterview User's
Guide as well as details of more technical changes that are documented only in the IBM SPSS Data
Collection Developer Library.

General

Single Sign-on. IBM SPSS Data Collection applications now support LDAP single sign-on (SSO). This
functionality uses Integrated Windows Authentication (SSPI). Single sign-on can be used to authenticate
and manage users in a multi-user, multi-repository environment and to store and retrieve the credentials

Chapter 3. What's New in IBM SPSS Data Collection Interviewer Server\IBM SPSS Data Collection Interviewer Server 23



that are used for logging into various content and workflow repositories. For more information, see the
Configuring for Single Sign-on topic in the IBM SPSS Data Collection Developer Library.

Hierarchical Data (unbounded loops). View and export data collected from questions with unbounded
loops.

Project templates. You can now save complex project settings to templates that will assist in creating and
configuring projects. Each project template contains all of the artifacts for starting a new project (settings,
resources, images, and so on) and an activation template to assist with project activation. You can store
project templates to, and access project templates from, server directories.

Project templates enable you to:
v Save a project, including all associated files and settings, as a project template.
v Create a new project that is based on the files and settings within an existing project template.
v Store and access project templates from an IBM SPSS Data Collection Interviewer Server, IBM SPSS

Data Collection Question Repository, local directory, or library.

HTML Player changes. The following updates have been made to the HTML Player component:
v Default XSL templates: You can now customize the XSL templates that are used by HTML Player

component. The HTML Player uses XSLT to create HTML source output. It uses the Player XML as
input, and retrieves relevant information from the Player XML. The source HTML is then transformed
by the relevant XSL templates.

v Intermediate XML schema: You can now customize the XSL templates that are used by HTML Player
component. Intermediate XML defines the question controls. HTML Player creates the schema against
the Player XML and transforms it to HTML source for questions controls.

v HTMLOptions update. The following options are new or updated for IBM SPSS Data Collection 7.0.1:
–– UseTablesLayout effectively reverts HTML rendering to pre-IBM SPSS Data Collection 7.0.1 behavior.
–– NoExpiryMetaTags replaces the NoExpiry option and excludes meta tags from the rendered HTML.
–– UsePredefinedKeyCodes uses predefined key codes for CATI Player questions.

IBM SPSS Data Collection Interviewer Server Activities

Note: Many of the new features require version 6 sample management scripts. If you have existing
projects that use pre-version 6 sample management scripts, the new features may not be recognized.

Hierarchical data (database questions). The following activities support single response, multiple
response, and loop questions whose category lists are generated by connecting to an external database.
v Launch - the activity supports projects that include database questions that are defined in other IBM

SPSS Data Collection applications (for example, IBM SPSS Data Collection Professional and IBM SPSS
Data Collection Author).

v Export Data - the activity supports the exportation of hierarchical data in the Data Collection Data
File/> and Data Collection XML Data File formats.

v Survey Results - the activity supports hierarchical data in the form of unbounded loop questions.

Refer to the "Database questions" topic in the IBM SPSS Data Collection Developer Library for more
information.

Note: The IBM SPSS Data Collection Interviewer Server Anonymous User (defined during IBM SPSS
Data Collection Server 7.0.1 6 installation) must have permission to log into the appropriate database
server(s), and must have read permission to access the database tables that contain the questions. Refer to
the "Database question configuration information" topic in the IBM SPSS Data Collection Developer Library
for more information.
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Phone activity. IBM SPSS Data Collection Dialer licensing is now established via the License
Authorization Wizard (installed with IBM SPSS Data Collection Server 7.0.1). Refer to the IBM SPSS Data
Collection Server User Guide for more information on licensing IBM SPSS Data Collection Dialer.

Note: When licensing IBM SPSS Data Collection Dialer in a Windows Server 2003 or 2008 (x64 64-bit
edition) environment, you must locally login to the server before attempting to license IBM SPSS Data
Collection Dialer. If you attempt to login to a domain and then license IBM SPSS Data Collection Dialer,
you will not be able to work with CATI projects in the Phone Participants activity.

Phone Participants activity. The user interface has been re-factored to better organize available features
and improve accessibility.
v Telephone keypad for dual tone multi-frequency (DTMF). You are now provided the option of using

a telephone style keypad for use in sending dial tones. This is useful when the contact can only be
reached via a menu system (for example, “Press 1 for Dr. Smith, press 2 for Dr. Jones”).

Activation Settings activity. The ActivationSettings.config.xml file is created after the first activation, or
when the configuration settings are updated in Activation Settings activity. The file stores activation
configuration settings, effectively bypassing the need to query the configuration settings from DPM, and
greatly improves overall activation performance. Refer to the "ActivationSettings.config.xml" topic in the
IBM SPSS Data Collection Developer Library for more information.

What's New in IBM SPSS Data Collection Interviewer Server 5.6
This topic lists all changes and enhancements available in IBM SPSS Data Collection Interviewer Server
5.6. It includes all the information for end-users from the various What's New sections in mrInterview
User's Guide as well as details of more technical changes that are documented only in the Data Collection
Developer Library.

IBM SPSS Data Collection Interviewer Server is now IBM SPSS Data Collection Interviewer Server.
Starting with version 5.6, the product formerly known as IBM SPSS Data Collection Interviewer Server is
now called IBM SPSS Data Collection Interviewer Server. The new name is reflected in the interface and
many installed elements of the product, such as files and folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in Data Collection Developer Library 5.6 topic in the Data Collection
Developer Library .

New system variables. MDD files that are activated for use with IBM SPSS Data Collection Interviewer
5.6 require four new system variables:
v DataCollection.BatchID
v DataCollection.BatchName
v DataCollection.DataEntryMode
v DataCollection.Removed

MDD’s that were created in Dimensions 5.5 or earlier do not include these system variables and must be
reactivated to IBM SPSS Data Collection Interviewer 5.6. You must also reactivate MDD files, created in a
previous release, that are opened and saved using a 5.6 application.

It is important to note that if you remove system variables from an MDD created in any release
(including 5.6), IBM SPSS Data Collection Interviewer 5.6 will require reactivation to ensure that all
system variables are present.

If you attempt to open a file that excludes one or more of these variables, IBM SPSS Data Collection
Interviewer will block the action and issue the following notification: “Required system variables missing.
Reactivation is required.”
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Refer to the "Activating Questionnaires" topic in the Autho 5.6 User's Guide for more information on
activation using Author 5.6.

Refer to the "Activating Interview Scripts" topic in the Data Collection Developer Library for more
information on activation using Professional 5.6.

Refer to the "Activating Projects" topic in the IBM SPSS Data Collection Interviewer Server 5.6 User's Guide
for more information on activation using IBM SPSS Data Collection Interviewer Server 5.6.

Refer to the "System Variables" topic in the Data Collection Developer Library for more information on
system variables.

IBM SPSS Data Collection Interviewer Server Activities

Note: Many of the new features require 5.6 sample management scripts. If you have existing projects that
use pre-version 5.6 sample management scripts, the new features may not be recognized.

Phone Activity. The following reports are new in 5.6:
v Dialer Statistics Report. Provides dialer specific statistics over the past eight hours.
v Interviewer Productivity. Provides interviewer productivity information for each interviewer and each

project.
v Interviewer Statistics Drilldown.

v Incidence Statistics. Can be used to help determine project costs and monitor call centre performance.
The Incidence Statistics report affects the following reports:
– Call Outcome By Segment. A new element FailedScreener "Failed screener" was added to
CallOutcome.
– Call Outcome Status. A new element FailedScreener "Failed screener" was added to CallOutcome.
– Incidence Report. This new report provides an industry standard calculation for incidence.

v Overall Disposition. Displays the last call outcome for each participant record, organized by project.
v Queue Status By Time Zone. Displays the queue status for each available time zone.
v Time Zone Status. Displays a list of all time zones in use by the project and whether the time zones

are active or inactive based on the defined call times.
See the “Phone” topic in the IBM SPSS Data Collection Interviewer Server User's Guide for details.

Participants Activity. The activity provides the following enhancements:
v Day Parts. Ensure that records are called at specific times of the day in order to increase the chance of

success in reaching participants. See the "DayPart" table entry in the IBM SPSS Data Collection
Interviewer Server User's Guide “Mapping Fields to Required Columns in the Sample Table” topic for
more information.

v Replicates. Replicates are a mechanism for making sets of participant records available for dialing. The
sets of participant records can be grouped based on a particular meaning (specific day of the week for
example) or may be arbitrary groups representing a portion of the available participant records. See the
“Replicates” topic in the IBM SPSS Data Collection Interviewer Server User's Guide for information on
configuring participant records to support replicates.

v Sample Expiration. Allows participant records to automatically expire and become unavailable for
dialing (except for retrieving appointments). For example, a project may dictate that participant records
can only be called within a specific date range. See the "ExpirationTime" table entry in the IBM SPSS
Data Collection Interviewer Server User's Guide “Mapping Fields to Required Columns in the Sample
Table” topic for more information.

v Force Preview Dial. National or state regulations may require that certain numbers cannot be
auto-dialed (cell phone numbers for example). The Force Preview Dial feature forces the interviewer to
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manually select the dial button for specific participant records, thus avoiding silent calls. See the “Force
Preview Dial” topic in the IBM SPSS Data Collection Interviewer Server User's Guide for details.

v Screener. Allows you to identify which respondents are the suitable candidates for the current survey.
Screener questions are designed to filter respondents. If a respondent answers do not meet the Screener
criteria, the respondent is not allowed to continue the survey, and the Screener field is recorded as
Failed. If respondent answers meet the Screener criteria, they are allowed to continue the survey, and
the Screener field is recorded as Passed. See the "Screener" table entry in the IBM SPSS Data Collection
Interviewer Server User's Guide “Mapping Fields to Required Columns in the Sample Table” topic for
more information.

Phone Participants Activity. The activity provides the following enhancements:
v Switch projects. Interviewers can now switch between projects to which they are assigned. See the

“Phone Participants Main Screen” topic in the IBM SPSS Data Collection Interviewer Server User's Guide
for details.

v Support for custom keycodes. The activity now supports custom keycodes that are defined for
categorical questions in Author or Professional. See the “Keycodes” topic in the Author User's Guide, or
the "Categorical" topic in the Data Collection Developer Library for details.

v Consistent keystroke support. The following keystokes can be performed before moving to the next
question and between multiple answers for a specific question:
– For text questions, the Enter key can be used to display the next question.
– The Shift+Enter keys can be used to insert new lines within a text question's response.
– The Space and Dash/Hyphen keys can be used between multiple answers for multiple-response,
categorical questions.
See the “Conducting Interviews” topic in the IBM SPSS Data Collection Interviewer Server User's Guide
for details.

v Answering Machine call outcome. The new Answering Machine call outcome is automatically
generated when mrDialer detects that a call was picked-up by an answering machine (interviewers are
no longer required to manually enter the Answering Machine call outcome). See the “Call Outcome
Codes” topic in the Data Collection Developer Library for more information.

v Transfer to Web call outcome. The new Transfer to Web call outcome allows interviewers to transfer
participants to the survey's web version. The respondents can then finish the survey on the web. When
this call outcome is selected, the interviewer is required to verify the participant's information before
hanging-up. See the “Call Outcome Codes” topic in the Data Collection Developer Library for more
information.

Activation History Activity. Each activation request is now added into a queue for asynchronous
activation. This new activity allows you to monitor the project activation status queue. The activity
provides options for viewing pending and completed activations and creating activation history filters.
See the “Activation History” topic in the IBM SPSS Data Collection Interviewer Server User's Guide for
details.
v Activation settings. Allows you to monitor the activation queue. Activation settings are available from

the Options menu.

Phone Surveys Activity. The activity provides the following enhancements:
v Ordering tab. Provides options for defining the order in which records are retrieved from each

individual queue.
v Call Times tab. Provides options for defining valid participant call times and for creating day parts for

the current project.
v Appointments tab. Provides options for defining a project expiry date and for creating appointment

schedules for the current project.
v Overrides tab. Provides options for changing the parameters that control dialing for a subset of

records.
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See the “Interviewer Server Activities in Interviewer Server Administrator” topic in the IBM SPSS Data
Collection Interviewer Server User's Guide for details.

For Administrators and Developers

Configure for FIPS 140-2 Compliance. You are now presented with a FIPS 140-2 Compliance step during
installation, allowing you to decide whether or not the installation will be configured for FIPS 140-2
compliance. FIPS 140-2 is a U.S. government computer security standard used to accredit cryptographic
modules.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not Configure
for FIPS 140-2 Compliance is enabled; for upgrade installations, the following rules apply:
v If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded in the

following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup log file. The log file is located at:
\Installer\NewPassword.log Interviewer Server Administrator administrators can supply users these new,
temporary passwords in a manner that is in accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change their passwords
at next login.

v When upgrading on a server that is currently not configured for FIPS 140-2, you are presented with the
option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash function
algorithm.

v Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the SHA-1 hash
function algorithm will continue to be employed.
– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the parameters
outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology website for more information regarding FIPS
140-2.

Note: When FIPS 140-2 is configured, the applications adhere to the password protection security
protocols that are defined on the IBM SPSS Data Collection Interviewer Server. For example, if the IBM
SPSS Data Collection Interviewer Server is configured for MD5 security, the client-side applications will
also use MD5 security for password protection, regardless of whether or not the Configure for FIPS
140-2 Compliance setting was selected during installation.

Cluster Single Sign-on. A single sign-on implementation for clustered environments improves user and
role administration. Cluster single sign-on allows a Interviewer Server Administrator user to perform
activities on each clustered IBM SPSS Data Collection Interviewer Server without signing onto each
server. For more information, see the Single Sign-on in a Cluster Environment topic.

Answering Machine Detection. mrDialer now supports answering machine detection. When an
auto-dialed participant record is dialed, and mrDialer detects that an answering machine picked up the
call, the call is automatically ended with the Answering Machine call outcome. See the “Configuring
Answering Machine Detection” topic in the IBM SPSS Data Collection Interviewer Server User's Guide for
more information.

Refer to your mrDialer documentation for instructions on configuring mrDialer for answering machine
detection.

28 IBM SPSS Data Collection\Dimensions What's New Guide

http://csrc.nist.gov/groups/STM/cmvp/standards.html#02


New and updated mrInterviewData tables. The following tables were added or updated for the
mrInterviewData database:
v AccessControl (updated)
v GlobalFilters (new)
v Projects (new)

Load Tool. The Load Tool now provides support for testing phone surveys.

What's New in mrInterview 5.5
This topic lists all changes and enhancements available in mrInterview 5.5. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in the Dimensions Development Library.

For Administrators and Developers

Remote Interviewing. The Phone Participants and Review Interviewers activities now support remote
interviewing.

Predictive dialing. The following changes have been made related to the provision of predictive dialing.
v The default values for most of the predictive dialing algorithm's properties have changed.
v The following properties have been added as CATI parameters: EnforceMaxSilentCalls,

MinPredictWaitingInterviewers.

Promote Sub-folders option for Promote Project. The new setting controls whether sub-folders are
promoted with the project files. See “Specifying the Activation Parameters” in the Promote Project chapter
of the IBM SPSS Data Collection Interviewer Server User's Guide for details.

Documentation

The following changes have been made to the technical documentation in the mrInterview section of the
Dimensions Development Library:
v Architecture documentation for Interview Player is now available. The new documentation provides an

overview of the Interview Player components and describes how the synchronization process works.

What's New in mrInterview 5.0
This topic lists all changes and enhancements available in mrInterview 5.0. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in the Dimensions Development Library.

For Administrators and Developers

Installation. In common with other products in the Dimension suite, mrInterview now uses a different
form of licensing. mrInterview uses product and concurrent usage licenses. The changes to the
installation procedure can be summarized as follows. Please be sure to read the installation instructions for
full details.

v Instead of entering your license codes at the start of the installation procedure, you now select the
components that you want to install and then use the License Activation Wizard at the end of the
installation procedure to activate the appropriate product licenses.

v Concurrent usage licensing limits the number of interviews that can be run at the same time and is
implemented using a (supplied) third party product called Sentinel License Manager, which you will
need to install separately. You will be asked to specify a machine on which you installed Sentinel. (If
your company already uses this product you can name the server on which it is installed.)
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Configuration settings for Phone Participants and Review Interviews. The new
DisplayCommentsInReverseOrder setting in the Phone Participants and Review Interviews Web.config files
causes interviewer comments to be displayed with the most recent comments at the top of the list.

Configuration settings for Promote Project. When a user activates a project that uses sample
management from one server to another, the dialog box displays a Participants frame in which the user
may specify the name of the database server, the sample database, and the sample table, as well as
choosing whether and from which queues to copy sample records. You can control access to these
facilities by altering the activity's application settings in DPM, for example to allow users to create new
sample databases or to prevent them copying records from queues other than the FRESH queue.

Predictive dialing. The following changes have been made related to the provision of predictive dialing.
v A fully functional predictive dialing algorithm is now supplied which replaces the rudimentary version

installed with mrInterview 4.5.
v Call Log Analysis for the Predictive Dialing Algorithm describes an investigation into call outcomes on

typical projects that helped shape functionality of the predictive dialing algorithm.
v The following properties have been added as CATI parameters: TargetPredictiveSilentCalls,

ControllerIntegralGain, and ControllerProportionalGain.
v The MinPredictiveSilentCalls property is no longer used and has been discontinued.

Entering single-choice answers in telephone interviews. When telephone interviews are conducted
using the HTML player and interviewers enter or select a single-choice answer, mrInterview displays the
next question straight away. If you would prefer that interviewers have to press Enter before the next
question is displayed, set NoAutoJump as one of the HTMLOptions for the Web Service.

mrInterview Load Tool. The maximum length for filenames has been increased from 16 to 30 characters.

Documentation. The following changes have been made to the technical documentation in the
mrInterview section of the Dimensions Development Library.
v A new topic lists reasons why users may be having problems accessing the interviewer session engine.
v A new topic explains how you can set up interviewer session engines for Web interviews only or for

telephone interviews only.
v The documentation for the quota object model has been moved to the Interview Scripting Reference

section of the Dimensions Development Library documentation to accompany the new chapter on
quota scripting.

Sample Management

Read-only columns in sample tables. You can now designate certain columns in a sample table as being
read-only, which prevents them being updated by sample management. This facility is primarily of use
for non-SQL databases that are linked into mrInterview to provide sample.

Audit field in sample records. The following changes have been made to this field.
v The Audit field no longer records changes made to the Comments field in the sample record. This

makes it easier to pick out details of changes to other fields in the record.
v Each entry in the field now stores the server date and time at which the change was made and the

name of the person making the change.
v Entries are formatted over two lines. The first line shows the date, time and user name; the second line

show the change made. The date and time are shown in the “long” format that gives month and day
names, and the server's time zone is included, both of which make the information easy to understand
regardless of the date and time format you normally use. Audit information from versions prior to v5.0
is not reformatted.
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Interviewer qualifications. Interviewer qualifications have been extended to cater for record selection
using sample segmentation. This type of qualification can be activated as required and can be changed by
interviewers according to the current requirements of the project.

Data types in sample tables. In preparation for supporting formats other than SQL for sample databases,
the way that data types are referenced externally in sample management has been changed. Where
previously data types were referenced using their SQL names, they are now referenced using their Data
Model names. These are as follows:

Data Model data type Maps to SQL data type

Long If length is 2, then maps to smallint; otherwise maps to int

Bool bit

Date datetime

Text(length) If length is less than 8000 then maps to nvarchar(length); otherwise
maps to ntext

Note that this change is an external one only. Internally, the Data Model data types are mapped to the
data types used by the database application you are using.

The Sample Table and History Table topics have been updated to reflect these changes.

Scriptwriting and Activation

Building questionnaire scripts. The interviewing program does not support .mov and .avi files as images.
The formats have been removed from the documentation for categorical questions, grids, and numeric
grids in the InterviewBuilder chapter of the mrInterview User's Guide.

Loading participant records. The following changes have been made to the Participants activity.
v On the Upload tab, the behavior of the “File containing participant records” box has been modified as

follows:

Upload outcome Action

Successfully uploaded The file is deleted from the disk and the File box shows
“No file loaded”

Successfully uploaded but contains duplicates, or

Unsuccessfully uploaded and a transaction has already
started

As above. If you still want to add the records to the
sample database, recreate the file (for example, copy it
from its back-up location), correct any errors (remove
duplicate records, perhaps), and repeat the upload
process from the beginning.

File fails data validation (e.g., wrong data type for a
column)

No transaction is started and the file is not deleted.
Correct the file or the columns specifications and click
Import Participants again.

v Participants now remembers any changes you make on the Additional Fields tab to the data type, field
length, and default values and displays them as the defaults the next time you use the tab. This is
particularly useful when you need to load a project's participant records from a number of files.

v On the Additional Fields tab, the data types shown in the Type column are now reported using
Dimensions Data Model terminology rather than SQL terminology. This should not affect the validity
of your records in any way. The changes you will notice are as follows:

SQL data type used pre-v5.0 Data Model data type used v5.0 and later

smallint or int Long
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SQL data type used pre-v5.0 Data Model data type used v5.0 and later

bit Boolean

datetime Date

nvarchar or ntext Text

See “Adding Other Information to the Sample Table” in the Participants chapter of the mrInterview
User's Guide for details.

v If you upload a file that has only a subset of the default fields (for example, a file designed for Web
interviewing loaded into a telephone interviewing project) the View tab shows only the default fields
present in the records. If you then upload a file that has more of the default fields (a file designed for
telephone interviewing, for instance), the View tab is now updated to show all the fields present in
either file. This is a change to the earlier behavior where only the default fields present in the first file
were visible. The exception is if you manually specify which fields are to be displayed on the View tab,
in which case you only ever see those fields.

v When displaying long fields on the View tab, Participants now shows only part of the field's contents.
Click anywhere in the field to view the full text in a pop-up box.

v When you change fields in sample records using the View tab, Participants no longer records changes
made to the Comments field in the Audit field. This makes the Audit field easier to read.

v Entries added to the Audit field now contain the date and time (according to the Accessories server) at
which a sample record was changed and the name of the person who made the change. The date and
time are shown in the “long” format that gives month and day names, and the server's time zone is
included, both of which make the information easy to understand regardless of the date and time
format you normally use.

v When downloading records, Participants creates a .csv file and has always used a semicolon as the field
delimiter. This has changed in version 5.0 so that the exported file uses the same field delimiter as was
used when the file was uploaded. You cannot currently change this.

v Although Timezone is a required field, Participants does not automatically assign a default value for it
in records that do not have a time zone specified. The problem has not yet been completely resolved,
but you can now force Participants to create the column in the sample table by specifying Timezone as
the last field in the record. The default value is the time zone setting for the Accessories server.

Activating projects. At the end of the activation process, the Launch activity now copies any files that
were copied into the Shared or Master folders back into your User folder. If you switch between using
mrStudio and mrInterview while developing a questionnaire, this ensures that you will always be using
the most recent versions of the project files in both applications. (In earlier versions, it was sometimes
possible to overwrite a newer file with an older one by activating sometimes in mrStudio and at other
times in DimensionNet. The "Activation Process" topic in the Launch chapter of the mrInterview User's
Guide has been updated accordingly.

Activating to another server. The following changes have been made to Promote Project.
v You can now activate projects that use sample management. This includes the ability to upload

participant records from one server to another. See “Specifying the Activation Parameters” in the
Promote Project chapter of the mrInterview User's Guide for details.

v You can specify which users will be able to access the project on the destination server. See “Specifying
the Activation Parameters” in the Promote Project chapter of the mrInterview User's Guide for details.

v The login dialog has been separated from the dialog for specifying activation parameters, and the
activity now remembers the server name or URL and your user name between sessions. See “Logging
in to the Destination Server” in the Promote Project chapter of the mrInterview User's Guide for details.

Setting up telephone surveys. The following changes have been made to the Phone Surveys activity.
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v You may now set up projects so that the next participant record is selected and passed to an
interviewer as soon as the interviewer finishes his or her current call. Refer to “Interview Settings” in
the Phone Surveys chapter of the mrInterview User's Guide for details.

v It is now possible for interviewers to select their qualifications at the start of a session and to alter
them during the course of the session. This makes it easier for interviewers to be allocated different
types of numbers according to the current sampling requirements. For example, if the number of
completed interviews in a particular location is very low, you can temporarily allocate more
interviewers to that location simply by having them change their location qualification. You can switch
this option on and off and can choose which qualifications are available for setting in this way using
the Interview Settings tab. See “Interview Settings” in the Phone Surveys chapter of the mrInterview
User's Guide for details.

v The “Can view other settings” and “Can edit other settings” features that relate to the use of the
Dialers tab have been renamed “Can view dialer settings” and “Can edit dialer settings” as this more
accurately reflects the features' purpose. “Controlling Access to Phone Survey Features” in the Phone
Surveys chapter of the mrInterview User's Guide has been updated.

Sending email. The drop-down selection list for the “Write into sample field named” box on the Email
text tab now lists only those fields that are the right length and type for storing dates and times.

Telephone interviewing — Interviewer Comments. The following changes have been made with regard
to interviewer comments entered on the main screen or on the appointment setting page. These changes
resolve a number of usability issues with the behavior of the Comments box and with the comments
themselves. Key differences from previous versions include:
v You now enter comments in a separate dialog box rather than directly into the Comments box on the

main screen.
v New comments are appended to existing comments.
v Each comment is tagged with the date and time (local to the interviewing server) at which it was

made, and the call outcome for the call.
v Comments are stored and displayed as three lines: the date and time and interviewer name, the

comment text, and the call outcome. Comments entered in versions prior to v5.0 are displayed in the
new format but are not reformatted in the sample table until a new comment is added.

v When you make appointments, the Comments box at the foot of the appointments frame no longer
displays the full set of comments for the record. Instead, it is blank and accepts new comments only.
These comments are appended to the main comments list when you submit the appointment.

A new topic that describes this functionality in full has been added to the user documentation. See
“Viewing and Entering Comments” in the Phone Participants chapter of the mrInterview User's Guide for
details.

Telephone Interviewing — Other changes

v The short-cut key to start dialing has been changed from Alt+D to Alt+# to avoid a conflict with
Internet Explorer 7.0 in which Alt+D takes you to the address bar.

v Interviewers may set and change their qualifications during an interviewing session. If this option is
available to you, you will be prompted to select your qualifications at the start of each session, and the
Change Qualifications button will be activated in the interviewing toolbar for altering your
qualifications partway through the session. See “Setting Interviewer Qualifications” in the Phone
Participants chapter of the mrInterview User's Guide for details.

v Supervisors may configure projects so that you do not need to click Next Contact to request a new
participant. Instead, Phone Participants will select the next participant automatically as soon as you
end your current interview. When you reach the end of your shift or you just need to take a break,
click the Cancel Current Contact button. This takes you to the usual page with the Next Contact,
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Specific Contact, or Exit. The “Using an Autodialer to Make Calls” and “Using Manual Dialing to
Make Calls” sections in the Phone Participants chapter of the mrInterview User's Guide have been
updated to reflect this change.

Monitoring remote interviewers. The Remote Manager activity has been added to allow you to monitor
the activities of remote interviewers. Remote interviewers use Interview Player to conduct interviews,
then synchronize their data through the Remote Manager Web service. See the Remote Manager chapter
of the mrInterview User's Guide for details.

Looking at your survey results. If you are working on a project where your access to the data is
restricted by a global filter, Survey Results displays the filter at the top of all your tables. You cannot
change it or remove it from the table header. (Global filters are applied at the user or role level to restrict
a user's or role's access to a project's data. They are set by your DimensionNet administrator.)

Exporting data. The following changes have been made to the Export Data activity.
v If you are working on a project where your access to the data is restricted by a global filter, the filter is

displayed in the Where Am I? box at the top of the page. You cannot change or remove it.
v When exporting data in delimited text format you may now choose between exporting category names

or category values.

See “Export Data” in the mrInterview User's Guide for details.

Viewing and downloading log files. The new Manage Logs activity is a tool for viewing and
downloading log files. It is particularly useful on clustered installations where log files are spread across
various machines in the cluster. See “Manage Logs” in the mrInterview User's Guide for details.

Note: Although the primary purpose of log files is to record events, some log entries may contain actual
data or respondent details or references that enable data or respondent details to be extracted from other
files. In addition, log files are not project specific and many log entries contain the project name, making
it easy to locate information for a particular project.

Since these things are likely to be security issues in companies that provide Dimensions services to a
number of external clients or where different teams work on different clients' projects, this first release of
Manage Logs is available only to Dimensions administrators. It is planned that future releases will
automatically filter log entries so that users see only the entries that refer either to the system as a whole
or to their own projects. Administrators will, of course, still have access to all records.

Uploading participant records when activating from the desktop. If you create and activate scripts using
Scriptwriter Station, you may now upload participant records as part of the activation process. The old
Sample Management tab in the Activate dialog box has been renamed Participants and now offers this
additional functionality. See “Participants Tab” in the Scriptwriter Station chapter of the mrInterview User's
Guide for details.

This change is also available to the command-line activate program if you save the Activate document
that is created in Scriptwriter Station first, and then name that document as part of the activate
command.

Quotas for sample management variables. When using the desktop Quota program, you no longer need
direct access to the database (SQL) server in order to set up quotas for sample management variables.
Instead, you can connect to it using a special web service that gives you internet access to the server.
Once you are logged on to the server, the procedure for selecting the sample database, table, and columns
remains almost unchanged from earlier versions. See “Displaying Sample Variables in the List Pane” in
the Quota Setup chapter of the mrInterview User's Guide for details.
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Note: As a result of this change, it is no longer possible to change the name of the .mdd file created to
contain the sample variables; it is always tablename_sm.mdd, where tablename is the name of the sample
management table.

What's New in mrInterview 4.5
This topic lists all changes and enhancements available in mrInterview 4.5. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in the Dimensions Development Library.

For Administrators and Developers

Operating systems supported. The following changes have been made with regard to the operating
systems on which you may install and run mrInterview.
v mrInterview Standard is no longer supported on machines running the Windows 2000 Server operating

system.
v mrInterview Professional is no longer supported on interview, accessories, or web servers running the

Window 2000 Server operating system.
v mrInterview Professional Scriptwriter Service is no longer supported on machines running Windows

2000 Server or Windows XP Service Pack 1.
v Internet Information Services (IIS) 5.0 is no longer supported: you must use IIS 6.0.
v mrInterview can now be run with Internet Explorer 6.0 or 7.0.

Indexing the SortId column in sample tables. mrInterview now uses the SortId column in sample tables
as the source for a random number that can be used for sorting records. This column is indexed
automatically in any new tables that you create, but if you are reusing existing tables you may want to
add the index manually. (Note that indexing this column vastly improves performance even if sample
records are not randomized.)

Group and predictive dialing. Group and predictive dialing are now supported for projects that use an
autodialer.

Record and play. Recording of individual questions and playing of audio files for questions or responses
is now supported for telephone interviewers working on dialer extensions.

Default display fields for Participants View tab. The ParticipantsDefaultDisplay site property in DPM
specifies the fields that are to be displayed on the View tab in the Participants activity. The property
applies to both Web and telephone projects, so contains some fields that are applicable only to telephone
projects. These additional field names are ignored when users are working on Web-only projects. Users
can choose which fields they want to see on the View tab for each project. If they choose a different set of
fields to those listed in ParticipantsDefaultDisplay, their preferences are saved in DPM in the
ParticipantsViewer\UserName\IncludedColumns property for each project.

Configuration setting for the Participants activity. The code for the new advanced selection and editing
facilities in Participants attempts to prevent the injection of malicious SQL as part of the selection or
update commands. The "advancedvalidation" key in the activity's Web.config file lets you specify words or
characters that Participants should ignore when checking what users type in the Select and Update boxes.

Configuration settings for the Review Interviews activity. The new Review Interviews activity allows
supervisors to review completed interviews for quality control purposes.

Configuration settings for interviewing activity reports. The new Interviewing Activity Reports activity
shows how busy each interviewer session engine is, and which projects are using each engine.
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Allowing use of .sam sample management scripts. For some time now, the use of .mrs sample
management scripts has been recommended for Dimensions projects. To further encourage this, the
option to select a .sam script for Dimensions projects has been removed (.sam scripts may now be selected
for Quancept projects only). If your company has an overriding requirement to use .sam sample
management scripts with Dimensions projects, you may reinstate the option to select .sam files by setting
the ShowVBScriptProvider key to 1 in the registry. This key is of type DWORD and is located in
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\mrInterview\3\Activate. If the key is not defined or has
a value of zero, .sam files cannot be selected.

Database maintenance. The new Maintaining Databases topic describes a recommended plan for
maintaining mrInterview databases that includes periodic re-indexing of databases to improve
performance.

Restarting timed-out interviews. The documentation for clicking Next to restart timed-out interviews has
been updated to describe what happens when the interview script has changed since the interview was
first started. The default is to use the latest version.

Cluster tuning. The test projects used in the cluster tuning example are now installed with the
Dimensions Development Library. You can find them in [INSTALL_FOLDER]\IBM\SPSS\
DataCollection\7\DDL\Scripts\Interview\Performance.

Load Tool. The following changes have been made to the mrInterview Load Tool.
v The default stagger time for concurrent interviews has been changed from zero to one second on the

General Parameters tab.
v If the test creates dummy sample records via parameters on the interview URL, the Queue filter on the

Sample Management tab is redundant and is not applied.
v The Test interview option is now selected by default on the Interview Parameters tab, so that all

interviews are flagged as test interviews.
v On the Interview Parameters tab, you can now specify interview and non-interview parameters to be

included in the URL of each interview.
v The Actions and Navigations labels on the Respondent tab have been updated to "Actions (per

interview %)" and "Navigations (per page %)" respectively to remind users of the base used for each
set of calculations.

v The AutoAnswer interview property is always set to 1 on the interview URL to indicate that interviews
will be running in Auto Answer mode. This change allows the interviewing process to bypass scripting
statements, such as quota checks, that are not valid for interviews run in this way.

Script that lists project properties. The ReadProjectAttributes.mrs script in [INSTALL_FOLDER]\IBM\
SPSS\DataCollection\7\DDL\Scripts\Interview\Utilities creates a file listing the project properties
(including Creator and DateCreated) for all projects in DPM. This may be useful for administrators
carrying out server maintenance work.

Telephone interviewing reports. Each report now has a SampleFilter property that indicates whether it is
a cumulative report based on history records or a sample report based on counts of sample records. The
Phone activity uses this property to determine how reports should be grouped. If the property is True,
the report goes under a sample setting and a filter is applied to reduce the report to just one record per
sample record. If the property is False, then the report goes in a history section and the filter is not
applied. This property is defined for each report in DPM (for example, in
Servers>ServerName?Applications>CatiReports>SampleUsage>SampleFilter) and replaces the sample filter
setting that used to be set in each report. If you write your own phone reports you can use this property
to add your report to the appropriate group.
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QSamp dialer interface component. The value of the DialingProvider property is now set to
QSampGroupSM.Provider when the dialing option is chosen in the Phone Surveys activity. This
supersedes the previous setting of QSampExtSM.Provider and allows predictive dialing to take place.

Cross-site scripting. The mrInterview activities have been reviewed to check whether they allowed for
cross-site scripting to take place and several internal changes have been made to prevent this. A new
topic has been added to the DimensionNet section of the Dimensions Development Library
documentation giving suggestions on how to avoid this in your own applications and some
recommendations for further reading on the subject.

Orphaned sample and quota objects. Orphaned objects are objects that are not assigned to an existing
project. The Dimensions Development Library installs the RemoveOrphanSampleAndQuota.mrs script for
removing orphaned sample and quota objects from DPM. The script is installed in [INSTALL_FOLDER]\
IBM\SPSS\DataCollection\7\DDL\Scripts\General\mrScriptBasic. To run it, open a command prompt
and type mrScriptCL RemoveOrphanSampleAndQuota.mrs.

Sample Management

Using an autodialer. The autodialer software now provides support for group and predictive dialing. A
new sample management script is provided for projects that require this capability. The script is stored in
DPM in the PredictScript property in SampleManagements>ProjectName>DialingPredict .

NOT_IN_USE queue. This new queue has been added to the CATIPredefinedQueues site property and
provides a means of removing records from a project without having to delete them from the sample
table. Any records in this queue are ignored for interviewing purposes but remain available for phone
reports.

Queue for records with DialerFailed call outcome. DialerFailed indicates that a record could not be
dialed due to an ISDN failure. Records with this outcome used to be placed in the SILENT queue with a
recall time of 72 hours. However, records in this queue contribute to the Silent Calls report which
companies often use as evidence that they are not breaking the silent call regulations for their country. To
avoid the possibility of artificially inflated counts, DialerFailed calls are now placed in the RECALL
queue, still with a callback time of 72 hours, and are presented for recall in the normal way.

Recall time for records in the SILENT queue. The multimode1.mrs sample script now sets a RecallTime
for records in the SILENT queue. This allows supervisors to move these records to the RECALL queue
and for the records not to be called until after the SilentAppointmentMargin time has passed. This change
mimics the existing behavior whereby an AppointmentTime is set so that records can be moved to the
APPOINTMENT queue and not be presented for calling until the AppointmentTime has passed.

Reviewed interviews. The following changes have been made in relation to the new interview review
facility:
v The PreviousInterviewerId field in the sample record is updated with the name of the reviewer.
v Sample records for interviews that are rejected by reviewers are assigned call outcome code 34,

RejectedByReviewer, and are moved into the UNUSABLE queue.

Registry keys. All sample management components now use registry keys defined in
HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\MRPropertyManagement\2.0. In earlier versions, some
components still used keys in ...\MRPropertyManagement\1.0.

Scriptwriting and Activation

Resizing text on tabs. You can now resize the text on tabs in all activities using your browser's text
resizing options. (In Internet Explorer, select View, Text Size and then choose from a drop-down list of
sizes.)
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Participant records. The following changes have been made to the Participants activity.
v The field delimiter chosen on the Upload tab is now remembered between sessions. Once you choose a

field delimiter, this character then becomes the default for all subsequent file uploads until you specify
a different delimiter. Each user has his/her own default field delimiter.

v The Apply button is now disabled (dimmed) on the View Settings tab to show that the expression has
been applied. It becomes available when you enter a new expression.

v The display state of the View tab (that is, " display all" or "display selection") is now remembered
between sessions so that the tab operates in your current session the way you left it in your previous
session.

v Each queue on the Summary tab has a View Queue icon that you can click to open the View tab with
the records in the chosen queue displayed.

v To reduce the need for horizontal scrolling, the View tab now shows a subset of the fields present in
participant records rather than all fields. A system-wide set of defaults exists but you can change it for
individual projects. See “Viewing and Editing Participant Records” in the mrInterview User's Guide for
details.

v A progress bar is displayed while records are being uploaded.
v A message is now displayed on your screen if the file you are trying to upload is too big. If this

happens, contact your DimensionNet administrator for help.
v You can now download all selected records rather than having to download them a page at a time and

then merge the resultant files. See “Downloading Records” in the mrInterview User's Guide for details.
v If you want a quick method of manipulating groups of records, use the Bulk Edit feature. With this

method, you type an SQL query that specifies the records you want to select, and Participants displays
a grid of records matching those criteria. See “Performing a Bulk Update” in the mrInterview User's
Guide for details.

v Participants now sets the SortId field to a random number as it loads records. If you load records in
batches, you have the choice of leaving the sort IDs for existing records unchanged, or of assigning
new IDs to all records. See “Naming the Database Server, Sample Database, and Sample Table” in the
mrInterview User's Guide for details.

v The standard view for text and numeric fields now supports the selection options “starts with”, “does
not start with”, “ends with”, and “does not end with”. See “Displaying a Selection of Records” in the
mrInterview User's Guide for details.

Activation. The option to select a .sam sample management script is no longer available for Dimensions
projects. Your Dimensions administrator can reinstate it if absolutely necessary, but note that .mrs scripts
are recommended for Dimensions sample management.

Sending email. The following changes have been made to the Email activity.
v You can now define a user name that will appear as the sender of the email in place of the sender's

email address.
v The “Text of email” box on the Email text tab now contains a suggested message text that includes

substitution markers to show the points at which participant- or project-specific information should be
inserted.

v The list of text substitutions now shows the most commonly used substitutions at the top of the list.
v If you choose to record when the email was sent, you may now choose the name of the sample field to

which the date and time should be written.

See “Creating a New Job” in the mrInterview User's Guide for details.

Managing telephone interviewing projects. The following changes have been made to the Phone
Surveys activity.
v You can now decide whether appointments should ever be restricted to being returned to the person

who made the appointment, or whether they are always eligible for calling by any interviewer.
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In earlier versions, records whose appointment time was within the time specified by “Before an
appointment, by arranger only” would be eligible for selection as long as the interviewer who made
the appointment was free to take the call. If that interviewer was not free, the record would not be
selected until either that interviewer became available or the appointment time fell within the time
specified by “After an appointment, by any interviewer”. At this point, the record could be allocated to
any interviewer who was available to take the call.
In version 4.5 the calling times have been separated from the requirement to return appointments to
the original interviewer. If you do not care which interviewer receives appointments, select “No
preference for appointments” on the Parameters tab and enter the time at which appointments become
eligible for selection in “Before an appointment, by any interviewer”. For example, if you want any
interviewer to be able to accept records whose appointment time is 3pm at any time from 2:50pm
onwards, type 10 in this field.
If you want appointments to be returned to the person who made them, choose “Give preference to the
interviewer who arranged the appointment” and enter the start and end of the calling window in
“Before an appointment, by the arranger only” and “After an appointment, by any interviewer”.
Records are then selected only for the person who made them while the calling window is open. After
that time records are allocated to anyone who is free. So, if the Before time is five minutes and the
After time is ten minutes, and Ben makes an appointment for 3pm, only Ben can take that call between
2:55pm and 3:10pm. After that it can be allocated to any interviewer.
See “Defining Sample Management Parameters” in the mrInterview User's Guide for details.

v The Call Outcomes tab now allows you to hide selected call outcomes from interviewers working on a
particular project. See “Setting Up the Call Outcome List” in the mrInterview User's Guide for details.

v The Interview Settings tab now provides options related to the review of completed interviews by
interviewers. These include whether the whole interview or just open-ended responses should be
available for review, and whether the review should happen automatically or be under the control of
the interviewer. It also lets you to specify the dialing mode for projects that use an autodialer. See
“Interview Settings” in the mrInterview User's Guide for details.

v The Other Settings tab has been renamed Dialer Settings and now offers support for predictive dialing,
including specifying how aggressive dialing should be, and setting the silent call percentages to trigger
starting and stopping predictive dialing. In addition, the option to send caller identification has been
extended so that you can specify what telephone number to send. The default remains the dialer's
phone number.
The Dialers tab also provides a Reset Statistics button for the rare cases when you need to reset the
silent calls percentage to zero. Note that this may cause the dial mode to switch from Extension to
Group or from Group to Predictive if the dial mode has fallen back due to hitting one of the limits.
See “Autodialer Settings” in the mrInterview User's Guide for details.

Conducting interviews. The interviewing program is now able to record respondents' answers and play
sound recordings to respondents. When recording or playback facilities are available, additional
start/stop buttons are displayed close to the question or response texts. The scriptwriter may write
include additional instructions in the question or response texts telling you how and when to use these
facilities. See “Recording the Participant's Answer” and “Playing a Sound to the Participant” in the
mrInterview User's Guide for details.

Reviewing interviews. Completed interviews can be reviewed either from the Phone Participants screen
or by running the new Review Interviews activity from DimensionNet. Interviewers will normally close
their current call and then review the interview to add text responses that they wrote down manually
during the interview, or to correct typing errors and similar in other texts. Supervisors will typically run
the Review Interviews activity and will be able to select interviews at random to run spot checks on
interviews for quality control purposes. In the mrInterview User's Guide, see “Reviewing Interviews” for
details of the review option in Phone Participants and “Review Interviews” for details of the supervisory
activity.
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Note: Reviewing interviews replays the script using the respondent's answers. If the project uses quota
control, the reviewing process attempts to pend the respondent's quota cells again. If the quota is now
full, the review path will be different from the original path. However, if the quota is not yet full, the
quota count is incremented again. Scriptwriters can prevent this happening by filtering the statements
that test and update quotas so that they do not apply to interviews that are being reviewed. See
“Reviewing Completed Interviews” in the Dimensions Development Library documentation for details.

The BasicQuota.mdd, LeastFullQuota.mdd and SimpleQuota.mdd sample scripts that are installed in
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\DDL\Scripts\Interview\Quotas, and the
MM1WithQuota.mdd sample script in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\DDL\Scripts\
Interview\CATI\MultiMode1 have been updated so that the review path is based on the pend results at
the time an interview was run.

Monitoring interviewers. The following changes have been made to the Interviewer Monitoring activity.
v When you select an interviewer to monitor, the display of that interviewer is now shown on the

Monitor tab, and you can switch between this tab and the Interviewers tab as necessary. See
“Monitoring an Interviewer” in the mrInterview User's Guide for details.

v The new Dialers tab gives a comprehensive overview of dialing activity on projects that are using any
form of autodialing. This includes the total number of interviewers (waiting interviewers are shown
separately for projects using predictive dialing), the percentage of silent calls, and the type of dialing
on each interviewing engine and dialer group. Certain parameters, such as dialing aggressiveness, can
be changed on this tab. See “Monitoring Silent Calls” in the mrInterview User's Guide for details.

Survey results. This activity now supports the use of date and boolean variables and text grids in tables
and as filters.

Phone reports. The following changes have been made to the Phone Reports activity.
v The screen layout has been changed so that the activity now has two tabs: the Overview tab that lists

the reports that can be run, and the Selected Report tab on which you specify further parameters for
the chosen report.

v Reports are now listed in groups according to whether they are based on call history or sample
information. This makes it easier to see which reports show cumulative counts (call history) and which
show record counts (sample information). A “most used” group lists the most frequently used reports.

v You can filter reports using filters of your choice. Filters are chosen on the Overview tab and are set up
using the new Tools, Set Filters option. See “Filtering Reports” in the mrInterview User's Guide for
details.

v The new Tools menu also provides facilities for choosing which reports to download, setting up
predefined filters of your choice (for example, all calls made during the morning shift), and defining
general options such as the type of data to report on (moved from the main screen) and how the report
is to be produced (for example, in HTML format with charts).

Interviewing activity reports. Interviewing Activity Reports is a new activity that reports the amount of
activity taking place on the interviewer session engines running on your system. The activity provides
two reports. Engine Status shows the current status by engine, giving the current load for the engine as
well as the number of projects and interviews currently running. Project Status shows the current engine
status broken down by project. For each project you see the version numbers, the names of the engines
on which each version is running, and the number of live and test interviews currently running. See
“Interviewing Activity Reports” in the mrInterview User's Guide for details.

Exporting data. The name of the zipped export file now contains the data format; for example, csv for
delimited text files. See “Export Data” in the mrInterview User's Guide for details.

Quick way to set up sample quotas. In the DDL, “Sample Quotas when you have No Access to the
Sample Database” describes a quick and easy way to set up quotas based on sample data. As the title
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explains, the technique is particularly useful for users who are working remotely and have no access to
the sample database, but it works equally well in other cases too. You may therefore prefer to use it to
the standard method of setting up sample quotas.

Quota reports. The Dimensions Development Library installs a new script that produces a simple quota
report in Excel format. The report lists the quotas and shows the target and the number of completed and
pending interviews for each one. The script is called DebugQuotaReport.mrs and it is installed in
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\DDL\Scripts\General\mrScriptBasic.

The program defines three variables whose values you may need to change. PROJECT_NAME is the
name of the project whose quotas you are checking. DEBUGQUOTA_DATASOURCE is the name of your
SQL datasource; the default is “(local)\SQLExpress". DEBUGQUOTA_DATABASE is the name of the
quota database containing the project's quotas. Just open the file in Notepad and replace the variables'
existing values with the ones you want. If you need to run quota reports on a number of projects, you
may like to place a copy of the program in the project folder and run it from there.

To run the program, open a command prompt, navigate to the folder containing the program, and type
mrScriptCL DebugQuotaReport.mrs.

What's New in mrInterview 4.0
This topic lists all changes and enhancements available in mrInterview 4.0. It includes all the information
for end-users from the various What's New sections in the mrInterview User's Guide as well as details of
more technical changes that are documented only in the Dimensions Development Library.

For Administrators and Developers

Installation. The following changes have been made to the installation kit and may necessitate additional
post-installation steps if they affect you.
v The Quancept Support option is no longer automatically distributed on the mrInterview CD. Instead,

you must request a separate CD via the SPSS web site. There are a number of reasons for this,
including the fact that fewer customers are now using Quancept scripting. SPSS is also keen to monitor
usage of the Quancept Support option and distribution on request is an ideal means of doing this.
Once requested, the CD should be with you within 28 days.

v All Dimensions applications now install into [INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\
rather than into C:\Program Files\SPSS MR. This change does not normally affect users. However, it
may be necessary to move the project folders of existing projects from SPSS MR\mrInterview\Projects
into SPSS Dimensions\mrInterview\Projects if you want users to be able to test existing projects
without reactivating them first. See "Moving Project Folders for Activated Projects" in the mrInterview
4.0 Installation Instructions for details.

v Anyone who uses the Phone activity to create charts must have a valid license to use MS Office Web
Components (OWC). You must ensure that you comply with this requirement before enabling charting
for a user. Then run the ChartConfiguration.exe program that is installed with mrInterview. See
"Enabling Charts in the Phone Reports Activity" in the mrInterview 4.0 Installation Instructions for
details.

Dimensions/Quancept functionality differences. mrInterview no longer provides identical functionality
for Dimensions and Quancept projects.

Autodialing. mrInterview now supports dialing with a dialer on Dimensions projects.

Timing out interviewer sessions. The new InterviewerTimeout registry setting for the interviewer session
is used to terminate interviewer sessions that have been inactive for the time-out period. This typically
happens when an interviewer closes the browser without closing the Phone Participants activity. When
the session times out, an error is logged if the session still has an active sample record. The sample record
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remains active and will need to be moved manually to another queue. Until an Interviewer session times
out, it remains in the list of interviewers who can be monitored.

Configuration settings for telephone interviews. The following changes have been made to the Phone
Participants Web.config file.
v You can now use the INTERVIEW_SERVER key to specify the name, port, and protocol for Dimensions

projects.
v The new CheckCallConnectionStatusInterval key specifies the frequency with which the activity

checks the status of calls connected by an autodialer. The default is every 1000 milliseconds.
v The ModemName key defines the name and type of modem that an interviewer will use for modem

dialing on telephone interviewing projects.

Interviewer ID for Web interviews. The User Interviewer ID for inbound interviews is now set to __Web
in sample history records rather than being left blank (see How to Match Log Messages to Data Records
for details). In previous versions, the blank interviewer ID would be displayed as NO_NAME in phone
reports and could be filtered out, possibly masking problems where the ID was blank for some other
reason. Now, you can filter out inbound calls using the __Web ID and any records that are shown as "–"
(the new text used instead of NON_NAME) will indicate possible problems with the call.

Modem dialing. You can now specify the type of modem that Phone Participants will use for modem
dialing.

Deleting orphaned sample management objects. You can now remove orphaned sample management
objects from DPM by selecting Remove, Orphaned Sample Managements.

Moving FMRoot. A new topic explains how to move the FMRoot folder to a new location after
installation.

Configuring the image cache. The following changes have been made to the image cache.
v The new ALTERNATE_REMOTE_LOCATION setting specifies an alternate location for image and

template files that will be used when the BASE_LOCATION is not available.
v You can now choose between caching images on the server or client machines.

Customized activity reports. The ISessionEngine_GetActivityReport method generates XML that reports
information about the interviewer session engine. Four reports are possible showing interview,
interviewer, project, and dialer activity on an engine. You can use the information in this XML output to
produce your own reports. For example, you might iterate through a list of interviewer session engines
once a minute requesting the ProjectActivity report, and then create a summary table that shows how
many interviews are active on each project on each engine for each minute through out the day.

Sample Management

Using an autodialer. A number of changes have been made to the multimode1_sample.mrs sample
management script in relation to the new autodialing facilities in mrInterview 17231174.0.157. These
include:
v The CHECK_NUMBER queue is provided for records that could not be dialed due to problems with

the telephone number (for example, unallocated numbers or numbers with too few digits). The SILENT
queue is used for records that result in nuisance (silent) calls.

v A number of new call outcomes are available for use in sample management scripts and, in some
cases, for display in the call outcome list displayed for interviewers.

v The dialer has a wide range of call result codes that uniquely identify each possible call outcome.
These are generally more detailed than are needed for most sample management systems, so a
mapping file is provided that maps dialer result codes to sample management call outcomes.
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v Communication between the sample management system and the dialer is logged in the IVW*.tmp log
files.

v The script has also been updated to allocate records with appointments that are currently within the
AppointmentMarginBefore and AppointmentMarginAfter period to the interviewer who made the
previous call. Once the AppointmentMarginAfter boundary has been passed, the record may be
allocated to any interviewer.

Note: multimode1.sam has not been updated to support autodialing.

+ sign in phone numbers. If a project uses an autodialer, phone numbers that start with + will have the
+ replaced with the value of the international access code configured for the autodialer in DPM. For
example, the code to access international numbers from the UK is 00. If this value is defined in the
InternationalAccessCode property in DPM, all phone numbers that start with + will have the + replaced
with 00. White space before + signs is deleted, but any other characters are not replaced.

Signal call outcome renamed. The Signal call outcome has been renamed OverQuota to reflect its
function more accurately.

Early completion call outcome. An EarlyComplete call outcome has been added to match the
sigEarlyComplete parameter to the IOM.Terminate setting in the interview script. This call outcome is
designed for interviews that are treated as completed interviews even though the respondent may not
have answered all applicable questions; for example, you may decide to treat interviews as completed if
respondent pass a certain point in the script. EarlyComplete is not normally displayed in the list of call
outcomes that the interviewer sees during the interview, but you can change this if necessary.

User-defined call outcomes. Call outcome numbers 1 to 149 have been reserved for use by the sample
management system. If you want to define your own call outcomes you must use numbers 150 or above.

Required fields in sample records. Sample records for telephone interviewing projects now require
several additional fields. The Audit field records changes that interviewers make to sample fields at the
start of a call or during the interview (these changes were previously held in the Comments field). The
PreviousInterviewerId field holds the name of the interviewer who made the previous call to the
participant (this is used in allocating appointments to the interviewer who made the previous call). The
SortId field stores an automatically generated value that can be used as the basis for sorting records prior
to selection (this field is required but not yet used). The CallRecordingsCount stores the number of
recordings made for a record.

Telephone interviewing project parameters. The following changes have been made.
v Two new project parameters have been added. RejectDelay specifies the number of minutes that must

elapse between consecutive calls to a number that rejected a call. SilentAppointment specifies the
number of minutes that must elapse between consecutive calls to a number that may have received a
silent call. Silent calls may occur when an autodialer generates more calls than there are interviewers
available to handle the calls.

v The RecallMarginAfter parameter has been dropped because it has no effect on record selection.

Use .mrs scripts for Dimensions projects. Although you can use sample management scripts written in
VBScript (.sam files) with Dimensions projects, it is now strongly recommended that you use scripts
written in the Dimensions scripting language (.mrs files) . .sam scripts are still required for Quancept
projects but the example scripts supplied with the Dimensions Development Library will no longer be
updated to match new functionality in the equivalent .mrs files. Related to this, the folder of example
sample files (DDL\Interview\Scripts\Sample Management – VBScript) is no longer installed as part of
the Dimensions Development Library, although the .sam files it contained are available in
DDL\Interview\Scripts\Quancept.
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Changes to Multimode1.mdd and MM1WithQuota.mdd. If an interview fails due to an error in the
script, the error handler in these example projects now displays a closing page for the interviewer rather
than just hanging up the call. The closing page displays the following text for the interviewer to read to
the respondent:

“Unfortunately an error has occurred in the interviewing software. We will need to investigate the error
before we can continue the interview. Could I make an appointment to continue this interview? If you
agree to continue the interview, we will restart the interview from where we are now.”

This is followed by this instruction to the interviewer (it will be shown all in upper case to identify it as
an interviewer instruction):

“IF THE RESPONDENT AGREES TO AN APPOINTMENT, PLEASE CHOOSE THE APPOINTMENT
RETURN CODE. IF NOT, PLEASE THANK THE RESPONDENT AND CHOOSE NEXT TO END THE
INTERVIEW AND HANG UP THE CALL.”

Sample management object model. The documentation for the sample management object model has
been moved to the interview scripting reference section to keep it with the user documentation.
Documentation for the sample management provider remains in the mrInterview reference section.

Sample Management Provider XML schemas. These are now documented.

Scriptwriting and Activation

Creating questionnaires. The following changes have been made to the Build activity.
v Factors for categorical responses are now set on the Export/Analysis tab rather than on the Advanced

tab. See “Single and Multiple Response Questions” and “Single and Multiple Response Grid
Questions” in the Build section of the mrInterview User's Guide for details.

v If you load a questionnaire that has been created outside of Build and it contains items that Build does
not support, Build flags the item with a “no entry” sign (a red circle with a horizontal white line across
the middle). On the Overview tab, a note explains that you may edit the item using Scriptwriter
Station or mrStudio. See “Unsupported Items” in the Build section of the mrInterview User's Guide for
details.

v A new help topic, “Question Limits” in the Build section of the mrInterview User's Guide, documents
limits associated with defining responses to questions. Where appropriate, there are links to this topic
from the topics on the individual question types. For example, the topic on creating single and
multiple response categorical questions refers you to the Question Limits topic to find out how many
responses you can put in a categorical response list.

v A new topic discusses issues with switching between Build and mrStudio or Scriptwriter station when
working on a questionnaire. See “Switching Between Build, mrStudio, and Scriptwriter Station” in the
Build section of the mrInterview User's Guide for details.

Activation with Launch. The following changes have been made to the Launch activity.
v The Project Info tab now provides an “Activate Subfolders?” check box that you can select if the

project's folder contains localization subfolders that must be copied to the Shared and Master project
folders along with the main project files. This brings Launch into line with mrStudio and Scriptwriter
Station which already provide this facility. See “Project Information” in the Launch section of the
mrInterview User's Guide for details.

v Project template files are validated to ensure that they contain only well-formed HTML, and any errors
found are reported on-screen. See “Activation Process” in the Launch section of the mrInterview User's
Guide for details.

Activation with Promote Project. Activation across the internet (that is, by entering the DimensionNet
URL) in now available for projects that do not use sample management. This allows users who do not
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have direct access to the mrInterview cluster to activate projects without connecting to their local
network. See “Promote Project” in the mrInterview User's Guide for details.

Activation with Scriptwriter Station or the desktop Activate program. The following changes have been
made to the activation program that is run by Scriptwriter Station and the desktop activation program
(the same changes also apply to activation from mrStudio).
v Project template files are validated to ensure that they contain only well-formed HTML, and any errors

found are reported on-screen. See “Activation Process” in the Scriptwriter Station section of the
mrInterview User's Guide for details.

v The Advanced tab of the Activate dialog box contains an option for assigning roles to the project so
that users other than yourself have access to the project. See “Advanced Tab” in the Scriptwriter
Station section of the mrInterview User's Guide for details.

v You can now activate projects across the internet (by specifying the DimensionNet URL) rather than by
accessing your site directly through your local network. This facility is not yet available for projects
that use sample management. See “Activating Projects” in the Scriptwriter Station section of the
mrInterview User's Guide for details.

v In Scriptwriter Station, the Primary Site Server box in the Options dialog box has been renamed to
indicate that either a server name or a DimensionNet URL may be entered. See “Setting Options” in
the Scriptwriter Station section of the mrInterview User's Guide for details.

v When activating from the command line, you have always been able to save yourself time on a new
project by taking an existing activate document and editing it for the new project. You can still do this,
but it may be necessary to make additional changes to the Activate Document if you are switching
between local and internet activation. Note that internet activation is not yet supported for projects that
use sample management. See “The Activate Document” in the “Activating Projects from the Command
Line” section of the mrInterview User's Guide for details.

Using an autodialer for telephone interviewing projects. You can use the new Dialer Administration
activity in DimensionNet to allow your telephone interviewing projects to use an autodialer. An
autodialer is a computer that automatically dials the phone numbers of participants to generate calls for
interviewers. The use of an autodialer also makes audio monitoring of interviewers possible. In addition
to setting up an autodialer in the Dialer Administration activity, you must also enter a position name on
every station that will use the autodialer. See “Dialer Administration” in the mrInterview User's Guide for
details.

Several of the telephone interviewing activities have also been changed to support the use of a autodialer,
as described below.

Setting up telephone interviewing projects. The following changes have been made to the Phone
Surveys activity:
v You can use a new option on the Interviewer Settings tab to specify that the project will use an

autodialer. If you select that option, you will also be able to amend the options on the new Other
Settings tab. All of the settings on the new tab currently relate to the use of an autodialer and include
the option to specify how long interviewers must wait to be connected to a participant before they can
leave their stations.

v The Define Fields, Define Parameters, and Define Call Outcomes tabs have been renamed Fields,
Parameters, and Call Outcomes. The Parameters tab includes two new settings called “Reject Delay”
and “Silent Appointment”, which relate to the use of an autodialer.

v The “Recall Margin After” setting, which was inoperative, has been removed from the Parameters tab
and the sample management script multimode1_sample.mrs no longer refers to that setting.

v You can now control access to the individual tabs in Phone Surveys.

See “Phone Surveys” in the mrInterview User's Guide for details.
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Conducting telephone interviews. The following changes have been made to the Phone Participants
activity:
v For projects that use an autodialer, a Start Dialing button replaces the existing Get Contact button.

Interviewers click the Start Dialing button when they want the autodialer to connect them to a
participant. Unlike manual dialing, the interviewer will see the participant's details on the Phone
Participants main screen only when the participant picks up the phone. Once the interviewer is
connected to a participant, the procedure for conducting an interview, making an appointment, or
selecting a call outcome is the same as for manual dialing.

v To make it easier for interviewers to use the keyboard only, keyboard shortcuts have been assigned to
the buttons used to retrieve the next contact, start the interview, and so on. A keyboard shortcut has
also been assigned to each outcome in the call outcome list.

See “Phone Participants” in the mrInterview User's Guide for details.

Telephone interviewing reports. The following changes have been made to the Phone activity:
v When you select a report to run, the report now appears in the center of the current browser window

(that is, the Phone activity no longer opens a new browser window to display the report). To
accommodate this change, the list of reports that you can run now appears on the left of the screen
instead of in the center.

v By default, reports no longer include charts. For information about how to show charts, search the
mrInterview 4.0 Installation Instructions for the topic "Enabling Charts in the Phone Reports Activity”.

v Three new reports have been added. They all relate to the use of an autodialer and are called “Answer
Time Distribution”, “Busy, Wait, and Idle Time”, and “Silent Call Statistics”. Note that the new reports
always show both real and test data—you cannot choose to show only real or test data.

See “Phone” in the mrInterview User's Guide for details.

Monitoring interviewers. The following changes have been made to the Interviewer Monitoring activity:
v For projects that use an autodialer, the Interviewer Monitoring activity now supports audio monitoring

of interviewers. The real-time display in the Interviewer Monitoring activity has been changed to
display one of the following states for each interviewer: Audio and visual monitoring is possible, Only
visual monitoring is possible, Monitoring is not allowed, or The interviewer is being monitored by
another supervisor.

v You can now add the following columns to the real-time display: Off Hook, Phone, Position, and Wait
Time. These columns all relate to the use of an autodialer.

v If the interviewer selects a call outcome while conducting an interview, the selected outcome is
displayed on the monitoring screen.

v Interviewers working on Quancept projects no longer appear in the list of working interviewers. This
means that you cannot monitor them at all, not even in overview mode.

See “Interviewer Monitoring” in the mrInterview User's Guide for details.

Reviewing and changing quotas. The following changes have been made to the Quotas activity.
v The Edit menu has been replaced with an Edit drop-down box on the left of the screen. This means

that your current working mode is always visible.
v You can now prioritize quotas for multiple response questions using the Quotas activity rather than

editing the QUOTA_Matrix table directly. See “Prioritizing Quotas” in the Quotas section of the
mrInterview User's Guide for details.

v Selecting a grid slice (that is, one row or column from a grid question) now displays correctly so you
can edit values in the normal way.

v Table quotas for questions in blocks are now displayed correctly.

Setting up quotas. The desktop Quota program now allows you to define quotas with a target of zero.
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Exporting data. The Export Data activity now uses the FavorMemory option when connecting to the
source data. In previous versions, the FavorSpeed option was used but this would sometimes prevent
some records being exported on projects where live data was still being collected. Future versions will
issue an error when this problem occurs.

What's New in mrInterview 3.5
This topic lists all changes and enhancements available in mrInterview 3.5. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in the Dimensions Development Library.

For Administrators and Developers

Installation. The following changes have been made to the installation program.
v You are no longer asked whether you want to install mrInterview with Quancept support. If you want

to install this option, you must run its installation program manually.
v The GNU C++ compiler is no longer installed automatically for mrInterview with Quancept Support. If

you have this option installed already, make a back-up copy of the compiler's files before you uninstall
your current version of mrInterview. You can then install mrInterview 3.5 and copy the files back into
the installation folder.

v mrInterview now works with database servers running SQL Server 2005.

Technical documentation. The mrInterview section of the Dimensions Development Library has been
substantially restructured and rewritten. Although this is an ongoing task, the current version of the
documentation should now provide more complete information about all aspects of the system for all
levels of administrative and development user. To help you find what you want as quickly as possible,
the topics have been reorganized into four main sections.
v mrInterview Architecture describes the mrInterview components and services and explains how they fit

together. Use this section if you want a broad understanding of how something works, but are not
interested in how to set it up or change it.

v Administration and Maintenance is designed primarily for system administrators and describes the
files, folders, and databases that make up mrInterview and explains how to carry out routine
maintenance and how to make basic changes to the way mrInterview works. Generally, the tasks
covered in this section do not require programming knowledge.

v Configuration and Customization describes more advanced changes you can make to your system,
including changing registry settings, editing Web configuration files, and changing the behavior of the
value cache and data transfer service.

v Monitor and Tuning System Performance explains how to set up load balancing and how to use
performance counters to monitor how your system is running.

v The Reference section contains object model documentation and is mainly of use to developers.

Indexing sample tables. All sample tables that are created by mrInterview activities are now indexed to
improve performance. If you are upgrading from an earlier version of mrInterview and you want to take
advantage of these performance gains you should index any existing sample tables manually. The same
applies to any sample tables you create manually in the future. (This information is also available as a
post-installation task in the installation instructions for the Professional installation procedure.)

Default item names in the Build activity. When scriptwriters create questionnaires in Build, they can
either accept the default names that Build assigns to questionnaire items or they can create their own
names. The default names are based on the item types, so you have questions named Quest1, Quest2,
and so on. If you have a company standard that you want scriptwriters to use, you can change Build so
that it automatically creates items with the names you want.
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Default sample management script type for activation. If a project uses sample management, the
scriptwriter selects the script from a drop-down list when activating the project. By default, only scripts
written in the Dimensions scripting language are shown for Dimensions projects, although it is still
possible to activate using scripts written in VBScript. If you want to make VBScript sample management
scripts available to Dimensions projects, set their ShowForDimensionProject property to true in
InterviewConfig.xml .

Allowing editing of sample management scripts during activation. The Dimensions Launch activity and
the desktop activate program used to allow users to edit their sample management scripts before
activation, or to type new scripts directly into the script listing box. This facility has been disabled, but
you may enable it by editing the program's Web.config file.

Participants configuration settings. Users may now view records in a sample table from within the
Participants activity. The default display shows 50 records per page, but users may choose other page
lengths from a selection list.

Phone Participants configuration settings. You can configure the Phone Participants activity to work
with multiple interview session engines. This improves performance by allowing the activity to allocate
interviewers to the least loaded session engine and provides a recovery mechanism in case a session
engine fails. You can also specify how frequently a project's properties should be refreshed in the project
cache (the default is never refresh since this can affect performance on heavily loaded machines). Refer to
"Alternate Session Engines" and "Refreshing Project Properties in the Project Cache" in Settings for the
Phone Participants Activity for details.

Load tool. The following changes have been made to the mrInterview Load Tool.
v The load tool now reports an error if you configure it without sample management but run it against a

project that uses sample.
v Two more check boxes have been added to the Respondent tab. The "Complete interviews" check box

provides more control for tests that are set to run for a fixed amount of time. When a test of this sort
ends, any interviews that are in progress normally time out. Selecting this new check box allows them
to continue to completion. The "Set delay per question" check box is designed for scripts with pages
that display more than one question. When selected, it applies the delay between pages setting (also
specified on the Respondent tab) to each question on the page rather than to the whole page itself.

Sample Management

Scripts written in the Dimensions scripting language. You can write sample management scripts using
the Dimensions scripting language, and this is now the recommended scripting method for these projects.
Not only are Dimensions sample management scripts easier to debug but they can also give better error
messages in the field.
v Dimensions sample scripts can be used with Dimensions projects only. Quancept projects still require

sample management scripts written in VBScript.
v The Launch, Email, and Participant Rules activities have been updated to support Dimensions sample

management scripts, as has the desktop Activate program.
v Dimensions versions of the standard scripts are supplied with the DDL. These files have a .mrs

extension and contain the text _sample in their names to differentiate them from other types of .mrs
scripts. For example, Multimode1_sample.mrs is the Dimensions equivalent of Multimode1.sam.

v A framework for debugging Dimensions sample management scripts is available in the Dimensions
Development Library.

v Dimensions scripting supports the use of an error handler, whereas VBScript does not. The VBScript
versions of the sample scripts use On Error Resume Next when an error occurs, whereas the
Dimensions versions of the scripts use an error handler that writes a message to the log file and then
exits. This means that if an unexpected error occurs, you have a note of the exact line at which it
occurred and the message issued.
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v If you have your own sample management scripts that you want to port from VBScript to Dimensions
script, refer to Converting .sam Scripts into .mrs Format for recommendations about the types of
changes you'll need to make.

OVERQUOTA queue. This queue was added as a standard queue in version 3.1 but was overlooked in
the documentation. It is used for sample records in telephone interviews that fail quota control tests in
sample management and for records that are returned to the script from the interview with a
sigOverQuota (signal 5) setting. The equivalent queue for Web (inbound) interviews used to be
SM_REJECTED, but this has been renamed OVERQUOTA for consistency.

Scanning queues. The new @@Row sample field works with the ScanQueue function to allow you to
step through records without changing them.

If you set @@Row to a row number and include it in the SampleFields collection passed to
FindSampleRec, FindSampleRec returns the sample record at the specified row. For example, if you set
@@Row to 1, FindSampleRec internally selects all the records that match your search criteria and then
returns the first one. If you then change @@Row to 2 and repeat the search, FindSampleRec will return
the second record in the list of records matching the selection criteria. In this way, you can step through a
set of records without having to move them into a different queue to avoid looking at them again when
you rerun the search.

This functionality is now being used as part of the ScanQueue implementation, so as long as you do not
alter the search criteria (the where and order by clauses) passed to ScanQueue, it will retrieve the next set
of records each time.

Changes to the sample scripts. The following changes have been made.
v basic_quota_pend.sam and basic_quota_fail_if_any_fail.sam now set the Test field property even if the

quota check fails.
v multimode1.sam and multimode1_with_quota.sam use the new @@Row functionality to scan all

records that meet criteria specified when the Phone Participants activity requests a specific record.
v multimode1.sam and multimode1_with_quota.sam now check the OVERQUOTA queue for records that

have been moved by a signal instead of checking the UNUSABLE queue with a CallOutCome=Signal
setting.

v multimode1.sam and multimode1_with_quota.sam now exit with a failure if an attempt to move a
record into the ACTIVE queue fails. This can sometimes happen when telephone interviewing projects
are running under heavy load.

Scriptwriting and Activation

Greyed out screens during server interaction. In order to improve reliability, a number of activities now
display a greyed out screen and, sometimes, a Please Wait box while the activity is interacting with the
server.

Writing questionnaire scripts. In the Build activity, on the Overview tab, the new “Display option”
selection box lets you choose how much detail you want to see on that tab. Choose between Full question
(the default), Question and text, or Question name. The setting chosen then becomes your default for
future sessions.

Loading participant records. The following changes have been made to the Participants activity:
v Participants now deletes the uploaded sample file when it exits in order to avoid the possibility of it

being downloaded with the Files activity.
v The new View tab lets you display, edit, delete, and download records in the sample table.
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v The new View Settings tab lets you choose how records will be displayed on the View tab. This
includes the number of records per page, and the fields to display for each record, the order in which
they will appear, and the field on which the display is to be sorted.

v The new Summary tab reports the number of sample records in each queue.
v On the Upload tab the Import Participants button is now displayed at the foot of the screen rather than

on the left.
v Participants now reuses the server, database, and table names that you used in the last session rather

than leaving these fields blank. This change is mostly of interest to members of the DPMAdmins group
because these items are normally set to pick up defaults for other users.

Activation. The Launch activity and the desktop Activate program have been updated to support sample
management scripts written in the Dimensions scripting language (.mrs files). Changes to Launch include:
v Dimensions scripts are now the default script type for Dimensions projects, and these are the ones that

are now shown in the Script selection box on the Sample Management tab. If you need to use a sample
management script that is written in VBScript you can select it using the Browse button.
(Administrators can change the default if your site still uses mainly VBScript sample management
scripts.) Dimensions sample management scripts are not supported in mrInterview with Quancept
Support, so the default for Quancept projects remains VBScript.

v It is no longer possible to edit a script in the script listing box, nor can you type new scripts directly
into this box. Your Dimensions administrator can alter this behavior so that these facilities are once
again available.

v A Script Type box may be displayed below the script listing box. If visible, this box has two functions.
First, it allows you to select the type of script you want to use (either Dimensions or VBScript) so that
the appropriate scripts are displayed in the Script drop-down list. Second, once you have chosen a
script, it is updated to show the script type of that script. For example, if the default is Dimensions and
you choose a VBScript script, the Script Type box will be updated accordingly. This box is not normally
displayed, but your Dimensions administrator can change this.

The following changes have been made in desktop Activate:
v The Sample Management Provider box has been renamed Script Type, and now shows Dimensions

Script as the default script type. Choose VBScript to select a .sam script.
v It is no longer possible to edit a script in the script listing box, nor can you type new scripts directly

into this box. Your Dimensions administrator can alter this behavior so that these facilities are once
again available.

Sending email. You may now choose between sending messages in plain text or HTML format. The
layout of the Email text tab has been changed slightly to improve usability.

Setting up telephone interviewing projects. Additional options on the Interviewer Settings tab in the
Phone Surveys activity allow you to specify whether monitoring of the interviewer by a supervisor is
allowed, and if so, whether interviewers must obtain the participant's consent for the interview to be
monitored. Defaults for these new settings can be defined in catifield_default.mdd in [INSTALL_FOLDER]\
IBM\SPSS\DataCollection\7\mrInterview\FMRoot\Shared\Cati.

Conducting telephone interviews. The following changes have been made to Phone Participants:
v Right-clicking during an interview is now disabled as it does not apply in telephone interviews.
v The left-hand side of the screen has been redesigned with the buttons being replaced by icons. The Call

Outcomes list has been converted to a scrollable list box, which ensures that it should fit completely on
the screen for most screen sizes. The documentation has been updated accordingly.

v Depending on the monitoring options set in the Interviewer Settings tab of the Phone Surveys activity,
the Phone Participants main screen may include Yes and No options above the introductory script. The
interviewer should use these options to record whether the participant has given his/her consent for
monitoring.
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v On the Create Appointments dialog box, the Submit and Cancel links have been replaced with buttons
and moved to the lower right corner of the dialog box to make them more visible.

v If you do not require modem dialing, you can run Phone Participants using the Firefox browser on any
machine that supports this browser. Modem dialing requires a Windows PC and the Internet Explorer
browser.

Monitoring interviewers. A new activity, Interviewer Monitoring, is available in the DimensionNet Phone
menu. It allows supervisors to watch telephone interviews for Dimensions projects as they are being
conducted. The default permissions for the CATIsupervisor role have been updated to grant permission
to use this activity. See “Interviewer Monitoring” in the mrInterview User's Guide for more information.

What's New in mrInterview 3.1
This topic lists all changes and enhancements available in mrInterview 3.1. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in the Dimensions Development Library.

For Administrators and Developers

Non-default port numbers and SSL. The installation procedure now caters for web sites that use port
numbers other than 80 and/or SSL. When running a Professional installation, you will be able to specify
port numbers for each server and whether or not that server uses SSL. All URLs will be set up using this
information. This is also possible in a Standard installation when the Web Service is installed onto a
separate server.

Application pools on Windows 2003 servers. When making a Professional installation on Windows 2003
servers running IIS 6.0 and above, you may choose to create separate application pools for DimensionNet
activities and mrInterview web services (mrIWeb and mrIEng). This makes it less likely that services will
fail due to reaching the 2Gb limit imposed on IIS processes in Windows 2003. It also increases reliability
because issues that cause one application pool to restart will not impact the other application pool.

Load balancing with SSL accelerators. DimensionNet load balancing now works with SSL accelerators. A
simple post-installation addition to the load balancer's Web.config file is required.

Creating new participant databases. Users who have the CanCreateDatabase property set for the
Participants activity can create new databases to store participant records. However, users can only
upload records into the database at the time it is created; they cannot create the database and load
records, and then rerun Participants to load more records into that database. This is because the
SampleMgtGUI.Config.xml file is not updated with the name of the new database when it is created so
mrInterview assumes that no one has access to it. To get around this problem, the administrator should
edit the file and manually add the new database to it.

Player for CATI interviews. The Phone Participants activity now defaults to using the new CATI
keyboard player. This player has been designed for use in call centers and allows interviewers to conduct
interviews using only the keyboard. Sites wishing to use the standard HTML player as in earlier versions
may do so by setting the value of the HTML_PLAYER key in the activity's Web.config file.

Error and message texts. The following changes have been made to the error and message texts in
StandardTexts.mdd:
v Translations are now available in the following languages: German (Switzerland), Italian (Switzerland),

Portuguese (Portugal), Romanian, and Russian.
v Error and message texts have been added for ThousandsSeparator and for Don't know, No answer,

Refused, and Other.
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Case data databases. You now have more control over the creation of case data databases for projects.
You can specify which users can create new databases, and can specify a default database for all or
selected users. In particular, these changes now allow mrInterview to write case data for more than one
project to a single database.

Case data transfer service. The Transfer Service is the mechanism by which cached interview data is
copied into the project database. If you do not use this service, the interviewing program writes data to
the database as every question is answered. When you use the Transfer Service, each interview's data is
saved in a file in the FMRoot\Interview\Cache folder until the next time the service runs. At that point,
data for completed interviews is copied into the project database and the cached files for those interviews
are deleted.

If the service fails three times to transfer a file, it now moves the file into a Failed subfolder. This folder is
now created by the installation procedure. (Prior to version 3.1 patch 2 there was no such folder and files
for failed transfers were simply deleted.)

The Transfer Service is controlled by the AutoUpdateDataModel property in DPM, which is set to 1 by
default so that data is written to the database without caching. Each project has its own copy of this
property so you can vary the way different projects' data is written. To use the Transfer Service, use DPM
Explorer to set AutoUpdateDataModel to 0.

The following performance counters have been added to mrIEng for this service, and will exist separately
for each engine: Queued Transfers, Queued Retry Transfers, Total Transfers, and Transfers/sec. These
counters are useful to observe the operation of the transfer service as it scans the cache for files to
transfer and then transfers them.

Load balancing. The following changes have been made to the Interview Engine load balancing system.
v The default value for ConnectionLimit has been increased from 500 to 1000 for Dimensions projects. It

remains at 500 for Quancept projects.
v The default load script, defaultload.mrs, has been updated with comments explaining what it does, and

now works better when using multiple instances of mrIEng on the same machine.

LoadScriptDebugger. The documentation now explains how some of the figures produced by this utility
compare with similar data in Task Manager and Performance Monitor.

mrInterview Load Tool. The following changes have been made to the mrInterview Load Tool.
v On the Settings dialog box, a Default Server Name box for naming the server on which the test

interviews will be run.
v On the Respondent tab of the Test Configuration dialog box, an Answer Pooling check box for reusing

responses selected for the first test interview in subsequent interviews, and a Max Attempts box for
specifying the maximum number of attempts that the Auto Answer player will make to answer a
question.

v On the Interview Parameters tab of the Test Configuration dialog box, a Render HTML Output check
box for making mrInterview generate the HTML code required for the interview being run.

Activating projects. The following internal changes have been made to the activation procedure that is
run from a number of mrInterview activities and desktop programs.
v Users of desktop programs such as Scriptwriter Station and mrStudio no longer require access to

FMRoot in order to activate projects. Instead, their computers may be configured to use the File
Manager Web Service for activation. Whether a user has access to FMRoot is specified when
Scriptwriter Station (or mrStudio) is installed on the user's computer, but this can also be changed
manually afterwards should the need arise.

v The activation process now copies all the files it needs to activate into a project-specific folder in the
(new) Temp folder in the user's working folder. Once it has made copies of all the files, it then
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activates them from the Temp folder. In clustered installations, a separate subfolder is created for each
interviewing server to which the files will be activated. When activation is complete, the subfolders
and files are deleted.

Activation object models. Documentation is now available for Activate.Interfaces and ActivateClient.
Activate.Interfaces contains interface information required by scripting languages such as mrScriptBasic
and by COM clients. ActivateClient contains the dialog and methods required to activate a project.

Saving data for timed out interviews. If immediate writing of case data to the database has been
disabled (by setting the AutoUpdateDataModel project property to 0), the new FlagInterviewsForTransfer.mrs
script in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\DDL\Scripts\Interview\Utilities can be
used to request that subscriptions that have not been accessed for more than eight hours (interviews that
have timed out. for example) should be transferred to the database. Refer to the comments at the start of
this file for further details.

Per interview memory usage. The amount of memory used by each interview has been decreased.

Project affinity. In order to improve memory usage when a number of large projects are running
simultaneously, project affinity has been enabled in mrInterview with Quancept support (it is already
enabled for Dimensions projects). The main effect of this change is the way that interviews for projects
are allocated to interviewing engines. In earlier versions, interviews were automatically allocated to the
least loaded engine regardless of which project they belonged to. If a number of large projects were
running, interviews could fail because there was insufficient room to load a project on any server in the
cluster. The following diagram illustrates this problem:

Project affinity causes interviews to be allocated to whichever engine currently has that project loaded in
memory, regardless of the engine's loading. For example, if the first five interviews are all for project 1
they will all run on Engine1 because that is the server on which the first interview for that project started.
If the sixth interview is for project 2, it will run on Engine2 because that is the least loaded server.
Allocating interviews in this way means that once a project has been loaded on an engine, the amount of
memory required on that engine for subsequent interviews is less and, over time, this causes more
memory to be available for other projects.

Care Needed when Resetting IIS. From time to time you may need to reset IIS. Normally, this has no
untoward effects on applications, but if IIS is unable to shut down the interview engine within the
default time-out period, the DimensionNet Usage Reports activity and Performance Monitor may start
giving incorrect values for the SPSS mrIEng/Current Interviews counter. Rebooting the machine corrects
the problem, but you can avoid it altogether by specifying a time-out period when resetting IIS. For
example, typing iisreset /timeout:120 causes IIS to wait two minutes before stopping and restarting.
This delay provides sufficient time for the Interview Engine (and other applications) to shut down cleanly
before the restart. This information has been replicated in a topic for administrators.

Sample Management

Sample scripts with quota control. A number of Sample Management scripts are now provided that
support quota control. You'll find the scripts and their associated files in the Quota and
CATI\MultiMode1 folders in [INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\DDL\\Scripts\
Interview.

Saving or rolling back pended quotas. The QuotaAutoCommit variable now defaults to 1 in Dimensions
projects so that pended quota counts are either converted to completed interviews or rolled back when
interviews terminate. This means that sample management scripts for projects that use quota control can
be made simpler, and that the basic_with_quotas.sam script becomes obsolete. (Note: In Quancept projects,
QuotaAutoCommit defaults to 0 if the project uses sample management and to 1 if not.)

Chapter 3. What's New in IBM SPSS Data Collection Interviewer Server\IBM SPSS Data Collection Interviewer Server 53



Different routing context for CATI and Web interviews. You can specify the routing context for an
interview by setting the IOM.RoutingContext property in the Sample Management script. The example
multimode1.sam script sets up interviews to use the CATI context for CATI interviews and the Web context
for Web interviews. multimode1.mdd has been changed to use multiple contexts

Updated .sam scripts. All the .sam scripts have been updated to be more consistent and improve logging.
In some cases these changes are substantial so if you are using a modified version of one these scripts
you may wish to review the changes that have been made.

Changed behavior in quo_basic.sam. This script used to move records that failed authentication into the
SM_REJECTED queue, and records rejected by the interview script went into the SIF_OVERQUOTA
queue. They now both go into an OVERQUOTA queue, which makes it easier to move them back all at
once if necessary.

Scriptwriting and Activation

Creating questionnaires. The following changes have been made to the Build activity.
v The new Export/Analysis tab lets you specify variations of the standard question and response texts

that can be used as variable and category labels when the questionnaire is exported. In categorical
questions, you can also mark categories as “missing” so that they can be treated as missing data in
SPSS.. Refer to the documentation for the individual question types for details.

v A new option in the File menu makes it easier to import questionnaires that have been created with
programs such as WordCapture.

v The Import from Library radio button on the New Item dialog box has been changed to an ordinary
button in the lower left corner of the dialog box, so that it is available regardless of which tab you are
using. In addition, this option is now also available via the File menu.

v Build no longer creates SourceFile and Code variables. This means that exports do not contain these
variables unless required and are therefore leaner. If you require SourceFile variables for mrPaper or
mrScan, run the AddSourceFileVariablesTo MDD.mrs script in DDL\Scripts\General\mrScriptBasic. The
coding tools will add Codes variables if they are needed.

Loading participant records. The Participants activity now sets “Test” as a required sample management
field with a default data type of int (a whole number).

You do not need to add this field to existing sample tables as long as you do not reactivate the projects
that use them. If you reactivate an existing project after installing version 3.1, activation will fail with the
message:
The following required Sample Management fields are missing from the selected Fields:
Test
You may need to add the missing fields to the Sample table before activating.

You can add the Test field to the sample table in two ways. Either edit the sample table in SQL and add a
column called Test with a data type of int, or reload the participant records.

Setting up CATI projects. The following changes have been made to the Phone Surveys activity:
v You can now set the language for the text in the introduction screen so that it is displayed in the

respondent's language. To do this, download a copy of the catifields_projectname.mdd file into the project
folder and edit it using MDM Explorer to add the necessary languages and translations. Then upload
the file taking care not to rename it during the upload. Once you have done this you can switch your
DimensionNet preferred language and see the new text in Phone Surveys and Phone Participants.

v Supervisors may specify whether interviews can request specific numbers to call.
v Supervisors may specify that a project allows modem as well as manual dialing.
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Activating projects. The following changes have been made to the activation process used by the Launch
and Promote Project activities, Scriptwriter Station, and the command-line activate and site-to-site activate
programs:
v Increased flexibility in choosing the database to which a project's case data is written. The system

default is still to create a new database for each project, but it is now possible to write case data for
several projects to the same database, or create a new database with a name of your choice. Which
options are available to you depends on how your site is configured, so your administrator or
supervisor will advise you how to proceed.

v When a project has more than one routing context you can set one context as the default. This will
then be used for interviews or other activities that do not specify which routing context to use.

v On the Quota tab in the Launch activity, the selection box for the quota database has been replaced
with a Browse button. This change speeds up activation of projects that use quota control because it
means that there is no need to display a list of quota databases as soon as the user clicks Use Quota.

v Scriptwriters activating projects from Scriptwriter Station (or mrStudio) no longer need access to
FMRoot; only a DimensionNet user account is required. This is configured for you when the
Scriptwriter Service (or mrStudio) is installed on your machine.

v When activating on a cluster or between clusters, the activation process now checks that all
interviewing servers have the same version of the ActivateServer.dll component as is installed on the
machine you are working on. If it finds a mismatch, activation fails at that point and you will have
mismatched project files on the interviewing servers. When this happens, you may usually continue by
manually copying the project files to the servers that have not been updated. However, the best
solution is to ensure that all machines in the cluster are running the same version of mrInterview.

v While not strictly a change in functionality, please note that activation on machines running Turkish
operating systems always use an uppercase version of the filename as the project ID (for example,
activating drinks.mdd generates a project whose ID is DRNKS). In order to avoid file validation issues
when activating projects whose names contain the letter i or I, you should always save the .mdd file
with an uppercase name before activating.

Site to site activation. Promote Project now issues a warning if the project you are activating already
exists on the destination server. You may choose whether to continue and overwrite the existing project
files or to cancel the operation.

Deleting projects. When a user deletes a project whose case data is stored in a database with case data
for other projects, only the data for the named project is deleted. The database is not deleted until the
data for the last project that uses it has been deleted.

Conducting CATI interviews. The following changes have been made to the Phone Participants activity:
v Interviewers can request a specific contact or their most recent contact rather than receiving the record

for the next suitable participant.
v The appointment setting page now displays the call center time corresponding to the given

appointment time.
v Interviewers may click the Dial Contact button to have records called via a modem.
v The activity now defaults to using the CATI keyboard player rather than the standard HTML

(mouse-based) player. This means that interviewers can use keyboard shortcuts for navigating around
and between pages rather than clicking with the mouse. Your administrator can change this if
necessary.

CATI reports. The following changes have been made to the Phone activity:
v You can use filtering to separate test from live interviews.
v The Queue Status report now has separate categories for Refused and Stopped interviews, so no longer

includes them in the counts of active/live interviews. Also, the “Active” label has been changed to
“Live”.
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Exporting data. The following changes have been made to the Export Data activity.
v You can now choose which language to export.
v The datasource for SAV exports is now written back to the .mdd file. On tracking studies this allows the

aliasnames previously used for an export to be reused on a subsequent export.

Setting up quotas. The Quota program normally starts in the My Documents folder when you select File,
Open. You can specify a different starting folder by defining the location in HKEY_CURRENT_USER\
Software\SPSS\mrQuota\DefaultPath in the registry.

Routing contexts for Web and CATI interviews. The Interview Engine now supports multiple routing
contexts for a project, meaning that different routing contexts can be specified for CATI and Web
interviewing. To specify the routing context to use, either include the I.RoutingContext= parameter in the
URL, or use the RoutingContext property in the Sample Management script.

Quota Control. The QuotaAutoCommit variable now defaults to 1 in Dimensions projects so that all pended
quotas are either converted to completed interviews or rolled back when interviews terminate. Note that
this property is still not initialized in DPM when you create a new project, but you can add it using Edit
Project.

What's New in mrInterview 3.0
This topic lists all changes and enhancements available in mrInterview 3.0. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in Dimensions Development Library.

For Administrators and Developers

Changes to Architecture. The architecture of mrInterview has changed significantly in version 3.0. The
changes include:
v Interprocess communication now uses SOAP over HTTP instead of DCOM.
v IIS is now required on the Interview tier as well as the Web tier
v The Event Viewer now contains only process start/stop messages
v Log files are now written on the Web tier as well as the Interview tier
v There is a new component, the Interview tier Value Cache component.
v By default, data is now written to a file before being sent to a database.
v The connections table is no longer used.

Note: These changes do not apply to the Quancept Support for mrInterview.

Controlling user access to Sample Management scripts. As noted in the For Users section, the Launch
activity now allows users to select Sample Management scripts from a predefined list. There are two
administrative changes related to this feature:
v You can control which scripts appear in the script selection list by adding their names to the new

Interview.Config.xml file. The file also allows for different scripts to be made available to different roles.
v You can control whether users who select scripts from the list may view and edit them on the Sample

Management tab. By default, scripts selected in this way are not displayed and are not editable. To
allow these scripts to be viewed and edited, use Manage Access to assign the canEditSampleScript
property to those users who need it.

Writing CATI reports. You can write your own CATI reports and they will be included in the list of
reports displayed by the Phone activity.
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Interview time-out setting. The name and location of the registry key that stores the default time-out
delay for interviews has been changed to \HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\3\
Interview\InterviewTimeout, and the default value has been increased from 5 to ten minutes. This topic
used to mention a DialingTimeout key. This key no longer exists so it has been removed from the
documentation.

InterviewURL property and mrwebpl.dll. The InterviewURL site property that stores the default URL for
interviews has been replaced with a new property called DimensionsInterviewURL. The default setting for
this property is MachineName/mrIWeb, where MachineName is the name of the machine running the Web
Service. In addition, it is now mrIWeb.dll rather than mrwebpl.dll that runs interviews. Topics that
mention this property and/or this program in relation to mrInterview 3.0 have been updated throughout
the documentation. Topics that document mrInterview 3.0 with Quancept support have not been changed
because this version of mrInterview still uses the version 2 architecture and program names.

Sample Management

SampleManagementProvider interface. This interface provides support for scripts written in
mrScriptBasic.

Scriptwriting and Activation

The following changes have been made to the scriptwriting and activation aspects of mrInterview. Refer
to the Introduction to Scriptwriting section of mrInterview User's Guide for further details.

New scripting language, questionnaire structure, and interviewing system. Although the visual
appearance of the mrInterview activities and the way you use mrInterview is the same as in previous
versions, the underlying system and scripting language have been changed. The new scripting language
provides all the functionality of the Quancept language with many new features and improvements.
Many of the things that were difficult or impossible with Quancept are now easy to achieve; for example,
it is a simple scripting task to define special buttons that interviewers can click to jump to the first or last
question, or to a chosen question in the interview script.

mrInterview 3.0 also introduces a different questionnaire structure. In this structure, the question
definitions are defined in a separate section to the instructions defining the way in which the questions
are used and presented. These sections are called the Metadata section and the Routing section
respectively.

Refer to the mrInterview section of Dimensions Development Library for information about the new
interviewing system, and to the Interview Scripting section of Dimensions Development Library for
information about the interview scripting language.

Creating questionnaires. The following changes have been made to the Build activity:
v Question groups (pages) may now contain one or more grid questions.
v Response lists for single and multiple choice categorical and grid questions may now be filtered to

include only those responses that were mentioned or not mentioned at a previous question.
v An Insert from Script Library item for loading code for the Routing section of the questionnaire from

an external file. Build comes with a number of code files, including ones for formatting grids, changing
the interview language based on a language question, and writing data to a respondent's sample
record, and you can add your own files to the library.

v An IOM Script item for inserting statements for the Routing section directly into a Dimensions
questionnaire.

v The ability to specify default question and grid templates for Dimensions questionnaires.
v A Download Questionnaire menu point for downloading a questionnaire from Build into a location of

your choice.
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v Dimensions questionnaires consist of a Metadata section that defines the questions and a Routing
section that determines how and when the questions will be asked. Build automatically generates a
Routing section called Paper when you activate the questionnaire in test mode, when you download
the questionnaire, and when you leave Build.

v Grid templates are now stored as part of the main template file rather than as separate files. This
means that selecting templates for grid questions is now the same as for all other question types.

Uploading participant records. A number of usability improvements have been made to the Participants
activity. These include:
v Immediate access to online help. The initial File Upload dialog box has been replaced by a field on the

Location tab.
v Support for multiple uploads during the same session.
v More informative error messages when things go wrong.
v Improved handling of the file of participant records, including an option for defining a character of

your choice as the field delimiter in participant records.

Defining CATI parameters and introductory text. The following changes have been made to the Phone
Surveys activity:
v A facility for inserting references to sample fields or the interviewer's name in the introductory text.

When the text is displayed, the references are replaced with the current values of those fields.
v All changes are now saved automatically so the Save Changes button is no longer displayed on any

tab. Also you no longer need to reactivate the project in order for changes to take effect.
v The Define Fields tab now lists all fields found in the project's sample table, not just those that are

required for CATI.
v The catifields_ProjectName.mdd file is now documented in Making Sample Data Available to Interviewers

and Interviewer Settings.
v Changes in the way participant records are loaded during interviewing means that the meaning of the

Can Edit During Survey column on the Define Fields tab has changed. Where previously fields with
this flag set could be edited at any time during the interview, they may now be edited only at the start
of the call — that is, before the first question is displayed.

Activation. The following changes have been made with regard to activating projects through
DimensionNet:
v In the Launch, activity, you may now choose a Sample Management script from a list of scripts.
v The new Promote Project activity allows you to activate a project from one cluster to another. This

facility is sometimes referred to as site-to-site activation.

Desktop tools. Scriptwriter Station is the new desktop tool for writing and activating Dimensions
interviewing scripts.

What's New in mrInterview 2.3
This topic lists all changes and enhancements available in mrInterview 2.3. It includes all the information
for end-users from the various What's New sections in mrInterview User's Guide as well as details of more
technical changes that are documented only in Dimensions Development Library.

For Administrators and Developers

The following changes have been made in the Dimensions Development Library and will be primarily of
interest to administrators and developers.

Security updates. mrInterview 2.3 contains many security updates. These include:
v Defences against SQL injection.
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v The option to install DimensionNet web activities in locations other than c:\inetpub\wwwroot and the
Default Web Site.

v Access through SSL with no warnings.
v Improved performance and stability when multiple users are sharing a machine across DimensionNet.
v The SampleMgtGUI.Config.Xml file now stops users accessing databases for which they have no

authorization instead of stopping unauthorized databases from appearing in the listing in the
Participants and Launch activities. The Launch activity also restricts visibility of quota databases to
only those databases associated with projects that the user can access.

v The session ID available in a respondent's interview page has been made cryptographically random so
that respondents cannot guess other possible session IDs.

Log files. The new .Net version of the Launch activity creates log files called ACT*.tmp and AOM*.tmp,
which replace the AWZ*.tmp and maw*.tmp files generated by earlier versions. The new files have been
added to the list of log files in mrInterview Log Files. This topic has also been updated to include
information about the log files created by the Email activity and the various CATI activities. In addition,
components in the Web Service tier now write logging information to the ISE*.tmp files rather than the
Event Viewer.

Files types served by the image cache. The image cache has been changed to use the Mime mapping
defined in the IIS metabase rather than using information in the registry. This ensures that all image
types that are recognized by IIS will be usable with mrInterview.

NT security for clusters. It is now possible to set up NT security for cluster installations manually.

Documentation for administrators. A new section has been added for users who are responsible for the
day-to-day administration and maintenance of mrInterview. It covers such things as the structure and
content of the installation folders, and information on maintenance tasks such as clearing the connections
table, clearing log files, and backing up projects.

QCompileBack component. A new version of this component is installed with mrInterview 2.3, and may
affect applications that you have written that use this component.

Case sensitive databases. mrInterview 2.3 has been fully tested with case sensitive databases and no
problems have been found.

Setting up site-wide CATI parameters. CATI site administrators can set up call outcomes, interview
parameters, and other CATI project properties as DPM Site properties so that they will be used as the
default for new projects. Unfortunately, there is no documentation about this in Dimensions Development
Library at present.

Sample Management

The following changes have been made to Sample Management. Everything referred to in this section is
available to developers using Dimensions Development Library, whereas the Sample Management section
of mrInterview User's Guide contains descriptions and examples of Sample Management facilities but no
longer contains object model documentation.

Appointment setting in telephone interviewing projects. The following information has been added to
the documentation for version 2.3 to clarify the way in which Sample Management works for telephone
interviews.

In telephone interviewing projects, the Sample Management system keeps track of any differences
between respondents' and interviewers' time zones and presents records for calling at the time that the
respondent requested. The Sample Management system does not recognize null values in the TimeZone
column, so is unable to set appointments for these respondents. It therefore important that you set a
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non-null default TimeZone when loading sample records if you want appointments to be made. This
happens automatically if you create sample tables using the Participants activity, but if you create the
sample tables manually it is your responsibility to ensure that the default for the TimeZone field is not
null.

Time zone management when selecting records to call. You can now specify the times during which
respondents may be called on weekdays and at weekends. When an interviewer requests a record to call,
Sample Management uses this information together with information about the time zones in which
respondents are located to ensure that respondents are not called outside these hours.

Interviewer qualifications. Calls can now be allocated to interviewers based on each interviewer's
qualifications. Qualifications can be anything you like: for example, the languages that the interviewer
speaks, or the fact that the interviewer is skilled at persuading unwilling participants to be interviewed.
The User Context object in the Sample Management object model provides access to interviewer
qualifications within the Sample Management script.Refer to the Dimensions Development Library for
further details.

REFUSED queue. This new predefined telephone interviewing queue is for respondents who refused to
be interviewed. It is provided mainly for use with a HandleQueue_REFUSED interviewer qualification
which allows calls in this queue to be reassigned to respondents who are skilled at persuading reluctant
respondents to be interviewed.

Callbacks after language mismatches. The Language call outcome code has been renamed
LanguageBarrier, and a new LanguageRecall code has been added. The latter allows calls that fail due to
language problems to be rescheduled for calling after five minutes' delay.

LeastFull pending based on number of completes. Quota control can now increment the pending counts
based on the actual number of completes achieved so far in each cell rather than the percentage of
completes to the target. Refer to "Quota Prioritization for Multiple Response Categorical Questions" and
"The QUOTA_Matrix Table" in the Dimensions Development Library for further details. for further
information.

multimode1.sam script. This example Sample Management script has been updated to process
interviewer qualifications. It also no longer reschedules missed appointments and recalls for the same
time the next day. Instead, they are assigned to the next interviewer who requests a number are the
appointment time has passed. This means that appointments or recalls set for times when interviewers
are not working will now become available for calling at the start of the next shift.

A series of diagrams has been added to the documentation to illustrate the logic of the Sample
Management functions.

Locking and unlocking sample records. The SampleRec.LockRecord, SampleRec.UnlockRecord, and
SampleRec.IsRecordLocked methods used in SampleManagement scripts now return a boolean rather than
numeric value. The previous method of checking whether LockRecord succeeds can no longer be used
because it will now cause an infinite loop. The example telephone interviewing scripts that use these
methods have been updated to show the correct usage. The mrInterview installation procedure
automatically updates Sample Management scripts for active projects, but you will need to update any
other scripts manually.

Sample Management information in DPM. mrInterview 2.3 comes with a new version of DPM that
stores Sample Management objects as a properties collections. You can load Sample Management objects
from their properties using the Load method of IPersistProperties; see "IPersistProperties.Load" in
Dimensions Development Library for details. In addition, the components of the Sample Management
object model have been merged into a single .dll file (mrSMInterfaces.dll) which makes the task of writing
scripts much easier.
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Object model documentation. Documentation for the Sample Management and Quota object models has
traditionally been included in both the mrInterview User's Guide and the Dimensions Development
Library documentation. Since the Dimensions Development Library documentation is available on the
mrInterview installation CD and can be easily downloaded from there, the object model documentation is
no longer included in this User's Guide.

Scriptwriting and Activation

The following changes have been made to the scriptwriting and activation aspects of mrInterview. Refer
to the Introduction to Scriptwriting section of mrInterview User's Guide for further details.

Activation. The Activate wizard has been replaced with an Activate dialog box, and the activation
process has been streamlined and improved to provide the following new features:
v One-click re-activation of existing projects
v Activate templates (presets) for saving and reloading predefined settings
v Advanced activation allowing only certain tasks to be run
v Activation specifications can be saved to a file which can then be used for activating from the

command line
v Enhanced progress information
v Improved validation allowing earlier identification of invalid properties
v Improved usability

In addition, the actwiz command-line activation program has been replaced with the Activate program.
This is the same program that is used to control activation from within Quancept Compiler, but
additional options are available for command-line use. Command-line activation obtains its information
about the project's activation requirements from an XML Activate Document. This replaces the .ini file
used by actwiz. A conversion tool is provided for users who wish to use their existing .ini files with
Activate.

Multimode interviewing. A new accessory program (MDM Label Manager) simplifies the insertion of
additional contexts and label types in a project's .mdd file. This means the process of specifying differing
texts for self-completion and CATI interviews within the same questionnaire is now easier.

webdemo example questionnaire. The questionnaire script has been updated to show the use of the
image cache. The .qqc file is available in c:\mrInterviewSource\Samples\Projects\WebDemo. Search for
the statement labelled F15 to see how to use the image cache.

mrInterview Activities

Internationalization. mrInterview 2.3 is fully internationalized and contains English and Japanese texts.
The default is English. For information on running DimensionNet and mrInterview in Japanese, refer to
"Setting DimensionNet Options" in the DimensionNet online help or DimensionNet User's Guide.

Creating questionnaires. The following changes have been made to the Build activity:
v Reverse presentation of responses to categorical questions and categorical grids.
v Role-specific library and template files.
v A Download menu point for downloading the current questionnaire to a location of your choice.
v Generates questionnaire scripts in the Quancept or mrScriptBasic language according to the project

type. (There are no differences for the user when creating questionnaire items.)

Loading participant records. The following changes have been made to the Participants activity:
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v If participant records for a CATI project do not contain all the required fields, the supervisor can have
the Participants activity create them when it creates the database. This ensures that activation will not
fail because required columns are missing.

v The Type column on the Columns tab now shows the correct data type for all CATI fields so you no
longer need to set these manually for each project.

v mrInterview 2.3 comes with a Participants database that is designed specifically for storing participant
records, and the Participants activity normally loads records into this database. You should therefore
find that you need to make fewer selections on the Location tab when uploading records. Note,
however, that if your company has existing databases of participant records that it wishes to use, your
administrator may have changed the part of mrInterview that controls database access so that these
databases also appear in the selection list.

Setting up a CATI project. The following additions have been made to the Phone Surveys activity:
v Specify the time zones in which participants are located.
v Define weekday and weekend calling hours.
v Choose whether calls should be allocated based on interviewer qualifications.

For more detailed explanations of how these facilities are implemented, refer to “Time Zone
Management” and “Interviewer Qualifications” in Dimensions Development Library..

These new features together with the enhanced communication between the Participants and Launch
activities help to make the setting up and maintenance of CATI projects quicker and easier than in earlier
versions, and you may find that you can use default settings on many projects.

Activating projects.The following changes have been made to the Launch activity:
v There are fewer manual steps involved in activating projects that use sample management because

Launch obtains information about the participant database from the Participants activity and displays
the Sample Management tab with many of the fields already completed.

v When you activate a project that uses quota control, the database selection list on the Quota tab
includes only databases that are associated with projects that you can access.

Interview status codes reported by Status. The Status activity has an Undetermined Status category for
interviews whose data collection status code cannot be recognized. Also, descriptions of the status codes
used in the report have been added to the documentation.

Text responses in Survey Results. Text responses that are longer than the display width are now
wrapped. If a text response contains HTML or Javascript code, Survey Reports ignores it.

Exporting data. It is easier to see when the export process has finished.

Working with files created by desktop activities. The documentation for the Quancept activity now
includes information on uploading files that have been created using mrInterview desktop activities. It
deals in particular with how to avoid problems that can occur when mixing desktop and DimensionNet
activities for creating, compiling, and activating projects. (Note: This activity no longer exists in
mrInterview

Uploading files with Japanese characters in the filename. DimensionNet does not support Japanese
characters in pathnames or filenames. If you want to upload a file whose name contains Japanese
characters you should rename it before uploading.

What's New in mrInterview 2.2
For Administrators and Developers
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mrHTML. Documentation is now provided for the default page layouts implemented by the mrHTML
page renderer when a project has no templates specified.

Changing the time-out delay for interviews. Advice is now provided for administrators wishing to
change the time-out delay for interviews.

Changing the URL for starting interviews. A new FAQ explains how to change the InterviewStartURL
project property.

Load balancing counters. A new topic has been added to the load balancing section, documenting
counters that can be used in load balancing scripts.

mrEngine interaction with the Connections table. More detailed information is now provided on how
mrEngine interacts with the Connections table.

Sample Management changes. A number of changes have been made to Sample Management,
particularly in relation to the introduction of a telephone interviewing (CATI) facility in mrInterview.

Sample Management

Predefined Queues. When earlier versions of Sample Management needed to know what queues were
available, they would run a "SELECT DISTINCT" SQL query at the start and end of each interview that
scanned the whole sample table looking for queue names. This query was inefficient and an improved
method of locating queue names has been implemented in version 2.2. This new method is based on a set
of PredefinedQueues properties in DPM that define the queues that the Sample Management script can
expect to be available. Default definitions exist for these properties and you can edit them to remove
queues or add other queues if you wish.

Variable names with quota control. If a project uses Quota Control, the names of the Sample
Management variables should not be the same as any question or other variable names in the
questionnaire script. Any Sample Management variables whose names match questionnaire variables
cannot be used for Quota Control, and vice versa.

Referring to nonexistent sample fields. Sample Management scripting has been updated to make it
easier to test for empty or nonexistent fields.

Outbound telephone interviewing. mrInterview 2.2 provides a basic outbound telephone interviewing
facility, and a number of changes have been made to Sample Management in relation to this. These
changes include:
v GetSampleRec function. Specifies how sample records are to be selected for outbound calling.
v ScanQueue function. Selects a given number of records from a queue. The script specifies the

characteristics records must have in order to be selected, and the order in which the selected records
should be sorted when they are returned. See IQueues2.ScanQueue in Dimensions Development Library
for details.

v UtcNow function. Returns the current time in UTC. This can be used in the automatic setting of
appointment times relative to the time now.

v Fields required in the sample table. A number of additional fields must be defined in the sample
table. These include fields for storing telephone numbers and appointment times.

v Call outcome codes. A set of default call outcome codes is defined for telephone interviewing projects,
which forms the basis of the call outcome menu displayed for interviewers working on telephone
interviewing projects.

v Telephone interviewing project parameters. The Sample Management script makes use of a number of
parameters that can be set using the Phone Surveys activity in DimensionNet. These parameters cover
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such things as elapse times for automatically setting appointments for busy and no-answer calls, and
the maximum number of times records may be called back.

v MultiMode1.sam script. This example Sample Management script can be used for projects that
combine standard inbound Web interviews with outbound telephone interviews. Users who are
familiar with the Quancept Sample Management System will find that this script provides the same
basic functionality as the Quancept SMS basic1 standard algorithm.

v Sample History table. The HistoryTable table in the Sample Management database contains
information about outbound calls made to Sample records.

v DialingTimeout interview property. This new interview property defines the dialing time-out period
in seconds for the current interview. The dialing time-out period starts when the GetSampleRec function
in the Sample Management script passes the sample record to mrInterview and ends when the
interviewer starts the interview. It therefore includes the time that it takes to dial the number and for
the respondent to agree to be interviewed. The value of this property overrides any global dialing
time-out period set in the registry key HKEY_LOCAL_MACHINE\Software\SPSS\mrInterview\1.0\
DialingTimeout and the default dialing time-out of ten minutes which is used when this key is not
defined. (Notice that the interview property is set in seconds whereas the registry key is set in
minutes.)

Scriptwriting and Activation

Translatable error and information messages. There is now a new way of accessing translated error
messages which does not rely on the names of the message variables being defined as dummy questions
in the questionnaire script. mrInterview 2.2 comes with an ErrorMessage.mdd file that contains error and
information messages in a selection of languages, and which is loaded automatically mrInterview starts.
You can add you own translations into other languages to this file.

Maximum number of display and protect statements per page. There is now a default limit of 100
display and protect texts per page. When the limit is reached, the message 'too many display or protect
statements' is written to the ISE log file and the 101st text is displayed. (The message also includes the
text of the 101st display/protect statement and the current maximum.) Further display and protect
statements are silently ignored. To increase the limit, set the variable dsplymax to the required value in the
script.

Displaying the full question name. The variable qnameful can be used in display and similar statements
when you want to display the full question name, including iteration number, rather than the simple
question name as it is defined in the questionnaire. This is particularly useful in CATI interviews when
you want the interviewer to write down open-ended (text) responses rather than typing them as the
respondent speaks. In these cases, interviewers will need to record the full question name with the
response text so that the text can be entered against the correct question at the end of the interview. To
display the full question name as the page title in an interview, place the following statement in the
script:
set pgtitle = ’[+qnameful+]’

Text substitution with pgtitle. The functionality of the pgtitle variable has been extended so that the
text that you define as the page title can now contain text substitutions or expressions. As noted earlier,
this allows you to display the full question name, including iteration number, as the page title in CATI
interviews.

Expression evaluation. The Quancept language has been extended to cater for routing expressions that
are defined as If...Gotos in Build. The expression appears in the Quancept script as part of the eval
keyword and is passed to the interviewing program for evaluation with the Evaluate component. If you
write your questionnaire scripts directly in the Qunancept language, this keyword allows you to place
expressions in texts and to have their values substituted during the interview in the same way that text
substitution with [+'...'+] works.
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Multimode interviewing. It is now possible to write a single script that can be used for both Web and
WebCATI interviewing, and to specify different texts for each interviewing mode.

Infinite loops cause interviews to time out. mrInterview 2.2 is able to recognize infinite loops and
terminate the interview rather than leaving the interview to time out by itself. New variables associated
with this feature are scrtmout and scrtmpas.

Clearing data from off-path questions. mrInterview does not automatically clear data from questions
that switch from being on the interview path to being off-path. If you want data for off-path questions to
be cleared, set the variable ofpathmd to 0, 1, or 2 to determine when this should happen.

Interview replays after ODBC errors. When an ODBC error occurs during an interview, the interviewing
program replays the interview twice in an attempt to re-establish the connections to SQL and to the
ODBC database. You can change the number of replays by setting the variable rplaycnt to the required
value.

The interviewing program logs each ODBC error, including any error information from the ODBC driver,
and reports the number of ODBC errors that have been encountered so far. If rplaycnt is non-zero and
the ODBC error count is not zero, the interviewing program also logs an error just before an ask or pause
statement saying either "odbc errors found, replaying script" or "odbc errors found, no more script
replaying". This log entry includes the number of ODBC errors found, the number of replays so far, and
the number of replays allowed. If the number of replays so far is smaller than the number allowed, then
a replay is done, otherwise the interview continues despite any remaining ODBC errors.

To be sure that this feature works for your script, make sure that all ODBC statements appear before the
last ask or pause statement. in the script. If ODBC statements appear after this, and one of those ODBC
statements fails, the interviewing program will not replay the interview and will not attempt to reconnect
to SQL or the ODBC database.

Changing the SQL cursor type for ODBC database selections.

Note: This is an advanced feature and is designed for users with a reasonable knowledge of SQL. The
notes that follow provide only as much information as is required to implement this feature in an
mrInterview script. For further information on SQL cursors, refer to your SQL documentation (if you
have SQL Server installed, you can find out about SQL cursors by selecting SQL Server Books Online
from the Start menu).

Cursors are an SQL feature that allow selrec and nselrec statements in a questionnaire script to function
correctly. In particular, they are used for positioning at (in mrInterview terms, selecting) a record in a set
of records selected from an ODBC database by means of an SQL SELECT statement. In mrInterview, the
SELECT statement is defined in a dbquery statement in the questionnaire script.

The default cursor type used for mrInterview ODBC operations is the dynamic cursor, but this may not
be the most efficient one to use if you have large databases or if your selection criteria select many
records from the database. In these cases you may prefer to use a different type of cursor. As an example,
a simple test that used selrec to extract a field from the last row of a 100000-row database produced the
following timings:

Cursor type Time in seconds

Dynamic (default) 75

Keyset driven 35

Static 25

Forward only 1 to 2
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To choose a cursor type, place the following statement in your script:
set dbsqlcrs = value

where value is 1 for a keyset driven cursor, 2 for a static cursor, or 3 for a forward only cursor. If
dbsqlcrs has any other value or is not set, a value of 0 is assumed which equates to the default dynamic
cursor.

When choosing a cursor type, bear in mind the following points:
v Dynamic cursors are the default because they provide an automatic updating feature.
v It is your responsibility to test that the cursor you choose provides the functionality you expect from

your script.
v Testing has shown that the static cursor type does not support the SQL_FETCH_FIRST,

SQL_FETCH_NEXT, or SQL_FETCH_ABSOLUTE fetch orientations for SQL Server.
v Performance improvements can often be achieved by using SQL_FETCH_ABSOLUTE.
v nselrec currently fails when used with a forward only cursor. The error in the log file is 'odbc nselrec

failed, fetchscroll error'.
v Some combinations of cursor type and SQL_FETCH orientiation (for example, forward only cursor

with SQL_FETCH_ABSOLUTE) may fail.
v Some ODBC functions will always work slowly; for example, nselrec always steps through records

one at a time until it finds the requested record.

Range for real numbers. This note explains how mrInterview and the Dimensions Data Model store real
numbers and how this affects the range of real numbers that will be accepted as valid during an
interview.

The interviewing program stores data for questions with real number responses in a variable of type
double; that is, in binary 64-bit floating point notation. A double has approximately 15 significant digits
of precision, so the effective range for real numbers is roughly +/-1.7e308. This is rounded to 12 digits to
ensure that decimal values that are not representable in binary are still handled correctly. Users can enter
real values using scientific notation so the number of decimal places is not fixed.

In the Data Model, real values are passed as double values. In the Quantum DSC, values are formatted in
simple floating-point notation (xxx.yyy) and are rounded is necessary to fit into the numebr of columns
allocated in the card/column specifications. The number of columns includes the decimal point and a
leading minus sign if the value is negative. If the formatted number cannot be made to fit by removing
all digits after the decimal point, an error occurs and the record containing that value is not written.

Variable names with quota control. If a project uses Sample Management and Quota Control, the names
of question and other variables in the script should not be the same as any Sample Management
variables. Any questionnaire variables whose names match Sample Management variables cannot be used
for Quota Control, and vice versa.

Changes to the Activate Wizard and Command Line Activation. The Project Settings Page in the
Activate wizard now displays a With CATI check box that you should select when the project allows
CATI. An optional UseCATI property is available for switching on this feature when activating via the
command line.

Using a remote Project Management server with Quancept Compiler and Quota Setup. This point is
provided for clarification only; there have been no changes to this feature in either Quancept Compiler or
Quota Setup. It is particularly relevant to users who have single machine installations that were set up to
use a local user account for Project Management (the DPMServer service), but who sometimes need to
access machines that are part of a cluster installation. If you always work on machines that are part of the
same cluster then these notes are unlikely to apply to you.
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When you compile a questionnaire, Quancept Compiler writes information about the project to the
Project Management server on which the activated questionnaire will stored and on which interviewing
will take place. Similarly, when you set up quotas that use Sample Management variables, Quota Setup
uses the Project Management server to access the Sample Management database in which the variables
are stored. If the Project Management server is not in the same cluster as the machine on which you are
running Quancept Compiler or Quota Setup, then you must specify the name of the Project Management
server before you activate the questionnaire or set up quotas based on Sample Management variables.

Quancept Compiler prompts you for the name of your Project Management server the first time that you
run the program. If you need to use a different Project Management server from time to time, you can
name it in the Options dialog box. This server then becomes the default server for Quancept Compiler.

With Quota Setup, you name the Project Management server on the Schema2Mdd dialog box that is
displayed when you select Use Sample Management from the File menu.

If you do not set the Project Management server in this way, Quancept Compiler and Quota Setup will
fail if your local user account does not have permission to access the remote server. By naming the server,
you tell the program to use the Project Management service on the remote server to access the files and
databases that it needs.

mrInterview Activities

Usability changes. The activities have all been renamed so that the names better reflect the activities'
functions. Additionally, many of the menu bars, buttons and prompts have been redesigned, although the
functionality of each item remains the same.

Build (formerly InterviewBuilder)

v A Goto item for defining routing that applies to all respondents.
v An If...Goto item for routing that applies to all respondents with a given characteristic or set of

characteristics.
v An Exit item for terminating an interview immediately and flagging it with a particular signal code.
v A Bookmark item for defining a named location in a questionnaire. This is usually used as the

destination for routing defined with Goto or If...Goto items.
v Factors for single or multiple choice responses and responses in single or multiple response grids. .
v Single and Multi flags on the Advanced tab for converting single choice questions or grids to multiple

choice and vice versa.
v You can now select .bmp and .avi files when associating pictures with responses.
v A Save to Library option so that designers can save questionnaires to the library. (In earlier versions

you could not save to the library when running Build directly from DimensionNet.)
v A new section that deals with creating and installing shared templates.

Launch (formerly Activate)

v The code has been rewritten in .NET and has been generally optimized. This, in addition to reducing
the number of times that the .mdd file is opened, has resulted in considerable performance
improvements.

v It is now possible to activate projects with Sample Management when not connected to the network. In
previous versions, Launch would allow you to enter a SQL Server name but would then fail because it
could not find the server.

Email. This is a new activity that allows you to send email messages to respondents.

CATI support. CATI facilities is now available, allowing you to set up projects for outbound calling. The
following changes and additions are related to CATI:
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v A Phone Surveys activity that enables supervisors to set up parameters required for CATI interviewing.
v A Phone Participants activity for conducting CATI interviews.
v A Phone activity for use by supervisors wishing to run reports.
v A "Use CATI" check box in the desktop Activate wizard and on the Sample Management tab of the

Launch activity which, when selected, signal that this project must be activated to work with CATI.

What's New in mrInterview 2.1
For Administrators and Developers

There are few changes to the mrInterview technical documentation between versions 2.0 and 2.1. What
changes have been made are mainly to do with improving the structure of the section and adding more
links to topics both within the mrInterview section and in other sections of the document as a whole.

Sample Management

Processing records returned from interviewing. When records are returned to Sample Management at
the end of interviewing, Sample Management must deal with the incrementing and/or decrementing of
counts related to the record. For example, if the interview is completed, the Sample Management
program must increment the Completed count and decrement the Pending count. This must be done even
if all quotas are based on data gathered during the interview. This point was not made clear in earlier versions
of the documentation.

In version 2.1, you can now set the QuotaAutoCommit property to 1 to have counts updated
automatically at the end of an interview. This is an alternative to the old method of adding the necessary
statements to the ReturnSampleRec function.

Quota prioritization. When quotas are based on multiple response categorical questions, quota control
normally pends the cells for all responses chosen from a response list. Quota prioritization let you decide
how many cells to pend, and allows you to choose the method by which those cells are chosen. Two new
columns have been added to the QUOTA_Matrix table. PendMode defines the type of pending required
(Priority, Random or LeastFull) and PendLimit defines the number of cells to be pended. The Metadata
column has been added to the QUOTA_Quota table to store cells' relative priorities when Priority
pending is in force. See The QUOTA_Matrix Table and The QUOTA_Quota Table in Dimensions
Development Library for details.

Referring to nonexistent sample fields. A topic has been added to the documentation explaining what
happens when a Sample Management script tests the value of a nonexistent sample variable, and
suggesting ways round the unexpected behavior when standard scripting methods are used.

New project properties. The following project properties are now available: ProjectLocked,
ProjectLockedBy, QuotaProjectName, TimeLastActivated, LastActivatedBy, InterviewStartURL,
DataLocation, UseDefaultURLs, GroupName, ClusterList, DefaultCategoryType,
DefaultPresentationTemplate, ProjectInactivePage, ProjectInactiveType, QuotaFullPage, QuotaFullType. See
Project.Properties in the Log, Project, and Property Objects section of Dimensions Development Library for
details.

Example scripts. A new example script, urloverride.sam, is provided in the mrInterviewSource\Samples\
Sample Management folder to illustrate how to set or override the values of sample fields using
parameters passed on the interview URL. Documentation is now also provided for the following example
scripts: UrlParam.sam, basic_quota_redirect.sam, and LogQuestions.sam. The documentation for the example
scripts has been split into a number of smaller topics for ease of use.

Quota Object Model. The following changes have been made to the Quota Object Model.
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v The documentation of Quota.Percent incorrectly stated that the property returned the percentage of
completed interviews in a quota cell, when, in fact, the percentage is calculated using the sum of
completed and pending counts; that is, percent=(completed+pend)*100/target. The documentation for
version 2.1 has been updated accordingly. See Quota.Percent in the Quota Object Model section of
Dimensions Development Library for details.

v A new property, Quota.ExactPercent, returns the percentage of completed and pending interviews for a
quota cell in double precision. In some cases this provides a more accurate assessment of a quota's
status than the existing Quota.Percent property which returns the percentage as an integer value. See
Quota.ExactPercent in the Quota Object Model section of Dimensions Development Library for details.

v The values of the QuotaGroup.LeastFull and Quotas.LeastFull properties are now based on the sum of
completed and pending interviews rather than on just the number of completed interviews. See
QuotaGroup.LeastFull and Quotas.LeastFull in the Quota Object Model section of Dimensions
Development Library for details.

What's New in mrInterview 2.0
For Administrators and Developers

Project and Image Caches. A new section describing the project and image caches. The project cache
holds recently used projects in memory and maintains recently used SQL connections so that they can be
made available quickly when next required (for example, when the next respondent asks to start an
interview). The image cache allows the latest version of any image to be made easily available to all
DimensionNet applications that need it.

New Method of Load Balancing. The existing section on load balancing has been updated to reflect
changes in the way interviews are allocated to interviewing machines. The Load Balancing object model
is provided for defining and implementing a customized load balancing system.

Performance Monitoring. This new section describes how you can monitor the performance of
interviewing servers using SPSS additions to the standard Microsoft Performance Monitor.

Activation Process for Web-Based Activate Application. The Activation topic has been updated to
describe the activation process for the new mrInterview Activate application which runs through
DimensionNet.

Log Files for mrInterview Applications. Most of the new mrInterview applications that run through
DimensionNet create their own log files to record the actions they have taken and any errors that have
occurred.

Sample Management

Blank cells in numeric grids. mrInterview 2.1 offers two methods of allowing respondents to pass
through a numeric grid without entering a value in every cell. First, the existing silentnl facility has
been extended to work with numeric grids. Second, the new emptyok variable can be set to 1 to allow
respondents to leave cells in numeric grids blank. mrInterview treats these blank cells as unanswered
questions.

More flexible method of specifying page templates. The pagstyle variable provides a more flexible
method of defining the page template to be used for a set of questions in a questionnaire. It allows the
template to be specified as a text or as a variable whose value is set or generated elsewhere in the script.
It is particularly useful in reducing the amount of code that needs to be written when you want to set the
template to be used based on information gathered earlier in the interview. The original method of using
a combination of pgstyle and setfmt curpgstyle has been maintained for backwards compatibility and
may be used in the same script as pagstyle if necessary.
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Images files now come from the Image Cache. mrInterview 2.1 has a new management system for
image files called the Image Cache. The Image Cache holds copies of images present in the
FMRoot\Master\project directories and makes them available to applications that need to use them. If an
image is updated in a project directory, the copy in the Image Cache is updated automatically.

This change means that the syntax for defining images in the Quancept script has changed. Where
previously the img src tag pointed to the image file in a central images directory on the Web Service
machine, it now refers to the Image Cache application and gives the project name and image file name
separately.
<img src=//ServerName/SPSSMR/ImageCache/ImageCache.aspx?project=projname&file=filename>

For example:
activ ask ’Which country do you associate with this activity?
<img src=//zeus/SPSSMR/ImageCache/ImageCache.aspx?project=sports&file=surf.gif>’

resp sp ’Australia’ / ’USA’ / ’South Africa’ other dk

If you have a number of images to display, you can place the image cache reference and the project name
in a variable and then substitute that variable in the tag, for example:

set images = ’//zeus/SPSSMR/ImageCache/ImageCache.aspx?project=sports’
activ ask ’Which country do you associate with this activity?
<img src=[+images+]&file=surf.gif>’

resp sp ’Australia’ / ’USA’ / ’South Africa’ other dk

Quota prioritization. The new quota prioritization feature allows you to determine how mrInterview
pends quotas for multiple response categorical questions. The default, if no prioritization is defined, is to
pend all responses chosen. Prioritization allows you to pend only the quota that is the least full, or to
pend a quota at random, or to pend using a predefined priority list.

Enhancements to alphabetic sorting. Alphabetic sorting of responses with atoz now provides you with
more control over how responses are sorted. This is particularly useful for scripts in non-English
languages where, for example, responses starting with accented characters need to have the accent
ignored for sorting purposes. The keywords associated with these changes are atozlang, atozsort,
atozflgs, and atozmode.

Closing ODBC connections. It is now possible to close a connection to an ODBC database by placing the
following statement in the script:
set variable=dbclose(connect_label)

where:
v variable is the name of a temporary variable that will be set to 0 if the database is closed successfully

or to -1 if not.
v connect_label is the label of the connect statement that opened the connection to the database.

For example:
cdbopen connect(’sql:carsdb:admin: ’)

if (cdbopen = -1) {
dberr1 display ’Unable to open carsdb’

}
...
set cdbclose = dbclose(cdbopen)
if (cdbclose = -1) {

dberr1 display ’Unable to close carsdb’
}

If you do not close the database connection in the script it is still closed automatically at the end of the
interview. Any errors associated with closing the database are noted in the log file.

Selecting records from ODBC databases. The existing documentation for the dbquery statement states
that the statement returns a value of -1 if no records are selected. This is not true. The statement returns
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-1 only if it fails. In all other cases it returns a value of zero, even if no records are selected. This matches
the way that the standard SQL Query Analyzer works.

Inserting records in ODBC databases. When an ODBC error occurs during an interview, usually because
the connection to SQL is broken, the interviewing program replays the interview twice in an attempt to
re-establish the connections to SQL and to the ODBC database. If the connections can be re-established,
this is normally invisible to the user and the interview continues. However, if the replayed portion of the
interview contains statements that insert records in the database, this generates a duplicate record in the
database for each replay.

Note: Interviews are also replayed when the user continues an interview that has timed out and when the
user clicks Previous to return to the previous question.

To avoid inadvertently creating duplicate records in these circumstances, it is a good idea to check
whether a record exists before inserting it. For example, instead of simply writing:
set insok = dbquery(cdbopen,’insert into mytable(name,age)

values (’[+qcname+]’,qcage)’)

you might write:
if (cdbopen=0) {

if (done<>1) {
set insok = dbquery(cdbopen,’insert into mytable(name,age)

values (’[+qcname+]’,qcage)’)
set done = 1

}
}

Performance enhancements for ODBC connections. A number of changes have been made to the code
related to keywords that access ODBC databases to improve performance. If you use selrec or nselrec
with large databases you should notice reductions in the time taken to locate records in the database. A
side effect of these changes is that the words dbsqlold and dbsqlcrs cannot be used as statement labels in
scripts.

set logsql=1. In the version 1.2 documentation, the information for this statement was incorrect. It stated
that failed SQL statements for writing data at the end of the interview would be written to the SifSql.log
file only if the logsql variable had a non-zero value. The true behavior is that failed SQL statements are
always written to this file, and setting logsql to a non-zero value causes all SQL statements that write
data to be added to this file.

Larger log files The maximum size of the mrInterview and Project Management log files has been
increased from 100Kb to 4096Kb per file.

Recovering grid data from log files. When data for categorical or numeric grids is recovered from the
log files, mrInterview no longer writes null values to the .mdd file for these questions. Instead, it now
writes the responses that it finds in the log files.

Connect statements in log files. mrInterview's SQL log files no longer contain statements related to
connect statements in the questionnaire script. This is because these statements do not create entries in
the .mdd file, so attempting to execute these statements against the database caused problems because
there was no column for the statement.

Nodata variables in log files. The SQL statements that are written to the ISE logs no longer contain
nodata variables.

Clearing data from off-path questions. mrInterview does not clear data from questions that switch from
being on the interview path to being off-path. Clearing the data would mean that the data would not be
available if the question needed to be displayed after a snapback that changed the interview path again.
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Depending on how the script is written, this can cause other statements in the script to be executed when
they should be skipped. This can be avoided by setting the variable ofpathem to a non-zero value.

Specified Other with Not. When a question has a response list of the form resp mp not qname in list
and the respondent chooses Specified Other at qname, mrInterview no longer includes Specified Other in
the response list to the current question. To retain the pre-version 2.1 behavior where not ignores
Specified Other, set the variable nolimoth to a non-zero value in your script.

Rotation and randomization with snapbacks. When you snap back during an interview, mrInterview
now recalculates the random values used to control randomization and rotation with ranstart,
rotstart, newran, and newrot rather than reusing the original values calculated for the interview. This
solves a problem whereby, for example, a randomized loop following a ranstart block would present
different iterations of the loop after the snapback to those presented the first time the loop was executed.

Assigning categorical variables to temporary variables. A temporary variable that has been assigned the
value of categorical variable retains the value of that variable in the language that was current at the time
the assignment was made, regardless of any language changes that may occur later in the interview.
mrInterview has always done this, but prior to version 2.1 it would issue an error message when it tried
to update the value of the temporary variable after a language change, because temporary variables are
not stored in the .mdd file. The error message is not issued in version 2.1 because mrInterview is
functioning as intended.

Long response texts no longer truncated. mrInterview accepts response texts of up to 4000 characters.
However, earlier versions would allow users to enter longer texts and would silently truncate them at
16000 characters. The extra 12000 characters were not written to the case data or to the log files, and no
error messages appeared in the log files. Version 2.1 now enforces the 4000-character limit for response
texts and prevents users typing longer texts.

Selecting records using nselrec. The nselrec statement can be used to select records from response list
database by specifying their line numbers in the database. You can also use nselrec to step through a
subset of records that have been selected from a response list database, for example, if you want to repeat
a set of questions for each record chosen from the database.

Displaying the current question name with protect. The special variable name qname can be used on a
protect statement to display the name of the current question. For example:
p1 protect ’The name of the current question is ’+qname

Empty strings in questionnaire scripts. Zero-length text elements are no longer rendered on the
interview pages displayed to respondents. If an interview times out with the browser still open, and is
then restarted by the respondent clicking Next, it may now occasionally happen that the page's layout
changes when the page is redrawn. This can be avoided by replacing null-length text strings with text
strings consisting of a single space or similar. A typical example would be a multiask statement with a
blank question text. Instead of using two consecutive single quotes, place a space between the quotes.

Activation copies files to the DimensionNet Shared folder. The activation process has been updated to
copy project files created by the desktop Activate wizard to the Shared folder used by the mrInterview
applications that run through DimensionNet. This ensures that all project files created using desktop
applications or web-based applications are readily available to all users. The activation process still copies
files to the Master folder, and it is still from here that Interviewing servers obtain the files that will be
used for running interviews.

Project Management application replaced. The Project Management application has been replaced the
following applications in DimensionNet: ReviewQuotas for checking and changing quota targets,
ReviewProject for checking the current interviewing status of a project, Activate for activating projects in
Test, Active, or Inactive mode. In addition, InterviewReporter can be run from DimensionNet.
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What's New in mrInterview 1.2
For Administrators and Developers

Architecture. Additional information about the functions of the mrInterview components, and about the
SQL connections used by mrInterview.

Procedures. A new section describing the processes that take place on activation, at the start and end of
an interview, when an interview times out, and when a stopped or timed out interview is restarted.

Quota Control. A new section describing the Quota Control system and its functionality in terms of
quotas based not only on Sample Management data but also on data gathered during the interview. The
section also documents the structure of the quota database tables. The Sample Management section has
been updated with information on how to implement quota control in Sample Management scripts. The
mrInterview Reference section now describes the Quota Object Model that you can use for implementing
quota control in your Sample Management script, and the Quota Overview Object Model that generates
an XML document for each respondent.

The documentation has been restructured to remove some levels from the hierarchy, making it easier to
see what information is available.

Sample Management

Quota control. A flexible quota control system has been implemented for restricting the number of
respondents who participate in a survey, based on the characteristics that the respondents have. For
example, if you set quotas for 500 men and 500 women and you have interviews for 500 men, Sample
Management will prevent any further men from starting interviews while still allowing women to
participate. The Quota Object Model provides a range of methods and properties for defining quota
control within the Sample Management script.

REJECT code for use in AuthenticateSampleRec. The AuthenticateSampleRec function now has a
REJECT return code that you can use as an alternative to the FAILURE return code when you want to
prevent a respondent taking a survey. REJECT displays the rejected.htm Web page with the message
'Thank you for your interest in participating in this survey' but does not display the retry-authentication
page, so is useful for rejecting respondents who fail quotas. You can replace the default page with a page
of your choice in the same way as other pages in either the Activate wizard or PMWeb.

The sample scripts for mrInterview 1.1 all used the FAILURE return code to reject respondents with
records in the COMPLETED queue. These respondents should have seen just the message 'You have
already completed the survey. Thank you for participating in our survey.' but because FAILURE
automatically displays the retry-authentication page they would also see the message 'The authentication
information you have entered is incorrect. Please try again.' and the boxes to enter valid login
information. The sample scripts have been updated to use REJECT instead of FAILURE in this case, and
we recommend that you make the same changes in your Sample Management scripts.

New return code for flagging errors in Sample Management scripts. The new return code,
PARAM_ERROR, can be used to flag errors that occur in the Sample Management script, for example,
when the wrong SampleFields are passed to a function.

New return code for SampleRecReturnCode.Code. SampleRecReturnCode.Code is now set to 4 if the
interview fails for some reason. Previously interviews that failed in this way would not return their
sample records, leaving some records in the ACTIVE queue and with the variable Active set to 1.
Interviews for these records could not be restarted. If the record is moved to a FAILED queue when the
SampleRecReturnCode indicates failure, then the interviews can be restarted.
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The sample scripts have been updated to use this return code, and we recommend that you make the
same changes in your Sample Management scripts.

Adding SampleFields with duplicate names. Earlier versions of mrInterview allowed you to add a
SampleField even if one exists with the same name. This was found to cause a memory leak and is now
disallowed. The example script in the Sample Management documentation took advantage of this feature
by adding a new Id field even though one already existed, and has now been changed. If you have
scripts based on the example script, you will need to change them if you want them to work in version
1.2.

Versioning information in Sample Management scripts. Each sample script now starts with a small
header that indicates the mrInterview release in which the script was last changed and the date on which
the change was made. By checking the header you can see immediately whether you may need to update
your own Sample Management scripts.

SampleFields not defined in the sample table are ignored when adding sample records. In earlier
versions, calling the Queue.AddSampleRec method with SampleFields that were defined in the sample table
caused the method to fail. These fields are ignored in version 1.2 of the Sample Management object
model. This means that it is now easier to read a SampleFields collection from a URL, where additional
fields may be present.

Changed behavior for Queues.AddSampleRec. Queues.AddSampleRec now takes a copy of the
SampleFields object before changing or adding a record, so if the method fails you will need to remove
any sample fields that were added during the failed attempt before retrying. Previously, the SampleFields
object passed to the method was always inserted into the added SampleRec as SampleRec.Fields.

What's New in mrInterview 1.1
Sample Management

New sample scripts. mrInterview 1.1 comes with two new sample scripts (quocomp.sam and quo2dim.sam),
which illustrate using queues for quota checking.

Existing sample scripts improved. The other sample scripts have been updated to include the project,
respondent, and connection IDs in the logging entries. This means that the logging entries now conform
to the standard used by the other mrInterview components, which makes debugging easier. If you are
using the standard sample scripts, it is therefore recommended that you update to the new versions.

Default number of retries changed. The default number of times a respondent can attempt
authentication has been increased to six.

Blank authentication fields. In mrInterview 1.0, when an authentication field was not filled in on the
authentication page, it was not included in the SampleFields collection that was passed to the
AuthenticateSampleRec function. This behavior has now been corrected and in mrInterview 1.1, all of the
authentication fields are passed to the AuthenticateSampleRec function even if they are blank. For
example, suppose you define two authentication fields--Id and Password. When a respondent enters his or
her Id on the authentication page but leaves the Password input field blank, the SampleFields collection
passed to AuthenticateSampleRec in mrInterview 1.1 contains SampleField objects of Id and Password
(Password=""), whereas in mrInterview 1.0, the SampleFields collection contained the Id SampleField only.

Auto-authentication. In mrInterview 1.0, auto-authentication was always called when an interview
started in a project that used Sample Management regardless of how the interview was started. In
mrInterview 1.1, auto-authentication is called only if the authentication field(s) are passed on the URL as
virtual parameters. This changes the way scripts like addrandom.sam are used.
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Chapter 4. What's New in IBM SPSS Data Collection Survey
Tabulation

This section summarizes changes in the various IBM SPSS Data Collection Survey Tabulation product
versions.

What's New in IBM SPSS Data Collection Survey Tabulation 7
This topic provides information about changes and enhancements made in IBM SPSS Data Collection
Survey Tabulation release 7. The following new features have been added:

Support for IBM SPSS Visualization. The HTML Tables Export feature now offers the IBM SPSS
Visualization charting engine as an alternative to Microsoft Office Web Components (OWC). With the
exception of the Export Tables feature in IBM SPSS Data Collection Survey Tabulation, IBM SPSS
Visualization is now the default charting engine used during chart generation. The charting features are
available for all supported Microsoft Windows versions (32 and 64-bit). The IBM SPSS Visualization
charting engine provides a new Heat Map chart type.

When required, you can select the legacy Microsoft Office Web Components (OWC) for chart generation.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Survey Tabulation... > Details...

What's New in IBM SPSS Data Collection Survey Tabulation 6.0.1
This topic provides information about changes and enhancements made in IBM SPSS Data Collection
Survey Tabulation release 6.0.1. The following new features have been added:

Virtual directory, session engine, and Web service registration. During the product installation, you are
presented the option for configuring multiple virtual directories, session engines, and Web services.

Configuring multiple virtual directories, that run simultaneously, provides for optimum load balancing
within a cluster. When any of the following features are selected during installation, you are presented
with the Interviewer Server Administration Virtual Directory Configuration dialog during installation:
v Accessories Service
v Phone Interviews
v Remote Administration
v Survey Tabulation
v Survey Reporter Server Edition
v Author Server Edition

Configuring multiple session engines allows you to better utilize the memory on each IBM SPSS Data
Collection Interviewer Server machine. When you select to install the Interview Service feature, the
Interview Session Engine Configuration dialog displays during installation.

Configuring multiple Web services to run on a single machine allows you to better utilize the memory on
each Web server machine. When you select to install the Web Service feature, the Interview Web Service
Configuration dialog displays during installation.
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Refer to the Virtual directory, session engine, and Web service registration section in the IBM SPSS Data
Collection Server Installation Guide for more information.

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to the Reserved Keywords and Keyword Summary topics in the IBM SPSS Data Collection Developer
Library for more information.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and hotfix information. You can now view information regarding which fix packs and hotfixes
are installed via the application's Help menu.

Help > About IBM SPSS Data Collection Survey Tabulation... > Details...

What's New in IBM SPSS Data Collection Survey Tabulation 6
This topic provides information about changes and enhancements made in IBM SPSS Data Collection
Survey Tabulation release 6. The following new features have been added:
v No new features were added for version 6.

What's New in mrTables 5.6
This topic provides information about changes and enhancements made in Web Reports for Surveys
release 5.6. The following new features have been added:

mrTables is now Web Reports for Surveys. Starting with version 5.6, the product formerly known as
mrTables is now called Web Reports for Surveys. The new name is reflected in the interface and many
installed elements of the product, such as files and folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in Data Collection Developer Library 5.6 topic in the Data Collection
Developer Library.

Configure for FIPS 140-2 Compliance. You are now presented with a FIPS 140-2 Compliance step during
installation, allowing you to decide whether or not the installation will be configured for FIPS 140-2
compliance. FIPS 140-2 is a U.S. government computer security standard used to accredit cryptographic
modules.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not Configure
for FIPS 140-2 Compliance is enabled; for upgrade installations, the following rules apply:
v If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded in the

following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup log file. The log file is located at:
\Installer\NewPassword.log Interviewer Server Administrator administrators can supply users these new,
temporary passwords in a manner that is in accordance with their business practices.
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– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change their passwords
at next login.

v When upgrading on a server that is currently not configured for FIPS 140-2, you are presented with the
option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash function
algorithm.

v Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the SHA-1 hash
function algorithm will continue to be employed.
– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the parameters
outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology website for more information regarding FIPS
140-2.

Note: When FIPS 140-2 is configured, the applications adhere to the password protection security
protocols that are defined on the Interviewer Server. For example, if the Interviewer Server is configured
for MD5 security, the client-side applications will also use MD5 security for password protection,
regardless of whether or not the Configure for FIPS 140-2 Compliance setting was selected during
installation.

Rounding Options. You can now specify the default rounding calculation.

What's New in mrTables 5.5

This topic provides information about changes and enhancements made in mrTables release 5.5. The
following new features have been added:

There are no significant changes or additions for the mrTables 5.5 release.

What's New in mrTables 5.0

This topic provides information about changes and enhancements made in mrTables release 5.0. The
following new features have been added:

Dimensions Global Filters support. When defined in the DimensionNet Manage Access utility, mrTables
utilizes the defined user-level or role-level filters that control access to case data in a project.

Table grouping support. Related tables are now loaded and displayed as grouped under their respective
folders, as defined in Desktop Reporter. The table grouping feature allows you to:
v Add new tables the appropriate folders.
v Delete tables from existing groupings.
v Collapse and expand each populated folder.

Note that you cannot select, add, or delete folders from mrTables. The folders can only be modified
through Desktop Reporter.

Variable grouping support. Related variables are loaded and displayed as grouped under their respective
folders, as defined in Desktop Reporter. The variable grouping feature allows you to:
v Add new variables the appropriate folders.
v Delete variables from existing groupings.
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v Collapse and expand each populated folder.

Note that you cannot add or delete folders from mrTables. The folders can only be modified through
mrTables.

What's New in mrTables 4.5

This topic provides information about changes and enhancements made in mrTables release 4.5. The
following new features have been added:

Table document files now include variable edits. Variable edits and filters are now saved in table
document (.mtd) files in mrTables. This means that you can share your variable edits with other users of
mrTables. In addition, you can now open table document files from mrTables using Desktop Reporter and
mrStudio, and files from Desktop Reporter and mrStudio using mrTables.

Profile tables and difference attribute tables can be created in Desktop Reporter and mrStudio but not in
mrTables. If you open a table document containing such tables, you can see the table definitions and you
can populate the tables and view the results, but you cannot edit the tables. Table folders created in
Desktop Reporter or mrStudio are not displayed in mrTables, but any tables in the folders are displayed
as normal.

Change in behavior: As a result of the change to make table document files compatible with Desktop
Reporter and mrStudio, and to enable sharing of variable edits in mrTables, all variable edits are now
saved directly in the table document (.mtd) file and not in the Distributed Property Management (DPM)
system in DimensionNet. This means that changes made to variables apply only to the current table
document, not to the project. If you want variable edits to apply to all your table documents, it is
recommended that you create a template document including the variable edits. Any new table
documents created using the template will automatically include the variable edits.

Upgrade tool: Variable edits in DPM are no longer supported from release 4.5. An upgrade tool is available
for upgrading mrTables projects from 4.0 or earlier to 4.5 (or later). The tool saves the variable edits for a
project, currently stored in DPM, into each of the table document (.mtd) files that exist in the project
folder. After running the upgrade tool, .mtd files can be shared with other users of mrTables, and can also
be used in Desktop Reporter and mrStudio. You may prefer to ask your system administrator to run the
upgrade for you. For further information on running the upgrade tool, see "Running the Variable Edits
Migration Tool" in the mrTables Installation Instructions.

Upgrading Shared Table Documents:Table document files stored in the shared area are not affected by the
upgrade tool. To upgrade shared table documents, it is recommended that a user with the appropriate
access permissions saves the shared files to their own user area before running the upgrade tool. The files
will then be upgraded with that user's variable edits, and can be replaced in the shared area when the
upgrade is complete.

New charting features: The following new features are available when you export charts or display them
in mrTables:
v Chart different variables on the same chart. You can now choose whether to create charts for

individual categories, for individual variables, or for all variables on a table, using the Chart category
elements option in the Advanced dialog for HTML, Microsoft Excel, Microsoft PowerPoint, and
Microsoft Word exports, and in the View Table tab for individual tables.

v Chart special elements of same type to same chart. You can now create charts for one or more
statistical items (such as the mean, minimum value, standard deviation, etc.) using the Chart special
elements option in the Advanced dialog for HTML, Microsoft Excel, Microsoft PowerPoint, and
Microsoft Word exports, and in the View Table tab for individual tables.
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v Select cell item to base chart on. You can now base charts on a cell item other than the default,
provided that the cell item is included in the table. Use the Base chart on option in the Advanced
dialog for HTML, Microsoft Excel, Microsoft PowerPoint, and Microsoft Word exports, and in the View
Table tab for individual tables.

v Disable charts for individual tables. You can now choose not to create charts for specific tables. Type
No chart in the Chart type field in the View Table tab.

New export features: In addition to the new charting features listed above, the following options are now
available when exporting tables:
v Export to PowerPoint in table format. In addition to exporting results to Microsoft PowerPoint as

charts, you can now export results in table format using the options available in the Include
drop-down list in the PowerPoint Export dialog box.

v Wrap descriptions in Excel and PowerPoint tables. You can now choose whether or not to wrap long
descriptions onto the next line using the Wrap description text option in the Advanced dialog for
Microsoft Excel and Microsoft PowerPoint exports.

New File Formats. You can now work with data sources in the following additional file formats in
mrTables:
v Dimensions Data File. You can now open .ddf files in mrTables.
v Triple-S. You can now open .xml files that meet the Triple-S standard for the interchange of survey

data.

For further information, see the sections on the Dimensions Data File CDSC and the Triple-S DSC in the
Dimensions Development Library.

Support for Internet Explorer 7.0. mrTables now supports Microsoft Internet Explorer 7.0.

Enhancements to Insert Items dialog box. The following enhancements have been made to the Insert
items dialog box:
v You can now add median, mode, and percentile elements to a table using the Insert Items dialog box.
v When you add a mean, minimum, maximum, standard deviation, standard error, sample variance,

numeric, sum, median, percentile, or mode element to a numeric variable, the element refers to the
current variable by default. You can change this if required, using the Element Properties dialog box.

Enhancement to the display of variable names. When you configure mrTables to restrict the levels of
variable names to display, the setting is now also reflected in variable names that appear in the Based On
drop-down in the Preferences tab (to change the number of variable name levels to display, use the
LevelsShown project property in the Edit Project activity. The setting applies to all of the variables in a
project. See the Changing Project Properties topic in DimensionNet help for further information).

A new check box on the Preferences tab, Show Full Variable Names, enables you to override the value of
the LevelsShown setting. This check box applies only to variable names displayed in the Preferences tab.

Change in behavior in column proportions and column means calculations. The Column Proportions
and Column Means tests in mrStudio, mrTables, and Desktop Reporter previously used the expression:

DF = e 1 + e 2 - e 0 - 1

to calculate the degrees of freedom. This matches the calculation used in Quantum/Quanvert. From
release 4.0 Patch 1, the expression has changed to:

DF = e 1 + e 2 - e 0 - 2
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For backwards compatibility, the formula invoked by setting the Use the Quantum/Quanvert column test
formula option continues to use the original expression.

What's New in mrTables 4.0
This topic provides information about changes and enhancements made in mrTables release 4.0. The
following new features have been added:

Improvements to Open/Save dialog boxes with additional features for organizing table documents into
folders. The Open and Save dialog boxes in mrTables have been enhanced to include the ability to
organize table document files into folders, and to move files between folders directly in mrTables,
without requiring access to the Files activity.

Change the order of variables added to a table. You can now change the order of variables after you
have added them to a table, without the need to remove the variables from the table and re-add them.

Template table documents. It is now possible for system administrators or advanced end users to create
a template table document (.mtd) file and add it to the shared folder for a project. All new table
document files for the project contain the settings from the template file. The template file can contain
default settings, table and filter definitions, and results. The template file can be created using either
mrTables or mrStudio Tables Option.

New chart types available in mrTables. You can now choose from a number of different chart types
when displaying your results in mrTables and when exporting to HTML or to Microsoft Excel,
PowerPoint, or Word. You can also specify different chart types for individual tables. In addition, you can
select an Excel custom chart type that you have previously set up when you export to Excel, PowerPoint,
or Word.

Ability to hide individual items in a variable. Hiding elements of a variable so that they do not appear
on a table is now easier. Instead of entering the hide syntax using the Script tab of the Edit Variable
dialog box, simply check the new Hide check box in the Edit tab.

Improvement to the display of short names or full names of variables in mrTables. When you
configure mrTables to display variables using either short names or full names, these are now reflected in
the variable names in the Filter dialog box, the Weighting drop-down list, and the Sort Row and Sort
Column drop-down lists, rather than just the Variable List. This setting is applied to all of the variables in
a project, using the LevelsShown project property in the Edit Project activity. See the DimensionNet help
for further information on configuring Project Properties.

In addition, it is now possible to display the short name of a variable in headers and footers for the
weight, level, sort, and specification fields, using the \s switch.

Additional details when running statistical tests. mrTables now displays additional information and
warning details in headers and footers when you run statistical tests on a table. The information is
displayed in the PopulateWarnings and CellItemSymbols fields in the headers and footers. By default,
these fields are displayed in the left footer of a table.

Ability to aggregate hierarchical data at additional levels. You can now aggregate a higher level variable
at a lower level without having to tabulate a variable from the lower level.

Changes in behavior in mrTables 4.0

The Column Proportions test no longer uses the continuity correction by default. The default formula
for the column proportions test no longer includes the continuity correction when calculating the t value.
This is for compatibility with Quantum and Quanvert. The continuity correction can be added to a
column proportions test using the new UseContinuityCorrection property in mrStudio Tables Option.
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Change in behavior in default footer. As described above, the left footer position now contains
additional fields. The title footer position has also been changed so that the document description no
longer appears by default. It is still possible to include this annotation in headers or footers.

What's New in mrTables 3.5
This topic provides information about changes and enhancements made since mrTables release 3.1. The
following new features have been added:

Three access levels for mrTables. mrTables is now available in three different access levels:
v Minimum Access: If you have this access level, you can open existing table documents, populate

tables, and export results.
v Medium Access: If you have this access level, you can create new tables using existing variables, apply

filters to tables, edit variables on a table, edit the properties of tables, populate tables, and export
results.

v Full Access: If you have this access level, you have unrestricted access to all the features of mrTables,
including the ability to edit variables for an entire project.

Note: The default installation of mrTables provides full access. Your system administrator may have
assigned restricted access levels to you, for example, if you do not need all the options available in
mrTables. If you have several DimensionNet roles that each have different access levels, the least
restrictive access level applies.

Option to run HTML export on client machine. In previous releases, the HTML export component that
displayed populated tables in mrTables was always run on the server. You can now install this
component (HTMLExport.dll) on the client machine, to make displaying populated tables faster. You can
do this before running mrTables, using the SPSS Dimensions Exports Installer, or if the component is not
installed when you start mrTables, you are prompted to choose whether to install it. If you do not wish
to install this export component on the client machine, you can continue to use the component on the
server.

Open flat data sources using a hierarchical view. You can now open any data source that has a VDATA
DSC with metadata using a hierarchical (HDATA) view. This enables you to create grid tables and
provides better support for tabulating data collected using loops. The default view for opening this type
of data source using mrTables has been changed from flat to hierarchical to take advantage of this
feature. The hierarchical view is provided by the Table Services DSC.

Note that table document (.mtd) files include details of the type of view, and this will not be changed for
existing table documents.

Select a PowerPoint template to use in exports. You can now attach a different template to your
PowerPoint slides as you export them, using the Use PowerPoint template option.

Display bases in chart series in exports. You can now display the series bases in the chart legend when
you export charts to HTML or to Microsoft Excel, PowerPoint, or Word, using the Display series base
option.

Display headers and footers in PowerPoint exports You can now display the headers and footers from
your tables in PowerPoint slides using the DisplayHeaders and DisplayFooters options.

Display statistical test result column IDs in charts in Microsoft PowerPoint and Microsoft Word
exports. You can now display the column IDs shown in statistical test results when you export charts to
Microsoft PowerPoint and Microsoft Word, using the Display column proportion results option.
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What's New in mrTables 3.1
This topic provides information about changes and enhancements made since mrTables release 3.0. The
following new features have been added:

Release 3.1

Ability to reject new sessions when servers are busy. New minlimit and maxlimit performance counters
have been added to the load balancing configuration file, so that servers running mrTables can be
configured to reject new sessions when busy. See the mrTables Installation Instructions and Configuration
Notes for further information on setting up performance counters.

Ability to use short names or full names to display variables in mrTables. You can now configure
mrTables to display variables using either short names or full names. This setting is applied to all of the
variables in a project, using the new LevelsShown project property in the Edit Project activity. See the
DimensionNet help for further information on configuring Project Properties.

Load balancing between applications. When making a Professional installation on Windows 2003 servers
running IIS 6.0 and above, you may choose to create separate application pools for DimensionNet
activities and mrTables. This makes it less likely that services will fail due to reaching the 2GB limit
imposed on IIS processes in Windows 2003. It also increases reliability because issues that cause one
application pool to restart will not impact the other application pool. It is also possible to load balance
between mrTables applications and DimensionNet applications in separate application pools. See the
mrTables Installation Instructions and Configuration Notes for further information on setting up load
balancing.

Non-default port numbers and SSL. The installation procedure now automatically detects whether
servers use port numbers other than 80 and/or SSL, and configures mrTables accordingly.

MS XML 3 now supported. It is now possible to run mrTables using MS XML 3 rather than MS XML 4.
If you do not wish to install MS XML 4, please see your support representative for further information.
Note that MS XML 4 is recommended for use with mrTables.

Ability to suppress base rows and columns for all tables when exporting to Excel spreadsheets. You
can optionally remove all rows and columns containing base values from the output file for all tables
when you export to Excel, by selecting the Hide base elements check box in the Excel Export dialog box.

Charts appear only when requested. If you have the chart option enabled, mrTables now displays charts
only when you request them.

New minimum base and small base options in statistical tests. mrTables now detects when a sample
size is below the minimum recommended size to perform a column means, column proportions or paired
preference test on a table or part of a table. Rows or columns where the base is below the minimum
value (30) are not tested. This is denoted in the table by two asterisks (**), which appear instead of the
test result. In addition, if a sample size is above the minimum but is below the small base value (100), an
asterisk (*) next to the test result denotes this.

Ability to configure warning limits and set absolute limits when populating tables. A warning now
appears when you populate large tables. This is based on the total number of cells in the tables being
populated. By default, the warning appears for tables of over 10,000 cells. Your system administrator can
change the number of cells that triggers the warning, and can also add an absolute limit to prevent
population of very large tables created in error.

Ability to create mean summary tables. You can now create summary variables displaying mean or
other summary statistics for a number of other variables, by adding numeric items to a variable.
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Ability to include the sum of a numeric variable in another variable. You can now include the sum of a
specified numeric variable as an element in another variable, by adding the sum item to a variable.

Patch Release 3.0.2

Ability to chart statistical elements. Charts are now created for statistical elements, such as mean or
standard deviation elements. When you export charts to HTML, Microsoft Excel, Word or PowerPoint
formats, you can choose whether to create charts for statistical elements, using the Chart special
elements check box in the relevant Exports Dialog box.

Change in behavior of charts. When you export charts, you can now use either the rows or columns in
the table to form the chart series, using the Chart table rows as series check box in the relevant Exports
dialog box. By default, the chart series is formed from the rows of the table. In previous versions, charts
were always formed from the table columns.

Statistical tests on grid slices. In previous versions of mrTables, if a statistical test was run on a grid slice
from a variable, the test was flagged as invalid. It is now possible to run statistical tests on grid slices.

Improvement in performance of Excel export. Exporting tables to Excel is now faster. Excel exports now
use VBA macros instead of running the application directly. In some cases, this may mean that you need
to change security access settings in Excel.

Patch Release 3.0.1

Global Filter Enhancements. A new Edit Global Filter button has been added on the Define tab to open
the Global/Interview Filter Setup dialog box. This is in addition to the existing menu option. To improve
usability, the Global Filter dialog has been redesigned so that it is only possible to create one global filter
(previously, it was possible to create multiple global filters but only one could be applied).

mrTables remembers project options. The options language setting and the Advanced/Simple view
setting are now saved when you save an mrTables project and are remembered the next time you open
the project.

What's New in mrTables 3.0
This topic provides information about changes and enhancements made in mrTables 3.0.

Helper fields. You can now display helper fields, for example Other Specify fields, coding variables, or
source file variables, in mrTables, and include them in your tables.

Support for derived elements. A new dialog is now available to enable you to add rows or columns
containing values derived by calculation from the values of other elements in a table.

Note: The derived element feature was added to the scripting language in mrStudio Tables option 2.3.

Ability to run statistical tests at two levels of significance. You can now specify two significance levels
when performing a Column Proportions or Column Means test on a table.

Ability to run statistical tests on grids. You can now run the Column Proportions and Column Means
test on grid variables.

Ability to run statistical tests on tables with hidden rows or columns. When you run a statistical test on
a table with rows or columns that are hidden using the Suppress Row or Column option on the
Preferences tab, the rows and columns remain hidden. Previously, hidden rows or columns were
redisplayed when a statistical test was run.
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Ability to add weighting to individual rows or columns. You can now add weighting to a single
element in a variable. To do this, you need to edit the Top Definition or Side Definition field in the Define
tab, or the Script tab in the Edit Variable dialog box to add a weight property to the element. For further
information on the element weight property, see the Dimensions Development Library.

Ability to add multipliers to individual rows or columns. You can now specify a multiplier for a single
element in a variable. To do this, you need to edit the Top Definition or Side Definition field in the Define
tab, or the Script tab in the Edit Variable dialog box to add a multiplier property to the element. For
further information on the element multiplier property, see the Dimensions Development Library.

Enhancements to User Interface. A number of changes have been made to improve the mrTables user
interface by standardizing the buttons and menu options on the Define tab and enhancing the layout of
the tab.

Data Model 3.0. mrTables 3.0 comes with Data Model 3.0.

Performance Enhancements. The performance of mrTables has been improved in the following areas:
v The Variable List now takes less time to display when you open a project.
v Switching between the Define and View tabs is now faster.
v Populating tables from the Define tab now takes the same time as from the View tab.

What's New in mrTables 2.3
This topic provides information about changes and enhancements made in mrTables 2.3.

Main Features

The following new features have been added:

Paired Preference Test. This statistical test compares pairs of values.

Horizontal Text on Side Axis. A new option enables you to choose between displaying the text on a side
axis horizontally or vertically in tables you display in mrTables or export to HTML. Text is displayed
horizontally by default (in previous versions side axis text was always displayed vertically).

Assigning Factors to Nets and Combined Elements. You can now assign factors to nets and combined
elements in the same way as for other categorical elements.

Export Installation available on CD-ROM. A new installation program for the export components is now
available on the mrTables Installer CD-ROM, to make installing the export components easier for users
whose browser security does not allow installation from the server. If you receive an error message the
first time you attempt to run an export because your browser does not allow downloading and
installation of the export .cab files, you can use the new installation program to install the components.
Most users will not find it necessary to carry out this step.

Optional calculation of statistics data. A new option on the View Table Options dialog enables you to
turn on or off the calculation of diagnostics information for any statistical tests on your tables. Turning
this option off can increase the speed of population of tables.

Additional Enhancements

The following additional enhancements and changes to behavior have also been implemented:
v It is now easier to create a table using boolean variables, as a default expression is automatically

created when you add the variable to a table.
v You can now use the * character in element labels and within element expressions.
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v When you upload a project to DimensionNet, a metadata (.mdd) file is now created automatically for
the project if one does not exist. This improves performance when you open the project in mrTables.

v It is now easier to share table document (.mtd) files with other users. mrTables now looks in both the
user folder and the shared folder for the project information when you open a table document.

What's New in mrTables 2.2
This topic provides information about changes and enhancements made in mrTables 2.2.

Main Features

The following new features have been added:

Simplified uploading of projects. It is now easier to upload projects into mrTables. See the
DimensionNet help for further information on uploading projects.

Export Wizard. There is now a new wizard to assist in the creation of custom mrTables export
components.

Sorting of Tables. You can now sort tables on the values in a row or column.

Control over display of percent signs in a table. You can now choose whether or not to display percent
signs in a table.

Display of currency symbols and other text in a cell. You can now specify a prefix or suffix for a cell
item. You can use this feature to display currency symbols or other text in a cell.

Feedback on minimum/maximum values in case data when banding variables.

Suppression of Rows or Columns. You can now suppress rows or columns where the base count
contains only zeros, or where the base is below a certain value.

Display Variables as Questions. You can now display the source variables in the format of the questions
they represent.

Exclude categories from the Base. You can now exclude particular categories from the calculation of the
base, while still including the categories in rows or columns in the table.

Improvements to Filter dialog box.The Filter dialog box has been redesigned for greater ease of use.

Save Filter as Variable. You can now save the expression created for a filter, and reuse it as a new
variable.

Display Charts. If you have a license for Microsoft Office Web Components (OWC) version 10 or later,
you can display variables in mrTables in the form of a chart. In addition, Microsoft Office Web
Components (OWC) version 10 or later must be installed on the mrTables server. For details of the
software required to display data as a chart, and how to enable charts, see "What You Need to Use
mrTables 2.2" in the mrTables Installation Instructions.

Creating new variables is now easier. New commands on the Variables menu simplify the process of
creating new variables.

Changing the view. When you are working with data stored in a case data format that supports both the
hierarchical and the flat view of the data, you can now change between the two views. This is
particularly useful when working with data you have exported to an XML file.
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Configure the display of significance letters when exporting to Excel. You can now configure the
display of significance letters when exporting tables to Excel using the Show column proportion results
with first cell item check box.

View images attached to variables, and export images when exporting to HTML. mrTables now
displays images that have been associated with variables (images may be attached to survey responses in
mrInterview, or using mrStudio Tables option) and you can export the images when you export a table to
HTML.

Additional Enhancements

The following additional enhancements and changes to behavior have also been implemented:
v Simplified creation of tables for numeric variables. It is now easier to create a table using numeric

variables. You can create a table using a numeric variable without editing the variable first. Default
minimum, maximum, mean and standard deviation items are automatically created for the variable,
resulting in a summary table.

v Improved information on hierarchical levels. The user interface now provides clearer information
about the hierarchical level of the data being analyzed.

v Bases displayed as counts when cell contents are percentages. In a table that contains only
percentages, the base cells now automatically display total counts for the row or column, instead of
showing 100%.

v Improved handling of bases inside nets. In previous versions of mrTables, a base value inside a net
would include all cases in the variable. It now includes only cases within the net, providing a greater
level of detail.

v Tooltips for new and derived variables. The Variable List now displays tooltips for any new or
derived variables you have created.

v Multiple selection of tables. The Table List now enables multiple selection and deletion of tables.
v Menus adapt to what is selected. Options in the main menus are grayed out if not available.
v Decimal places. Ability to specify the number of decimal places of a summary statistic element.
v User interface enhancements. The graphical user interface has been revised to improve ease of use,

and changes have been made to simplify the terminology used on screen.

What's New in mrTables 2.1
This topic provides information about changes and enhancements made in mrTables 2.1.

Main Features

The following new features have been added:

Performance Improvements. Improved performance and resolution of a number of problems.

Word Export. Provided you have Microsoft Office 2000 or later installed on your desktop machine, you
can now export your tables and/or charts to Microsoft Word.

Text Export. You can now export your tables to a delimited text file (typically a .csv file).

HTML Export. This export has a new option to export variable and element labels with HTML
formatting.

Saving Tables as Script. You can now view your tables as a raw script. You can optionally save this
script and use it as the basis for a batch job to be run using mrStudio.
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Data Model 2.8.1. mrTables 2.1 comes with Data Model 2.8.1. A major change in Quanvert DSC in this
version of the Data Model means that you can now use packed Quanvert databases (.pkd files) with
mrTables. This makes setting up a mrTables project to analyze Quanvert data much easier.

Changing how a variable appears in a table. You can now change how a variable is to appear on a
specific table. For example, if you use the same variable in many tables, you can change the way the
variable appears in each different table.

Easier filtering on date variables. You can now use the normal view of the Filter and Edit Expression
dialog boxes to define a filter or expression based on a date variable. If you wanted to do this in
mrTables 2.0, you had to use the Advanced View of the dialog box.

Bases in nested tables. When variables were nested on the side or top axis, previously mrTables did not
create autobase elements in the outermost variables. This anomaly has now been corrected and autobase
elements are now created in the outermost variables.

Additional Enhancements

The following additional enhancements and changes to behavior have also been implemented:

Notes:

v There have been major changes to the internal architecture since mrTables 1.1 to provide support for
the new browser-based user interface.

v mrTables 2 has a new version of the Table Object Model, which has been redesigned to make it easier
to create tables using a script. Note that any programs or scripts that you developed to work with the
mrTables 1.1 Table Object Model will not work when you upgrade to mrTables 2.0 or later or the
mrStudio Tables Option.
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Chapter 5. What's New in IBM SPSS Data Collection Author

This section summarizes changes in the various IBM SPSS Data Collection Author product versions.

What's New in IBM SPSS Data Collection Author 7
IBM SPSS Data Collection Author 7 contains the following new features:

Activation. The activation process has been updated to support enhanced sample management, personal
interviewing, telephone interviewing, and quota features.

The feature includes the following enhancements:
v Participants - History Reports. The History Reports settings provide options for defining which fields

will display in the contact and session history reports.
v Telephone - Interviewing - Introduction. The Introduction settings now include an editor that

provides options for modifying a project's introductory text via HTML or plain text, and provides a
method for switching between available languages.

v Telephone - Interviewing - Interviewer. The Interviewer settings now include the option Display
status messages in Phone Participants. When the setting is enabled, interviewer status messages will
display in the IBM SPSS Data Collection Interviewer Server Phone Participants activity.

v Telephone - Interviewing - Project Message. This new feature provides options for creating and
editing project messages. Project messages provide specific project information to each interviewer. The
editor provides options for modifying message text via HTML or plain text.

v Quota. The Quota settings now provide options for defining the percentage of quota targets that are
assigned to each personal interviewer.

v Advanced - Properties. The new Properties settings provide options for creating custom properties
during activation.

v Advanced - Other. The Other settings include the new setting Check for next project at end of
interview. The setting enables survey chaining for the project. This allows a different survey to be
initiated immediately after the current survey is completed.

v New personal_sample.mrs script. The new sample management script is suitable for personal face to
face interviews conducted by interviewers in homes or other locations. Refer to the Scripts in the IBM
SPSS Data Collection Sample Management Folder topic in the IBM SPSS Data Collection Developer Library
for more information.

Interview Services. The new Interview Services features provide options for defining and configuring
external web services that can be used in the routing script. The IBM SPSS Collaboration and Deployment
Services service type provides advanced real-time scoring and text analytics capabilities and can greatly
improve respondent interactions. The Salesforce service type is a COM-callable proxy for the
Salesforce.com web service. Some examples of how these services can be used are:
v Allow for a more natural and engaging use of text responses, basing survey logic on concepts and

sentiment captured in open-ended questions.
v During the survey, automatically ask follow-up questions as a result of scoring against existing

attitudinal and transactional data.
v Based on scoring results, ask the most respondent-pertinent questions. Asking the right questions,

instead of all the questions, is increasingly important as survey response rates continue to fall.
v Centralize complex routing logic in models stored in IBM SPSS Collaboration and Deployment Services

(segmentation, for example).
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You can also configure custom services to further take advantage of third-party web services. External
services must first be configured via the authoring application's Interview Services Options.. feature. Refer
to the following topics for more information:

Client certificate support via smart card authentication. Client certificates are now supported via smart
card authentication. Client certificates are used to secure access to IBM SPSS Data Collection Accessory
servers. A valid PIN number is required when employing client certificates via smart card authentication.
Users who cannot provide the appropriate client certificate and PIN number are denied access to the IBM
SPSS Data Collection Accessory servers. Refer to the Working with client certificates to secure accessory server
access topic in the IBM SPSS Data Collection Desktop 7.0.1 Installation Guide for more information regarding
client certificates.

Client certificate support in SSL environments. Client certificates are now supported in SSL
environments. Client certificates are used to secure access to IBM SPSS Data Collection Accessory servers.
Users who cannot provide the appropriate client certificate are denied access to the IBM SPSS Data
Collection Accessory servers. Refer to the Working with client certificates to secure accessory server access topic
in the IBM SPSS Data Collection Desktop 7.0.1 Installation Guide for more information regarding client
certificates.

Sample and Quota options. The following features are now available to support enhanced sample and
quota functionality:
v Testing tab in Options dialog. The new Testing tab provides options for selecting a file that contains

the default participant records when the Participant.xsu file is not found in the project directory, and
options for defining the quota report script and debug quotas data file locations.

v Quota. The Tools menu now provides the following Quota options:
Configure - launches the Quota application
Enable debugging - toggles Quota tracking
Reset Counters - resets the quota counters to 0 (zero)
View Report - runs the DebugQuotas.mrs file and displays the quota results in Microsoft Excel

Gallery. The new IBM SPSS Data Collection Gallery feature provides options for supporting the various
sample library items that are installed with the application. The gallery provides a simple user interface
that organizes library items by type and function, allowing you to browse library items and view item
descriptions, prerequisites, and package contents before adding items to your projects.

HTML5 input type. The Option dialog's Preview tab provides options for defining the HTML and
XHTML Doctype attribute for web surveys. HTML5 is now supported.

The IStyle.Control.Type enumeration has been extended to support HTML5 input types. This allows for
the conversion between IBM SPSS Data Collection types to HTML5 input types.Refer to the HTML5 input
types topic in the IBM SPSS Data Collection Developer Library for more information.

Apply sub templates in grids. The Option dialog's Preview tab provides the new HTML Option Apply
sub templates in grids. The feature enables and disables custom controls in sub-templates for grid and
loop questions.

Browser capabilities. The Option dialog's Preview tab provides the new Browser capabilities option that
allows you to define specific browser capabilities.

Specify image attributes. You can now define specific image attributes such as alternate text, width, and
height.
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Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Author... > Details...

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

What's New in IBM SPSS Data Collection Author 6.0.1
IBM SPSS Data Collection Author 6.0.1 contains the following new features:

Virtual directory, session engine, and Web service registration. During the product installation, you are
presented the option for configuring multiple virtual directories, session engines, and Web services.

Configuring multiple virtual directories, that run simultaneously, provides for optimum load balancing
within a cluster. When any of the following features are selected during installation, you are presented
with the Interviewer Server Administration Virtual Directory Configuration dialog during installation:
v Accessories Service
v Phone Interviews
v Remote Administration
v Survey Tabulation
v Survey Reporter Server Edition
v Author Server Edition

Configuring multiple session engines allows you to better utilize the memory on each IBM SPSS Data
Collection Interviewer Server machine. When you select to install the Interview Service feature, the
Interview Session Engine Configuration dialog displays during installation.

Configuring multiple Web services to run on a single machine allows you to better utilize the memory on
each Web server machine. When you select to install the Web Service feature, the Interview Web Service
Configuration dialog displays during installation.

Refer to the Virtual directory, session engine, and Web service registration section in the IBM SPSS Data
Collection Server Installation Guide for more information.

Exit routing items and project reporting accuracy. In previous versions, when an Exit routing item was
inserted into a questionnaire, you were typically required to create an info item that required the final
Next button to be clicked in order to successfully complete the survey. When the final Next button was
not clicked, the survey was not marked as complete, resulting in project reporting discrepancies.

IBM SPSS Data Collection Author now provides the option to manually set the End of Interview /
Stopped text, without the need for an info item, via the Exit routing item's new Exit text setting. This
enhancement allows surveys to successfully complete without the need to click the final Next button.

Auto Answer feature enhancements. The Auto Answer feature has been updated to support more robust
auto answer playback capabilities including adding, editing, changing, and removing data sources
connections, defining the number of cases, and so on. Note that working with data sources is not
supported in IBM SPSS Data Collection Author Server Edition.

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
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Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to the Reserved Keywords and Keyword Summary topics in the IBM SPSS Data Collection Developer
Library for more information.

Support for creating text response grids. You can now create text response grids (in addition to existing
support for categorical response and numeric response grids. Text response grid appearance and behavior
is similar to that of numeric response grids.

Interview preview enhancements. When previewing interviews, via the Preview Interview feature, you
can now:
v Click New Case to restart the interview preview (return the questionnaire to the beginning).
v Record case data when previewing a questionnaire. This recorded case data can be used during auto

answer playback.

Script filters. You can now create script filters that allow you to define expressions that cannot be directly
parsed for IfBlock, If Go To, and Skip-and-Fill items.

Project expiry setting in Local Deployment Wizard. The Local Deployment Wizard now provides an
expiry date and time step that allows you define the project's expiration date and time (UTC time).
Defining a project expiration date and time allows interviewers to easily identify expired projects.

Client Sniffer custom control. The Client Sniffer custom control launches a wizard that asks what
explanatory text should be displayed to a survey respondent while browser data is collected in the
background. The information is stored in text variables that can be used to create branching logic in the
survey.

Display descriptions for unsupported script. When you open a file (created in another application) in
IBM SPSS Data Collection Author that includes script that the application is unable to parse, a new script
routing item is created that includes a sampling of the unsupported script. You can provide this new
routing item a name and, if necessary, rewrite the script in the Design pane's Script tab.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and hotfix information. You can now view information regarding which fix packs and hotfixes
are installed via the application's Help menu.

Help > About IBM SPSS Data Collection Author... > Details...

What's New in IBM SPSS Data Collection Author 6
IBM SPSS Data Collection Author 6 contains the following new features:

Author is now IBM SPSS Data Collection Author. Starting with version 6, the product formerly known
as Author is now called IBM SPSS Data Collection Author. The new name is reflected in the
documentation, interface, and many installed elements of the product, such as files and folders.

Single Sign-on. IBM SPSS Data Collection applications now support LDAP single sign-on (SSO). This
functionality uses Integrated Windows Authentication (SSPI). Single sign-on can be used to authenticate
and manage users in a multi-user, multi-repository environment and to store and retrieve the credentials
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that are used for logging into various content and workflow repositories. For more information, see the
Configuring for Single Sign-on topic in the IBM SPSS Data Collection Developer Library.

Web-deployed IBM SPSS Data Collection Author. You can now install IBM SPSS Data Collection Author
from an IBM SPSS Data Collection Interviewer Server, allowing you to create and deploy surveys within
the server environment. The web-deployed version of IBM SPSS Data Collection Author is governed by
usage licenses and by administrative roles that are assigned to the individual users.

IBM SPSS Data Collection Publish Assets Utility. Allows you to manage your customized files for
web-deployed IBM SPSS Data Collection products (for example, IBM SPSS Data Collection Author Server
Edition, IBM SPSS Data Collection Survey Reporter Server Edition.

Role-based access to IBM SPSS Data Collection Author. Allows you to customize and manage
permissible tasks assigned to IBM SPSS Data Collection Author users. Role-based limitations restrict users
from viewing, editing, and adding components in a survey without the proper privileges. Role-based
access applies to both the desktop and web-deployed versions of IBM SPSS Data Collection Author when
the application accesses projects that are located in IBM SPSS Data Collection Interviewer Server
Administration.

New roles were added in IBM SPSS Data Collection 6 Patch 1. As a result, the roles have been grouped in
IBM SPSS Data Collection Interviewer Server Administration based on their function. The migration
behavior of these new roles is as follows:
1. For split features, the deprecated feature is replaced with the new corresponding features. The

following features have been split:
v Can activate project is replaced with the Can activate in test mode, Can activate in go-live mode, Can view

advanced activation settings, and Can edit advanced activation settings features.
v Can manage context and language is replaced with the Can manage context and Can manage language

features.
v Can insert/edit script items is replaced with the Can edit script item, Can insert script item, and Can

delete script item features.
2. For new features, a IBM SPSS Data Collection Interviewer Server Administration administrator will

need to manually add the features to the appropriate roles.
3. Users or roles who have access to IBM SPSS Data Collection Author will be automatically granted the

newly added features; users or roles who have access to the Can Manage Context And Language or Can
Activate Project features will be automatically granted the associated split features.

4. Some of the new features are not intended for every user or role. You can manually remove any
unneeded permissions by utilizing the provided InitializeRoleBase.mrs script. The script allows you to
batch add or remove the feature permissions for existing users and roles. The script is located at:
[INSTALL_FOLDER]\IBM\SPSS\DataCollection\7\Interviewer Server Administration\\RoleBasedAccess.
There are two files in the RoleBasedAccess directory:

v InitializeRoleBase.mrs - Run this script to add or remove feature permissions for users and roles
defined in the InitializeRoleBase.xls file. Before you run the script, you will will need to specify the
ExcelFilePath parameter in the script.

v InitializeRoleBase.xls - Identifies the feature permissions to add or remove for existing users or roles.
For example:

Activity Feature Roles Action

Author SampleManager;SurveyLauncher Remove

Author CanManageContext SurveyCreator;Translator;ProjectManager Remove

Author CanManageLanguage Translator;Analyst;ProjectManager Remove

Activity - Identifies the activity.
Feature - Identifies the corresponding activity feature.
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Roles - Specifies users or roles for the activity feature. Users and roles are separated via semicolons.
Action - Specifies whether to Add or Remove the defined activity features for the specified users and
roles.
Configure the spreadsheet to define the custom access levels for any user-created users or roles.
Note: Running InitializeRoleBase.mrs with the predefined InitializeRoleBase.xls spreadsheet will restore the
default activity feature permissions for the existing Data Collection roles.

Refer to the Assigning users or roles to activity features section in the IBM® SPSS® Interviewer Server
Administration User's Guide for more information.

IfBlock routing. Allows you to create logical routings using If, ElseIf, and Else conditional statements.

Set Response routing item. Allows you to set the response to a specific question using the question's
default answers as set in metadata, responses to other questions, or manually entered expressions.

Improved skip-and-fill functionality. You can now set filled responses more efficiently when building
skip-and-fill conditional statements for use in IBM SPSS Data Collection Data Entry.

Hierarchical data (unbounded loops). You can now create unbounded loops that render iterations based
on the response to a preceding numeric question with no maximum value configured. Also, you can
render unbound loops in IBM SPSS Data Collection Author with unlimited iterations based on scripts
built in IBM SPSS Data Collection Professional.

Hierarchical data (database questions). You can now create single response, multiple response, and loop
questions whose category lists are generated by connecting to an external database.

Activation user interface. The Activation user interface has been re-factored to improve organization of
the active project's settings and to integrate project template functionality. Refer to the Activating
Questionnaires topic for more information.

Project templates. You can now save complex project settings to templates that will assist in creating and
configuring projects. Each project template contains all of the artifacts for starting a new project (settings,
resources, images, and so on) and an activation template to assist with project activation. You can store
project templates to, and access project templates from, server directories.

Project templates enable you to:
v Save a project, including all associated files and settings, as a project template.
v Create a new project that is based on the files and settings within an existing project template.
v Store and access project templates from an IBM SPSS Data Collection Interviewer Server, IBM SPSS

Data Collection Question Repository, local directory, or library.

What's New in Author 5.6
Author 5.6 contains the following new features:

Author is now Author. Starting with version 5.6, the product formerly known as Author is now called
Author. The new name is reflected in the documentation, interface, and many installed elements of the
product, such as files and folders.

New system variables. MDD files that are activated for use with Interview Player 5.6 require four new
system variables:
v DataCollection.BatchID
v DataCollection.BatchName
v DataCollection.DataEntryMode
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v DataCollection.Removed

MDD’s that were created in Dimensions 5.5 or earlier do not include these system variables and must be
reactivated to Interview Player 5.6. You must also reactivate MDD files, created in a previous release, that
are opened and saved using a 5.6 application.

It is important to note that if you remove system variables from an MDD created in any release
(including 5.6), Interview Player 5.6 will require reactivation to ensure that all system variables are
present.

If you attempt to open a file that excludes one or more of these variables, Interview Player will block the
action and issue the following notification: “Required system variables missing. Reactivation is required.”

Configure for FIPS 140-2 Compliance. You are now presented with a FIPS 140-2 Compliance step during
installation, allowing you to decide whether or not the installation will be configured for FIPS 140-2
compliance. FIPS 140-2 is a U.S. government computer security standard used to accredit cryptographic
modules.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not Configure
for FIPS 140-2 Compliance is enabled; for upgrade installations, the following rules apply:
v If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded in the

following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup log file. The log file is located at:
C:\Program Files\Common Files\IBM\SPSS\DataCollection\[version]\Installer\NewPassword.log
DimensionNet administrators can supply users these new, temporary passwords in a manner that is in
accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change their passwords
at next login.

v When upgrading on a server that is currently not configured for FIPS 140-2, you are presented with the
option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash function
algorithm.

v Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the SHA-1 hash
function algorithm will continue to be employed.
– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the parameters
outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology website for more information regarding FIPS
140-2.

Note: When FIPS 140-2 is configured, the applications adhere to the password protection security
protocols that are defined on the Interviewer Server. For example, if the Interviewer Server is configured
for MD5 security, the client-side applications will also use MD5 security for password protection,
regardless of whether or not the Configure for FIPS 140-2 Compliance setting was selected during
installation.

User interface enhancements. The Author user interface has been greatly enhanced to ease and aid
questionnaire authoring. Enhancements include:
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v Design and Details panes. These panes have been replaced with a new Design pane work space that
combines the best features of both panes and displays a single question per-page. The newly-designed
work space provides a tabbed navigation experience that provides the appropriate options for the
selected question type.

v Question preview. Performance has improved significantly. You can now refresh the question preview.
This is useful for viewing response ordering changes.

v Shortcuts pane. This new pane contains a collection of shortcuts to commonly used actions. Each
shortcut icon mirrors an action available from the application menus.

v Advanced Category Editor. This new editor provides advanced category editing capabilities.
v Advanced Response Editor. This new editor provides advanced response editing capabilities for

numeric based grids.
v Advanced Text Editor. This new editor provides advanced text editing capabilities.
v Formatting enhancements. The formatting toolbar now allows for the formatting of both question and

response text (only question text was previously supported). In addition, the following formatting
enhancements were implemented:
– Categories now support rendered HTML.
– When editing in a grid, CTRL+B, CTRL+I, CTRL+U applies standard formatting.
– The Design pane contains a Field Chooser icon that allows you to select which fields display in the
pane.
– The Edit menu's Convert to Grid option will ask a loop as a grid, and convert the loop into a grid
question if compatible.
– The Edit menu's Convert to Loop option will ask a grid as a loop, and convert the grid question into
a loop.

v Sublists and Shared Lists. New options are provided in the response context (right-click) menu.
– The Group into Sublist feature groups selected response rows into a sublist.
– The Ungroup Sublist feature converts the selected response sublist into individual responses.
– The Convert All to Shared List feature converts all question responses into a shared list.
– The Convert Selected to Shared List feature converts only selected question responses into a shared
list.

v Auto-fill. This new option is available in the response context (right-click) menu and enables Author to
automatically create keycodes for question responses.

v Do not show this dialog in the future. You are now provided the option of hiding certain
informational and confirmation dialogs. You can reset the dialog settings via the Reset Dialogs option.

v Paste as Text. You can now paste text, that is copied from within Author or from another application,
as unformatted text. The Paste as Text option is available from Author's Edit menu, and from the
right-click menu.

v Welcome Dialog. When you launch Author you are now presented with the Welcome to Author
dialog. The dialog allows you to create a new document, open an existing document, or open a
Statistics file.

Support for namespacing. This new feature allows category names to be based on the name of the
shared list in which they reside. The Namespace property is available for shared lists via the Advanced
Category Editor's Advanced Properties pane.

Custom Keycodes and Analysis Values. You can now assign custom keycodes and/or analysis values for
each question response. Author automatically assigns analysis values to categories for the following
question types:
v Single Response
v Multiple Response
v Single Response Grid
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v Multiple Response Grid

Author can automatically assign keycodes to question responses. Keycodes are used in the Interview
Player application to help limit the number of keystrokes required when entering response values.
Custom keycodes are also included in survey's that are printed via Paper.

Entering a custom keycode or analysis value for a categorical list question allows you to define the values
used for entry rather than using those generated by Author. This custom keycodes and analysis values
remain the same even when categories are filtered.

Skip and Fill. You can now specify the response value for a set of questions, based on the responses to a
previous set of questions, and then jump to another question.

Read-only questions. The properties pane now provides the option to set questions as read-only. When a
question is set to read-only, no response is required for the question, and responses that are defined for
the question are disabled.

Other Specify responses. You can now specify that responses be treated as Other Specify responses,
allowing respondents to enter additional text when selecting the response.

Copy Routings. You can now copy specific routing information from an existing routing to a new
routing.

Open IBM SPSS Statistics files. You can now open and import the question metadata contained within
IBM SPSS Statistics files. IBM SPSS Statistics files are imported into new, untitled .mdd documents with a
.SAV routing.

Expert expression filter. You can now provide expert expressions for category filtering, allowing
responses to be filtered on multiple questions. This new feature is available in the Responses section in
the Properties Pane.

Local Deployment Wizard. This new wizard allows you to deploy a survey to one or more Interview
Player installations without requiring an Interviewer Server. The wizard provides a simpler alternative to
the Activate dialog that is commonly used to deploy surveys to Interview Player.

Activate. A new Interview Player tab was added to the Activate dialog. This new tab provides options
for defining various Interview Player settings for activated or locally deployed questionnaires. The tab
provides the same options as those available in the Local Deployment Wizard.

Activation Console. This new utility allows you to view pending and completed activations, and create
activation history filters.

Save enhancements. You are no longer required to manually save an open questionnaire before
performing the following operations:
v Apply style templates or previewing a questionnaire
v Store to, and insert from, a repository
v Insert from the library
v Print and Print Preview with Paper
v Auto-answer

Note: You are required to save a questionnaire before activation.

Previewing questionnaires. You can now preview questionnaires in Data Entry mode.
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Spell checking. Author now automatically checks the spelling of words as you type question and
response text. To check the spelling of the entire questionnaire at once, press F7 or go to:

Tools > Spelling

What's New in Author 5.5
Author 5.5 contains the following new features:

Project activation. You are now provided the option of excluding specific folders and files from project
activation.

User documentation. The user documentation has been updated as follows:
v A new topic, Activate Dialog Box - Files Tab, discusses the options for excluding specific folders from

activation when activating a project. Excluding specific folders effectively limits the number of files that
are uploaded during the activation process.

What's New in Desktop Author 5.0
Desktop Author 5.0 contains the following new features:

Question Repository. Desktop Author supports the following Question Repository features:
v Store Survey Assets to a Predictive Enterprise Repository. You add questions to a Question

Repository by storing Survey Assets, that contain one or more standard survey questions, to the
Predictive Enterprise Repository.

v Browse a Predictive Enterprise Repository for Survey Assets. You can navigate through existing
topics and identify Survey Assets to insert into your questionnaire.

v Insert Survey Assets stored in a Predictive Enterprise Repository. After locating the appropriate
Survey Assets you insert them into the working questionnaire.

Questionnaire wizards. Many library items now include questionnaire wizards to help you tailor content
to your needs. When you insert one of these items, the wizard prompts you for specific details before
adding the item to your questionnaire file.

Loops based on shared lists and user-entered lists. You can now create loops based on shared lists or
user-entered lists.

Question templates. You can quickly apply a template to questions in your questionnaire by using the
new questions templates feature. After inserting a question template from the Library, you can then edit it
as required. Two special question templates are included with Desktop Author: a Calendar Question and
a Slider Question.

Compound questions. You can now use compound questions, which group a number of questions that
share a category list. Compounds are typically used for presentation purposes in paper questionnaires, to
present a number of separate questions that use the same response list side-by-side on the page.

Advanced properties. The new Advanced Properties pane shows advanced properties for the selected
question. This is designed for advanced users who are familiar with Dimensions Scripting. You can
change advanced properties of a question without having to use mrStudio. Use caution when modifying
advanced properties, as there is limited error validation. For complete details about advanced properties,
see the Dimensions Development Library (DDL).

Draft surveys in Word. If you have mrPaper installed, Print and Print Preview in Desktop Author will
prompt you to select a Look Group and will automatically launch mrPaper. For details about Look
Groups, see the mrPaper User's Guide.
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Descriptions for routings and questions. The Description field is now available for routings and
questions. When printing draft paper surveys in mrPaper, this description is included. Descriptions are
not included in the actual paper survey.

Paper mode. When creating a new questionnaire, you can specify the interviewing mode to control the
supported question types. Some question types are not supported in paper mode.

Specifying categories as missing. You can set responses in a Single Response, Multiple Response, or
Compound question to be treated as missing data. This is useful when analyzing questionnaire results in
other applications such as SPSS.

Changing grid types After creating a single, multiple, or numeric grid, you can change the grid type
later.

External browser preview. Use the Preview tab of the Options dialog box to set defaults for previewing
interviews in Desktop Author. By default, interviews are previewed using Internet Explorer. Select Use
alternate browser to preview interviews in an alternate Web browser.

Text formatting toolbar. You can use the new Formatting toolbar to change the simple formatting of
question text.

Auto-answer storage. After running an interview using Auto Answer, details of the questions and
answers are listed in the Answer Log pane. You can now save these details to a data source.

Operating System. Installation of Desktop Author is now supported on a 32-bit or 64-bit version of
Microsoft® Windows® Vista Ultimate Edition.
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Chapter 6. What's New in IBM SPSS Data Collection Survey
Reporter

This section summarizes changes in the various IBM SPSS Data Collection Survey Reporter product
versions.

What's New in IBM SPSS Data Collection Survey Reporter 7
IBM SPSS Data Collection Survey Reporter 7 contains the following new features:

IBM SPSS Data Collection Survey Reporter wizards. IBM SPSS Data Collection Survey Reporter now
includes wizards to simplify common or complicated table and variable editing capabilities. While IBM
SPSS Data Collection Survey Reporter ships with a variety of wizards, you may find it useful to create
your own using IBM SPSS Data Collection Professional.

Client certificate support via smart card authentication. Client certificates are now supported via smart
card authentication. Client certificates are used to secure access to IBM SPSS Data Collection Accessory
servers. A valid PIN number is required when employing client certificates via smart card authentication.
Users who cannot provide the appropriate client certificate and PIN number are denied access to the IBM
SPSS Data Collection Accessory servers. Refer to the Working with client certificates to secure accessory server
access topic in the IBM SPSS Data Collection Desktop 7.0.1 Installation Guide for more information regarding
client certificates.

Client certificate support in SSL environments. Client certificates are now supported in SSL
environments. Client certificates are used to secure access to IBM SPSS Data Collection Accessory servers.
Users who cannot provide the appropriate client certificate are denied access to the IBM SPSS Data
Collection Accessory servers. Refer to the Working with client certificates to secure accessory server access topic
in the IBM SPSS Data Collection Desktop 7.0.1 Installation Guide for more information regarding client
certificates.

Support for IBM SPSS Visualization. The HTML Tables Export feature now offers the IBM SPSS
Visualization charting engine as an alternative to Microsoft Office Web Components (OWC). With the
exception of the Export Tables feature in IBM SPSS Data Collection Survey Tabulation, IBM SPSS
Visualization is now the default charting engine used during chart generation. The charting features are
available for all supported Microsoft Windows versions (32 and 64-bit). The IBM SPSS Visualization
charting engine provides a new Heat Map chart type.

When required, you can select the legacy Microsoft Office Web Components (OWC) for chart generation.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Survey Reporter... > Details...

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

What's New in IBM SPSS Data Collection Survey Reporter 6.0.1
IBM SPSS Data Collection Survey Reporter 6.0.1 contains the following new features:
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Virtual directory, session engine, and Web service registration. During the product installation, you are
presented the option for configuring multiple virtual directories, session engines, and Web services.

Configuring multiple virtual directories, that run simultaneously, provides for optimum load balancing
within a cluster. When any of the following features are selected during installation, you are presented
with the Interviewer Server Administration Virtual Directory Configuration dialog during installation:
v Accessories Service
v Phone Interviews
v Remote Administration
v Survey Tabulation
v Survey Reporter Server Edition
v Author Server Edition

Configuring multiple session engines allows you to better utilize the memory on each IBM SPSS Data
Collection Interviewer Server machine. When you select to install the Interview Service feature, the
Interview Session Engine Configuration dialog displays during installation.

Configuring multiple Web services to run on a single machine allows you to better utilize the memory on
each Web server machine. When you select to install the Web Service feature, the Interview Web Service
Configuration dialog displays during installation.

Refer to the Virtual directory, session engine, and Web service registration section in the IBM SPSS Data
Collection Server Installation Guide for more information.

Integration with IBM SPSS Collaboration and Deployment Services Repository. IBM SPSS Data
Collection 7.0.1 provides support for storing and retrieving .mtz packages (zip archives) to a IBM SPSS
Collaboration and Deployment Services Repository. A package is an executable element of IBM SPSS Data
Collection.

An .mtz package contains a primary .mtd file and a configuration file for the .mtd.

IBM SPSS Collaboration and Deployment Services is used as a job scheduling and configuration platform.
User-configured script items are exposed to IBM SPSS Collaboration and Deployment Services, but IBM
SPSS Collaboration and Deployment Services will not execute any part of a IBM SPSS Data Collection
script. User-configured items include parameters and store locations, access permissions, and output file
properties.

IBM SPSS Data Collection Survey Reportersupports the following integration with the IBM SPSS
Collaboration and Deployment Services Repository:
v Script Packager component. The component provides support for generating deployable .mrz, .dmz,

and mtz packages (zip archives) for the purpose of integration with IBM SPSS Collaboration and
Deployment Services Repository. Refer to the Script Packager Component Object Model section in the IBM
SPSS Data Collection Developer Library for more information.

v IBM SPSS Data Collection Execution Server. Provide the web services to process the zip archive
packages and associated configuration files. The server executes and returns the output variables and
output files via a web service response. The server also supports IBM SPSS Collaboration and
Deployment Services job step cancellation.

v IBM SPSS Data Collection IBM SPSS Collaboration and Deployment Services example. The IBM
SPSS Data Collection IBM SPSS Collaboration and Deployment Services example provides an IBM
SPSS Data Collection integration scenario with IBM SPSS Collaboration and Deployment Services. The
example is stored in the [INSTALL_FOLDER]\IBM\SPSS\DataCollection\[version]\DDL\Scripts\Data
Management\Collaboration Deployment Services directory.
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Refer to the Introduction to IBM SPSS Collaboration and Deployment Services Repository integration section in
the IBM SPSS Data Collection Developer Library for more information.

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to the Reserved Keywords and Keyword Summary topics in the IBM SPSS Data Collection Developer
Library for more information.

Bulk updating table specifications. You can now bulk update the banners (top axis) and side axis for
multiple tables. When you select multiple tables, that have same side or top axis, the side and top axes
will display as a single table. Changes applied to side or top axis design controls will apply for all
selected tables.

Bulk updating table filters. You can now bulk update the filters for multiple tables. When you select
multiple tables, that have the same filters, the selected tables will display as a single table. Expression
and level changes for the displayed filter will apply to all selected tables.

Converting IBM SPSS Quanvert Table Specification (.qsf) files to Data Collection Table Document
(.mtd) files. You can use the IBM SPSS Quanvert to Data Collection Table Document Files Conversion
wizard to convert IBM SPSS Quanvert Table Specification (.qsf) files to Data Collection Table Document
(.mtd) files. When you open a IBM SPSS Quanvert Table Specification (.qsf) file in IBM SPSS Data
Collection Survey Reporter, the wizard automatically displays and walks you through the conversion
process.

Shortcuts for the bulk conversion of Count, Sum, and Mean tables. Menu and toolbar shortcuts have
been added to aid in the bulk conversion of selected tables to Count, Sum, and Mean tables. When you
select one or more tables, and there is only one numerical variable selected in the variable list window,
you can select the following options:
v Summarize by count. Available under the Tables menu and on the Tables toolbar, this option converts

the selected table(s) to count tables based on the selected variable.
v Summarize by sum. Available under the Tables menu and on the Tables toolbar, this option converts

the selected table(s) to sum tables based on the selected numeric variable.
v Summarize by mean. Available under the Tables menu and on the Tables toolbar, this option converts

the selected table(s) to mean tables based on the selected numeric variable.

Exporting data. You are now provided the option of selecting which variables should be exported for the
axis variable.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and hotfix information. You can now view information regarding which fix packs and hotfixes
are installed via the application's Help menu.

Help > About IBM SPSS Data Collection Survey Reporter... > Details...

What's New in IBM SPSS Data Collection Survey Reporter 6
IBM SPSS Data Collection Survey Reporter 6 contains the following new features:
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Reports for Surveys is now Survey Reporter. Starting with version 6, the product formerly known as
Reporter is now called Survey Reporter. Survey Reporter refers to both the desktop and Web
deployments of the product. The new name is reflected in the interface and many installed elements of
the product, such as files and folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the Data Collection Developer Library.

Summary Means Table. You can now run column means tests against a range of variables, which can
include both numeric and categorical variables.

Hierarchical data (database questions). You can now create single and multiple response questions
whose category lists are generated by connecting to an external database.

IBM SPSS Data Collection Publish Assets Utility. Allows you to manage your customized files for
web-deployed IBM SPSS Data Collection products (for example, IBM SPSS Data Collection Author Server
Edition, IBM SPSS Data Collection Survey Reporter Server Edition.

What's New in Reporter 5.6
Reporter 5.6 contains the following new features:

Reporter is now Reports for Surveys. Starting with version 5.6, the product formerly known as Reporter
is now called Reports for Surveys. Reports for Surveys refers to both the desktop and Web deployments
of the product. The new name is reflected in the interface and many installed elements of the product,
such as files and folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the Data Collection Developer Library.

Configure for FIPS 140-2 Compliance. You are now presented with a FIPS 140-2 Compliance step during
installation, allowing you to decide whether or not the installation will be configured for FIPS 140-2
compliance. FIPS 140-2 is a U.S. government computer security standard used to accredit cryptographic
modules.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not Configure
for FIPS 140-2 Compliance is enabled; for upgrade installations, the following rules apply:
v If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded in the

following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup log file. The log file is located at:
\Installer\NewPassword.log Interviewer Server Administrator administrators can supply users these new,
temporary passwords in a manner that is in accordance with their business practices.
– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change their passwords
at next login.

v When upgrading on a server that is currently not configured for FIPS 140-2, you are presented with the
option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash function
algorithm.

v Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the SHA-1 hash
function algorithm will continue to be employed.
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– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the parameters
outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology website for more information regarding FIPS
140-2.

Note: When FIPS 140-2 is configured, the applications adhere to the password protection security
protocols that are defined on the Interviewer Server. For example, if the Interviewer Server is configured
for MD5 security, the client-side applications will also use MD5 security for password protection,
regardless of whether or not the Configure for FIPS 140-2 Compliance setting was selected during
installation.

Support for multi-wave studies. New features added in version 5.6 allow you to move between different
waves of a study without having to recreate variables and table definitions. Variable edits, variable axis
expressions, and table edits are all now retained when changing between different survey data files.

New filter options. You can create more complex filter statements with the new filter options available in
Reports for Surveys. The has a value and has no value options have been added to the filter conditions
available for most variable types. In addition, when grouping multiple variables, you now have the
option to select NOT to include the case only if the grouped variable conditions are not true.

Ability to restrict viewing of unweighted data. A new access setting is available to restrict users from
viewing unweighted data in survey results files on the server. Users who have this option set may find
some Reports for Surveys options unavailable.

Create new grids. Sometimes different questions that share the same response list (for example, separate
satisfaction questions across a range of different services) need to be reported as a single grid. You can
now easily create a derived grid based on other variables, and then tabulate based on the new grid
variable.

Edit Grids. You can now edit grid iterations in the Edit Variable dialog.

Rounding Options. You can now specify the default rounding calculation.

Specify Column IDs. You can now specify the table column IDs.

DefaultWeight custom MDM property for use with the Quanvert DSC. The new custom property
provides support for a default weight in .mdd files. You can use the property when there is a default
weight variable for analysis. Refer to the topic "Quanvert MDM Custom Properties" in the Data Collection
Developer Library for more information.

LevelID variable. The auto-generated LevelID variable is now available from Variable Folders pane. The
variable is activated via the Variables menu's Show LevelID Variables option. The LevelID variable
allows you to:
v Use to auto-generated LevelID variable in filters and expressions.
v Create new variables that are based on a grid slices.

Refer to the "Derived Grid Tables" topic in the Data Collection Developer Library for examples on how
LevelID is used in script.

Support for Microsoft Excel 2007 chart templates. You can now specify a chart template to use when
exporting a table to Microsoft Excel 2007.
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What's New in Reporter 5.5
Desktop Reporter 5.5 contains the following new features:

Categorize all text variables. You can now perform simple, non-linguistic categorization of variables by
converting Text, Date or Numeric variables, which cannot be directly used in table tabulation, to
Categorical variables. This allows data to be analyzed for reporting purposes. See Simple Categorization
for more information.

Net and Keep. When creating nets, you can now choose to retain the original categories as well as the
net categories. This allows variables to be included in two or more nets. See Creating Nets for more
information.

Export Data enhancements. The following export data enhancements are now available. See Export Data
Dialog Box: General Tab for more information.
v Export factors. You can now choose to export case data for single-response categorical variables, that

have factor values, as factor values.
v Select hierarchical level to export to SPSS.
v Compressed Dimensions Data File support. You can now export data in compressed Dimensions Data

File format (.dzf).

What's New in Reporter 5.0
Desktop Reporter 5.0 contains the following new features:

New Web-launched Reporter. Reporter can be launched from DimensionNet instead of requiring all
users to perform a full desktop installation. Use Reporter to open and work with DimensionNet projects
(not locally saved files). See Starting Desktop Reporter for more information. The Web-launched version
is referred to as Reporter, and the client version is referred to as Desktop Reporter.

Open from DimensionNet server. You can now use the File menu in Desktop Reporter to open files from
the DimensionNet server (sometimes known as the Accessories server). For more information, see
Opening Survey Data Files and Opening and Saving Table Documents.

Dimensions Global Filters. Desktop Reporter honors the new global filters that can be configured in
DimensionNet. Select Dimensions Global Filter from Desktop Reporter's Filter menu to view global filter
information. Dimensions global filters are defined using the Manage Access utility in DimensionNet. For
details, see the DimensionNet User's Guide.

Create new table document. For projects opened from DimensionNet, you can now create a new table
document from the File menu or the toolbar in Desktop Reporter and Reporter. The table document is
based on the current DimensionNet project, and the current user has minimum permissions.

What's New in Reporter 4.5
Desktop Reporter 4.5 contains the following new features:

Share table document files with users of mrTables. You can now open table document (.mtd) files
created in mrTables using Desktop Reporter, and vice versa. For information on how to open table
documents from other applications in Desktop Reporter, see Opening Table Documents from Other
Applications.

Variable edits are saved in the table document file. Profile tables and difference attribute tables can be
created in Desktop Reporter and mrStudio but not in mrTables. If you open a table document containing
such tables in mrTables, you can see the table definitions and you can populate the tables and view the
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results, but you cannot edit the tables. Table folders created in Desktop Reporter or mrStudio are not
displayed in mrTables, but any tables in the folders are displayed as normal.

New File Formats. You can now work with data sources in the following additional file formats in
Desktop Reporter:
v Dimensions Data File. You can now open .ddf files in Desktop Reporter, and export data to .ddf file

format.
v Triple-S. You can now open Triple-S files in Desktop Reporter, and export data to .xml files that meet

the Triple-S standard for the interchange of survey data.
v Delimited Text File (Excel). You can now merge data to a delimited text file using the Data Merge tool.

Support for Internet Explorer 7.0. Desktop Reporter now supports Microsoft Internet Explorer 7.0.

Enhancements to Print Variables option. The Print Variables option in Desktop Reporter now
automatically handles the resizing of columns in the Variables list and produces an improved printout.
See Printing Variables for more information.

Summary Statistic Tables. You can now create summary tables of statistics such as means, by selecting a
number of variables and using the new Summary Statistic Table menu option to create a table with one
row for each variable. See Creating Summary Statistic Tables for more information.

Performance enhancements. Adding multiple variables to a table is now substantially quicker.

Chart different variables on the same chart now available for individual charts. The option to choose
whether to create charts for individual categories, for individual variables, or for all variables on a table
(introduced as an Export option in release 4.0.1) can now be set for individual charts, using the Chart
category elements option in the Chart tab of the Table Properties dialog box.

Chart special elements of same type to same chart now available for individual charts. The option to
choose whether to create charts for one or more statistical items such as the mean, minimum value, or
standard deviation (introduced as an Export option in release 4.0.1) can now be set for individual charts,
using the Chart special elements option in the Chart tab of the Table Properties dialog box.

Select cell item to use in chart now available for individual charts. The option to base charts on a cell
item other than the default (introduced as an Export option in release 4.0.1) can now be set for individual
charts, using the Base chart on option in the in the Chart tab of the Table Properties dialog box.

Option to auto-generate counts and percentages in the Edit Variable dialog box. A new option is
available in the Options dialog box to turn on or off the auto-generation of counts and column
percentages in the Edit Variable dialog box.

What's New in Reporter 4.0.1
Desktop Reporter 4.0.1 contains the following new features:

New export features:

v Export to PowerPoint in table format. In addition to exporting results to Microsoft PowerPoint as
charts, you can now export results in table format using the options available in the Include
drop-down list in the PowerPoint Export dialog box.

v Wrap descriptions in Excel and PowerPoint tables. You can now choose whether or not to wrap long
descriptions onto the next line using the Wrap description text option in the Advanced dialog box for
Microsoft Excel and Microsoft PowerPoint exports.

v Chart different variables on the same chart. You can now choose whether to create charts for
individual categories, for individual variables, or for all variables on a table, using the Chart category
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elements option in the Advanced dialog box for HTML, Microsoft Excel, Microsoft PowerPoint, and
Microsoft Word exports, and in the Result Display Options dialog box for charts in the Results tab.

v Chart special elements of same type to same chart. You can now create charts for one or more
statistical items (such as the mean, minimum value, standard deviation, etc.) using the Chart special
elements option in the Advanced dialog box for HTML, Microsoft Excel, Microsoft PowerPoint, and
Microsoft Word exports, and in the Result Display Options dialog box for charts in the Results tab.

v Select cell item to base chart on. You can now base charts on a cell item other than the default,
provided that the cell item is included in the table. Use the Base chart on option in the Advanced
dialog box for HTML, Microsoft Excel, Microsoft PowerPoint, and Microsoft Word exports, and in the
Result Display Options dialog box for charts in the Results tab.

v Disable charts for individual tables. You can now choose not to create charts for specific tables. Type
No chart in the Chart type field in the Charts tab of the Table Properties dialog box.

For further information on export options, see the Export Tables Dialog Box.

Multi-select variables for deletion in the Design pane. You can now select and delete multiple variables
from the side or top of a table in the Design pane. Use Ctrl+click to select the variables, then press the
Delete key. See Deleting a Table for more information.

New filter operators. Additional operators are now available when you create filters using the Filter tab.
For numeric variables, you can now create filters using the is between operator. For multiple response
variables, you can now create filters using:
v includes exactly these

v includes at least

v includes at most

v is between

See Filter Conditions for more information.

New Save Variable As button. The option to save an existing variable with a new name was available in
the first release of Desktop Reporter from the File menu in the Edit Variables dialog box. This feature is
now also available from a new Save Variable As button on the Variables toolbar. See Save Variable As for
more information.

Double-click a variable on the side or top to edit the variable. The option to edit a variable on a single
table was available in the first release of Desktop Reporter by selecting the variable in the Design pane
and choosing Edit Table Variable from the Variable menu to open the Edit Table Variable dialog box. In
this release, you can also open the Edit Table Variable dialog box by double-clicking the variable on the
Design tab. See Editing Variables for more information.

Automatic update of snapshot values. Values for counts in the Edit Variable dialog box are now
generated automatically when you open the dialog box. See Displaying a Snapshot of Values for
Categories in a Variable for more information.

Sort and hide results based on the first or last row or column. When sorting or hiding rows or columns
in a table, new options of First row/column and Last row/column are now available. These options are
useful if you add new categories to your surveys over time and you want to reuse the tables. For
example, if you have a table containing monthly data, you can select Last column to sort the table by the
latest month, rather than selecting the name of the month each time you update the data. For further
information see Sorting a Table and Hiding a Row or Column.

New dialog box for changing the number of responses in a variable. You can now change the
maximum number of responses allowed for a variable using the new Number of Responses dialog box.
Use this dialog box when you have created a new variable and want to specify whether it is a single or a
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multiple response variable, or when you have edited a variable by adding new categories or combining
existing ones, if this results in a change to the number of responses that can be stored for a respondent.
See Setting the Number of Responses in a Variable for more information.

Cut/copy/paste tables. You can now cut, copy, and paste tables in the Tables pane. Copying and pasting
provides a quick way of creating new tables from existing tables. Copying a table also copies any filters
or properties that are specified for the original table. See Copying a Table for more information.

Easier way of creating tables sorted by column significance. A new button and menu option have been
added to enable you to set a number of commonly requested options on selected tables in a single action.
Choose the Sort by Column Significance button or menu option to:
v add a column proportions and column means test
v apply the show minimum p-value option
v sort rows in ascending order by the minimum p-value column
v hide rows where the minimum p-value is greater than the default significance level

You can change any of these settings individually using the relevant options in the Table Properties
dialog box. See Sorting by Column Significance for more information.

Undo/redo. You can now undo and redo actions in the Desktop Reporter window. This includes actions
carried out in the Tables pane, the Design tab, the Table Syntax pane, the Filter tab, the Filter Syntax
pane, the Table Properties dialog box, and the action of creating a Difference Attribute table. See Undoing
and Redoing Actions in Desktop Reporter for more information.

Export data to SAS. You can now export data to SAS using the SAS DSC. See Export Data Dialog Box:
General Tab for more information. Change in behavior in column proportions and column means
calculations. The ColumnProportions and ColumnMeans tests in mrStudio, mrTables, and Desktop
Reporter previously used the expression:
DF = e1 + e2 - e0 - 1

to calculate the degrees of freedom. This matches the calculation used in Quantum/Quanvert. From 4.0.1,
the expression has changed to:
DF = e1 + e2 - e0 - 2

For backwards compatibility, the formula invoked by setting the Use the Quantum/Quanvert column test
formula option continues to use the original expression. See Statistical Tests Compared to Quantum and
Quanvert for more information.
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Chapter 7. What's New in IBM SPSS Data Collection
Professional

This section summarizes changes in the various IBM SPSS Data Collection Professional product versions.

What's New in IBM SPSS Data Collection Professional 7
What's new in IBM SPSS Data Collection Professional 7 is summarized under the following headings:
v IBM SPSS Data Collection Professional IDE

v IBM SPSS Data Collection Question Repository

v Data Management

v Interview Scripting

v Table Scripting

v Table Scripting Samples

IDE

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Professional... > Details...

What's New Information for Previous Releases

What's New information for previous IBM SPSS Data Collection\Dimensions releases can be found in the
Data Collection\Dimensions What's New document that is located at C:\Program Files\Common
Files\IBM\SPSS\DataCollection\7\Documentation\ibm_help\eclipse\plugins\com.spss.ddl_doc\
PDF\User_Guides\Legacy_Whats_New.pdf

The document is in Adobe Portable Document Format (.pdf) Viewing and printing the document requires
Adobe Reader. If necessary, you can download it at no cost from www.adobe.com. Use the Adobe Reader
online Help for answers to your questions regarding viewing and navigating the document.

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

Data Management

Publishing Data. The new Publish Data feature allows you to publish live data, via DMS scripting, to
reporting applications (namely IBM Cognos Business Intelligence). The feature is designed to provide
enterprise level reporting, analysis, score-carding, and event notification.

Interview Scripting

Sample options. The following features are now available to support enhanced sample functionality
v Default participant records. The Professional Options dialog provides an option for selecting a file

that contains the default participant records when the Participant.xsu file is not found in the project
directory. The Participant.xsu file is used when found in the project directory. This is useful when you
have a Participant.xsu file in each project directory that matches the project's sample, rather than having
to change the option every time you switch to a different project.
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Quota options. The following features are now available to support enhanced quota functionality:
v Debug Quotas: Data File Location. Identifies the quota data records file location. You can now use a

local DDF file rather than manually installing SQL Server Express.
v Debug Quotas: Report Script Location. Indicates the DebugQuotas.mrs file location. You previously

were required to manually run the script; there is now a option to automatically run the script.
Running the script displays the quota results in Microsoft Excel.

v Quota menus. The Tools menu now provides the following quota options:
Tools > Quota > Configure...

Tools > Quota > Enable Debugging

Tools > Quota > Reset Counters

Tools > Quota > View Report...

Activation. The activation process has been updated to support enhanced sample management, personal
interviewing, telephone interviewing, and quota features. The feature includes the following
enhancements:
v Participants - History Reports. The History Reports settings provide options for defining which fields

will display in the contact and session history reports.
v Telephone - Interviewing - Introduction. The Introduction settings now include an editor that

provides options for modifying a project's introductory text via HTML or plain text, and provides a
method for switching between available languages.

v Telephone - Interviewing - Interviewer. The Interviewer settings now include the option Display
status messages in Phone Participants. When the setting is enabled, interviewer status messages will
display in the IBM SPSS Data Collection Interviewer Server Phone Participants activity.

v Telephone - Interviewing - Project Message. This new feature provides options for creating and
editing project messages. Project messages provide specific project information to each interviewer. The
editor provides options for modifying message text via HTML or plain text.

v Quota. The Quota settings now provide options for defining the percentage of quota targets that are
assigned to each personal interviewer.

v Advanced - Properties. The new Properties settings provide options for creating custom properties
during activation.

v Advanced - Other. The Other settings include the new setting Check for next project at end of
interview. The setting enables survey chaining for the project. This allows a different survey to be
initiated immediately after the current survey is completed.

v New personal_sample.mrs script. The new sample management script is suitable for personal face to
face interviews conducted by interviewers in homes or other locations.

v HTMLOptions update. The new ApplySubTemplatesInNestedBlocks, UseGlobalTemplate, and
ApplySubTemplatesInGrids features (Professional Options > Interview Options > HTMLOptions)
provide the following options:
– ApplySubTemplatesInNestedBlocks - applies question sub-templates to questions in nested blocks.
– ApplySubTemplatesInGrids - enables and disables custom controls in sub-templates for grid and loop

questions.
– UseGlobalTemplate - searches for templates from the global location before checking the project

location.

Library. The Library pane allows you to browse available library items before adding items to your
projects. Some of the new library items provide for options for client-side validation.

Gallery. The new IBM SPSS Data Collection Gallery feature provides options for supporting the various
sample library items that are installed with the application. The gallery provides a simple user interface
that organizes library items by type and function, allowing you to browse library items and view item
descriptions, prerequisites, and package contents before adding items to your projects.
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Interview Services. The new Interview Services features provide options for defining and configuring
external web services that can be used in the routing script. The IBM SPSS Collaboration and Deployment
Services service type provides advanced real-time scoring and text analytics capabilities and can greatly
improve respondent interactions. The Salesforce service type is a COM-callable proxy for the
Salesforce.com web service. Some examples of how these services can be used are:
v Allow for a more natural and engaging use of text responses, basing survey logic on concepts and

sentiment captured in open-ended questions.
v During the survey, automatically ask follow-up questions as a result of scoring against existing

attitudinal and transactional data.
v Based on scoring results, ask the most respondent-pertinent questions. Asking the right questions,

instead of all the questions, is increasingly important as survey response rates continue to fall.
v Centralize complex routing logic in models stored in IBM SPSS Collaboration and Deployment Services

(segmentation, for example).

You can also configure custom services to further take advantage of third-party web services. External
services must first be configured via the authoring application's Interview Services Options.. feature. Refer
to the following topics for more information:

Support for project chaining. Chaining is defined as using a primary project to start off a chain of
projects without the respondent (or interviewer) being aware of the switch between projects. Chaining
can be used to provide the best projects for a particular user or to setup omnibus style interviews where
a single respondent is interviewed for several clients.

Geolocation question templates. You can now create question templates that use HTML 5 geolocation
features.

Browser capabilities detection start page example. A Browser Capabilities detection start page example
is installed with the IBM SPSS Data Collection Developer Library at [INSTALL_FOLDER]\IBM\SPSS\
DataCollection\7\DDL\Scripts\Interview\Frequently Asked Questions\Browser capabilities and
respondent IP address. The example files, provide a template for implementing project start pages that
capture respondent browser capabilities. The browser information can be used to perform auto post-back
by adding BrowserCapabilities to the query string. Refer to the comments in start.html for more
information.

New object model documentation. The following object have been added to support Interview Services:
v Interview Services Object Model. Provides support for defining and configuring external web

services that can be used in the routing script.
v CaDSClient Interview Services Object Model. The IBM SPSS Collaboration and Deployment Services

Interview Service type provides advanced real-time scoring and text analytics capabilities and can
greatly improve respondent interactions. New samples are included to demonstrate the new object
model's features.

v Salesforce Interview Services Object Model. The Salesforce Interview Service is a COM-callable
proxy for the Salesforce.com web service.

v Database Connection Interview Services Object Model. The Database Connection Interview Service
allows ADO database connections to be shared between multiple running interviews. This helps
improve performance and scalability for interview scripts, that use direct database access, by
eliminating the need for each script to individually connect to a database.

Default Layout Template updates. The default layout template is designed to eliminate fixed widths and
provides the fluidity required for adaptation to any browser window size. The template utilizes various
CSS style sheets in order to ensure specific content behavior in relation to the specific web browser
(re-size in relation to the browser window size, prevent zooming, use media queries, and so on). The
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template also provides JavaScript support for web browsers that do not support media queries, the
default layout template utilizes a JavaScript file that provides similar user experience when compared to
using media queries.

Refer to for information on working with sample scripts. Refer to the topic Sample mrScriptBasic Files in
the IBM SPSS Data Collection Developer Library for information on working with sample scripts.

IBM SPSS Data Collection Survey Reporter wizard creation support. IBM SPSS Data Collection
Survey Reporter includes wizards to simplify common or complicated table and variable editing
capabilities. While IBM SPSS Data Collection Survey Reporter ships with a variety of wizards, you may
find it useful to create your own using IBM SPSS Data Collection Professional.

Table Scripting

Heat map chart type. The new chart type allows you to export tables as heat charts (also referred to as
heat maps). Heat charts represent individual data values, contained in a matrix, as colors.

Grid detection options. In order to provide backward compatibility with IBM SPSS Data Collection 5.6
and earlier, the new statistics property IStatistics.GridDetectionMethod was added to control grid
detection. The property provides two options, gdUseMaxResponses and gdUseMetadata. The
gdUseMaxResponses option classifies a grid based on whether the variables on the side and top are
multiple-response. This is the default grid detection method used in IBM SPSS Data Collection 6.0 and
later. The gdUseMetadata option classifies a grid based on whether the variables on the tables are defined
as grids in the metadata. This is the grid detection method used in IBM SPSS Data Collection 5.6 and
earlier.

Table Scripting Samples

CreateOperatorReports.mrs. This script uses the IBM SPSS Data Collection Interviewer
DataCollectionAudit_Analysis.mdd and DataCollectionAudit_Analysis.ddf files to generate audit related
reports. The script can be run via mrScriptCl.exe or IBM SPSS Data Collection Professional. Before running
the reports, you will need to either copy the report script to the directory where the
DataCollectionAudit_Analysis.mdd and DataCollectionAudit_Analysis.ddf are stored, or update the script
(METADATA and DBLOCATION are defined at the top of the script) to point to the appropriate file paths. These
files are typically located at: C:\Documents and Settings\<running user>\Application

Data\IBM\SPSS\DataCollection\6\Interviewer\Config\Audit. You may also want to
update the OUTPUT define setting (this defines the name and location of the output file). The output files
are named OperatorReport.mtd and OperatorReport.htm and are located in the current directory. However,
you can provide a different path and file names via the OUTPUT define setting. Once you have updated the
settings, you can run the script from a Windows command prompt using: "mrScriptCl.exe
CreateOperatorReports.mrs". This will create an output .htm file of exported tables as well as an output
.mtd that you can use in IBM SPSS Data Collection Survey Reporter for more investigation.

SimpleCategorization_Museum.mrs and SimpleCategorization_HouseHold.mrs. These new samples
demonstrate how to use the ICoding.CreateCategorizedVariable method to create categorized variables.
The scripts are based on the Museum and Household data samples (respectively).

What's New in IBM SPSS Data Collection Professional 6.0.1
This topic summarizes the new features in IBM SPSS Data Collection Professional 6.0.1:

What's new in IBM SPSS Data Collection Professional 6.0.1 is summarized under the following headings:
v IBM SPSS Data Collection Professional Installation

v IBM SPSS Data Collection Professional IDE

v IBM SPSS Data Collection Question Repository
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v Data Management

v Interview Scripting

v Table Scripting

v Table Scripting Samples

Installation

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and hotfix information. You can now view information regarding which fix packs and hotfixes
are installed via the application's Help menu.

Help > About IBM SPSS Data Collection Professional... > Details...

IDE

Integration with IBM SPSS Collaboration and Deployment Services Repository. IBM SPSS Data
Collection 7.0.1 provides support for storing and retrieving .mrz, and .dmz packages (zip archives) to a
IBM SPSS Collaboration and Deployment Services Repository. A package is an executable element of IBM
SPSS Data Collection.

A .dmz package contains a primary .dms file, a configuration file for the primary .dms file, and any other
internal includes files.

An .mrz package contains a primary .mrs file, a configuration file for the primary .mrs file, and any other
internal includes files.

IBM SPSS Collaboration and Deployment Services is used as a job scheduling and configuration platform.
User-configured script items are exposed to IBM SPSS Collaboration and Deployment Services, but IBM
SPSS Collaboration and Deployment Services will not execute any part of a IBM SPSS Data Collection
script. User-configured items include parameters and store locations, access permissions, and output file
properties.

IBM SPSS Data Collection Professional supports the following integration with the IBM SPSS
Collaboration and Deployment Services Repository:
v Script Packager component. The component provides support for generating deployable .mrz, .dmz,

and mtz packages (zip archives) for the purpose of integration with IBM SPSS Collaboration and
Deployment Services Repository. Refer to the Script Packager Component Object Model section in the IBM
SPSS Data Collection Developer Library for more information.

v IBM SPSS Collaboration and Deployment Services comment block. The IBM SPSS Collaboration and
Deployment Services comment block defines parameters for .mrs and .dms scripts. The new
CaDSCommentBlock.dms sample provides an IBM SPSS Collaboration and Deployment Services
comment block example in .dms format.

v DMS Runner. DMS Runner provides support for the /loc:<location> option. The option allows you
to specify which location is used when working with a .dmz package (zip archive).

v mrScript Command Line Runner. The mrScript Command Line Runner provides support for the
/loc:<location> option. The option allows you to specify which location is used when working with
an .mrz package. A package is an executable element of IBM SPSS Data Collection; each package
contains a main script that is utilized for execution entry and a set of scripts that are included in the
main script. Packages supports script integration with the IBM SPSS Collaboration and Deployment
Services Repository.
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v IBM SPSS Data Collection Execution Server. Provide the web services to process the zip archive
packages and associated configuration files. The server executes and returns the output variables and
output files via a web service response. The server also supports IBM SPSS Collaboration and
Deployment Services job step cancellation.

v IBM SPSS Data Collection IBM SPSS Collaboration and Deployment Services example. The IBM
SPSS Data Collection IBM SPSS Collaboration and Deployment Services example provides an IBM
SPSS Data Collection integration scenario with IBM SPSS Collaboration and Deployment Services. The
example is stored in the [INSTALL_FOLDER]\IBM\SPSS\DataCollection\[version]\DDL\\Scripts\Data
Management\Collaboration Deployment Services directory. Refer to "The Data Collection Collaboration and
Deployment Services example" for more information.

Refer to the Introduction to IBM SPSS Collaboration and Deployment Services Repository integration section in
the IBM SPSS Data Collection Developer Library for more information.

Interview scripting

Support for <mrSharedRef> tag. The <mrSharedRef> tag provides support for accessing shared content.

Refer to the topic Sample mrScriptBasic Files in the IBM SPSS Data Collection Developer Library for
information on working with sample scripts.

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to the Reserved Keywords and Keyword Summary topics in the IBM SPSS Data Collection Developer
Library for more information.

Auto Answer feature enhancements. The Auto Answer feature has been updated to support more robust
auto answer playback capabilities including adding, editing, changing, and removing data sources
connections, defining the number of cases, and so on.

Census.mdd hierarchical data example. The new Census.mdd hierarchical data example is included in the
IBM SPSS Data Collection Developer Library at [INSTALL_FOLDER]\IBM\SPSS\DataCollection\
[version]\Scripts\Interview\Frequently Asked Questions\Loops and Grids. The example demonstrates
the use of hierarchical data when working with loops and grids.

MaxRecordsInBatch property. This new CATI parameter defines the maximum number of records to pass
to the sample management script. The maximum value defaults to 25 when the property is not defined.

Support for Web browser capability detection. A new property collection that contains the respondent's
browser capabilities has been implemented.

Table Scripting

QsfTom component object model. The QsfTom component converts Quanvert saved table specs (as
many as possible) to a set of TOM table specs in an MTD file.

Table Scripting Samples
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What's New in IBM SPSS Data Collection Professional 6
This topic summarizes the new features in IBM SPSS Data Collection Professional 6:

What's new in IBM SPSS Data Collection Professional 7.0.1 is summarized under the following headings:
v Professional Installation

v Professional IDE

v Question Repository

v Data Management

v Interview Scripting

v Table Scripting

v Table Scripting Samples

Data Management

Hierarchical data (unbounded loops). You can now create unbounded loops that render iterations based
on the response to a preceding numeric question with no maximum value configured. Also, you can
render unbound loops in IBM SPSS Data Collection Author with unlimited iterations based on scripts
built in IBM SPSS Data Collection Professional.

In IBM SPSS Data Collection Professional 6 you can:
v Script unbounded loops, where iterations can be added to a loop continually during an interview. A

selection can be made to end the loop when the number of iterations is satisfied.
v Script loops that iterate based on a previous numeric response with no maximum value configured.

The scripts used to build these loops can be rendered in IBM SPSS Data Collection Author.

In IBM SPSS Data Collection Professional 6 you can:
v Script unbounded loops, where iterations can be added to a loop continually during an interview. A

selection can be made to end the loop when the number of iterations is satisfied.
v Script loops that iterate based on a previous numeric response with no maximum value configured.

The scripts used to build these loops can be rendered in IBM SPSS Data Collection Author.

Project templates. You can now save complex project settings to templates that will assist in creating and
configuring projects. Each project template contains all of the artifacts for starting a new project (settings,
resources, images, and so on) and an activation template to assist with project activation. You can store
project templates to, and access project templates from, server directories.

Project templates enable you to:
v Save a project, including all associated files and settings, as a project template.
v Create a new project that is based on the files and settings within an existing project template.
v Store and access project templates from an IBM SPSS Data Collection Interviewer Server, IBM SPSS

Data Collection Question Repository, local directory, or library.

Refer to the Project Templates topic in the IBM SPSS Data Collection Professional User's Guide for more
information.

InitializeUsers.mrs. Demonstrates how to add and assign user and roles via batch. Refer to the topic
Sample mrScriptBasic Files in the IBM SPSS Data Collection Developer Library for information on working
with sample scripts.
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TabulationServices.mrs. Creates a derived variable based on the axis expression that bands the visits
values into two categories. It also includes a special mean element. Refer to the Tabulation Services
Component Object Model Reference topic in the IBM SPSS Data Collection Developer Library for more
information.

Interview Scripting

Hierarchical data (unbounded loops). Scripting now supports unbounded loops (adding and deleting
iterations) and the creation of loops that are based on numeric responses (with no maximum value). Refer
to the Repeated questions topic in the IBM SPSS Data Collection Developer Library for more information.

Two new .mdd files examples, MeetingManagent-Enrollment.mdd and MeetingManagent-EnrollmentPlus.mdd,
demonstrate how to add and delete unbounded loop iterations. The files are installed with the IBM SPSS
Data Collection Developer Library at: [INSTALL_FOLDER]\IBM\SPSS\DataCollection\[version]\DDL\
Scripts\Interview\Documentation.

Hierarchical data (database questions). You can now create single response, multiple response, and loop
questions whose category lists are generated by connecting to an external database. Refer to the Database
questions topic in the IBM SPSS Data Collection Developer Library for more information.

New macros were added to support database questions.

The following sample scripts are provided to demonstrate database question creation:
v CreateSingleDBQuestions.mrs. Demonstrates the creation of a single response database question.
v CreateMultipleDBQuestions.mrs. Demonstrates the creation of a multiple response database question.
v CreateDBArrayQuestions.mrs. Demonstrated the creation of a database array.

Refer to the topic Sample mrScriptBasic Files in the IBM SPSS Data Collection Developer Library for
information on working with sample scripts.

Activation Script.mrs Demonstrates how the ActivateClient component can be used for automating
activation via a web service. Refer to the Samples topic in the IBM SPSS Data Collection Developer
Library for more information.

Table Scripting

Grid Overlap formula. While performing statistical tests, such as Column Proportions or Column Means,
the overlap formula may need to apply if one respondent appears in different rows or different columns.
The default rules are as follows:
v When the columns have no respondents in common, use the standard formula.
v When the columns do have respondents in common, but only in the same rows, use the (simple)

multiple response overlap formula. This implies there is at least a multiple response question or a grid
on the Top axis.

v When the columns have respondents in common, but some (or all) appear in different rows, use the
grid overlap formula. This means both side and top have at least one multiple response question or
grid.

The axis expression can modify the original variable's response type. For example, an axis express can
change a multiple response to a single response question. In this case, the software cannot judge the
response type based on the axis expression. You should set the max response value for the axis if the
response type differs from the original variable. Refer to the Table and Axis Syntax topic in the IBM SPSS
Data Collection Developer Library for more information regarding MaxResponses syntax.
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Note: When applying the grid overlap formula, the dependencies between columns and rows need to be
collected. The calculation usually takes more time and requires more memory. You can avoid using the
grid overlap formula by setting the MaxResponses property of the IAxis, or setting IStatistics.
UseGridOverlapFormula, to False.

Table Scripting Samples

CreatingTablesBasedOnDatabaseQuestions.mrs. Demonstrates how to create tables that are based on
Database Questions. Refer to the Creating tables based on database questions topic in the IBM SPSS Data
Collection Developer Library for more information.

FailoverDemo.mrs. In certain cases, you can populate many tables via a batch process. Occasionally some
of the tables may fail to populate (due to issues such as not enough memory for example). Before version
6.0, a single table population failure would cause the entire batch process to fail. Starting with version 6.0,
you can use this new script to populate the remaining batch tables when one or more fail. You can use
the script to check if any tables failed and iterate the tables to repopulate failed tables. Refer to the Table
Population and Failover topic in the IBM SPSS Data Collection Developer Library for more information.

What's New in Professional 5.6
This topic summarizes the new features in Professional 5.6:

mrStudio is now Professional. Starting with version 5.6, the product formerly known as mrStudio is now
called Professional. The new name is reflected in the documentation, interface, and many installed
elements of the product, such as files and folders.

In addition, many other products in the Data Collection family have been renamed.

What's new in Professional 5.6 is summarized under the following headings:
v Professional Installation

v Professional IDE

v IBM SPSS Data Collection Question Repository

v Data Management

v Interview Scripting

v Table Scripting

v Table Scripting Samples

Professional Installation

Configure for FIPS 140-2 Compliance. You are now presented with a FIPS 140-2 Compliance step during
installation, allowing you to decide whether or not the installation will be configured for FIPS 140-2
compliance. FIPS 140-2 is a U.S. government computer security standard used to accredit cryptographic
modules.

For new installations, the SHA-1 hash function algorithm is used regardless of whether or not Configure
for FIPS 140-2 Compliance is enabled; for upgrade installations, the following rules apply:
v If FIPS 140-2 is enabled, all existing user information from the previous version is upgraded in the

following steps:
– The original, encrypted user passwords are archived to a setup log file.
– New user passwords are randomly assigned and saved to a setup log file. The log file is located at:
\Installer\NewPassword.log Interviewer Server Administrator administrators can supply users these new,
temporary passwords in a manner that is in accordance with their business practices.
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– The MustChangePasswordAtNextLogin setting is enabled, which forces users to change their passwords
at next login.

v When upgrading on a server that is currently not configured for FIPS 140-2, you are presented with the
option to reset user passwords:
– If you choose to reset user passwords, the SHA-1 hash function algorithm is employed.
– If you choose to not reset user passwords, the server will continue to use the MD5 hash function
algorithm.

v Keep the following points in mind when modifying an existing installation:
– When changing Configure for FIPS 140-2 Compliance from enabled to disabled, the SHA-1 hash
function algorithm will continue to be employed.
– When changing Configure for FIPS 140-2 Compliance from disabled to enabled, the parameters
outlined in the first bullet point are employed.

Refer to the National Institute of Standards and Technology website for more information regarding FIPS
140-2.

Note: When FIPS 140-2 is configured, the applications adhere to the password protection security
protocols that are defined on the Interviewer Server. For example, if the Interviewer Server is configured
for MD5 security, the client-side applications will also use MD5 security for password protection,
regardless of whether or not the Configure for FIPS 140-2 Compliance setting was selected during
installation.

Professional IDE

New system variables. MDD files that are activated for use with Interviewer 5.6 require four new system
variables:
v DataCollection.BatchID
v DataCollection.BatchName
v DataCollection.DataEntryMode
v DataCollection.Removed

MDD’s that were created in Dimensions 5.5 or earlier do not include these system variables and must be
reactivated to Interviewer 5.6. You must also reactivate MDD files, created in a previous release, that are
opened and saved using a 5.6 application.

It is important to note that if you remove system variables from an MDD created in any release
(including 5.6), Interviewer 5.6 will require reactivation to ensure that all system variables are present.

If you attempt to open a file that excludes one or more of these variables, Interviewer will block the
action and issue the following notification: “Required system variables missing. Reactivation is required.”

Refer to the "Activating Questionnaires" topic in the Author 5.6 User's Guide for more information on
activation using Author.

Refer to the "Activating Interview Scripts" topic in the Data Collection Developer Library for more
information on activation using Professional.

Refer to the "Activating Projects" topic in the Interviewer Server 5.6 User's Guide for more information on
activation using Interviewer Server.

Refer to the "System Variables" topic in the Data Collection Developer Library for more information on
system variables.
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Local Deployment Wizard. This new wizard allows you to deploy a survey to one or more Interviewer
installations without requiring an Interviewer Server. The wizard provides a simpler alternative to the
Activate dialog that is commonly used to deploy surveys to Interviewer.

Activate. A new Interviewer tab was added to the Activate dialog. This new tab provides options for
defining various Interviewer settings for activated or locally deployed questionnaires. The tab provides
the same options as those available in the Local Deployment Wizard.

Activation Console. This new utility allows you to view pending and completed activations, and create
activation history filters.

IBM SPSS Data Collection Question Repository

There are no significant changes in the 5.6 release.

Data Management

New Samples. New data management scripts were added to demonstrate the benefits of HDATA support
in data management. Data transfer now supports unbound loop questions, aggregations, and expressions.

Support for merging to existing output metadata. Input metadata can now be merged to any existing
output metadata (with the existing output acting as the master).

New Functions. The following Data Management functions are new in the 5.6 release:
v CombineIterations – Combines the response value for nested grid questions iterations.
v CopyGrid – Transfers data from SourceGrid to DestinationGrid.
v CreateGridSummary – Creates a summary result for a grid.
v Decode – Provides the same functionality as an IF-THEN-ELSE statement.
v FlattenGrid – Converts grid sub-questions into flattened questions.
v FlipGrid – Retrieves flipped data from SourceGrid.
v RemoveCategory – Removes the deprecated OldCategory from MDMObject.
v ReplaceCategory – Replaces oldCategory with newCategory for a loop/categorical questions.
v SubtractQuestion – Subtracts the values for one or more questions.
v SumQuestions – Sums the value for more than one categorical question.

New sample DMS file. The new sample DMS file UtilizeOuterDirectives.dms demonstrates passing
directives to the Data Management Script (DMS) via the IJob.Load function's second parameter.

Interview Scripting

Support for custom keycodes. You can now define custom keycodes for each question response.

IsUploadSample property. IsUploadSample is used to prevent multiple users from uploading samples, for
the same project, at the same time. Resource conflicts can occur when multiple users access the same
table.

MAX_TRIES queue. This new predefined queue stores records where the TryCount value, or DayPart
TryCount value (if using Day Parts), exceeds the MaxTries setting.

Table Scripting

Change in results for the ColumnProportionsTest.mrs sample script. The sample script now produces
an additional table that demonstrates defining column IDs as a string.
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RoundingOptions. This new property allows you to specify the default rounding calculation.

Change in results for the GridAndLoopSlice.mrs sample script. The sample script now produces an
additional table that illustrates the use of grid and loop slices to create derived variables.

Change in results for the HierarchicalFilters.mrs sample script. The sample script now produces
additional tables that illustrate filters that make use of loop slice expressions.

Table Scripting Samples

The following new sample table scripts have been added in this release:

ChartTemplate.mrs This new sample script demonstrates how to enable custom charting template
features in MS Office 2007.

TomVariablesDemo.mrs This new sample script provides examples for creating and configuring variables
and folders in script, and organizing questions with the variables interface.

DerivedGridTables.mrs This new sample script demonstrate creating .mdm derived grids and using
derived gird in tables.

What's New in mrStudio 5.5
What's new in mrStudio 5.5 is summarized under the following headings:
v Data Management Scripting

v Interview Scripting

v User Documentation

Data Management Scripting

Dimensions Data File now supports a compressed file format. You can export data to a compressed
Dimensions Data File by specifying the .dzf file extension.

Interview Scripting

Project activation. You are now provided the option of excluding specific folders and files from project
activation.

User documentation. The user documentation has been updated as follows:
v A new topic, Files Tab, discusses the options for excluding specific folders from activation when

activating a project. Excluding specific folders effectively limits the number of files that are uploaded
during the activation process.

User Documentation

The chapter describing how to create questionnaire wizards for Author has been updated with new
examples and screen shots.

What's New in mrStudio 5.0
What's new in mrStudio 5.0 is summarized under the following headings:
v mrStudio IDE

v Question Repository

v Data Management Samples
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v Interview Scripting

v Table Scripting

v Table Scripting Samples

mrStudio IDE

Version check validation. mrStudio 5.0 checks the version of any opened .mdd file against the version of
the tool to ensure corruption does not take place.

Question Repository

Question Repository. mrStudio 5.0 supports the following Question Repository features:
v Store survey assets to a IBM SPSS Collaboration and Deployment Services Repository. You add

questions to a IBM SPSS Data Collection Question Repository by storing survey assets, that contain one
or more standard survey questions, to the IBM SPSS Collaboration and Deployment Services
Repository.

v Browse a IBM SPSS Collaboration and Deployment Services Repository for survey assets. You can
navigate through existing topics and identify survey assets to insert into your questionnaire.

v Insert survey assets stored in a IBM SPSS Collaboration and Deployment Services Repository. After
locating the appropriate survey assets you insert them into the working questionnaire.

Data Management Samples

Dimensions Data Files. Many sample data management scripts have been modified so that they read the
Dimensions Data File version of the Museum sample data set instead of the XML file version. The
Dimensions Data File format was introduced in Data Model 4.5 and has several advantages over an XML
file written by the XML CDSC.

The MSExcelTransferToFromDDF.dms and DDFToRDB.dms data management scripts have new names to
indicate that they now input a Dimensions Data File instead of an XML file. In addition, the
XMLInput.dms sample include file has been replaced by DDFInput.dms.

QuantumToDDF.dms. This new script demonstrates reading the “Ski Demo” Quantum sample file
supplied with the Dimensions Development Library (DDL).

RDBToTripleS.dms. This new script demonstrates writing to Triple-S metadata and case data files. The
script creates two Triple-S case data files, one that contains fixed-format fields and another that contains
comma-separated values.

TripleSToDDF.dms. This new script demonstrates reading from Triple-S metadata and case data files.
Both this script and RDBToTripleS.dms above use the Triple-S DSC, which was introduced in Data Model
4.5.

Change to cleaning.dms. The cleaning.dms sample file was changed as follows:
time_spent = time_spent.ran(1)

was changed to:
time_spent = time_spent.Response.ran(1)

Interview Scripting

Global questions. These are questions that are displayed at the top of every page. You might use them as
a means of gathering general comments that are then written to a database or emailed to the project
manager at the end of an interview, or to make usability features such as page colors or text size
available to respondents.
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Off-path data. Off-path data is now cleared from the case data when an interview completes rather than
when it ends. If your company sometimes chooses to treat partially completed interviews as completes
for analysis purposes, this may affect the validity of your tables as they may contain off-path data. You
can get around this issue by manually setting OffPathDataMode to with dmClearOnNavigateBack or
dmClearOnExit at or near the start of each script.

Instructions and subheadings in drop-down lists. The processing for drop-down lists has been changed
so that you can either display subheadings in the list or display the list with an instructional text as the
first item. In version 4.5, all top-level texts were treated as subheadings, and prior to that as instructional
(and therefore selectable) text. This change provides additional flexibility without impacting the speed
with which pages are drawn.

Rotation and randomization with grids. If the order of responses in a row or column of a grid differs
from the order of those responses in the header row or column, the grid is not displayed. An error
message is displayed on the page and written to the IVW* log file. This prevents data corruption that
would happen if the script was allowed to run as written. A simple way to avoid this error is always to
specify rotation or randomization for loops in the metadata section of the script, as this ensures that all
iterations of the loop will use the same rotation or randomization pattern. If you have to specify rotation
or randomization in the routing section, you should always set the program's state before requesting the
reordering. For example, always set the randomization seed before requesting randomization, as shown
here:
For Each Question In MyLoop

SetRandomSeed(IOM.Info.RandomSeed)
Question.Order = OrderConstants.oRandomize

Next

User documentation. The user documentation has been updated as follows:
v A new chapter has been added that describes how to implement quota control in interview scripts.
v A new chapter has been added that describes how to set up questionnaire wizards for use in Author.
v A new topic, Validating Grids that Contain More Than One Question, discusses a validation function

that you can use in grids that contain more than one question, when whether or not a question
requires an answer depends on whether another question in the grid is answered.

v The new Testing and Debugging Scripts topic explains how to flag statements as being or not being
applicable to interviews run in debug or auto answer mode in mrStudio.

v Formatting Substituted Values now explains how you can format categorical response texts when
displaying answers to a question.

v Using a Custom Validation Function incorrectly stated that the custom validation functions runs
instead of rather than in addition to the standard validation function. This has been corrected.

v The topics on horizontal and vertical alignment have been rewritten and expanded to provide more
information about how these facilities work, and a new topic has been added that focuses on creating
forms.

v The documentation for the Quota Object Model can now be found in the Interview Scripting Reference
section of the Dimensions Development Library documentation rather than in the mrInterview
Reference Section.

Table Scripting

Change in results for column means calculation. Results of column means test calculation have been
updated and are reflected the in the test's generated tables.

Table Scripting Samples

The following new sample table scripts have been added in this release:
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CellChiSquareTests.mrs . . Looks at each table cell and tests whether it is significantly different from its
expected value in the overall table.

TTestTests.mrs . . Determines whether the mean of a numeric variable is significantly different from zero
or some other specified value.

TukeyTest.mrs . . Uses the Studentized range statistic to make all pairwise comparisons between groups.

What's New in mrStudio 4.5
What's new in mrStudio 4.5 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Interview Scripting

v Table Scripting

v Table Scripting Samples

mrStudio IDE

Testing Quotas. You can now use mrStudio to test quotas that are based on the answers to questions in
your interview script (.mdd) files.

Viewing Metadata and Routing Together. You can now view the metadata and routing sections of your
interview script at the same time, as two halves of mrStudio's Edit pane.

Metadata Viewer is Optional. You can now specify that you do not want a metadata viewer to open
whenever you open an interview script.

Data Management Scripting

OnBadCase event. If the input data source in your data management script includes a metadata source,
you can add an OnBadCase event section to your script. The OnBadCase event is executed for each
record that has failed validation and will not be transferred. You typically use the OnBadCase event
section to create a report of bad cases.

Data Management Samples

Dimensions Data Files. Many sample data management scripts have been modified so that they read
and write Dimensions Data (.ddf) files instead of XML files. A Dimensions Data File is a new format for
the storage of “offline” mrInterview data and has several advantages over an XML file written by the
XML CDSC.

Several existing data management scripts have been renamed to indicate that they now output a
Dimensions Data File instead of an XML file. They are mrInterviewCategoricalsOnlyToDDF.dms,
MSExcelToDDF.dms, QdiDrsToDDF.dms, QuanvertPkdToDDF.dms, and SavToDDF.dms. In addition, the
XMLOutput.dms sample include file has been replaced by DDFOutput.dms.

Several existing data management scripts have been modified to input Dimensions Data Files instead of
XML files. The Dimensions Data Files contain exactly the same case data as the XML files that they
replace. The scripts are MergeHorizontal.dms, MergeVertical.dms, and JapaneseMergeHorizontal.dms.

RDBToSAS.dms. To demonstrate the new SAS DSC, this script transfers data from a Dimensions
Relational MR database to a SAS data file.

Chapter 7. What's New in IBM SPSS Data Collection Professional 125



Interview Scripting

IVR hand-off. Interview scripting and the interviewing program now support the transfer of calls and
interviews to an IVR system.

Record and play. The interviewing program now supports recording and playback facilities for the CATI
(telephone interviewing) players. Related to this, the interview scripting program has a new Audio object
attached to the existing Style object that allows you to script which responses should be recorded and the
questions and responses for which sound files may be played. You can also control the positions of the
record and playback button bars.

Customized text on the End of Interview page. Interview banners that are valid when the interview
ends are now displayed on the End of Interview page. This allows you to display customized text on
these pages while still using the same template files for all participants and projects. For example, if your
company runs surveys for a number of clients, you can use the same end of interview template for all
clients, but customize the end of interview pages by creating a banner that displays the client's logo.

What to display in the Goto navigation list. You can now display question texts in the Goto navigation
list. Question names remains the default.

Clearing off-path data. The new Question.ClearOffPathResponse() method immediately removes a
question's response from the value cache and sets its value in the case data to null when the question is
no longer on the interview path.

Formatting inserts. Inserts are now formatted using the user's locale, either IOM.Locale if set, or the
locale based on IOM.Language if no locale has been explicitly specified. Previously, inserts were
formatted using the server's locale.

Reviewing interviews. A number of changes and additions have been made to cater for reviewing
completed interviews. While most of them are more to do with what happens during an interview, it can
be useful to be aware of how the review process differs from the original interview process.

Running in Auto Answer mode. If you are building your script in mrStudio, you can test it by running
it automatically using mrStudio's Auto Answer facility. This saves you having to answer the questions
manually. If your script contains code such as quota checks or custom validation that cannot be run in
AutoAnswer mode you can use the new IInterviewInfo.IsAutoAnswer property to test whether the script
is running in Auto answer mode and, if so, skip those statements. For example, if you want your custom
validation function to return True whenever the script is running in Auto Answer mode, you could type:
Function ValidateQuestion (Question, IOM, Attempt)

If (IOM.Info.IsAutoAnswer) Then
ValidateQuestion = True

Else
perform custom check

End If
End Function

User documentation. The user documentation has been updated as follows:
v The following properties have been added to Table of Project and Interview Properties:

HiddenCodesList, MonitoringAllowed, RaisePositionError, and SilentCallAudioFile. Of these, only
SilentCallAudioFile is new in version 4.5.

v A new topic, Special Characters in Question and Response Texts, lists the characters that have special
meanings in question and response texts and explains how you can display them during interviews.

v The new Keywords for Data Analysis chapter introduces statements for tabulating and analyzing the
case data. It covers the specification of factors for categorical responses and numeric bands, and the
definition of analysis-specific elements such as merged responses.

v Working with Sample Records is a new chapter that explains how you can read data from sample files
into interview scripts and write interview data back to the sample records.
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v The new Multiple-Language Scripts chapter discusses how to write scripts that allow interviews to be
conducted in different languages.

v More Than One Question on a Page has been updated to show how question names can be used as
alternatives to indexes when templates are used for placing multiple questions on one page.

v The chapter on filtering now explains how to filter questions in one grid based on responses given in a
previous grid.

v Further recommendations have been added to Scriptwriting Rules and Recommendations, including
how to refer to individual cells in a grids.

v The documentation for the Add and AddNew methods has been updated to explain more clearly what
each method does. Add() adds an existing label object complete with the inserts and style of that label.
AddNew() adds a new label object with a specified text; this object has its own inserts and styles. In
both cases, if you want to add a new label with the same name as an existing one, you must manually
remove the old label first.

Table Scripting

Export tables to PowerPoint. You can now export tables to PowerPoint using the DisplayOption property.
This also means that you can now export profile tables to PowerPoint format. Additional formatting
properties for exporting tables have also been added.

Wrap descriptions in Excel and PowerPoint tables. You can now choose whether or not to wrap long
descriptions onto the next line using the WrapLabelText property for Microsoft Excel and Microsoft
PowerPoint exports.

Select cell item to base chart on.You can now base charts on a cell item other than the default, provided
that the cell item is included in the table, using the ChartCellItem chart property. This option is available
when exporting to HTML, Microsoft Excel, Microsoft PowerPoint, and Microsoft Word exports, and can
be applied to all tables or to individual tables.

Chart different variables on the same chart. You can now choose whether to create charts for individual
categories, for individual variables, or for all variables on a table, using the You can now choose whether
to create charts for individual categories, for individual variables, or for all variables on a table, using the
ChartCategoryElements property. This option is available when exporting to HTML, Microsoft Excel,
Microsoft PowerPoint, and Microsoft Word exports, and can be applied to all tables or to individual
tables.

Chart special elements of same type to same chart. You can now create charts for one or more statistical
items (such as the mean, minimum value, standard deviation, etc.) using the ChartSpecialElements
property. This option is available when exporting to HTML, Microsoft Excel, Microsoft PowerPoint, and
Microsoft Word exports, and can be applied to all tables or to individual tables.

Disable charts on per-table basis. You can now choose not to create charts for specific tables, using the
“No chart” setting in the Chart Type property,

Change in behavior in column proportions and column means calculations. The Column Proportions
and Column Means tests in mrStudio, mrTables, and Reporter previously used the expression:

DF = e 1 + e 2 - e 0 - 1

to calculate the degrees of freedom. This matches the calculation used in Quantum/Quanvert. From
release 4.0 Patch 1, the expression has changed to:

DF = e 1 + e 2 - e 0 - 2
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For backwards compatibility, the formula invoked by setting the Use the Quantum/Quanvert column test
formula option continues to use the original expression.

Table Scripting Samples

The following new sample table scripts have been added in this release:

HideRules.mrs. This script contains examples of how to use the hide rule options to hide rows, columns,
and cells in a table.

The following sample table scripts have been updated in this release:

ProfileTables.mrs. This script contains a new example showing how to create profile tables using grid
slices.

What's New in mrStudio 4.0
What's new in mrStudio 4.0 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Interview Scripting

v Table Scripting

v Table Scripting Samples

mrStudio IDE

Importing and Exporting Interview scripts. The procedure for importing an interview script from a
proprietary data format has changed. You must now use the Import Metadata menu option from the
mrStudio File menu. To export an interview script to a proprietary data format, use the Export Metadata
menu option from File menu. You must also use these options if you want to open or save .ivs files.

mrStudio No Longer Creates .ivs Files mrStudio no longer creates an .ivs file whenever you save an
interview script (.mdd) file. An .ivs file is a plain text file that contains only the script portion of a .mdd
file. You can still create .ivs files yourself, for example, so that you can store them in a version
management system and easily see the differences between versions of your interview scripts. To create
an .ivs file, use the Export Metadata menu option described above. To open an .ivs file, use the Import
Metadata option described above.

Choosing the Project Activation Target and Method. When you activate a Dimensions project from
mrStudio, you can now choose which mrInterview cluster you want to activate to and how you want to
activate, depending on whether you are connected to the same local network as the cluster and have
access to the FMRoot shared folder on the primary DPM server. By default, when you choose Activate
from the mrStudio Tools menu, a Login dialog opens in which you can enter the name of the primary
DPM server or, if you are not connected to the local network, the DimensionNet URL and login details. If
you typically activate to more than one cluster, you can easily select the required server name or URL
from a drop down list.

Viewing and Updating Alternative Contexts. In the metadata section of your interview script (.mdd) file,
you can now view and edit label texts and custom properties for alternative user-contexts. For example,
when you create a new interview script, you can use this new feature to include label texts in the
Analysis context.
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Adding Languages to Interview Scripts. You can now start MDM Label Manager from within mrStudio,
so that you can easily add languages to interview script (.mdd) files.

Comparing Interview Scripts. To compare different metadata versions of your interview script (.mdd) file,
or compare your interview script file with another interview script file, you can now start the new MDM
Compare accessory from within mrStudio.

Writing Case Data to an SPSS SAV File. When running or debugging an interview script (.mdd) file, or
when running an interview using Auto Answer, you can now optionally write the case data to an SPSS
SAV file.

AllowedCategories Hint. When creating hints in your interview script (.mdd) file for use by mrStudio's
Auto Answer feature, you can now specify an AllowedCategories hint, which defines a subset of categories
from which mrStudio can choose an answer.

Listing all Occurrences of a Text String. You can now list all the occurrences of a text string in your
script by clicking Find All in the mrStudio Find pane. Every line of your script that contains the string is
listed in the new Find Results pane. Double clicking on any line in the Find Results pane displays the
corresponding line in the Edit pane.

Using Regular Expressions to Find and Replace Text. You can now using regular expressions to search
for text in your script. Regular expressions are a flexible and powerful notation for finding patterns of
text.

Items in Scriptassist's Suggestion List. You can choose to not display functions from the IBM SPSS Data
Collection Function Library in Scriptassist's suggestion list.

Macro for Adding an Analysis Category. A new macro called AN_CAT has been added to the list of
mrScriptMetadata macros that are available in mrStudio. You can use the new macro to insert the
mrScriptMetadata syntax for an analysis category in your script.

Data Management Scripting

Order of Variables in Output Data Source. You can now specify that variables should be output in the
order in which they appear in the SelectQuery statement in the InputDataSource section. To do this,
include the option VariableOrder = “SELECTORDER” in the OutputDataSource section of your data
management script.

Analyzing Tracking Studies. A new topic in the Dimensions Development Library (DDL) documentation
describes how you can use data management scripting and other Dimensions and SPSS technologies to
analyze the response data from your tracking studies. The sample scripts described in the process are
included with the DDL.

Data Management Samples

TrackingStudy-prefixed sample DMS files. These samples can be used to analyze the response data
from a tracking study.

Interview Scripting

Category filtering that leaves only special responses. Questions are now skipped if there are no
categories other than dk, na, or ref. This is independent of the question's MustAnswer setting so a
question may be skipped even if MustAnswer=True. No response to the question is written to the case
data if the question is skipped (they have null responses).

Text substitution and inserts. The following changes have been made in relation to inserts.
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v You can now insert the values of temporary variables in texts using the {#Name} syntax that you use for
inserting the answers to questions.

v Response inserts using full variable names are now supported, so references of the form
{#\.DrinksLoop[{Water}].HowOften} are no longer reported as errors. This means that you can insert
responses to questions that are part of a block or loop. Note, however, that the ^. syntax is not
supported for full variable names.

v Response inserts formatted using the default "b" format specification now use the category label
instead of the element label. This means that inserts in the label are correctly replaced. This change also
correctly sets the IResponse.Label property. For example, if Q1.Response = {red} and Q2.Response =
{cool}, Q2.Response.Label now returns "Red is cool" instead of "{#q1} is cool".

Testing multilingual scripts. It is now possible to use languages in the interview script that have not yet
been added to the metadata. When you run the script, an error message is displayed and the appropriate
metadata current value is used instead (for example, IDocument.Languages.Current for the script
language). For example, if your script is set up as follows:
Metadata(en-GB, Question, Label)
Q1 ...
Q2 ...
End Metadata
Routing(Web)
IOM.Language = "fr-fr"
Q1.Ask()
Q2.Ask()
End Routing

you can test the script in English if there are no French translations available. Once there are French
translations the script will run in French rather than English. This change applies not only to the script
language but also to the Context and LabelType properties.

Templates.The following changes have been made in relation to templates.
v The DisplayEngineName.htm layout template is supplied for testing purposes. Based on the default

layout template, this template displays the name of the interviewing engine that is running the
interview at the bottom of every page. The template is installed in \Scripts\Interview\Templates.

v You can use <form> elements to add buttons to your interview pages. However, it is important that
your <form> elements do not become part of the <form> elements that the Player inserts.

User documentation. The user documentation has been updated as follows:
v A new set of topics describes various methods of text substitution for inserting variable information in

fixed text. These topics cover such things as displaying respondent-specific information in a question
text or banner, displaying answers to Other responses as part of a second response list, and inserting
texts from a categorical loop control list into the texts of the questions inside the loop. Another topic
also explains how you can specify the format in which the inserted values should be displayed.

v The new chapter called Filtering Questions and Response Lists provides detailed explanations and
many examples of how to filter irrelevant questions and responses out of an interview. It covers the
common requirements of including or excluding responses that were chosen or not chosen at a
previous question, as well as suggesting ways of asking one question at random from a set of
questions, or of asking one question about a single response selected at random from the responses to
an earlier question. For loops, it tells you how to ask a subset of questions for all repetitions, how to
ask all questions for certain repetitions only, and how to create a "jagged grid" in which some of the
cells are blank.

v A new chapter, Ending, Suspending, and Rolling Back Interviews, describes what happens when an
interview ends, stops, restarts, or is rolled back, and introduces a number of routing statements that
you can use to interact with this process. Many users will find the topics about displaying a question
and answer summary at the end of the interview and calculating the duration of an interview
particularly useful.
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v A new topic, Lining Up Wrapped Response Texts, explains how to line up continuation lines in
wrapped categorical response texts. This requires editing a .css file and is provided as a temporary
solution until such time as this functionality is added to the interview scripting language.

v The documentation about Events has been moved from the Reference section into the Writing
Interview Scripts section. It has been updated to provide more information about each event and, in
most cases, examples of the sorts of things you can do with events. The chapter ends with a detailed
example that illustrates how to use all events together to gather paradata about each interview.
(Paradata is a general term that describes information about how the interview data was collected. It
includes data such the start and end times of the interview and the number of questions asked and
answered.)

v A new topic, Checking for Unique Ranks in a Ranking Grid, describes a customized validation function
that you can use for validating categorical ranking grids.

v Rows or Columns, and How Many now describes how the interview scripting program processes
requests to place responses in a set number of rows or columns, and explains why it may sometimes
seem that your specifications are being ignored.

v Asking Questions now explains how to use the SelectRange function to ask all questions in a specified
range.

v The new Default Responses topic describes how to define default answers for questions.
v The Setting Initial Values topic has been rewritten and now provides more information about this

feature.
v The new Example Layouts topic in the Grid Styles section will be enlarged over time. Currently, it

contains one example showing how to create nested grids with radio buttons in each cell.
v The new Labels on Navigation Buttons topic explains how to customize and translate the text

displayed on navigation buttons.
v The new Automatic Focus on the Next Button topic provides some HTML code that you can insert in

your templates to get around the problem of browsers that set the focus on the Previous button when
respondents press Enter.

v The following dialer-related properties have been added to Table of Project and Interview Properties:
AutoDial, AutoDialTimeout, CallerID, DialerCallOutcome, DialingProvider, DialingTimeout,
NoAnswerTimeout, PercentCallsRecorded, RecordCall, RecordingProhibited, and RecordInterviewOnly..

v The script snippets that appear in the documentation topics are now subject to regression testing along
with the program source code. Runnable scripts related to the individual chapters of the interview
scripting documentation are planned for a later version of the Dimensions Development Library.

v IRunningInterview.Post(). The object model documentation for IRunningInterview.Post has been
extended to explain how the method can be used. This includes the purpose of the Event and
ReturnType parameters and a description of the return value.

Table Scripting

Ability to define autobase specifications. You can now define specifications for automatically generated
base and unweighted base elements that mrStudio adds to a table if there is no base. For example, you
can create your own labels to override the default labels, or add an expression to define the autobase. To
do this, use the new AutoBaseSpecification and AutoUnweightedBaseSpecification table properties.

Ability to restrict displayed cell items to counts only for an element. You can now use the CountsOnly
element property to display only counts for a particular element, overriding the cell items specified for
the table.

For further details see the Table Object Model Reference help for the CountsOnly property.

Ability to add a format expression to a cell. You can now add formatting to a cell item using the
FormatExpression property of the Cell Item object.
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For further details see the Table Object Model Reference help for the FormatExpression property.

Ability to aggregate hierarchical data at additional levels. You can now aggregate a higher level variable
at a lower level without having to tabulate a variable from the lower level.

Ability to set a minimum base for a table. You can now set a minimum base value for a table, and
suppress values in any cells where the base row or column value is below the minimum, using the new
MinBase table property. In addition, you can use the new MinBaseSymbol property to specify the symbol
to display instead of the cell value, and you can adjust the way in which the minimum base is applied
using the MinBaseOptions table property.

Ability to create profile tables. You can now create profile tables to display non-aggregated respondent
data. Filtering, sorting, and annotations are available for profile tables. Profile tables can also be displayed
in Reporter 4.0. They are not available in mrTables 4.0.

New chart types. You can now choose from a number of different chart types when exporting results to
HTML or to Microsoft Excel, PowerPoint, or Word. You can also specify different chart types for
individual tables. In addition, you can select an Excel custom chart type that you have previously set up
when you export to Excel, PowerPoint, or Word.

Improved ability to use custom style sheets for HTML exports. You can now use a custom style sheet
from a folder other than the output folder, using the CSSLocation property.

Enhancements to annotations. The following new features are available when specifying annotations:
v Indicate table numbers hierarchically. You can now include hierarchical numbering for tables that are

inside folders, using the new \g switch for the TableNumber annotation macro.
v Add annotations for custom table properties. You can now add an annotation for any custom

property that you add to a table, using the new TableProperty annotation macro.
v Specify the context when displaying labels (descriptions). When you specify annotations that use the

\l switch to display labels instead of names, you can now specify the context for the label. For
example, if you add an annotation to display the table specification using the variable descriptions, you
can choose whether to display the descriptions shown in the questionnaire (the Question context) or
those used in the analysis (the Analysis context).

v Use variable short names in headers and footers. A new annotation switch, \s, has been added to
enable you to use the short name of a variable in headers and footers.

v Additional details when running statistical tests. mrTables now displays additional information and
warning details in headers and footers when you run statistical tests on a table. The information is
displayed by the {PopulateWarnings} and {CellItemSymbols} macros. These macros are displayed in the
left footer annotation by default.

Change to default annotations. As described above, the left footer position now contains additional
macros. The Title Footer annotation position has also been changed so that the {DocumentDescription}
macro no longer appears by default. It is still possible to include this macro in annotations.

Additional cell items available. Four new cell items are now available: itColBase, itRowBase,
itUnweightedColBase, and itUnweightedRowBase.

The name of the UseStyles Excel export property has changed. The name of the export property that
enables you to use Microsoft Excel styles when exporting tables has changed from UseStyles to
UseExcelStyles. This is to prevent confusion with another property called UseStyles.

The Column Proportions test no longer uses the continuity correction by default. The default formula
for the column proportions test no longer includes the continuity correction in calculating the t value.
This is for compatibility with Quantum and Quanvert. The continuity correction can be added to a
column proportions test using the new UseContinuityCorrection property, for example:
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Statistics["ColumnProportions"].Properties["UseContinuityCorrection"] = True

Table Scripting Samples

The following new sample table scripts have been added in this release:

ProductDifferenceTest.mrs. Contains an example showing how to set up a product difference test for a
table.

ProfileTables.mrs. Contains examples showing how to create profile tables.

The following sample table scripts have been updated in this release:

Annotations.mrs. Updated to include an example of adding a custom property to a table and displaying
it in an annotation using the TableProperty macro. Also updated to remove the value for the
DocumentDescription annotation, which is no longer required as it is not displayed in footers by default.

ExcelExport.mrs. Updated to use the UseExcelStyles property instead of UseStyles.

HierarchicalData.mrs. Updated to include an example of tabulating a higher level variables at a lower
level.

What's New in mrStudio 3.5
What's new in mrStudio 3.5 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Interview Scripting

v Table Scripting

v Table Scripting Samples

mrStudio IDE

Context-Sensitive Help. You can now access help for any element of your data management, interview,
or mrScriptBasic script by selecting the element in the Edit pane and pressing the F1 key. The relevant
help topic will then be displayed in the new mrStudio Help pane. Help topics are included for all
mrScriptBasic and mrScriptMetadata keywords, data management script elements, Data Model functions,
preprocessor directives, and Dimensions object models. To be able to use context-sensitive help, you must
install the browser-based version of the Dimensions Development Library (DDL) help files, which you
can do from the DDL installation program.

Data Management Scripting

Accessing Special Responses. It is now possible to access the response to a non-categorical question's
codes list, which typically contains special response categories such as Don't Know and No Answer. In
the following example from the OnNextCase event, the response to question Q1's codes list is tested to
see if it is a category named NA, meaning No Answer:
If Q1.Response.Coded = {NA} Then

...
End If

For more information, see “Accessing special responses to non-categorical questions”.
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Performance Considerations. A new topic in the mrStudio “Troubleshooting” section describes some
methods for improving the performance of data management scripts.

Data Management Samples

Merge of Japanese (Multibyte) Data Sources. Two data management scripts have been added to the
DDL to demonstrate this.

DMSRunExample.dms. Demonstrates the use of text substitution in a DMS file when running the file
using the DMS Runner command prompt utility.

Interview Scripting

Repeating grid headers. You can now set up column headings so that they are repeated every n rows
and displayed at the bottom of the grid as well. For example, specifying
TeaLoop.Style.Cell.RepeatHeader = –3 repeats the column headings every three rows as well as
displaying them at the bottom of the grid. Similar functionality exists for repeating row headings across
the grid.

Setting the language for data entry and validation. The IInterview.Locale property has been changed to
be read/write so that you can set the language in which responses should be entered and validated
independent of the main interview language.

What to do with off-path data. Off-path data consists of responses to questions that are no longer on the
interview path. They occur when a respondent snaps back and changes an answer to a question, and that
change causes different questions to be asked. The data held for questions that no longer apply to the
respondent is known as off-path data.

NOTE: This feature was introduced in mrInterview 3.1 patch 2, but with a different default. Please be
sure to read the following descriptions carefully. If you have projects that were created using mrInterview
3.1 patch 2 and you want them to work identically in mrInterview 3.5 you will need to insert the
appropriate instruction at the top of your routing script.

To specify what to do with off-path data, type:
IOM.OffPathDataMode = OffPathDataModes.
mode

in the routing section of the script, where mode is one of the following:
v dmClearOnComplete to clear off-path data when the interview completes. Off-path data is kept for

stopped or timed out interviews.
v dmClearOnExit to clear off-path data when the interview ends for any reason (that is, completes, stops,

or times out). The case data for stopped or timed out interviews will contain data for all questions,
whether on or off the interview path, until the interview completes, stops, or times out. If an interview
is restarted from sample management, and a different path through the interview is taken, any
questions that are not re-asked after the restart are set to null. This is the default.

v dmClearOnNavigateBack to clear off-path data immediately when the respondent clicks the Previous
button or skips to another question using Goto or First, or when an ISavePoint.Go() instruction is
encountered in the routing section of the interview script. With this option, the case data always
reflects the questions that are on the current interview path, so this option does not attempt to clear
off-path data on exit, because it assumes that the case data is up to date. If an interview is restarted
from sample management, and a different path through the interview is taken, any questions not
re-asked after the restart are not set to null. (This behavior was the default in mrInterview 3.1 patch 2.)

v dmKeep to keep all off-path data.
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Flagging interviews terminated by an error handler. The new sigError signal is provided for flagging
interviews that are terminated by an error handler due to an error in the script. Sample scripts that use
an error handler have been updated to use this signal.

Number of times a question is asked. IQuestionInfo.AskCount is now incremented when a question is
re-asked due to validation errors (in previous versions it did not do this even though the documentation
stated that it did), and when a question is re-asked after a restart using sample management. In previous
versions this property was reset to 0 when the interview was restarted; now it is set to 1 for all
previously answered questions.

Number of times a question has been successfully answered. IQuestionInfo.AnswerCount is now
incremented when a question is re-asked during a restart from sample management. In previous versions
this property was reset to 0 when the interview was restarted; now it is set to 1 for all previously
answered questions.

Number of times a question has been incorrectly answered. The new IQuestionInfo.ErrorCount
property reports the number of times that a question has been answered incorrectly.

Using the Last navigation. When a respondent or interviewer click Last, the interviewing program now
skips forward to the first question whose IQuestionInfo.AnswerCount property is set to 0.

Restarts from sample management. The new IInterviewInfo.IsRestart property is True while the
interview is being replayed during a restart from sample management. It is False during normal
execution of the routing script.

Custom controls. You can now define custom controls to provide functionality that is not provided as
standard in Interview Scripting. Two example custom controls are supplied, one that displays a slide bar
for numeric questions and the other than displays a calendar for date questions.

New interview properties. The following properties have been added to the Interview (IOM) object:
v IInterview.AutoSelectOther. Determines whether the interviewing program will accept Other responses

even if the Other check box or radio button is not selected. The default is False which means that
respondents must select the Other response as well as entering text in the text box. When set to True,
the interviewing program accepts responses with text in the text box but without the Other check box
or radio button being selected.

v IInterview.SessionToken. A unique token that identifies the interview.
v IInterview.InterviewStatus. The current status of the interview.
v IInterview.MessagesDocument. The name of the standard messages file.

Interview start time. DataCollection.StartTime is no longer rewritten if it already exists in the recordset.
This means that interviews that time out and are then restarted via sample management (usually via the
authentication page) do not have their original start time overwritten.

Filtered response lists in timed out interviews restarted with sample management. When a timed out
interview is restarted via sample management, mrInterview now validates responses to questions with
filtered response lists to ensure that they are still valid. If it encounters a response that is now invalid, the
replay stops at that point and mrInterview prompts the respondent for an answer. For example, suppose
that Q9 has a filtered response list containing the responses A to E. On the first pass through the
interview, all responses are valid and the respondent chooses response A. The interview times out and is
restarted. Only responses C to E are now valid so Q1 will be displayed again so the respondent can
choose another answer. In earlier versions, mrInterview would retain the original response chosen (in this
case, A) even if it was now invalid.
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Running custom validation before the default validation. The OnBeforeQuestionValidation event can be
used to modify a response before validation is run, for example, to remove currency symbols. Note that
currency symbols appropriate for the interview language are automatically ignored.

Rotation and randomization in interviews restarted using sample management. When interviews are
restarted via sample management, mrInterview now uses the random seed stored in the interview's case
data record rather than a seed defined on the interview URL or a new randomly generated seed. This
means that restarting in this way is now the same as restarting a timed out interview by clicking Next.

Changed behavior with infinite loops when respondents click Last. The interviewing program now
displays the last question reached rather than stopping with an error if MaxQuestionsOnReplay is
exceeded when re-executing a script after the respondent has selected the Last navigation. See
IInterviewInfo.MaxQuestionsOnReplay for details.

Changed behavior for snapbacks. When a respondent enters or selects a response to the current question
and then clicks Previous, First, or Goto to snap back to a previous question rather than clicking Next, the
interviewing program now accepts the response if it is valid or ignores it if it is invalid. If no response
was entered, the response is set to Null.

Named banners in templates. You can now refer to banners by name on <mrData> tags in templates
rather than by index number. For example, if you want to display a $ sign in front of the input box for a
numeric question about cost or price, you can define it in the routing section as:
QCurrency.Banners.Add("Currency", "£")
Qcountry.Banners.Add("Country", "US")

and then refer to it in the template as:
<mrData QuestionElement="Banner" Name="Currency"/>
<mrData.QuestionElement="Controls"/>

The advantage of using names rather than indexes is that you can define banners in any order rather
than having to ensure that they are defined in the order they are used in the template.

Naming questions on <mrData> tags in templates. Use the new QuestionName attribute to refer to
questions by name on <mrData> tags. For example, suppose you have four questions defined in the
order Q1, Q2, Q3, and Q4 that you want to display on a page as Q3, Q2, Q4, Q1. Until now, you would
have to write four <mrData> tags that referred to the questions using Index=3, Index=2, Index=4, and
Index=1 respectively. If you got the indexing wrong, the questions appeared in the wrong order. Now,
you can refer to them by name so mistakes are less likely to arise. Simply type a statement of the
following form for each question in the order you want the questions to appear on the page:
<mrData QuestionName="Qname">[Text]</mrData>

QuestionName takes priority over Index, so if Index and QuestionName are both set, Index is ignored. If two
<mrData> tags reference the same question, one with QuestionName and the other with Index, the
question will be inserted at both locations.

If a question is referenced by an <mrData> tag by QuestionName, it will not be inserted at an <mrData>
tag that does not specify QuestionName or Index. For example, if the template contains:
<mrData QuestionName="Q2"/>
<mrData QuestionName="Q3"/>
<mrData Index="1"/>
<mrData Index="3"/>
<mrData/>

and the questions are Q1, Q2, Q3, Q4, the rendered page will show them in the following order: Q2, Q3,
Q1, Q3, and Q4.

User documentation. The user documentation for writing interview scripts has been updated and
expanded. Changes include:
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v The section on errors and error handling has been completely rewritten and now explains how to
change the texts of the standard error messages and how to write an error handler to deal with
run-time errors. Several examples of error handling routines are provided which you can use as they
are or modified to suit your company's requirements.

v The sublist keyword is now documented. It provides a flexible method of specifying subheadings for
shared lists when more than one list is used in a response list. As part of this change, the existing
topics on subheadings have been restructured.

v The topics on reordering responses in a response list now explain how to define response order in the
routing section. See the subtopics in Sorting Categorical Response Lists for details.

v The documentation for numeric responses now explains how you can allow respondents to type
numeric responses containing thousands separator characters. For example, you may allow respondents
to type numbers such as 1,234.56 (comma separator) or 1.234,56 (dot separator). It also tells you how
you can use the IOM.Locale property to control which characters can be used as decimal points and
thousands separators. See Questions with Integer Responses and Questions with Decimal Responses
for details.

v A section about project and interview properties has been added to the reference section. This section
brings together property information that was previously only available in scattered locations
throughout the Dimensions Development Library and various topics in user guides. The summary
table of project and interview properties will be of particular interest to interview and sample
management scriptwriters.

Sample script for paradata events. Paradata is data about the data collection process. The new
EnglishMuseum_WithParadata sample script illustrates how you can use events in the routing section of
an interview script to collect this data. Refer to Paradata Example Readme.htm in \Scripts\Interview\
Frequently Asked Questions\Events for further details.

Filtered responses with priority quotas in interviews restarted using sample management. When an
interview stops or is timed out and the respondent restarts it using the survey URL, the interviewing
program restarts the interview using the data currently stored for that interview in the database. If the
interview timed out when a priority quota was pended, it could be that priorities have changed in the
meantime and the respondent will be allocated to a different quota cell. If the script contains questions
whose response lists are filtered according to the respondent's quota cell, the interview will continue
replaying but different responses will be selected due to the change in priority. The respondent will not
be aware of this and may be confused to be being asked questions based on a different response. For
example, if the respondent buys brands A and D and was allocated to the quota cell for brand D in the
original interview, he/she may wonder why the interviewing program is now asking about brand A
instead.

There are a number of ways round this problem. One option is simply to display a message informing
the respondent that quota changes mean that he/she will be asked about a different brand. Another is to
check whether the original cell is still unfilled and, if so, pend that cell instead of the one currently
pended so that the respondent's previous answers are still valid. You can then reinstate the previous
answers to questions using QuestionName.Info.OffPathResponse.

What's New in mrStudio 3.1
What's new in mrStudio 3.1 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Interview Scripting

v Table Scripting

v Table Scripting Samples
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mrStudio IDE

Case Data Source. If your interview script has more than one data source, it is now easy to select the
data source that you want to use to store case data. Simply right-click in the interview-specific Metadata
viewer associated with the script, and on the shortcut menu choose Change DataSource. The same
shortcut menu now also contains an Add DataSource option, which you can use to add a new data
source, which then automatically becomes the current data source. These new features make it easy to
change from an XML to an RDB data source as you develop your interview script.

Edit Pane. The following improvements have been made to the Edit pane:
v The text editor has been updated. As a result some editing tasks, such as using the mouse to select

multiple words in a script, now work more reliably.
v If you attempt to edit a script while it is still running, mrStudio now displays an error message at the

bottom of the window.
v When you are editing questions in the routing section of an interview script, it is now easy to find the

definition of a question in the metadata section. Simply right-click on the question in the routing
section, and on the shortcut menu choose Goto Definition.

Expressions Pane. The following improvements have been made to the Expressions pane:
v Copy and paste are now supported. You can either copy selected text, or if no text is selected then the

entire contents of the text box will be copied. If you right-click in the Expressions pane, the Copy and
Paste commands are available from the shortcut menu.

v To execute an expression, you can now type the expression and press Enter.
v To evaluate an expression, you can now start the expression with a question mark (for example,

?myVariable) and press Enter.
v You can now use the Expressions Pane to declare variables. For example, type Dim myNewVariable and

press Enter to declare myNewVariable.

CATI Interviews. By default, when you run an interview script using a routing context called CATI, the
interview will now be presented using the new CATI HTML player. This player, which is also included in
the mrInterview 3.1 Web CATI option, has been designed for use in call centers and allows the interview
to be completed using only the keyboard. If you prefer, you can amend the Routing Selection Mode option
in mrStudio so that CATI interviews will be presented in the standard HTML player.

Activating an Interview. You can now activate an interview from the Windows Start menu without
having to start mrStudio.

Auto Answer Pane. This pane now shows the standard Dimensions variable-type icons alongside each
question.

Look and feel. The toolbar icons in mrStudio have been redesigned so that they appear “softer” and less
intrusive.

Data Management Scripting

Case Data Merge. When running a horizontal merge, you can now specify that an input data source
must not be sorted before the input data sources are joined. This will improve the performance of the
merge when you have a one or more large data sources that are already sorted in the correct order. To
stop a data source from being sorted, add JoinKeySorted = True to the InputDataSource section for that
data source.

Reading Microsoft Office Files. A new topic in the DDL explains how to use the Dimensions ADO DSC
to read Access and SQL Server tables, Excel worksheets, and other data sources for which a non-Data
Model OLE DB provider is available. Using the ADO DSC provides several advantages over using a
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non-Data Model OLE DB provider directly, such as the ability to query the input data using the VDATA
virtual table and create an output metadata document (.mdd) file during the transfer.

Categorical Responses. It is now possible to use the Format function in the Dimensions function library
to access the names of categorical responses. In the following example from the OnNextCase event, the
name of the response to categorical question Q1 is returned:
MyCategoryName = Q1.Response.Format("a")

Data Management Samples

The following data management scripts have been added to the DDL:
v CreateCSVAndCategoryMap.dms. Creates a tab-delimited file, which can be opened in Microsoft

Excel. To help understand the contents of the file, the script also outputs a list of the category values
used and their corresponding category labels.

v MSAccessToQuantum.dms. Transfers data from a Microsoft Access database to a Quantum .dat file.
This script uses the Dimensions ADO DSC and the Microsoft OLE DB Provider for ODBC Drivers to
read the Access database. In addition, a .adoinfo file is created in the OnBeforeJobStart event and used
as a metadata source for the input data source. This allows the Quantum card, column, and punch
definitions to be allocated in the transfer and saved to an output metadata document (.mdd) file.

v MSExcelToQuantum.dms. Transfers data from a Microsoft Excel worksheet to a Quantum .dat file. This
script works in a similar way to MSAccessToQuantum.dms.

v QuantumWeighting.dms. Demonstrates using the new update capability of the Quantum DSC by
adding weights to a Quantum output file.

v SavWeighting.dms. Demonstrates using the new update capability of the SPSS SAV DSC by adding
weights to a SPSS SAV output file.

v SurveycraftToSav.dms. Transfers data from a Surveycraft data source to an SPSS SAV file.
v TablesDefineSpecialElements.dms. Adds special elements and their associated helper elements to the

metadata using derived variables.

The following data management scripts have been updated:
v mrInterviewNextBatchToQuantum.dms. Now uses the read capability of the Quantum DSC to

determine which cases should be included in the batch of cases to be exported to the Quantum file.
v MSAccessToSav.dms and MSExcelToXml.dms. These scripts have been modified to use the

Dimensions ADO DSC and the Microsoft OLE DB Provider for ODBC Drivers to read the input data
source. Reading Microsoft Access and Excel data sources in this way allows them to be queried using
the VDATA virtual table. In addition, an OnBeforeJobStart event has been added to the scripts to create
a .adoinfo file, which is then used as a metadata source for the input data source. This allows an output
metadata document (.mdd) file to be created.

v STAfSMerge.dms. This script has been modified to make it easier to understand and use.
v TablesDefineAxesExportToRDB.dms. Factors assigned to the categories of the childhhz variable are

now specified as properties of the categories instead of on the variable's axis expression. This reduces
the length of the axis expression and improves the clarity of the script. In addition, the factor for the
initial category has been changed from 1 to 0, to give a more realistic value for this category.

Interview Scripting

Page layout facilities. This section of the interview scripting documentation has been completely
rewritten and expanded so that it now describes all the facilities available for controlling the visual
appearance of your interview pages. The documentation is broken down into three subsections — styles,
default styles, and templates — to reflect the internal page layout hierarchy, and example script snippets
and illustrations are included to show the effect of each layout control.
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Default styles for grids. Default styles have been implemented for grids so it is now possible to make all
columns in grids evenly spaced. See IOM.DefaultStyles.Grids and GridStyleTypes for details.

Repeating row headers across a grid. You can now repeat the row heading column cross a grid in a
similar way to how you repeat the column heading row. See Repeating Header Cells and
ICellStyle_RepeatSideHeader for details.

Error messages in grids. When a grid contains only one question, any error messages are displayed in
the same grid cell as the category header rather than in the same cell as the first response.

Naming grid templates in the script You can now name grid templates in the interview script using
theIOM.GridTemplate property.

Assigning initial responses to questions. The InitialAnswer keyword now works in the metadata
section and sets the initial answer for the current question. Documentation of this keyword in relation to
grids is available in Initial and Default Cell Values, but you can use it for other types of question too.

Digit grouping symbol. By default, digit grouping symbols, such as the comma used in English for
thousands, are not valid in numeric (long and double) responses. Use the
Question.Validation.AllowThousandsSeparator property to allow the use of digit grouping symbols. See
IValidation.Options for details.

Disallowing this symbol ensures that an error is displayed when a respondent incorrectly uses an
English-style decimal separator rather than one appropriate to his or her locale. For example, a German
user may enter a period (dot) to indicate a decimal point when mrInterview is expecting a comma to
match the settings in the German locale. If the digit grouping symbol is allowed, mrInterview will
interpret the period as a digit grouping symbol instead of displaying an error.

Other Specify. Response.Other now accepts categorical values.

Coded responses in categorical lists. You can now add coded responses to a categorical response list. This
allows you to separate “real” responses and coded responses into separate variables. For example:
CodedCat "Rating?" categorical[1..1]
{Resp1, Resp2, Resp3}
Codes({DK, REF});

Inserts with Other Specify. When a text contains a #QuestionName insert and the insertion text is an
Other Specify response, the interviewing program now displays “Other: respondent's answer”.

Unpopulated inserts. Inserts that are not populated now display as {insertname} rather than as empty text
so that they are more easily identifiable during testing.

Changed default for MustAnswer. The default setting for the MustAnswer property has been changed
from False to True so that the behavior of the interview scripting language mirrors that of the Build
activity.

MustAnswer with text questions that allow no response. By default, text questions accept anything
between 0 and 1024 characters as a response. If the respondent enters no text and the question is flagged
as requiring an answer (MustAnswer=True) there is a conflict. In this situation only, MustAnswer overrides
the MinValue property and the respondent must enter at least one character to continue.

This also applies to Other Specify. If the respondent selects this category he/she must type something in
the accompanying text box.

Note: If you test your scripts using the Auto Answer feature in mrStudio, this change may cause the test
to fail where previously it did not, because Auto Answer does not know that 0 characters are not allowed
as a response.
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Setting No Answer when no other categorical response is chosen. If MustAnswer=False (either
IOM.MustAnswer for all questions in the interview or Qname.MustAnswer for a particular question) and
the question has an NA category, this category is hidden and clicking Next without selecting a category
automatically selects the NA category.

Skipping questions with only special responses available. When a script has filtering that causes a
question to have only the special No Answer, Don't Know, and Refused responses available, the
interviewing program does not present this question during the interview even if it is flagged as
requiring an answer (that is, MustAnswer=True). The same applies to pages, blocks, and compound
questions where filtering means that there are no questions to present.

No answer, don't know, and refused. Special responses in text and numeric questions are now
automatically flagged as exclusive. In addition, default labels for the DK, NA, and REF keywords are
now read from the “Code” block within the “StandardTexts” block. If a label is not defined for the
current lcl for a DK, NA, or REF category, then the appropriate standard text is used. If no standard text
is present, then fixed texts defined in mrMsgDll are used.

Getting and setting response values. Question.Response.Value now supports the Format function.

Text substitution on multiple questions. Using # inserts allows you to make the same text substitution
on multiple questions, banners, and categories. The syntax is as follows:
v {#/. Qname } to insert the response to Qname, where Qname is at the root (document) level.
v {# Qname } to insert the response to Qname, where Qname is at the same level as the question

containing the insert (e.g., both at the root level or both inside the same loop.)
v {#^. Qname } (or {#^.^. Qname } etc.) to insert the response to Qname, where Qname is at the parent level

relative to the current question (or an ancestor depending on the number of ^. operators included).

Formatting codes. Formatting codes, as used by the Format function, are now supported. To specify
formatting when defining an insert, follow the insert reference with a colon and then the format code; for
example, {#Earnings:f2}.

For named inserts such as {Qname}, the format codes are always applied to the replacement text. The a,
A, b, and B codes have no effect. For index inserts such as {@}, the format codes are always applied to
the label for the specified iteration. The a, A, b, and B codes have no effect. For response inserts such as
{#Qname}, the format codes are applied to the Response.Value object.

All codes work (as long as they are appropriate) so, for example, if the response is a categorical value
then the “b” format code will get the label of the category. If the response is a numeric value, then format
codes such as f2 can be used. If no format code is specified for a categorical response, the “b” code is
applied automatically.

Percentage signs in texts. Invalid escape sequences in scripts are now ignored. The only valid escape
sequences are %%, %{, and %n. The result of this change is that percentage symbols can now be entered
normally in question and response text and will display correctly during interviews.

Which application is running the interview? It is now possible to check whether a script is being run
from mrStudio or mrInterview by using IOM.Info.IsDebug in the Routing section. This returns True if the
script is running in mrStudio and False if the script is being run in mrInterview. (To test whether the
interview is being run in test or active mode, you can use the existing IOM.Info.IsTest property.)

Terminating interviews. IOM.Terminate is now supported.
v Calling IOM.Terminate() always sets the {Signal} category for DataCollection.Status.
v If TerminateStatus is specified as tsCompleted, the {Complete} category is also set for

DataCollection.Status.
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v If TerminateStatus is specified as tsScriptStopped, the {ScriptStopped} category is set for
DataCollection.Status.

v The WriteData argument must currently always be True otherwise an error occurs. This will change in
a later release.

Termination signals. The Signals type definition defines signal values for use when terminating
interviews. The standard sample management scripts handle these signals but if other signals are added,
you will need to add them to your sample management scripts.

End of Interview and Interview Stopped messages. You can set these messages in the routing script
using IOM.Texts.EndOfInterview and IOM.Texts.InterviewStopped. See IOM.Texts for details.

Current response label. The Response.Label property returns the label for the current response, making
it easier to access the text of a response in the script. Instead of writing
Q1.Categories[Q1.Response].Label you can now write Q1.Response.Label. The property returns an
empty label for non-categorical responses; for Other Specify responses it returns the answer given by the
respondent.

Infinite loop detection. The read-write IOM.Info.MaxQuestionsOnReplay property lets you specify the
number of questions that can be answered automatically before the script is considered to be in an
infinite loop. The default is 4000 questions — that is to say, 4000 executions of an Ask() statement. If you
want a different value, you can set it in the interview script or you can include the parameter
I.MaxQuestionsOnReplay=n on the interview URL.

This property is used when an interview is restarted and the interviewing program needs to skip over
questions that have already been answered, or when a respondent selects Last from the Goto drop-down
in the navigation bar after snapping back to an earlier question. In the latter situation the interview is
re-executed in case the respondent changed an answer which then affects the path through the rest of the
script. If the respondent has changed an answer, it is possible that the new routing will take the interview
into an infinite loop through questions that already have answers. In this case the 'Last' navigation would
never get to the last question. The MaxQuestionsOnReplay property determines how many questions with
existing answers should be skipped before assuming that an infinite loop has occurred.

It is also theoretically possible for an infinite loop to occur when an interview is restarted via Sample
Management. In this case the interview is replayed to the last asked question using answers stored in the
database. This type of infinite loop is less likely to occur because the replay stops when the last asked
question is reached.

MaxQuestionsOnReplay is related to the existing MaxOpcodesExecuted property that prevents infinite loops
occurring between Ask() statements.

The mrIEng interview engine sets the MaxQuestionsOnReplay property based on the MaxQuestionsOnReplay
registry value stored in HKEY_LOCAL_MACHINE\SOFTWARE\SPSS\mrInterview\3\Interviewing.

Finding the respondent's locale. The IOM.Locale property picks up the respondent's locale so that it can
be used by formatting functions in the routing script.

Validating responses. The IValidation.Function property allows you to run a custom validation function
on a question of your choice as part of the standard validation that happens when the respondent
answers a question. You define the function in the routing section of the script and then call it for a
question by typing Qname .Validation.Function=" Function_name " before asking the question.

The Complex Questions example scripts in the Dimensions Development Library have been updated to
use Validation.Function.
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Accessing the project name. The IOM.ProjectName property makes the project name available to the
routing section of the interview script.

Filter and QuestionFilter properties. Category values (integers) can now be used in these properties as
well as Categoricals. See ICategory.Filter and IQuestion.QuestionFilter for details.

Activation on or between clusters. When activating on a cluster or between clusters, the activation
process now checks that all interviewing servers have the same version of the ActivateServer.dll
component installed as is installed on the machine you are working on. If it finds a mismatch, activation
fails at that point and you will have mismatched project files on the interviewing servers. When this
happens, you may usually continue by manually copying the project files to the servers that have not
been updated. However, the best solution is to ensure that all machines in the cluster are running the
same version of mrInterview.

Activation on machines with Turkish operating systems. The Activate process always uses an uppercase
version of the filename as the project ID (for example, activating drinks.mdd generates a project whose ID
is DRNKS). In order to avoid file validation issues when activating projects whose names contain the
letter i or ı, you should always save the .mdd file with an uppercase name before activating.

What's New in mrStudio 3.0
What's new in mrStudio 3.0 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Interview Scripting

v Table Scripting

v Table Scripting Samples

mrStudio IDE

Interview Option. You can use the new Interview Option to develop and test interviews in mrStudio 3.0
before activating them in mrInterview 3.0.

A new look and feel. The standard theme is now based on that of Microsoft Visual Studio 2005. You can
also select from several other themes.

Enhanced toolbars and menus. Toolbars and menus can now “float” and “dock”. Toolbar buttons have
been added for common tasks such as Page Setup, Print Preview, and Print.

Easier to work with multiple files. It is now possible to view several open files simultaneously by
arranging them horizontally or vertically within the workspace.

Layouts can be customized for different tasks. mrStudio now restores the layout you were using when
you last edited, run, or debugged a script, or when you run an interview script in Auto Answer mode.
For example, if you increase the size of the output pane while a data management script is running,
mrStudio will automatically make the output pane that size when you next run a script.

Enhancements to ScriptAssist. Two new keyboard shortcuts, have been introduced that can be used to
activate ScriptAssist in an interview script. Pressing Ctrl+Q in a blank area of the script will now display
a list of all the questions defined in the metadata section. If Ctrl+Q is pressed again after selecting a
question, a list of any sub questions appears. If Ctrl+R is pressed after selecting the name of a categorical
question, the category list appears.
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Extended hardware support. mrStudio now supports the mouse tilt wheel.

Data Management Scripting

Case data merge. You can now use a data management script to combine the case data from two or more
data sources into a single data source.

Data Management Samples

Case data merge. Three new sample scripts have been introduced that demonstrate how to run a case
data merge. They are MergeHorizontal.dms, MergeVertical.dms, and STAfSMerge.dms. The last script also
demonstrates how to merge coded data that was produced using SPSS Text Analysis for Surveys (STAfS).
with the original mrInterview data.

Interview Scripting

Release 3.0 of the Dimensions products sees the first full release of the new Interview Scripting Language
and Interview Object Model, which provide a powerful yet flexible replacement for Quancept scripting.
The documentation effort in replacing the Quancept and mrInterview Scriptwriter's Manual is immense
and will take many months to complete, but all the necessary information is available in various forms in
Dimensions Development Library. The documentation provided with version 3.0 falls into three
categories:
v User documentation. This is the replacement for the Scriptwriter's manual and describes how to write,

activate and test scripts. It describes all the basics of writing scripts, but does not yet cover all the more
complex scripting that is possible in the Routing section, and there is very little on templates and
styles. This section will continue to expand over future releases of Dimensions Development Library,
and we welcome your suggestions on topics you would like to see in future releases.

v Example scripts. Dimensions Development Library installs a number of example scripts that you can
use as the basis for your own scripts or simply as a means of learning more about how interview
scripting works. These example scripts and templates are normally installed into subfolders within
\Scripts\Interview. You'll find them useful supplements to the user documentation; in particular, the
files in the Templates subfolder are a good source of information and ideas about templates and styles.
The Scripts folder is constantly being updated with new scripts, so refer to the
InterviewScripts_ReadMe.htm file in that folder for up to date details.

v mrScriptMetadata and mrScriptBasic documentation. These sections document the syntax of all the
statements that you may use in an interview script in a precise and factual way. If you cannot find
what you want in the user documentation, these sections are good places to look for information.

v Interview Scripting Object Model. Programmer's documentation describing the objects, methods and
properties available for interview scripting. This is a good place to look for help when you are writing
the Routing section of an interview script.

This section also contains the Sample Management and Quota Control sections that were previously part
of the mrInterview section of Dimensions Development Library documentation.

What's New in mrStudio 2.3
What's new in mrStudio 2.3 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Interview Scripting

v Table Scripting

v Table Scripting Samples

mrStudio IDE
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This new version includes an improved ScriptAssist and the option to view two parts of a script
simultaneously by splitting the Edit pane. Also reintroduced in this version is the ability to expand and
collapse sections of code such as events and functions.

The improvements to ScriptAssist are as follows:
v Pressing Ctrl+Space anywhere in a Data Management Script, a mrScriptBasic Script or the Routing

section of an Interview Script will display ScriptAssist's global suggestion list.
v The global suggestion list now includes the following intrinsic objects: mr, debug and err (in all script

types); dmgrJob, dmgrQuestions, dmgrLog, dmgrWeightEngines, dmgrTableDocuments, dmgrGlobal (in Data
Management Scripts only); The Interview Object Model (in Interview Scripts only). Intrinsic objects are
distinguished by a blue icon in the suggestion list .

v In Interview Scripts, the global suggestion list now also includes all Question variables.
v Pressing Ctrl+M displays a suggestion list of macros that are relevant to the type of script you are

editing.

The new version of Data Model, version 2.10, includes internal improvements and new DSCs.

Data Management Scripting

Text substitution in concatenated strings must no longer be indicated with __STRING__. You need not
preface the Search text with __STRING__ when using text substitution in a concatenated statement.

The ++ operator no longer required. In connection strings or SQL statements in the Input and Output
sections of a DMS file, use the + operator; the ++ operator is no longer required in order to avoid conflict
with SQL syntax.

The optional text-substitution feature of the Include statement is no longer supported. The syntax of
the #include statement no longer supports the use of optional search and replace values. To replace text
in an Include file, use the #define statement.

Interview Scripting

Table Scripting

Changes since version 2.2 include:
v You can now define elements that contain the result of a calculation based on other elements, using a

derived element.
v You can now change the default label for a variable in a table axis, using the syntax variable

[’label-text’]. For example, if you have a table of age * gender, the default labels for the variables
are Age of Respondent and Gender of Respondent. To change the label for the age variable, you could
use the script: age ’Age Range’ * gender. You can also specify labels to use for other languages, using
the syntax: variable [LanguageID:’label-text’], for example, age ENU: ’Age Range’ ESN:’Edad’.

v You can now include the same variable twice in one axis, using the new variable as axis_name
syntax. In the current release, this method is available only in mrStudio Tables option, not in mrTables.
However, a similar result can be achieved in mrTables by using the Copy Variables feature to create a
duplicate variable.

v You can now use the * character in element labels and within element expressions.
v You can now control whether or not raw statistical diagnostics data is calculated when a table

document is populated. The default is that the data is not calculated.
v If you display information on statistical tests in table annotations using the {Statistics} macro, the

annotation 'invalid' is now displayed if an invalid statistic is added to the table. Previously, statistics
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annotations were suppressed for a table if an invalid statistic was added. A new switch, \i-, is
available to suppress the annotation if the statistic is invalid for the table, replicating the previous
behavior.

v A new Export property, HorizontalSideAxis, enables you to choose between displaying the text on a
side axis horizontally or vertically when you export to HTML. The default is to display the text
horizontally (in previous versions, side axis text was always displayed vertically).

v A new method in the Table Object Model, IDocument.OpenWithDataSet, is available for use when
opening table document (.mtd) files. You can use this method to override the location of the metadata
or case data stored in the (.mtd) file. For further information, see IDocument.OpenWithDataSet.

Table Scripting Samples

New Scripting Sample

Dimensions Development Library 2.3 comes with the following new table scripting sample:

CombineGridSlices. Shows how to combine elements that are grid iterations.

Updated Scripting Samples

CellValuesAndLabels. This script has been updated to use the ElementHeadings collection instead of the
Elements collection. This has the benefit that the order of elements in the ElementHeadings collection is
updated when the table sorted, as well as automatically reflecting any hidden elements.

MoreOnConcatenatingAndNesting.mrs. Updated to add an example of using the as syntax for
specifying a variable twice in the same axis.

SpecialElements.mrs. Updated to add tables illustrating the use of derived elements.

What's New in mrStudio 2.2
What's new in mrStudio 2.2 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Table Scripting

v Table Scripting Samples

mrStudio IDE

mrStudio now supports improved editing, improved search and replace features, and improved printing
of scripts with better control of formatting and page setup. You can also now edit a script when an error
has arrested the execution of the code.

The new version of the Data Model, version 2.9, includes internal improvements and new DSCs.

Data Management Scripting

Debugging the mrScriptBasic sections of DataManagementScript files. You can now use the full range
of mrStudio debugging features to debug the Event section of your DataManagementScript (DMS) files,
such as stepping through code, setting breakpoints, and examining the values of variables when
execution has been halted.
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ScriptAssist in the mrScriptBasic sections of DataManagementScript files. You can now use ScriptAssist
in the Event section of your DataManagementScript (DMS) files.

Change of Syntax Due to New Preprocessor

The following now must be enclosed in quotes:

v Connection strings.
v Any SQL queries.
v Any parameters to sections that are free text (typically the second description parameter).
v Filenames outside the Event section.
v All properties in the logging section except FileSize.

Text substitution in concatenated strings must be indicated with __STRING__. When using text
substitution in a concatenated statement, you must preface the Search text with __STRING__.This will
ensure that the preprocessor does not cause the Search text to be confused with the Replace text.

Use of the ++ operator. In the connection strings or SQL statements in the Input and Output sections of a
DMS file, you must use the use ++ operator instead of just the + operator. This is because the Input
sections are not interpreted by the mrScriptBasic engine so the normal + operator does not work for
concatenation. ++ was chosen as + would conflict with SQL syntax.

The syntax for using the #define keyword for substituting text in a DMS file has changed. The new
syntax is:

#define Search Replace

Samples with duplicate content have been consolidated.

Data Management Samples
v The sample DMS files have been tested using mrStudio 2.2.
v The samples have been revised to reflect changes to the syntax due to a new preprocessor.

Table Scripting

Changes since version 2.1 include:
v Control over display of percent signs in a table. You can now choose whether or not to display percent

signs in a table.
v Display of currency symbols and other text in a cell. You can now specify a prefix or suffix for a cell

item. You can use this feature to display currency symbols or other text in a cell.
v Improved control over the creation of summary statistic tables. You can now create tables that display

summary statistics for numeric variables. For example, you can create mean summary tables.
v Improved control over the inclusion and exclusion of special responses from the base count. You can

exclude categories from the calculation of the base using the new IncludeInBase property.
v Ability to add an expression to some special element types, for example, to restrict the cases included

in a base, mean or sample variance.
v Ability to specify the number of decimal places of a summary statistic element.
v New wizard to assist in the creation of custom mrTables export components.
v Ability to run a paired preference test.
v Ability to attach images to elements and export them to HTML files.
v Ability to specify the calculation scope for elements that use factors. You can now determine whether

you want mean or other summary statistics that use factors to be calculated for only those elements
preceding the statistic, or for all elements.
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v Ability to assign a statistic to a variable, so that the statistic is automatically generated for a table when
the variable is placed on the appropriate axis. By using the custom properties TstatProp, TstatMean or
TstatPPT for a variable, you can automatically generate a column proportions, column mean or paired
preference test when the variable is placed on the appropriate axis (top for the column proportions and
column means tests, and side for the paired preference test).

v Ability to remove elements from a table depending on whether they appear in a row or column. This
allows you, for example, to remove special items from Quanvert that appear on the top axis.

v Ability to determine whether an element exists in a specific version of the metadata and calculate
percentages based on numbers of respondents who were asked a question compared to the number
who answered.

v Ability to specify a custom stylesheet when exporting tables to HTML.
v Ability to configure the display of significance letters when exporting tables to Excel using the

MergeColPropResults Excel Export property.
v The DataSet object now has an additional property, CanChangeView, which checks whether or not it is

valid to change the data view. For further information, see the IDataSet object.
v The Table object now has an additional property, DefaultLevel, which returns the default aggregation

level for a table containing hierarchical data. For further information, see the ITable object.
v The Table object now has an additional property, IsValid, which checks whether a table is valid or not

(tables become invalid if they use variables that have been deleted). For further information, see the
ITable object.

Additional enhancements and changes to behavior

v Bases displayed as counts when cell contents are percentages. In a table that contains only percentages,
the base cells now automatically display total counts for the row or column, instead of showing 100%.

v Change of behavior of base elements inside nets. In mrStudio Tables Option 2.1 and earlier, a base
element inside a net would include all cases in the variable. It now includes only cases within the net.

v Elements from Quantum or Quanvert that are unable to be processed by mrTables are now displayed
as XXXXX instead of 99999.

v It is now possible to tabulate arrays of type mlLevel, provided that they have elements.

Table Scripting Samples

New Scripting Samples

Dimensions Development Library 2.2 comes with a number of new table scripting samples.

CellPrefixAndSuffixUsage.mrs. Shows how to define prefix and suffix properties for cell items.

DecimalPlacesOnSummaryElements.mrs. Shows how to specify decimal places for summary statistic
elements.

DisplayElementImages.mrs. Shows how to attach images to elements and export them to HTML files.

IncludeInBase.mrs Provides examples of excluding categories from the base calculation using the
IncludeInBase property.

PairedPreferenceTest.mrs. Creates a paired preference test.

PercentageOnElementsAsked.mrs. Uses the IsElementInVersions function to determine whether an
element exists in a specific version of the metadata and calculate percentages based on numbers of
respondents who were asked a question compared to the number who answered.
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SummaryStatisticTables.mrs. Shows how to create tables containing summary statistics of numeric
variables.

Updated Scripting Samples

In addition, a number of existing scripting samples have been updated.

HTMLExportOptions.mrs. This script now includes an example of creating a custom stylesheet.

RDBTables.mrs. This script now includes an example of hiding an element only if it appears in a row.

SpecialElements.mrs. This script now includes an example of adding an expression to the base element.

What's New in mrStudio 2.1
What's new in mrStudio 2.1 is summarized under the following headings:
v mrStudio IDE

v Data Management Scripting

v Data Management Samples

v Table Scripting

v Table Scripting Samples

mrStudio IDE

The main Edit window now has a shortcut menu and the Expressions pane has a new Execute button.

The new version of the Data Model, version 2.8.1, includes internal improvements and a new version of
the Quanvert DSC, which supports packed Quanvert databases.

Data Management Scripting

Transferring data from packed Quanvert databases. You can now transfer data from a packed Quanvert
database without manually unpacking it first.

Working with system variables. Previously, if you specified in the select query in the InputDataSource
section one or more of the system variables, all of the system variables would be included in the output.
(However, case data would be transferred for the system variables that were specified only.)
Improvements in Data Model 2.8.1 mean that now only the specified system variables will be included in
the output. For example, if you specify Respondent.Serial and no other system variables in the select query,
the output will now include Respondent.Serial and no other system variables.

Working with helper fields and variables inside metadata blocks. Previously, when you specified in the
select query in the InputDataSource section a helper field or a variable that was nested inside a block
(Class object) in the metadata, the parent object and all of its child objects would be included in the
output (although case data would be transferred for the variables that were specified in the select query
only.) Improvements in Data Model 2.8.1 mean that now only the specified variables will be present in
the output. However, the parent object will be included in the output metadata, but other sibling objects
that have not been specified in the select query will not be present. Note that this does not apply to the
variable instances that represent the "slices" of a grid or loop. If you specify in the select query one or
more variable instances that relate to a variable inside a grid or a loop, all of the related variable
instances will be included in the output, but case data will be transferred only for the variable instances
specified in the select query.

Table Scripting in a DMS file. This section has been expanded to include an example that sets up axis
expressions in the metadata using mrScriptBasic code in the OnBeforeJobStart Event section.

Chapter 7. What's New in IBM SPSS Data Collection Professional 149



Releasing the MDM Document. In previous versions of mrStudio, it was not necessary to release the
MDM Document if you opened it in an Event section. However, the migration of some of the Data Model
components to .NET has changed the way that objects are released. This means that if you call the MDM
Document.Open method explicitly, you should now call MDM Document.Close at the end of the relevant
code to release the Document object. If you do not do this, you may get an error, typically containing the
text "The process cannot access the file because it is being used by another process". Note that calling
Document.Close is not necessary if you open the Document in NoSave mode. For an example of calling
Document.Close, see OnAfterMetaDataTransformation Event Section.

Transferring hierarchical data. In mrStudio 2.1, when you transfer data using a DMS file and the IBM
SPSS Data Collection OLE DB Provider, the flattened (VDATA) view of the data is always used. This
means that you can use a DMS file to export hierarchical data only if it can be represented in a flattened
form. This is true for all hierarchical data collected using mrInterview and earlier and mrPaper and
mrScan. However, you cannot use a DMS file to transfer hierarchical data that was collected using other
tools if it cannot be flattened--for example, because it was collected using an unbounded loop. The lower
levels in a Quanvert Levels are an example of this type of hierarchical data, and you therefore cannot
export data from the lower levels of a Quanvert levels project using a DMS file.

Data Management Samples

Samples. This version of the Dimensions Development Library comes with a number of new and
improved data management samples.
v The sample DMS files have been tested using mrStudio 2.1.
v TablesDefineAxesExportToRDB.dms. This new table scripting sample DMS sets up summary axis

expressions for all numeric variables.
v QuanvertPkdToXml.dms. This provides an example of transferring data from a packed Quanvert

database.
v mrInterviewNextBatchNewVersionToSav.dms, mrInterviewMoreVersionsToSav.dms. These samples

have been rewritten to use the functionality built into the MDM itself, rather than the MDM Manager
component, which has now been deprecated.

v Releasing the MDM Document. The samples that call the MDM Document.Open method in the
OnBeforeJobStart or OnAfterMetadataTransformation Event sections have been updated to call the
Document.Close method. This is now necessary to release the MDM Document, because of a change in
the way objects are released due to the migration of some of the Data Model components to .NET.

Table Scripting

Changes since version 2.0 include:
v Dimensions Data Model 2.8.1. mrStudio 2.1 comes with Data Model 2.8.1, in which the Quanvert DSC

has a major new feature that enables it to read data in a Quanvert packed project (.pkd file). For an
example of loading Quanvert data from a .pkd file, see 14. Loading Other Types of Data.

v Word Tables Export. This new section provides information about the new component for exporting
tables and charts to Word.

v Text Export. This new section provides information about the new component for exporting tables to a
text file.

v New HTML Export Property. The HTML Export component has a new UseFormattedLabels property,
which enables you to export element labels with HTML formatting. The new FormattedLabels.mrs
sample provides an example of using this option.

v Working with axis expressions. This new section provides information about setting up axis
specifications for variables in the metadata. This makes it easy to tabulate numeric and other
non-categorical variables in mrTables 2 and your table scripts.

v Valid Annotation HTML Tags. This topic now provides more information and new examples.
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v Bases in nested tables. When variables were nested on the side or top axis, previously mrStudio did
not create autobase elements in the outermost variables. This anomaly has now been corrected and
autobase elements are now created in the outermost variables.

v Reference. This section has been updated to reflect changes in the Table Object Model (TOM) in
mrStudio Tables Option 2.1. Most notably, the Document class has a new GenerateScript method. See
the IDocument.GenerateScript method for more information.

Table Scripting Samples

Dimensions Development Library 2.1 comes with a number of new and improved table scripting
samples.

AllFieldsAndShowOpenEnds.mrs. This is a new advanced script that demonstrates how to generate
table syntax to summarize numeric variables, how to automatically categorize Boolean variables, how to
change the cell contents to show row percentages in a grid table instead of the default column
percentages if the default orientation of the grid requires this, and how to embed the answers to text
questions directly within your tables. (Note that this is accomplished by accessing the Data Model using
ADO.)

Annotations.mrs. Now includes using the <FONT> tag to format an annotation and the <IMG> tag to
insert a logo.

AutoCategorizeWordTopLines.mrs. Another new advanced script that demonstrates how to intelligently
define a table for a numeric question. This is accomplished by determining the number of unique
answers to the numeric question (using the Data Model). If there are fewer than a specified number of
unique answers, the script bands the numeric question, defining one band for each unique answer. If
there are more than the specified number of unique answers, it makes a summary table. Similarly for text
(open-ended) questions, the script determines the number of unique answers. If there are more than a
specified number of answers, it displays the text answers themselves and if there are fewer than the
maximum number of unique answers, it autocodes them, defining one category for each unique answer.
The raw text answers are placed in a separate HTML file that can by URL-accessed from the Word
export. Note that this is an advanced feature and understanding this part of the script requires
knowledge of XML, XSLT, and the MSXML DOM. This script also demonstrates using a customized Word
template. Note that this script may not be suitable for text variables that store some non-alphabetic
characters, such as line feeds.

AutoSummarizeNumerics.mrs. Demonstrates creating summary tables for all of the numeric variables in
a data set.

AutoSummarizeNumericsAndSave.mrs. This is similar to the AutoSummarizeNumerics.mrs sample except
that the axis expressions are written to the metadata permanently and grid tables are created for any
numeric variables nested inside a grid.

FilterOnAgeGroups.mrs. Demonstrates setting up tables that are filtered on each category of a categorical
variable.

FormattedLabels.mrs. Demonstrates setting up HTML formatting in the variable and element labels and
exporting them to HTML using the UseFormattedLabels HTML export property.

TextExport.mrs. Demonstrates exporting tables to a .csv text file.

WordExport.mrs. Demonstrates exporting tables to Microsoft Word. To run this sample, you need to have
Microsoft Office 2000 or later installed.
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What's New in Data Management Scripting 2.0
What's new in Data Management Scripting 2.0 is summarized under the following headings:
v Data Management Scripting

v Data Management Samples

v Table Scripting Samples

Data Management Scripting

This section, previously called the mrDataManager section, has been renamed the mrStudio Data
Management Scripting section to reflect the fact that mrDataManager has been replaced by mrStudio.

Creating a Quantum specification. mrStudio 2.0 comes with Data Model 2.8, which includes a new
version of Quantum DSC that has a new MDSC capability. This means that it is now easy to include code
in your DMS and .mrs files to write out a basic Quantum specification to match the card, column, and
punch definitions in the metadata. Most of the sample DMS files that export data to Quantum have been
updated to include code to do this.

Creating "Total Awareness" variables. When you create a derived variable by combining two or more
existing categorical variables, you no longer need to specify the categories.

Accessing the Job object in the OnAfterJobEnd Event section. Provided you have specified an input
metadata source, the Job object is now available in the OnAfterJobEnd Event section. You can use the Job
object to access all of the other objects to which it gives access (with the exception of the Questions
collection).

Table scripting. If you have the mrStudio Tables Option, the Job.TableDocuments property returns a
collection of TableDocument objects, one for each suitable output data source. Note that although you can
define your tables in the OnJobStart, OnNextCase, OnJobEnd, and OnAfterMetadataTransformation Event
sections, you cannot populate or export your tables in these sections. (Attempting to do so may lead to
an error.) You should populate and export the tables in the OnAfterJobEnd Event section.

Line numbers in error messages. Line numbers shown in error messages displayed by mrStudio and
DMS Runner are now shown relative to the start of the start of the expanded DMS file. This is a change
of behavior compared to mrDataManager 1.0, where the line numbers were shown relative to the section
in which the error occurred. This change means that it is now easy to locate the line on which the error
occurred in mrStudio, provided you use the option to display the line numbers. Note that the line
numbers refer to the file after any #include and #define statements have been expanded and comments
between sections have been removed. You can use the DMS Runner /a: option to save the expanded
DMS file, which you can then open in mrStudio.

Other Specify responses. You can now access Other Specify responses in the OnNextCase Event section.
A problem in mrDataManager 1.0 that prevented you doing this has now been fixed.

New DataSources.Remove method. This new method is useful for removing the input data source object
when programming against DMOM.

Data Management Samples
v Most of the samples that export data to Quantum, now also export a Quantum specification.
v The Dimensions Development Library now comes with a number of new samples for creating tables

using the new mrStudio Tables Option.
v The new GetOtherSpecifyText.dms sample provides an example of accessing the responses to an Other

Specify category in the OnNextCase Event section.
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v The MSExcelTransferToFromXML.dms and MSExcelTransferToFromRDB.dms samples now include an
OnBeforeJobStarts Event section that creates the empty Excel file.

Table Scripting Samples
v A number of new sample mrScriptBasic (.mrs) files that demonstrate using the mrStudio Tables Option

to create market research tables using a script.

What's New in Data Management Scripting March 2003
What's new in Data Management Scripting March 2003 is summarized under the following headings:
v Data Management Scripting

v Data Management Samples

Data Management Scripting

You typically use a superversion when you want to export or analyze response data that has been
collected using more than one version of the questionnaire. See:
v Understanding Versions
v Selecting Multiple Versions
v WinDMSRun Window: Selecting Versions

Scheduling the running of DMS files. The documentation now covers using the At command and the
Windows Scheduled Task wizard to schedule the execution of your DMS files, for example, during the
night or at regular intervals.

Cleaning Multiple Response Questions. The 4. Cleaning Other Question Types topic now shows you
how to iterate through the responses in a multiple response question.

Creating New Variables. The 3. Creating Filter Variables topic now provides information on working
with Null values.

Troubleshooting and FAQs. The following topics now include additional information:
v General Queries
v Running DMS Files
v How To Set Up Specific Jobs
v SQL Syntax
v Metadata Section FAQs
v Event Section Problems
v Other Common Errors
v Weighting
v Programmer's FAQs

Data Management Samples

New sample DMS files. The following samples were new in Dimensions Development Library - March
2003:
v CreateDRS.dms. This writes the Short Drinks sample case data to a text file in the standard Quancept

.drs format. This sample demonstrates a recursive subroutine call, accessing category attributes, dealing
with multiple response values, retrieving category labels, and a replace string function. Note that this
sample does not export the Other Specify texts.
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v mrInterviewAllVersionsToQuantum.dms. This sample shows you how to select all versions when
opening the metadata for use with the MDM2Quantum component and during the export of data to
Quantum.

v mrInterviewAllVersionsToSav.dms. This sample replaces the mrInterviewMergeAllVersionsToSav.dms
sample and is designed for exporting to SPSS data collected with all versions of the metadata.

v mrInterviewMoreVersionsToSav.dms. This sample replaces the mrInterviewMergeMoreVersionsToSav.dms
sample and is designed to be run after mrInterviewAllVersionsToSav.dms. It merges all versions of the
project's metadata into the output metadata from mrInterviewAllVersionsToSav.dms so that wherever
possible the alias names are reused.

v mrInterviewMultipleVersionsToSav.dms. This sample shows you how to select two versions of the
metadata and export only case data collected using those versions and their minor versions.

v WeightingFactors.dms. This uses the Weight Component to set up weighting based on known
weighting factors based on age groups and gender. A derived categorical variable is set up in the
Metadata Section for the age groups on which the factors are based.

v WeightingTargets.dms. This is similar to the WeightingFactors.dms sample, except that it uses weighting
targets rather than factors.

Existing sample DMS files. The main changes are:
v mrInterview Batch exports to Quantum. These samples now use all versions of the metadata for the

export. This means that the samples can handle exporting to the same .dat file when categories and
variables have been deleted in new versions. However there are some potential problems that you
should be aware of.

v MDM2Quantum. The samples that use the MDM2Quantum component in the OnBeforeJobStart Event
section now use the DataSources.Find method to search for a Quantum DSC data source. This is the
recommended way of searching for an existing data source in an .mdd file.

v MSWordToplines.dms. This sample now shows percentages, category labels, and question texts,
formats the output in Word, and saves the output to a Word .doc file and an HTML file.

v MSExcelCharts.dms. This sample now calls the Quit method on the Excel object. Unfortunately the
sample released with the Dimensions Development Library - November 2002 did not do this, which meant
that the Excel object did not get released from memory correctly.

v MSPowerPointCharts.dms. Similarly, this sample now calls the Quit method on the PowerPoint object.
There was also another problem in the version of this sample released with the Dimensions Development
Library - November 2002, which meant that when you double-clicked on any of the PowerPoint charts,
the chart would revert to the default data chart. This problem has now been corrected.

v NewVariables.dms. This sample has been updated to include the new example included in the 3.
Creating Filter Variables topic.

v MSExcelDataViewer.dms. This sample now displays the category name rather than the label.
v QuanvertToSav.dms. This sample has improved code for cleaning up the Quanvert-specific information

in the .mdd file.
v AdvancedCleaning.dms. This sample now uses the data type constants that are built into

mrScriptBasic.
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Chapter 8. What's New in IBM SPSS Data Collection
Interviewer

This section summarizes changes in the various IBM SPSS Data Collection Interviewer product versions.

What's New in IBM SPSS Data Collection Interviewer 7
The following enhancements have been made to the IBM SPSS Data Collection Interviewer 7.

Configuration Wizard. The Configuration Wizard now provides options for synchronizing projects to
multiple server clusters. See the topic "IBM SPSS Data Collection Interviewer - Advanced Configuration"
for more information.

Support for participants. Participant records can now be assigned in IBM SPSS Data Collection
Interviewer Server Administration and synchronized to interviewers to support directing interviewers to
particular respondents. This includes synchronizing participant records and history, displaying participant
records in the case list, and the ability to select contact outcomes while interviewing.

Support for quota. Quota targets can now be assigned to interviewers and tracked. This includes
assigning quota targets using percentages or specific numbers per interviewer, synchronizing quota
targets and completes, checking quotas during respondent selection or interviewing, and viewing quota
information. See the topic "The Quota Viewer" for more information.

Start interviews via the command line. You can now start interviews, and issue related commands, via
the command line. See the topic "Starting an interview from the command line" for more information.

Support for multiple data sets. IBM SPSS Data Collection Interviewer now supports importing and
exporting data from multiple data sets. This allows supervisors to manage and synchronize data from
multiple interviewers. Refer to the topics "Importing a project" and "Creating a data file for analysis" for
more information.

Live Interview Player. This new feature allows you to conduct surveys in web or telephone mode. If the
project includes participant records, the Live Interview Player provides a participant and outcome
interface for sample management. See the topic "The Live Interview Player" for more information.

Synchronization options. Projects can now be selected for manual or automatic synchronization. See the
topic "The IBM SPSS Data Collection Synchronization Console window" for more information.

Synchronization Console. The Synchronization Console has been updated to display the current activity
data for each cluster. The most recent synchronization appears at the top of the display. The summary
panel at the top of the screen reflects the current synchronization status. See the topic "The IBM SPSS
Data Collection Synchronization Console window" for more information.

Suspend synchronization. You can now suspend an active synchronization via the Synchronization
Console. See the topic "The IBM SPSS Data Collection Synchronization Console window" for more
information.

Project information. Each active project now displays pertinent information in a new banner at the top of
the screen and in the Project Information pane. The information includes the cluster name, current user
name, and active project name. The Data Entry Player displays the project name, batch ID, entry mode,
and unique ID in the banner.
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Case List filter. This new feature provides various filter functions. You can define custom filters, select
the preset filter, or update the preset filter. See the topic "The Case List filter" for more information.

Category search. The new search feature provides options for filtering the displayed categories in the
Response List pane. See the topic "Category search" for more information.

Enhanced cluster support. Interviewers can now register with each defined server cluster.

Client certificate support via smart card authentication. Client certificates are now supported via smart
card authentication. Client certificates are used to secure access when synchronizing with interview
servers. A valid PIN number is required when employing client certificates via smart card authentication.
Users who cannot provide the appropriate client certificate and PIN number are not allowed to
synchronize with the interview servers. Refer to the "Working with client certificates to secure accessory
server access" topic for more information regarding client certificates.

Client certificate support in SSL environments. Client certificates are now supported in SSL
environments. Client certificates are used to secure access when synchronizing with interview servers.
Users who cannot provide the appropriate client certificate are not allowed to synchronize with the
interview servers. Refer to the Working with client certificates to secure accessory server access topic in the
IBM SPSS Data Collection Desktop 7.0.1 Installation Guide for more information regarding client certificates.

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > >About IBM SPSS Data Collection Interviewer... > >Details...

What's New in IBM SPSS Data Collection Interviewer 6.0.1
Improved synchronization control. You can now select individual projects and project batches to
synchronize with the IBM SPSS Data Collection Interviewer Server.

Project expiration date settings. You can now view project expiration date and time settings (if so
defined).

New audit data format. Prior to this release, the DataCollectionAudit.ddf stored data based on one record
per interaction. The problem with this method was that most reports require data per respondent. In
order to build report scripts, this method requires merging the original data, which adds an unnecessary
level of complexity. The new audit data format allows IBM SPSS Data Collection Interviewer Server
Administration to directly generate audit data as one record per respondent. This saves a considerable
amount of work when writing scripts. The new audit data is stored to a central .ddf file providing for a
more simplistic data merge process. The new audit files, DataCollectionAudit_Analysis.mdd and
DataCollectionAudit_Analysis.ddf supersede the prior DataCollectionAudit.mdd and DataCollectionAudit.ddf
files.

CreateOperatorReports.mrs - This script uses the IBM SPSS Data Collection Interviewer
DataCollectionAudit_Analysis.mdd and DataCollectionAudit_Analysis.ddf files to generate audit related
reports. The script can be run via mrScriptCl.exe or IBM SPSS Data Collection Professional, and is located
in the default installation directory: [INSTALL_FOLDER]\IBM\SPSS\DataCollection\[version]\DDL\Scripts\
Interview. Before running the reports, you will need to either copy the report script to the directory
where the DataCollectionAudit_Analysis.mdd and DataCollectionAudit_Analysis.ddf are stored, or update the
script (METADATA and DBLOCATION are defined at the top of the script) to point to the appropriate file paths.
These files are typically located at: C:\Documents and Settings\<running user>\Application
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Data\IBM\SPSS\DataCollection\6\Interviewer\Config\Audit. You may also want to update the OUTPUT
define setting (this defines the name and location of the output file). The output files are named
OperatorReport.mtd and OperatorReport.htm and are located in the current directory. However, you can
provide a different path and file names via the OUTPUT define setting. Once you have updated the
settings, you can run the script from a Windows command prompt using: "mrScriptCl.exe
CreateOperatorReports.mrs". This will create an output .htm file of exported tables as well as an output
.mtd that you can use in IBM SPSS Data Collection Survey Reporter for more investigation.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

What's New in IBM SPSS Data Collection Interviewer 6
PASW Interviewer is now Interviewer. Starting with version 6, the product formerly known as Interview
Player is now called Interviewer. The new name is reflected in the interface and many installed product
elements, such as files and folders. In addition, many other products in the Data Collection family have
been renamed. For more information, see the What's New in DDL 6 topic in the IBM SPSS Data Collection
Developer Library.

Single Keystrokes Replace Multi-Stroke Actions. A number of actions that previously required multiple
keystrokes--such as Alt+P for previous--can now be accomplished with a single keystroke, as well as the
original multi-stroke combination.

Automatic Advancement. The Data Entry Player now supports automatic advancement to the next
question for single response questions and automatic insertion of separator characters for multiple
response questions.

Changing Languages. The Data Entry Player now supports questions that change the language in which
subsequent questions and answers are displayed.

What's New in Interviewer 5.6
Interviewer Player is now Interviewer. Starting with version 5.6, the product formerly known as
Interview Player is now called Interviewer. The new name is reflected in the interface and many installed
product elements, such as files and folders. In addition, many other products in the Data Collection
family have been renamed. For more information, see the What's New in DDL 5.6 topic in the Data
Collection Developer Library.

Interviewer 5.6 adds the capability to use application features in a non-server environment, enabling the
transfer of files through more traditional means (for example, LAN, or saving to storage media).

Data Entry Player. The Data Entry Player was added to provide an interface for rapid, heads-down data
entry. The player supports keying in multiple passes by one or more operators, including full and partial
verification waves. Data Entry Player also provides effective tools for resolving conflicts and ensuring
data quality. Data Entry Player supports survey logic for outputting cleaner data files for analysis.

Configuration Wizard. The Configuration Wizard was updated with an alternative for more basic
configuration options, enabling quick Interviewer start-up.

What's New in Interview Player 5.5
There are no significant changes or additions for the Interview Player 5.5 release.
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What's New in Interview Player 5.0
Interview Player is a new, fully integrated mobile interviewing solution including the Interviewer Console,
IBM SPSS Data Collection Synchronization Console, and Remote Manager components. Interview Player was
released with 4.5 as a standalone tool for running interviews. New functionality added in 5.0 makes the
entire mobile interviewing process streamlined and manageable.
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Chapter 9. What's New in IBM SPSS Data Collection Paper

This section summarizes changes in the various IBM SPSS Data Collection Paper product versions.

What's New in IBM SPSS Data Collection Paper 7
Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > >About IBM SPSS Data Collection Paper... > >Details...

Help > About IBM SPSS Data Collection Interviewer... > Details...

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

What's New in IBM SPSS Data Collection Paper 6.0.1
Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to the Reserved Keywords and Keyword Summary topics in the IBM SPSS Data Collection Developer
Library for more information.

Support for Other Specify Category in Grid Looks. IBM SPSS Data Collection Paper can now render
the other specify category in grid questions. By default, this is supported by the Look Groups Compact,
Contemporary, Traditional, and Traditional Compact. When scanning, you can create the custom Grid Look
by inserting the SPSS masked controls into a Grid Look and applying the mr Category Other Specify Object
identification character style.

Support for sub-list headings in categorical questions. IBM SPSS Data Collection now supports the
rendering of sub-list headings, that are defined in categorical questions, when IBM SPSS Data Collection
Paper loads metadata in draft mode.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and hotfix information. You can now view information regarding which fix packs and hotfixes
are installed via the application's Help menu.

Help > About IBM SPSS Data Collection Paper... > Details...

What's New in IBM SPSS Data Collection Paper 6
Support for Database Questions. IBM SPSS Data Collection Paper now supports previewing draft
questionnaires that contain Database Questions created in IBM SPSS Data Collection Author 6. The
following Database Question types are supported:
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v Single Response Database Question. Although the actual question type is Text, these questions are
rendered as single answer questions and use the Looks of categorical questions.

v Multiple Response Database Question. Similar to a single response Database Question, these
questions are rendered as multiple answer questions and use the Looks of categorical questions.

v Database Array. These questions are rendered as existing Numeric loops.
v Database Grid. These grids are rendered as multiple-question grids and use the Looks of compound

questions.

Support for If/Block and Set Response routing items. IBM SPSS Data Collection Paper now supports
previewing the If/Block and Set Response routing items when the Include routing item scripts option is
selected.

Select a context. IBM SPSS Data Collection Paper now supports multiple-contexts. A new Context option
has been added to the Load Questionnaire dialog, allowing you to display content in a different context.

Randomized presentation. The new conditional display character style mr Is Randomized instructs the
interviewer to randomize the category list.

What's New in Paper 5.6
mrPaper is now Paper. Starting with version 5.6, the product formerly known as mrPaper is now called
Paper. The new name is reflected in the interface and many installed elements of the product, such as
files and folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in Data Collection Developer Library 5.6 topic in the Data Collection
Developer Library.

Support for multiple user accounts on the same workstation. IBM SPSS Data Collection Paper and IBM
SPSS Data Collection Paper - Scan Add-on now support multiple user accounts on the same workstation.
Administrative rights are required for the initial installation.

What's New in mrPaper 5.5
There are no significant changes or additions for the mrPaper 5.5 release.

Compatibility of mrPaper 5.5 with Other SPSS Products
Compatibility with Earlier Versions of mrPaper

mrPaper 5.5 cannot coexist with earlier versions of mrPaper. If you install mrPaper 5.5 on a machine that
has an earlier version of mrPaper installed, the installation of version 5.5 will prompt you to uninstall the
earlier version. You must uninstall the earlier version before proceeding with the 5.5 installation.

Compatibility with mrInterview

mrPaper 5.5 is compatible with mrInterview 5.5.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

Note: In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.
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What's New in mrPaper 5.0
The following new features are available in mrPaper 5.0:

Create a draft document.You can now create a draft version of a paper questionnaire. This allows you to
print the draft document, with or without routing item descriptions and scripts, so that it can be checked
and annotated before you print the final version.

Include routing item descriptions in a draft document. You can now choose to display the routing item
descriptions in draft versions of paper questionnaires. This is useful if you are printing draft
questionnaires that you have created in Desktop Author 5.0 and want to check the routings that are set
up.

Include routing item scripts in a draft document. You can now choose to display the routing item scripts
in draft versions of paper questionnaires. This is useful if you are printing draft questionnaires that you
have created in Desktop Author 5.0 and want to check the routings that are set up.

Support for true/false questions. mrPaper now includes support for true/false (boolean and boolean
grid) questions. True/false questions are only available for draft documents.

Data Model 5.0. mrPaper 5.0 comes with the Data Model 5.0. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information getting help on the Data Model, see To Open the Data Model Online Help.

Compatibility of mrPaper 5.0 with Other SPSS Products
Compatibility with Earlier Versions of mrPaper

mrPaper 5.0 cannot coexist with earlier versions of mrPaper. If you install mrPaper 5.0 on a machine that
has an earlier version of mrPaper installed, the installation of version 5.0 will prompt you to uninstall the
earlier version. You must uninstall the earlier version before proceeding with the 5.0 installation.

Compatibility with mrInterview

mrPaper 5.0 is compatible with mrInterview 5.0.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

Note: In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.

What's New in mrPaper 4.5
The following new features are available in mrPaper 4.5:

Run mrPaper from Desktop Author. You can now create questionnaires in the new Desktop Author
product, and then run mrPaper to set up formatting and scanning information. For further details, see
your Desktop Author documentation.

Select routing context. You can now select the routing context to use when you open a file containing
multiple routings. You do this using the Routing drop-down list in the Load dialog box.
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Option to open a new Word document when loading an .mdd file. You can now choose whether or not
to open a new Word document when you load an .mdd file, using the new Create new document check
box in the Load dialog box.

Data Model 4.5. mrPaper 4.5 comes with the Data Model 4.5. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information getting help on the Data Model, see To Open the Data Model Online Help.

Compatibility of mrPaper 4.5 with Other SPSS Products
Compatibility with Earlier Versions of mrPaper

mrPaper 4.5 cannot coexist with earlier versions of mrPaper. If you install mrPaper 4.5 on a machine that
has an earlier version of mrPaper installed, the installation of version 4.5 will silently uninstall the earlier
version.

Compatibility with mrInterview

mrPaper 4.5 is compatible with mrInterview 4.5.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

Note: In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.

What's New in mrPaper 4.0
The following new features are available in mrPaper 4.0:

Data Model 4.0. mrPaper 4.0 comes with the Data Model 4.0. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information getting help on the Data Model, see To Open the Data Model Online Help.

Compatibility of mrPaper 4.0 with Other SPSS Products
Compatibility with Earlier Versions of mrPaper

mrPaper 4.0 cannot coexist with earlier versions of mrPaper. If you install mrPaper 4.0 on a machine that
has an earlier version of mrPaper installed, the installation of version 4.0 will silently uninstall the earlier
version.

Compatibility with mrInterview

mrPaper 4.0 is compatible with mrInterview 4.0.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

Note: In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.

What's New in mrPaper 3.5
The following new features are available in mrPaper 3.5:
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Data Model 3.5. mrPaper 3.5 comes with the Data Model 3.5. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information getting help on the Data Model, see To Open the Data Model Online Help.

Compatibility of mrPaper 3.5 with Other SPSS Products
Compatibility with Earlier Versions of mrPaper

mrPaper 3.5 cannot coexist with earlier versions of mrPaper. If you install mrPaper 3.5 on a machine that
has an earlier version of mrPaper installed, the installation of version 3.5 will silently uninstall the earlier
version.

Compatibility with mrInterview

mrPaper 3.5 is compatible with mrInterview 3.5.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

Note: In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.

What's New in mrPaper 3.1
The following new features are available in mrPaper 3.1:

Data Model 3.1. mrPaper 3.1 comes with the Data Model 3.1. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information getting help on the Data Model, see To Open the Data Model Online Help.

Unicode characters. mrPaper now handles Unicode characters. Note that, as a result, the default.ini files
containing settings for mrPaper Looks and Look Groups must now be Unicode files, rather than ASCII
files. If you wish to use Looks created using an earlier version of mrPaper, you must resave each of the
default.ini files in Unicode format.

Autogeneration of question numbers. A new option in the Load dialog box gives you the option of
automatically generating question numbers for each question in the .mdd file.

Compatibility of mrPaper 3.1 with Other SPSS Products
Compatibility with Earlier Versions of mrPaper

mrPaper 3.1 cannot coexist with earlier versions of mrPaper. If you install mrPaper 3.1 on a machine that
has an earlier version of mrPaper installed, the installation of version 3.1 will silently uninstall the earlier
version.

Unicode characters. mrPaper now handles Unicode characters. Note that, as a result, the default.ini files
containing settings for mrPaper Looks and Look Groups must now be Unicode files, rather than ASCII
files. If you wish to use Looks created using an earlier version of mrPaper, you must resave each of the
default.ini files in Unicode format. To do this, locate the files in the backup folder of the Looks folder. The
default Looks folder varies with the operating system. Under Windows 2000, it is located within the
C:\Documents and Settings\user\Local Settings\Application Data\SPSS Dimensions\mrPaper 3.1 folder,
where user is your user name. (The Looks folder is a hidden folder and you can see it in Windows
Explorer only if you have selected the option to view hidden files.) Then open the file in Notepad, choose
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Save As from the File menu, and select "Unicode" from the Encoding drop-down (this option selects the
form of Unicode known as little endian utf16). When asked whether you want to replace the file, choose
Yes.

Alternatively, you can delete the default.ini files and reapply default Looks and Look groups using the
mrPaper Look Organizer.

Looks. You can use in mrPaper 3.1 the Looks that you created using an earlier version of mrPaper. You
can also use in mrPaper 3.0, 1.2, 1.1, or 1.0 the Looks that you create using mrPaper 3.1, with the
exception that scanning-enabled categorical Looks that handle Other Specify categories are not compatible
with mrPaper 1.0. Also, note that the values inserted by the mr Category Value character style may be
different in mrPaper 3.1, 3.0 and 1.2 from the values inserted in mrPaper 1.1 or 1.0.

Questionnaire definition files. You can load into mrPaper 3.1 questionnaire definition (.mdd) files created
using Quanquest 2.2 and In2form 4.5. However, the questionnaire definition is then upgraded and is no
longer usable with mrPaper 1.0. If you install mrPaper 3.1, you should upgrade your authoring tool to
either Quanquest 2.4.1 or higher or In2Form 4.5.1 or higher. Conversely, if you install Quanquest 2.4.1 or
higher or In2Form 4.5.1 or higher, you should install mrPaper 3.0 or higher to read the questionnaire
definition files created by these tools.

Compatibility with mrInterview

mrPaper 3.1 is compatible with mrInterview 3.1.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

Note: In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.

What's New in mrPaper 3.0
The following new features are available in mrPaper 3.0:

Support for Office 2003. mrPaper 3.0 is compatible with Microsoft Office 2003, and can be used with
Word 2003.

Data Model 3.0. mrPaper 3.0 comes with the Data Model 3.0. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information getting help on the Data Model, see To Open the Data Model Online Help.

Addition of paper routing to .mdd files. A new script is available to enable you to add a paper routing
to a metadata file that has no routing or uses a different type of routing, for example, files created in
mrStudio. The script, CreatePaperRouting.mrs, is available when you install the Dimensions Development
Library, in the \DDL\scripts\General\mrScriptBasic directory.

Additional Information

In mrPaper version 3.0 and later, Microsoft Word 97 is no longer supported.

Compatibility of mrPaper 3.0 with Other SPSS Products
Compatibility with mrPaper Versions 1.2, 1.1, and 1.0
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mrPaper 3.0 cannot coexist with earlier versions of mrPaper. If you install mrPaper 3.0 on a machine that
has an earlier version of mrPaper installed, the installation of version 3.0 will silently uninstall the earlier
version.

Looks. You can use in mrPaper 3.0 the Looks that you created using mrPaper 1.2, 1.1, or 1.0. You can also
use in mrPaper 1.2, 1.1, or 1.0 the Looks that you create using mrPaper 3.0, with the exception that
scanning-enabled categorical Looks that handle Other Specify categories are not compatible with mrPaper
1.0. Also, note that the values inserted by the mr Category Value character style may be different in
mrPaper 3.0 and 1.2 from the values inserted in mrPaper 1.1 or 1.0.

Questionnaire definition files. You can load into mrPaper 3.0 questionnaire definition (.mdd) files created
using Quanquest 2.2 and In2form 4.5. However, the questionnaire definition is then upgraded and is no
longer usable with mrPaper 1.0. If you install mrPaper 3.0, you should upgrade your authoring tool to
either Quanquest 2.4.1 or higher or In2Form 4.5.1 or higher. Conversely, if you install Quanquest 2.4.1 or
higher or In2Form 4.5.1 or higher, you should install mrPaper 3.0 to read the questionnaire definition files
created by these tools.

Compatibility with mrInterview

mrPaper 3.0 is compatible with mrInterview 3.0.

Upgrading from Word 97 to Word 2000

If you upgrade to Word 2000 after installing mrPaper, you do not need to update your Looks. In Word
2000, you can continue using the Looks you created or modified in Word 97.

What's New in mrPaper 1.2
The following new features are available in mrPaper 1.2:

Backup and Restore mrSeparator content. This new check box on the Update Document dialog box lets
you retain any changes you have made to items in the mr Separator style when you update an mrPaper
document from one version of the questionnaire definition file to another.

Word XP. mrPaper 1.2 can be run with Word XP.

Card and column information from MDM2Quantum. The card and column information that
MDM2Quantum writes to the questionnaire definition file is now visible in mrPaper.

Updating questionnaires. mrPaper no longer places questions incorrectly or generates errors when you
update a questionnaire from one version to another. This problem occurred only if you were using
mrPaper 1.1 with Data Model version 2.3 or 2.4.

Data Model 2.7. mrPaper 1.2 comes with this new version of the Data Model. For detailed information
about the Data Model, including the accessories, see its online Help. For information getting help on the
Data Model, see To Open the Data Model Online Help.

Questionnaire bookmark. It is no longer a requirement for template files to contain a Questionnaire
bookmark to mark the position at which questionnaire definitions should be loaded relative to the
template contents. In mrPaper 1.1 you could not load or update questionnaires if the template did not
contain a Questionnaire bookmark.

New Short Drinks Sample. mrPaper 1.2 comes with a new version of the short drinks sample
questionnaire. This sample contains multiple versions of the questionnaire, as follows:
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Version Description

Version 1 The questionnaire was created using Quanquest and then the project was activated in Test
mode in mrInterview.

Version 2 The project was activated in Active mode. Versions 1 and 2 of the questionnaire are more or
less the same.

Version 3 The category Fulltime Parent was added to Q3 (sclass).

Version 4 In Q4 (hhsize), one category was changed and another was deleted.

Version 5 The text of one category of the Q7 numgrid (numdrksz) was changed and Q3 (sclass) was
replaced with an open-ended question. This version is almost the same as the short drinks
sample installed with earlier versions of mrPaper, apart from some small variations in, for
example, variable names.

Compatibility of mrPaper 1.2 with Other SPSS Products
mrPaper 1.2 cannot co-exist with earlier versions of mrPaper. The installation program will not install
mrPaper 1.2 on a machine on which it detects that mrPaper 1.1 or mrPaper 1.0 is installed. Before you
can install mrPaper 1.2, you must uninstall mrPaper 1.1 or mrPaper 1.0.

Looks. You can use in mrPaper 1.2 the Looks that you created using mrPaper 1.1 or 1.0. You can also use
in mrPaper 1.1 or 1.0 the Looks that you create using mrPaper 1.2, with the exception that
scanning-enabled categorical Looks that handle Other Specify categories are not compatible with mrPaper
1.0. Also, note that the values inserted by the mr Category Value character style may be different in
mrPaper 1.2 from the values inserted by mrPaper 1.1 or 1.0.

Questionnaire definition files. You can load into mrPaper 1.2 questionnaire definition (.mdd) files created
using Quanquest 2.2 and In2form 4.5. However, the questionnaire definition is then upgraded and is no
longer usable with mrPaper 1.0. If you install mrPaper 1.2, you should upgrade your authoring tool to
either Quanquest 2.4 or higher or In2Form 4.5.1 or higher. Conversely, if you install Quanquest 2.4 or
higher or In2Form 4.5.1 or higher, you should install mrPaper 1.2 to read the questionnaire definition files
created by these tools.

Compatibility with mrInterview

mrPaper 1.2 is fully compatible with mrInterview 1.2.

What's New in mrPaper 1.1
The following new features are available in mrPaper 1.1:

Document Info. This new command displays a summary of the Looks applied to the questionnaire items
in an mrPaper document.

AutoSave Questionnaire. This new command enables you to automatically save the Look information to
the questionnaire definition (.mdd) file at regular intervals.

Serial number question. A new option in the Load dialog box gives you the choice of suppressing the
serial number system variable from your mrPaper documents.

Highlighting changes. A new option in the Update Document dialog box gives you the choice of
automatically highlighting any changes in the questionnaire definition.

Improved display of compound questions. Compound questions can now be automatically formatted to
fill the available page width. You specify whether you want to use this option for a particular compound
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Look using the new Post processing option in the Save Compound Look wizard. This option is selected
for all of the installed compound Looks, apart from those that are designed for use in a two-column
page.

Improved handling of shared list subLooks. The problem that caused mrPaper 1.0 to confuse categorical
and shared list subLooks has now been corrected.

Other Specify categories. You can now create Other Specify categories for use with mrScan.

New character style. mrPaper 1.1 has a new character style, mr Category Other Specify Object. This is used
to identify to mrScan SPSS masked controls that you use for Other Specify category character fields.

Improved version handling. mrPaper 1.0 could save the Look details to the questionnaire definition only
if the latest version was loaded. Now, however, mrPaper can save the Look details to any open version of
the questionnaire definition, and if the latest version is locked, mrPaper can create a new open version
for you.

DataModel 2.2. mrPaper 1.1 comes with this new version of the DataModel, which includes new
features and two useful accessories. These are MDM2Quantum, which you can use to define card and
column specifications in the questionnaire definition, and Questionnaire Viewer, which you can use to
view questionnaire definition (.mdd) files in a browser. For detailed information about the DataModel,
including the accessories, see its online Help. For information getting help on the Data Model, see To
Open the Data Model Online Help.

Compatibility of mrPaper 1.1 with Other SPSS Products
Compatibility with mrPaper 1.0

Looks. You can use in mrPaper 1.1 the Looks that you created using mrPaper 1.0. You can also use in
mrPaper 1.0 the Looks that you create using mrPaper 1.1, but there is one exception. This is that
scanning-enabled categorical Looks that handle Other Specify categories are not compatible with mrPaper
1.0. Also, note that the values inserted by the mr Category Value character style may be different in
mrPaper 1.1 from the values inserted by mrPaper 1.0.

Questionnaire definition (.mdd) files. You can load into mrPaper 1.1 the questionnaire definition (.mdd)
files that you author using Quanquest 2.2 and In2form 4.5. However, the questionnaire definition is then
upgraded and is no longer compatible with mrPaper 1.0.

Compatibility with mrInterview 1.0

In mrInterview 1.0, you can use a multiask statement in your script to group several questions on a
single HTML page. To make questionnaire definitions that contain this feature display correctly in
mrPaper 1.1, you need to install the mrInterview 1.0 Patch 1 and then recompile the script and reactivate
the project. The new version of the questionnaire definition that is created when the project is reactivated
will then display correctly in mrPaper 1.1.
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Chapter 10. What's New in IBM SPSS Data Collection Paper -
Scan Add-on

This section summarizes changes in the various IBM SPSS Data Collection Paper - Scan Add-on product
versions.

What's New in IBM SPSS Data Collection Paper - Scan Add-on 7
Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > About IBM SPSS Data Collection Paper - Scan Add-on... > Details...

What's New in IBM SPSS Data Collection Paper - Scan Add-on 6.0.1
x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Fix pack and hotfix information. You can now view information regarding which fix packs and hotfixes
are installed via the application's Help menu.

Help > About IBM SPSS Data Collection Paper - Scan Add-on... > Details...

What's New in IBM SPSS Data Collection Paper - Scan Add-on 6
There are no new features for the IBM SPSS Data Collection Paper - Scan Add-on 6 release.

What's New in Scan 5.6

mrScan is now Scan. Starting with version 5.6, the product formerly known as mrScan is now called Scan.
The new name is reflected in the interface and many installed elements of the product, such as files and
folders. In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in DDL 5.6 topic in the Data Collection Developer Library.

Support for multiple user accounts on the same workstation. Paper and Scan now support multiple
user accounts on the same workstation. Administrative rights are required for the initial installation.

What's New in mrScan 5.5
There are no significant changes or additions for the mrScan 5.5 release.

What's New in mrScan 5.0
New features in mrScan 5.0 include:

Compatibility with Eyes & Hands Forms. mrScan 5.0 is compatible with ReadSoft Eyes & Hands Forms
(EHF) 5.2 Service Pack 13 Hotfix 4.
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Data Model 5.0. mrScan 5.0 comes with the Data Model 5.0. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information on opening the Data Model online Help, see To Open the Data Model Online Help.

What's New in mrScan 4.5
New features in mrScan 4.5 include:

New File Formats. You can now transfer data to the following additional file formats using mrScan
Transfer:
v Dimensions Data File. You can now transfer data from mrScan to .ddf file format using the new

Dimensions Data File CDSC.
v Triple-S.You can now transfer data from mrScan to .xml files that meet the Triple-S standard for the

interchange of survey data, using the new Triple-S DSC.
v SAS. You can now transfer data from mrScan to SAS data files in the SAS version 7 for Windows,

standard-extension format with a .sas7bdat extension, using the new SAS DSC.

Compatibility with Eyes & Hands Forms. mrScan 4.5 is compatible with ReadSoft Eyes & Hands Forms
(EHF) 5.2 Service Pack 13 Hotfix 4.

Data Model 4.5. mrScan 4.5 comes with the Data Model 4.5. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information on opening the Data Model online Help, see To Open the Data Model Online Help.

What's New in mrScan 4.0
New features in mrScan 4.0 include:

Compatibility with Eyes & Hands Forms. mrScan 4.0 is compatible with ReadSoft Eyes & Hands Forms
(EHF) 5.2 Service Pack 12.

Data Model 4.0. mrScan 4.0 comes with the Data Model 4.0. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information on opening the Data Model online Help, see To Open the Data Model Online Help.

What's New in mrScan 3.5
New features in mrScan 3.5 include:

Compatibility with Eyes & Hands Forms. mrScan 3.5 is compatible with ReadSoft Eyes & Hands Forms
(EHF) 5.2 Service Pack 11 Hotfix 7.

Data Model 3.5. mrScan 3.5 comes with the Data Model 3.5. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information on opening the Data Model online Help, see To Open the Data Model Online Help.

Change in Default Setting for Mass Verify Option. In mrScan 3.5 the default for the Mass Verify option
in the Mark Fields and Numeric Fields tabs of the Options dialog has been changed from checked to
unchecked. This is because when using Eyes & Hands Forms (EHF) 5.2 Service Pack 11 Hotfix 7, pages
that contain only mark fields do not pass the verification stage when Mass Verify is checked. It is
recommended that you do not change this setting when using mrScan with Eyes & Hands Forms 5.2
Service Pack 11 Hotfix 7.
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What's New in mrScan 3.1
New features in mrScan 3.1 include:

Compatibility with Eyes & Hands Forms. mrScan 3.1 is compatible with ReadSoft Eyes & Hands Forms
(EHF) 5.2 Service Pack 10.

Data Model 3.1. mrScan 3.1 comes with the Data Model 3.1. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information on opening the Data Model online Help, see To Open the Data Model Online Help.

What's New in mrScan 3.0
New features in mrScan 3.0 include:

Compatibility with Eyes & Hands Forms. mrScan 3.0 is compatible with ReadSoft Eyes & Hands Forms
(EHF) 5.2 Service Pack 9 Hotfix 11.

Application of Image Settings from Eyes & Hands Forms. mrScan 3.0 now automatically applies the
scanner settings in Eyes & Hands Forms Manager to all forms.

Data Model 3.0. mrScan 3.0 comes with the Data Model 3.0. For detailed information about the Data
Model, see its online Help, which is now incorporated in the Dimensions Development Library (DDL)
help. For information on opening the Data Model online Help, see To Open the Data Model Online Help.

Optional recognition fields. mrScan 3.0 has a new option to enable you to choose whether or not to add
recognition fields. By default, recognition fields are turned off. To turn on recognition fields, choose
Options from the mrScan menu, and check the Insert Recognition Fields check box on the General tab.

What's New in mrScan 1.2
New features in mrScan 1.2 include:

Compatibility with Eyes & Hands Forms 5.2. mrScan 1.2 should be run with ReadSoft Eyes & Hands
Forms 5.2 Service Pack 5. Versions later than Service Pack 5 are untested but are expected to work.

Data Model 2.7. mrScan 1.2 comes with the Data Model 2.7. For detailed information about the Data
Model, see its online Help. For information on opening the Data Model online Help, see To Open the
Data Model Online Help.

New option for illegal responses. When defining scanning requirements for Mark Fields, you can now
choose to allow illegal responses into the data. This provides an alternative to the existing Illegal Value
option, which should no longer be used.

Support for SPSS MR Relational Database 2 CDSC. mrScan Transfer 1.2 offers an option for exporting
data using the SPSS MR Relational Database 2 CDSC.

What's New in mrScan 1.1
New features in mrScan 1.1 include:

Compatibility with Eyes & Hands Forms 5.2. mrScan can now take advantage of all of the new features
and improved functionality that are provided in ReadSoft Eyes & Hands Forms 5.2 (EHF).
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Fifth adjustment field. mrScan now has an option to insert a fifth adjustment field into your paper
questionnaires. mrScan inserts this adjustment field in a different position on each page. This generally
means that each page results in a unique image, which speeds up scanning because it reduces the time
the scanning software spends matching each page.

New mark field options. New options on the Mark Field tab in the mrScan Options dialog box make it
easy to define Detect Noise and Detect Strikeout settings for responses to categorical questions in EHF.

New text field transfer option. Now you can choose whether to define text fields in EHF as character
fields or as image fields.

New light, contrast, and form rotation options. A new tab in the mrScan Options dialog box enables you
to define light, contrast, and form rotation settings to be used for the form definitions that are set up in
EHF when you run the Transfer to Scanning Software command in mrScan.

New system variables option. You can now specify in mrScan which EHF system variables you want to
store with the scanned data in EHF.

Other Specify categories. mrScan can now handle Other Specify categories in categorical questions.

New category value settings in EHF. EHF category values can now be defined as 1+, which means that
EHF automatically assigns ascending values to each category in a categorical question or subquestion.
(These values are used internally by EHF and do not affect the category values in the data when it is
exported by mrScan Transfer.) This option leads to improved validation because all of the categories in
the question or subquestion are treated as a group, which means that EHF correctly recognizes the
minimum and maximum values defined in the questionnaire definition and applies them correctly to the
question or subquestion, rather than to each category individually. This new option is recommended,
especially if you are using mrScan Transfer to export your data from EHF.

Exporting image files is now easier. You no longer have to set up the export options manually in EHF
when you want to export image files of your open-ended and numeric responses, because mrScan now
does it for you.

Double-sided scanning. mrScan now supports double-sided scanning.

Questions that span more than one page. mrScan can now handle questions that span more than one
page. However, a question that spans two pages will be treated as two separate questions by EHF, and
for categorical questions, the maximum number of responses is set to the same value for both of the
questions. For example, suppose a multiple response question, whose maximum number of responses is
50, spans two pages. The two EHF variables that represent the two parts of the question will have their
maximum number of responses set to 50, even though there are less than 50 possible responses in each of
the two parts of the question. You can correct this problem by manually changing the maximum value for
affected questions in EHF Manager. When you export the scanned data using mrScan Transfer, the
responses are recombined into a single variable.

Data Model 2.2. mrScan 1.1 comes with the Data Model 2.2, which includes data source components for
writing your scanned data to three new data formats. This means that in addition to writing the data to a
Quantum-format ASCII file, you can now write your scanned data to a .sav file for analysis in SPSS, to an
MS SQL Server Database in the format used by mrInterview and mrTables, or to an XML file, which
makes it easy to transfer the data from one location to another.

The Data Model 2.2 also comes with two accessories--MDM2Quantum, which you can use to define
card and column specifications in the questionnaire definition, and Questionnaire Viewer, which you can
use to view questionnaire definition files in a browser.
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For detailed information about the Data Model, including the accessories, see its online Help. For
information on opening the Data Model online Help, see To Open the Data Model Online Help.
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Chapter 11. What's New in IBM SPSS Translation Utility

This section summarizes changes in the various IBM SPSS Translation Utility product versions.

What's New in IBM SPSS Translation Utility 7
The following enhancements have been implemented in IBM SPSS Translation Utility 7:

Fix pack and interim fix information. You can view information regarding which fix packs and interim
fixes are installed via the application's Help menu. You can sort the interim fix information by Role,
Server, or Interim Fix.

Help > >About IBM SPSS Translation Utility... > >Details...

Links to the IBM SPSS Community and IBM SPSS products. The application's Help menu now
provides links to the IBM SPSS Community and IBM SPSS products.

What's New in IBM SPSS Translation Utility 6.0.1
The following enhancements have been implemented in IBM SPSS Translation Utility 6.0.1:

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

Patch and hotfix information. You can now view information regarding which patches and hotfixes are
installed via the application's Help menu:

Help > About IBM SPSS Translation Utility... > Details...

What's New in IBM SPSS Translation Utility 6
There are no new features in IBM SPSS Translation Utility 6 release.

What's New in Data Collection Translation Utility 5.6
Data Collection Translation Utility 5.6 is now known as Data Collection Translation Utility 5.6. Starting
with version 5.6, the product formerly known as mrTranslate is now simply called the Data Collection
Translation Utility 5.6. The new name is reflected in the interface and many installed elements of the
product, such as files and folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in Data Collection Developer Library 5.6 topic in the Data Collection
Developer Library.

What's New in mrTranslate 5.5
v mrTranslate version 5.5 has been updated to use the Data Model version 5.5.
v You are now provided the option of bypassing the re-sizing rows process when opening .mdd files.

Re-sizing rows can be a time consuming process when a file's metadata contains a large number of
categories. This new feature is presented upon opening each .mdd file.
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What's New in mrTranslate 5.0
mrTranslate version 5.0 has been updated to use the Data Model version 5.0.

What's New in mrTranslate 4.5
mrTranslate version 4.5 has been updated to use the Data Model version 4.5.

What's New in mrTranslate 4.0

mrTranslate version 4.0 has been updated to use the Data Model version 4.0.

What's New in mrTranslate 3.5
mrTranslate version 3.5 has been updated to use the Data Model version 3.5.

What's New in mrTranslate 3.1
This topic provides information about what is new in mrTranslate since version 3.0. The new features
added in mrTranslate 3.1 are:
v New Autofill option. You can now autofill all occurrences of a name, rather than just the final

occurrence in the file, using the new Autofill by Name option.
v mrTranslate version 3.1 has been updated to use the Data Model version 3.1.

What's New in mrTranslate 3.0
mrTranslate version 3.0 has been updated to use the Data Model version 3.0.

What's New in mrTranslate 2.3
This topic provides information about what is new in mrTranslate since version 2.1. The new features
added in mrTranslate 2.3 are:
v A new accessory, MDM Label Manager, is now supplied with mrTranslate. You can use this to

configure context, label type and language options. For further information, see the Dimensions
Development Library.

v Languages can be set as read-only using MDM Label Manager, so that no further changes can be made
to the language text. This can help prevent accidental changes from being made.

v All languages, including the source language, can be set as write-enabled using MDM Label Manager.
This enables you to edit the source language text if required. By default, the source language is
read-only.

v You can now use mrTranslate to enter text for contexts and label types. Together with the ability to edit
the source language, this means that you can set up new contexts and label types in MDM Label
Manager, and enter the source language text for them in mrTranslate.

v International Language codes are now displayed in the language column headers and in the
Add/Remove Languages dialog box.

v mrTranslate now supports translation of page items.
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Chapter 12. What's New in IBM SPSS Data Collection Survey
Reporter Developer Kit

This section summarizes changes in the various IBM SPSS Data Collection Survey Reporter Developer Kit
product versions.

What's New in IBM SPSS Data Collection Survey Reporter Developer
Kit 7
The IBM SPSS Data Collection Survey Reporter Developer Kit contains the following new features in
version 7:

Support for IBM SPSS Visualization. The HTML Tables Export feature now offers the IBM SPSS
Visualization charting engine as an alternative to Microsoft Office Web Components (OWC). With the
exception of the Export Tables feature in IBM SPSS Data Collection Survey Tabulation, IBM SPSS
Visualization is now the default charting engine used during chart generation. The charting features are
available for all supported Microsoft Windows versions (32 and 64-bit). The IBM SPSS Visualization
charting engine provides a new Heat Map chart type.

When required, you can select the legacy Microsoft Office Web Components (OWC) for chart generation.

What's New in IBM SPSS Data Collection Survey Reporter Developer
Kit 6.0.1
The IBM SPSS Data Collection Survey Reporter Developer Kit contains the following new features in
version 6.0.1:

Support for reserved names and keywords in metadata. IBM SPSS Data Collection now provides full
support for SQL and mrScript reserved names and keywords in metadata variables. In previous releases,
the use of reserved SQL keywords could cause issues when using the IBM SPSS Data Collection Data
Model to query data for processes such as DMOM; the use of reserved mrScript keywords could cause
syntax errors when referenced within a routing script.

Refer to the Reserved Keywords and Keyword Summary topics in the IBM SPSS Data Collection Developer
Library for more information.

x64 64-bit support. x64 64-bit editions are now provided for the IBM SPSS Data Collection applications
(note that IBM SPSS Data Collection Author Server Edition and IBM SPSS Data Collection Survey
Reporter Server Edition are only provided as x86 32-bit). Refer to the appropriate IBM SPSS Data
Collection installation guide for more information.

What's New in IBM SPSS Data Collection Survey Reporter Developer
Kit 6
The IBM SPSS Data Collection Survey Reporter Developer Kit contains the following new features in
version 6:

Reports for Surveys Components is now IBM SPSS Data Collection Survey Reporter Developer Kit.
Starting with version 6, the product formerly known as Reports for Surveys Components is now called
IBM SPSS Data Collection Survey Reporter Developer Kit. The new name is reflected in the interface and
many installed elements of the product, such as files and folders.
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In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in DDL topic in the IBM SPSS Data Collection Developer Library.

What's New in Reports for Surveys Components 5.6
The Reports for Surveys Components contains the following new features in version 5.6:

Dimensions Component Pack is now Reports for Surveys Components. Starting with version 5.6, the
product formerly known as Dimensions Component Pack is now called Reports for Surveys Components.
The new name is reflected in the interface and many installed elements of the product, such as files and
folders.

In addition, many other products in the Data Collection family have been renamed. For more
information, see the What's New in DDL topic in the IBM SPSS Data Collection Developer Library.

What's New in DCP 5.5
The Dimensions Component Pack contains the following new features in version 5.5:

Data Model 5.5. See Chapter 14, “What's New in IBM SPSS Data Collection Data Model,” on page 189 for
details of the new features in the Data Model.

Data Management Scripting. See Chapter 7, “What's New in IBM SPSS Data Collection Professional,”
on page 111 for details of the new features in Data Management Scripting.

Table Scripting. See Chapter 7, “What's New in IBM SPSS Data Collection Professional,” on page 111 for
details of the new features in mrStudio Tables Option.

What's New in DCP 5.0
The Dimensions Component Pack contains the following new features in version 5.0:

>Data Model 5.0. See Chapter 14, “What's New in IBM SPSS Data Collection Data Model,” on page 189
for details of the new features in the Data Model.

Data Management Scripting. See Chapter 7, “What's New in IBM SPSS Data Collection Professional,”
on page 111 for details of the new features in Data Management Scripting.

Table Scripting. See Chapter 7, “What's New in IBM SPSS Data Collection Professional,” on page 111 for
details of the new features in mrStudio Tables Option.

What's New in DCP 4.5
The Dimensions Component Pack contains the following new features in version 4.5:

>Data Model 4.5. See “What's New in Data Model 4.5” on page 192 for details of the new features in the
Data Model.

Data Management Scripting. See “What's New in mrStudio 4.5” on page 125 for details of the new
features in Data Management Scripting.

Table Scripting. See “What's New in mrStudio 4.5” on page 125 for details of the new features in
mrStudio Tables Option.
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What's New in DCP 4.0
The Dimensions Component Pack contains the following new features in version 4.0:

>Data Model 4.0. See “What's New in Data Model 4.0” on page 193 for details of the new features in the
Data Model.

Data Management Scripting. See “What's New in mrStudio 4.0” on page 128 for details of the new
features in Data Management Scripting.

Table Scripting. See “What's New in mrStudio 4.0” on page 128 for details of the new features in
mrStudio Tables Option.

What's New in DCP 3.5
The Dimensions Component Pack contains the following new features in version 3.5:

>Data Model 3.5. See “What's New in Data Model 3.5” on page 194 for details of the new features in the
Data Model.

Data Management Scripting. See “What's New in mrStudio 3.5” on page 133 for details of the new
features in Data Management Scripting.

Table Scripting. See “What's New in mrStudio 3.5” on page 133 for details of the new features in
mrStudio Tables Option.

What's New in DCP 3.1
The Dimensions Component Pack contains the following new features in version 3.1:

>Data Model 3.1. See “What's New in Data Model 3.1” on page 194 for details of the new features in the
Data Model.

Data Management Scripting. See “What's New in mrStudio 3.1” on page 137 for details of the new
features in Data Management Scripting.

Table Scripting. See “What's New in mrStudio 3.1” on page 137 for details of the new features in
mrStudio Tables Option.

What's New in DCP 3.0
The Dimensions Component Pack contains the following new features in version 3.0:

>Data Model 3.0. This new version of the Data Model includes new connection properties and a new
DSC. See the topic “What's New in Data Model 3.0” on page 195 for more information.

Data Management Scripting. You can now use a data management script to merge data from two or
more data sources. See the topic “What's New in mrStudio 3.0” on page 143 for more information.

Table Scripting. The new version of mrStudio Tables Option includes enhancements to statistical tests,
and the ability to assign weighting and multiplier properties to individual elements. See the topic
“What's New in mrStudio 3.0” on page 143 for more information.

What's New in DCP 2.3
The Dimensions Component Pack contains the following new features in version 2.3:
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>Data Model 2.10. This new version of the Data Model includes internal improvements and new DSCs.
See the topic “What's New in Data Model 2.10” on page 196 for more information.

Data Management Scripting. The syntax has been simplified for text substitution in concatenated strings.
The text-substitution feature of the Include statement is no longer supported. See the topic “What's New
in mrStudio 2.3” on page 144 for more information.

Table Scripting. Improved editing control, and many functional improvements. See the topic “What's
New in mrStudio 2.3” on page 144 for more information.

What's New in DCP 2.2
The Dimensions Component Pack is a new feature in version 2.2.
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Chapter 13. What's New in IBM SPSS Data Collection Data
Model Scripting

This section summarizes changes to IBM SPSS Data Collection Data Model Scripting for the various
versions.

What's New in Scripting in IBM SPSS Data Collection Data Model 7
There are no significant scripting changes or additions for the IBM SPSS Data Collection Data Model 7
release.

HTML5 input types. The IStyle.Control.Type enumeration has been extended to support HTML5 input
types. This allows for the conversion between IBM SPSS Data Collection types to HTML5 input types.

Specify image attributes. The IStyle.Control.Type enumeration includes a new Image object. The new
object is backwards compatible (Name is the default property).

What's New in Scripting in IBM SPSS Data Collection Data Model 6.0.1
There are no significant scripting changes or additions for the IBM SPSS Data Collection Data Model 6.0.1
release.

What's New in Scripting in IBM SPSS Data Collection Data Model 6
There are no significant scripting changes or additions for the IBM SPSS Data Collection Data Model 6.0
release.

What's New in Scripting in Data Model 5.6
There are no significant scripting changes or additions for the Data Model 5.6 release.

What's New in Scripting in Data Model 5.5
There are no significant scripting changes or additions for the Data Model 5.5 release.

What's New in Scripting in Data Model 5.0
There are no significant scripting changes or additions for the Data Model 5.0 release.

What's New in Scripting in Data Model 4.5
This topic lists all changes and enhancements to Dimensions Scripting in Data Model 4.5.

IBM SPSS Data Collection Function Library

The following functions are new in this release:
v FormatValue. Identical to the Format function, except that the metadata to be used for formatting is

provided by one variable, while the value to be formatted may come from elsewhere.
v RandomPassword. Returns a string whose content and length are selected randomly within the

constraints specified by the parameters. Intended to be used to generate unpredictable passwords.
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The following functions have been modified for this release:
v Find. You can now specify that the comparison is case-sensitive.
v Format. You can now specify that more than one style code should be used to format the supplied

value. In addition, for a supplied value that is not an object, but can be converted to a long value, the
“a” and “A” style codes now attempt to get the name of the corresponding MDM mapped category
value if an MDM document is available, but does not contain a corresponding element.

What's New in Scripting in Data Model 4.0
This topic lists all changes and enhancements to Dimensions Scripting in Data Model 4.0.

IBM SPSS Data Collection Function Library

The following function is new in this release:
v IsOneOf

mrScriptMetadata

You can now add a label to categorical and numeric loops that will be displayed for each iteration when
the questions in the loop are asked sequentially. For example, you can use this label to display the label
text of the current controlling category (for categorical loops), or the current number from the loop's
range expression (for numeric loops).

mrPrePro Preprocessor

The documentation has been updated to describe how to run mrPrePro from your own application and to
list the mrPrePro options that you can use.

What's New in Scripting in Data Model 3.5
What's new in Dimensions Scripting in Data Model 3.5 is summarized under the following headings:
v IBM SPSS Data Collection Function Library

v mrScriptBasic

IBM SPSS Data Collection Function Library

The following functions are new for version 3.5:
v IsEqualObject
v IsNullObject

The following functions contain significant changes for version 3.5. You can find a note of the changes at
the end of each topic under the heading “Requirements”:
v FindItem
v MonthName
v Validate
v WeekdayName

mrScriptBasic

Option GlobalVariables. By default, a variable defined in mrScriptBasic is visible only to the main script
block. To make script-level variables visible to Functions and Sub procedures, include an Option
GlobalVariables statement in your script.
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Keyword Summary. The mrScriptbasic section of the DDL now includes a list of all keywords, including
those reserved for future use.

What's New in Scripting in Data Model 3.1
What's new in Dimensions Scripting in Data Model 3.1 is summarized under the following headings:
v mrScriptBasic

v mrScriptMetadata

mrScriptBasic

mrScript Command Line Runner. You can use the new /d option of mrScriptCL to to specify a definition
that will be recognized by the mrPrePro preprocessor. The /d option is the equivalent of including a
#define preprocessor directive in the mrScriptBasic script.

Multiline string literals. mrScriptBasic now supports string literals that contain newline characters.

Preprocessor Directives. A new section in the DDL describes how to use preprocessor directives in
mrScriptBasic and Data Management scripts. Preprocessor directives define preliminary operations that
the preprocessor performs on script code before the code is parsed and executed by the scripting engine.

mrScriptMetadata

Custom Message Texts. The range of messages that can be customized now includes the labels of special
responses (such as Don't Know and No Answer) and interview messages.

Initial Answers. You can now define an initial answer to a question. Unlike a default answer, an initial
answer will be visible to the respondent when the question is presented.

Labels, Properties, Styles, and Templates on the Document. To set labels, custom properties, styles, and
templates on the document, you can now create an info field called HDATA and add the labels,
properties, styles, and templates to that field.

Text Insertion. There are now more options for inserting text in question and category labels and the
syntax for doing this has been simplified. You can choose to insert the responses to previous questions,
loop index values, or text values that you specify in the routing section of the interview script.

What's New in Scripting in Data Model 3.0
What's new in Dimensions Scripting in Data Model 3.0 is summarized under the following headings:
v IBM SPSS Data Collection Function Library

v mrScriptMetadata

IBM SPSS Data Collection Function Library

The following functions are new for version 3.0:
v DateDiff
v DBNull
v EngineVersion
v FindItem
v Format
v IsDBNull
v Pow
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v Round
v Sleep

The following functions contain significant changes for version 3.0. You can find a note of the changes at
the end of each topic under the heading Requirements:
v Find
v Intersection
v IsEmpty
v Log
v Union

mrScriptMetadata

mrScriptMetadata contains significant changes for version 3.0, some of which provide support for the
new interview scripting feature of mrStudio. The main changes are as follows:

Interview scripting. You can now use mrScriptMetadata to write the metadata section of an interview
script (.mdd) file in mrStudio.

Styles and templates. You can use styles and templates to define any aspect of how a field will appear
when an interview script is run.

Special responses. You can now add Don't Know, No Answer, and Refused to Answer special responses
to the categories list of a Categorical question, or the codes list of a Long, Double, Text, Date, or Boolean
question.

Grid fields. A grid is the same as a categorical loop that has the grid and expand keywords specified.

Page fields. A page field is used to group questions together on a page.

Default answers. You can specify a default answer for a question, in which case the question does not
need to be answered when an interview script is run.

Factors. Factors can be used to present non-categorical questions, such as long and date, as
single-response categorical questions when an interview script is run.

Precision and scale. You can now define both precision and scale for Double questions and precision for
Long questions.

Comments. mrScriptMetadata code can now include comments.

What's New in Scripting in Data Model 2.10
IBM SPSS Data Collection Function Library. Data Model 2.10 comes with the following new functions:
v DateOnly
v GetInterface
v GetTimeZone
v GetTimeZoneDaylightSaving
v GetTimeZoneName
v GetTimeZoneOffset
v LocalToUTCTime
v MaxOf
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v Merge
v MinOf
v SetTimeZone
v TimeOnly
v UTCToLocalTime

The following functions have been changed in Data Model 2.10 to add optional arguments to specify the
time zone and whether to ignore daylight saving adjustments:
v DateNow
v Now
v TimeNow

What's New in Scripting in Data Model 2.9
IBM SPSS Data Collection Function Library. Data Model 2.9 comes with the following new functions:
v DefinedFactors
v DefinedListElements
v Factor
v InputBox
v IsElementInVersions
v IsSet
v MakeMDMName
v RanSequence
v Replace
v RevSequence
v RotSequence
v SelectRange
v Validate

The following changes have been made to existing functions:
v BitAnd, BitOr, and BitXor now allow a variable number of arguments to be combined with the first

argument.
v DefinedCategories, DefinedElements, and DefinedFactors now work with objects in MDM Document

Fields; that is, in Grids and Loops as well as Variables).

mrScriptBasic. The changes include:
v Debug object. This new object provides functions for displaying messages and debug output, making it

easier to locate and resolve problems with scripts written in mrScriptBasic.
v Resume Next. This statement has been implemented so that it is possible to resume execution after an

error handling routing has finished.
v On Error Goto 0. This is now implicit when entering the error handler to avoid the possibility of

infinite recursion.
v Error reporting. If an error occurs in a sub-procedure, the error message now reports the line numbers

for the entire call stack rather than the line where the call to the procedure was made. For example,
"Execure Error(1): SomeFunction(4): SomeOtherFunction(9): Division by zero".

v Iterator variables in For...Next statements. mrScriptBasic no longer expands defaults when setting the
iterator variable in a For...Next statement. This prevents problems when using the same temporary
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variable as the iterator in more than one loop. Typically, problems happened when the iterator variable
pointed to an object in one loop and was then re-used to point to a series of numeric values in another
loop. For example:

For Each N in ObjectCollection
...

Next
...

For N = 1 To 20
...

Next

In this example, the second loop would attempt to assign the values 1 to 20 to the default property of an
object in ObjectCoolection. This would fail if there was no default property or if the default property was
read only. The change in the way loop iterator variables are set means that code such as this now works
as intended.
v Trailing commas with categorical values. Specifications of the form {value1,value2,} in which there is

an unnecesary comma after the last value, now generate an error.
v GetObjectType method. The GetObjectType method now uses a single Dispatch coclass for each call to

IScriptEngine:Execute rather than recreating the dispatch type for each call.

mrScript Command Line Runner. The following changes have been made.
v mrScriptBasic preprocessor. The new mrPrePro preprocessor is now run on mrScriptBasic files.
v New command line options. Options are now available for suppressing the preprocessor and for

initializing COM as free threaded.

What's New in mrScriptMetadata in Data Model 2.81
Working with mrScriptMetadata in MDM Explorer. Improvements in Data Model 2.8 mean that MDM
Explorer is now able to display an mrScriptMetadata representation of the main structural objects in the
metadata. This makes it easy to view and change the mrScriptMetadata and is a great tool for learning
mrScriptMetadata.

What's New in Scripting in Data Model 2.8
What's new in Dimensions Scripting in Data Model 2.8 is summarized under the following headings:
v Scripting with Data Model 2.8

v mrScriptMetadata in Data Model 2.8

Scripting with Data Model 2.8

Expression Evaluation. This section includes a new topic on Hierarchical Expressions, which covers using
expressions with the hierarchical HDATA view of the data and the new up-lev and down-lev operators.

mrScriptBasic. The changes include:
v Debug Options. The mrScript command line runner now has a new ! debug option, which enables you

to execute a specified statement.
v Understanding Numbering Systems. This topic now provides a better explanation and more examples.

mrScriptMetadata in Data Model 2.8

The main changes to mrScriptMetadata in Data Model 2.8 are:

Loops and grids. The syntax for defining categorical and numeric loops has been extended to provide
row and column orientation options and expand and grid keywords for specifying that the case data is to
be stored in a flattened form and that the loop is to be displayed as a grid, respectively. See:
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v Categorical Loop
v Numeric Loop

Namespacing options. The namespacing options have changed in Data Model 2.8.
v Categories. In Data Model 2.7 category full names automatically included the name of the parent list if

there was one. In Data Model 2.8, the inclusion of the list name in the category full name is optional
and will be off by default. However, you can now use the namespace keyword to request this feature.

v Compounds. You can now use the nonamespace keyword on compounds to specify that the name of
the compound should not be included in the full names of the questions nested inside.

Range specifications. The syntax for defining the valid values for long, double, and date questions and
numeric loops has been extended. For example, you can now specify several ranges of valid values. See:
v Long
v Double
v Date
v Numeric Loop

Precision. You can now define the precision for a double field.

Validation of text values. You can now define validation for the open-ended responses.

Axis expression. When creating Long, Double, Date, Text, Boolean, and Categorical questions, you can
now use the new axis keyword to define the axis specification to be used in mrTables 2.0 and the
mrStudio Tables Option. For example, you can define the banding and special elements to be used by
default when tabulating numeric variables and add special net elements to categorical variables.

Creating "Total Awareness" derived variables is now easier. You no longer need to specify the categories
when you create a derived categorical variable based on one or more other categorical variables. See the
sixth example in Categorical for more information.

Special analysis elements. The syntax for defining special analysis elements has changed.

List ordering options. You can now use the randomize, rotate, reverse, ascending, descending, and fix
keywords on category lists to define how the list is to be ordered in questionnaires.

Defining special usage types. mrScriptMetadata now includes syntax for defining special variable usage
types.

Helper variables. mrScriptMetadata now includes syntax for creating helper variables.

mrScriptMetadata and MDM objects. This new topic explains the objects that are created in the MDM
Document from the various types of fields you can create in mrScriptMetadata.

What's New in mrScriptMetadata in Data Model 2.6
A preview version of mrScriptMetadata was released with Data Model 2.5. This preview version did not
include all of the planned features, although the documentation covered many of the unimplemented
features. Data Model 2.6 and later come with a "real life" version of mrScriptMetadata. However, note
that some of the features planned for the new version of mrInterview have not been implemented and
there may be some further changes to the mrScriptMetadata syntax when these features are implemented
in future versions.

Data Model 2.6 and later come with a new version of mrScript MDSC that can both read and write
mrScriptMetadata files.
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The main changes to mrScriptMetadata in Data Model 2.6 are:
v Field definitions. The field definitions in a list of fields are now separated by a semicolon (;).
v Derived variables. The Derived field type has been replaced by the expression keyword, which can be

used to define an expression for a category or any simple field type, such as a Categorical, Long,
Double, and Boolean.

v Fields keyword. This new keyword is used in front of the list of fields in Categorical Loops, Numeric
Loops, Blocks, and Compounds.

v Defined lists. The syntax for using a defined list has changed.
v Blocks. The Block syntax has changed.
v Special categories. You now define special categories (such as Don't know, No answer, and Refused to

answer) in the same way as any other categories. Typically, these categories have the Exclusive
keyword to indicate that they are single-choice categories.

v Special analysis elements. You now define special elements (such as base and subheading elements)
for use during analysis.

v Keyword changes. A number of keywords have changed. For a full list of mrScriptMetadata keywords,
see mrScriptMetadata Keyword Summary.

Tip: Data Model 2.6 and later come with a new version of the mrScript MDSC that can write an MDM
Document as mrScriptMetadata. This means that it is easy to convert your Data Model 2.5
mrScriptMetadata files to the new syntax. However, note that the new mrScript MDSC write capability
has some limitations and this may mean that some of your code is not be converted.

To convert your Data Model 2.5 mrScriptMetadata files to the new syntax:

1. Before you upgrade to Data Model 2.6 or later, open your Data Model 2.5 mrScriptMetadata files in
the MDM Explorer sample application. You do this using the Open mDSC command on the MDM
Explorer File menu. Then save them as .mdd files by using the Save As command on the MDM
Explorer File menu.

2. After you upgrade to Data Model 2.6 or later, open the .mdd files you created in the previous step in
MDM Explorer and use the Save mDSC command to save them as .ivs files.
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Chapter 14. What's New in IBM SPSS Data Collection Data
Model

This section summarizes changes in the IBM SPSS Data Collection Data Model for the various product
versions.

What's New in IBM SPSS Data Collection Data Model 7
This topic highlights new features added in IBM SPSS Data Collection Data Model 7.

HTMLDocType and HTMLOptions custom properties. These new custom properties control the HTML
DocType and HTML options that are used in the rendered HTML page.

RDB DSC 2 schema. The database has been updated to support the new Publish Data feature.

What's New in IBM SPSS Data Collection Data Model 6
This topic highlights new features added in IBM SPSS Data Collection Data Model 6.

The Relational MR Database CDSC now supports unexpanded loops for reading and writing data. The
IBM SPSS Data Collection Data Model 6 hierarchical data features are only available for the RDB DSC 2
schema and the hierarchical view of the data is available only when an MDM document is attached.

Triple-S DSC. Triple-S ouput now conforms to Triple-S validator. Refer to the Triple-S Validator web site
for more information. Refer to Triple-S DSC topic in the IBM SPSS Data Collection Developer Library for
more information regarding the Triple-S DSC.

What's New in IBM SPSS Data Collection Data Model 6
This topic highlights new features added in IBM SPSS Data Collection Data Model 6.

The Relational MR Database CDSC now supports unexpanded loops for reading and writing data. The
IBM SPSS Data Collection Data Model 6 hierarchical data features are only available for the RDB DSC 2
schema and the hierarchical view of the data is available only when an MDM document is attached.

Triple-S DSC. Triple-S ouput now conforms to Triple-S validator. Refer to the Triple-S Validator web site
for more information. Refer to Triple-S DSC topic in the IBM SPSS Data Collection Developer Library for
more information regarding the Triple-S DSC.

What's New in Data Model 5.6
This topic highlights new features added in Data Model 5.6.

Dimensions is now Data Collection. The product family formerly known as Dimensions has been
renamed to Data Collection in version 5.6. Documentation in this section has been updated to refer to
“Data Model” rather than “Dimensions Data Model.”

In addition, many other products have been renamed.

Improved hierarchical data support. The following hierarchical data enhancements are include in the 5.6
release:
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v Reference grid slices from the hierarchical view (HDATA): Filters can now make use of loop slice
expressions.

v Export hierarchical data as a flattened dataset: To ensure data can be exported to the largest number
of data formats, the Data Management Object Model (DMOM) now recognize when the source query
does not contain any level variables and should therefore transfer data to VDATA. Existing merge
options can be used when transferring a flattened hierarchical dataset to VDATA. A flattened dataset
can be exported from any level, and variables can be selected from other levels that will be copied
down, or summarized up, to the selected level (as required). Down-lev, up-lev variable, expression, and
aggregation are all now supported in the select query.

v Copy hierarchical data as part of Data Management: The writing of hierarchical data has been added
to the Data Collection OLE DB provider and to Data Collection Data Management. The primary
purpose of this feature is to allow either all or a subset of a hierarchical dataset to be copied from one
data format to another. Down-lev, up-lev variable, expression, and aggregation are all now supported
in the select query.

v Enhanced VDATA support (expression, aggregation, and renaming grid slices): The Data
Management Object Model (DMOM) now supports expression, aggregation and the renaming of grid
slices. A new variable or grid (when grid slices are selected) is now created at the metadata's top level
of metadata for renamed variables, grid slices, expressions, and aggregations.

Native support for WHERE expressions. The IBM SPSS Data Collection Data File (DDF) CDSC now
natively supports a variety of WHERE expression types. Natively evaluated WHERE expressions are
extremely fast, and can improve overall IBM SPSS Data Collection Data File DSC performance.

Indexing IBM SPSS Data Collection Data Files. The IBM SPSS Data Collection Data File CDSC supports
indexing on specific columns. Indexing significantly speeds up the selection, update, and deletion of
statements when indexed columns are used in filter expressions.

Custom applications that are built against published Data Collection\Dimensions APIs. A number of
the Data Collection 5.6 dynamic link library (.dll) files have updated assembly versions. As a result, any
custom applications that are built against published Data Collection\Dimensions APIs will need to be
recompiled. The following table identifies the components that were updated in 5.6. You will need to
recompile your custom applications if they use any of these components:

Component Previous Assembly Version Data Collection 5.6 Assembly
Version

MDM.dll 2.119.2.n 2.122.2.n

MetadataServicesLib.dll 1.0.1.n 1.1.0.n

Spss.Dimensions.Controls.Windows.Shared.dll 3.2.0.n 3.5.0.n

Spss.Dimensions.Daf.Capabilities.DataManager.dll 3.1.2.n 3.4.2.n

Spss.Dimensions.Daf.Capabilities.IOM.dll 3.0.2.n 3.3.2.n

Spss.Dimensions.Daf.Capabilities.Metadata.dll 3.1.2.n 3.4.2.n

Spss.Dimensions.Daf.Capabilities.System.dll 3.1.2.n 3.4.2.n

Spss.Dimensions.Daf.Capabilities.Tabulation.dll 3.1.2.n 3.4.2.n

Spss.Dimensions.Daf.Core.dll 3.1.2.n 3.4.2.n

Spss.Dimensions.Daf.Utils.dll 3.0.2.n 3.3.2.n

Spss.Dimensions.LevelsExport.dll 1.0.2.n 1.1.2.n

SPSSMR.Dimensions.Windows.UI.Controls.dll 1.4.2.n 1.6.2.n

SPSSMR.DPM.Agent.dll 2.3.2.n 2.6.2.n

SPSSMR.DPM.Interfaces.dll 2.3.2.n 2.6.2.n

SPSSMR.DPM.Scripting.dll 1.0.2.n 1.3.2.n
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Component Previous Assembly Version Data Collection 5.6 Assembly
Version

TOM.dll 1.10.2.n 1.12.0.n

What's New in Data Model 5.5
What's new in Data Model 5.5 is summarized under the following headings:
v Available DSCs

v Samples

v User documentation

Available DSCs

Dimensions Data File. Dimensions Data File now supports a compressed file format. The compressed
format reduces the size of Dimensions Data Files, making them more portable. Compressed Dimensions
Data Files have a file extension of .dzf.

Samples

mrScriptBasic Scripts

v MSExcelFormatting.mrs. You can use this script for formatting Excel sheets from .mrs files. For
example, the file provides examples for freezing panes and including auto-filters. To run this sample,
you need to have Microsoft Excel.

User documentation

A new topic was added to explain the concurrent use limitations of Dimensions Data File.

What's New in Data Model 5.0
What's new in Data Model 5.0 is summarized under the following headings:
v Available DSCs

v MDM2Quantum Component

v Tools

Available DSCs

Surveycraft DSC. By default, the Surveycraft DSC now generates only an HDATA virtual table. This
should improve performance when tabulating Surveycraft files that contain large nested loops, which
would previously have caused the Surveycraft DSC to generate thousands of columns in the VDATA
virtual table. If you want the Surveycraft DSC to generate the VDATA table, use the vdata setting.

Log DSC. Two new custom connection properties (FileTypeFilter and FileDateFilter) have been added for
file type and date and time filtering.

MDM2Quantum Component

Support for exporting categorical variables as numerics. You can now export categorical variables as
numerics through the DataFormat custom property. When DataFormat is set to "numeric," the variable is
exported with the value set in the Value custom property. If the Value property is not set, the value is
determined by combining the column offset and punch.

Tools
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Creating Dimensions data and metadata files from Quanvert files. The command-line QVtoDF.exe
program creates Dimensions data (.ddf) and questionnaire (.mdd) files from a Quanvert .pkd file or project
folder.

WordCapture with Office 2007. Using WordCapture on a machine with Office 2007 installed opens the
Word document in a separate instance of Word rather than the current instance, with the result that you
are only able to edit the document rather than capture anything from it. To force the document to open in
the current instance of Word, add the BrowserFlags key to the registry in HKEY_LOCAL_MACHINE\
SOFTWARE\Classes\Word.Document.8. Make the key of type REG_DWORD and set its value to zero.

What's New in Data Model 4.5
What's new in Data Model 4.5 is summarized under the following headings:
v Available DSCs

v Samples

Available DSCs

Dimensions Data File CDSC. This new CDSC reads and writes case data to a Dimensions file-based
database that has a .ddf extension. Dimensions Data Files provide a portable alternative to Dimensions
Relational Databases for the storage of “offline” mrInterview data.

SAS DSC. This new DSC writes files in the SAS version 7 for Windows, standard-extension format.

Triple-S DSC. This new DSC reads and writes files that meet the Triple-S standard for the interchange of
survey data.

Delimited Text DSC. This DSC can now be used to read delimited-text files.

Quanvert DSC. You can now use custom connection properties and other methods to set the base
language in the MDM document generated by the Quanvert MDSC. In addition, the Quanvert DSC will
now read projects that were created in a version of Quanvert before version 1.6.

Relational MR Database (RDB) CDSC. The RDB DSC now supports some types of WHERE expression
natively, which can improve performance when filtering data for tabulation.

VDATA view for HDATA-only DSCs. You can now query a flat (VDATA) view of the data when using
any read-enabled CDSC that supports only a hierarchical (HDATA) view, providing that the connection to
the CDSC includes a metadata source. In addition to reading data, the generated VDATA view can be
used for creating tables and inserting, updating, and deleting data if the CDSC supports those features.
The xp_syncdb stored procedure can also use the generated VDATA view to synchronize the case data
with the metadata source.

Samples

Data Samples

v Dimensions Data Files. The Dimensions Development Library (DDL) now includes several sample
data files that were created using the new Dimensions Data File CDSC. Dimensions Data File versions
of the Museum, Household, and Short Drinks samples are included.

v Triple-S Files. The DDL now includes Triple-S versions of the Museum and Skidemo samples, which
can be used to demonstrate the new Triple-S DSC. Triple-S metadata and case data files are provided.

mrScriptBasic Scripts

v DebugQuotaReport.mrs. You can use this script to check quota counts when testing quotas in the
mrStudio Interview Option.
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v RemoveOrphanSampleAndQuota.mrs. You can use this script to remove orphaned sample and quota
objects from Distributed Property Management (DPM). Orphaned objects are objects that are not
assigned to an existing project.

What's New in Data Model 4.0
What's new in Data Model 4.0 is summarized under the following headings:
v Available DSCs

v Samples

v Accessories

Available DSCs

SPSS Statistics SAV DSC. There are several changes to this DSC, including the following:
v To avoid the potential for data loss when reading case-data values that do not match a predefined

category, the default behavior of the SPSS Statistics SAV DSC has changed. When generating an MDM
Document from the .sav file or accessing the case data with no metadata, the SPSS Statistics SAV DSC
now scans the case data and generates any missing categories. When accessing the case data with an
MDM document, the SPSS Statistics SAV DSC matches any unrecognized values to the corresponding
MDM variable's Other category, if it has one.

v Three new properties have been introduced to control how the SPSS Statistics SAV DSC determines
which variables are categorical.

v When asked to use a language that is not supported on the current computer, the default behavior of
the SPSS Statistics SAV DSC is now to issue an error message and stop.

Samples

Data Samples

v Packed Quanvert project. The Household sample Quanvert project that comes with the Dimensions
Development Library now includes a packed project file called househol.pkd.

Code Samples

v Word Macros to Clean Text Responses. These macros allow you to use the functionality within
Microsoft Word to clean verbatim text responses collected in an mrInterview project. For example, you
can correct spelling mistakes, remove erroneous characters, expand abbreviations, and so on.

mrScriptBasic Scripts

v CreateMddFromQuanvert.mrs. This script can be used to create an MDM document (.mdd) file for an
existing Quanvert project. The MDM document can then be used to load the Quanvert project into
mrTables. For large Quanvert multiprojects, this approach will deliver better performance than using
the Quanvert MDSC to read the metadata.

v CreateMddFromSavProperties.mrs. This script sets properties for the SPSS Statistics SAV DSC to use
when it creates an MDM Document (.mdd) file from an SPSS (.sav) file.

Accessories

MDM Compare. You can use this new accessory to compare two Dimensions metadata documents. The
metadata documents can either be two separate .mdd files or can be different versions or superversions of
the same .mdd file.
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What's New in Data Model 3.5
What's new in Data Model 3.5 is summarized under the following headings:
v Available DSCs

v Samples

Available DSCs

HDATA view for VDATA-only DSCs. It is now possible to query a hierarchical (HDATA) view of the
data when using any read-enabled CDSC that supports only a flat (VDATA) view, providing that the
connection includes a metadata source. In the hierarchical view, expanded loops are represented as child
tables under the top-level HDATA virtual table. The hierarchical view is provided by the Table Services
DSC, which is invoked automatically by the IBM SPSS Data Collection OLE DB Provider (and other
Dimensions components, such as the Weight Component) whenever a query is run against the HDATA
table or one of the child tables. This new feature means that you can now run hierarchical queries when
using the following Dimensions DSCs:
v SPSS Statistics SAV DSC
v Quantum DSC
v QDI/DRS DSC
v Log DSC
v ADO DSC

In addition, data accessed using the above DSCs will now be treated as hierarchical in mrTables. This
means that you can add variables within loops to your tables and create grid tables. See ”Supported Data
Formats” in the mrTables User's Guide for more information.

Log DSC. When viewing all the log (.tmp) files in a folder, you can now include log files in sub folders
by specifying the SearchSubFolders custom connection property.

QDI/DRS DSC. This DSC now supports a number of unique custom connection properties, which can be
used to set card, column, and punch information in the MDM for example.

SPSS Statistics SAV DSC. There are several changes to this DSC, including support for .sav files created
by SPSS version 14, improvements to the methods for converting dates, and the ability to create log files.

Samples

Japanese data. Two new data sets have been added to the Dimensions Development Library (DDL) to
demonstrate the merging of multibyte data sources.

What's New in Data Model 3.1
What's new in Data Model 3.1 is summarized under the following headings:
v Accessing the Data Model

v Available DSCs

v Metadata Model (MDM)

v Samples

Accessing the Data Model
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Accessing Dimensions Data from Third Party Applications. A new section in the DDL describes how to
make Dimensions data available to any third party application that can execute a Microsoft SQL Server
query. For example, you could use this approach to analyze your survey data using Microsoft Analysis
Services.

Available DSCs

SPSS Statistics SAV DSC. This DSC can now be used to update SPSS SAV files. This allows weights to
be added to a SAV file.

Quantum DSC. This DSC can now be used to update Quantum files. This allows weights to be added to
a Quantum file.

ADO DSC. To provide more information about using .adoinfo files as input metadata sources, the DDL
now includes a topic called Example .adoinfo Files. In addition, four data management script (.dms) files
included with the DDL have been amended to input .adoinfo files.

Delimited Text DSC. By default, this DSC now exports an index number for each category (1 for the first
category, 2 for the second, and so on) rather than the MDM mapped category value. However, you can
change this behavior if you wish.

Metadata Model (MDM)

Translations of System Variables. More translations of the label texts for system variables have been
added to the MDM. The new translations include Turkish, Chinese (PRC), Chinese (Hong Kong SAR),
Korean, Malay, Swedish, Spanish (Spain), Greek, Russia, Romanian, and Portuguese (Portugal). If the
current language of a metadata document (.mdd) file is one of these languages, the translated label texts
will be displayed in mrTables and in the Survey Results activity in mrInterview.

Data Samples

v Quantum data source. A Quantum sample data source has been added to the DDL.

mrScriptBasic scripts

v AddSourceFileVariablesToMDD.mrs. This new script demonstrates how to add SourceFile variables to
specific data types in a metadata document (.mdd) file. This allows you to use the .mdd file with
mrScan.

v CompareTwoMDDFiles.mrs. You can use this script to compare two metadata document (.mdd) files.
v CreateSQLDatabase.mrs. This new script demonstrates how to use mrScriptBasic to create a Microsoft

SQL Server database.
v FormatOrdinalFunction.mrs. This script contains an mrScriptBasic function that you can use to convert

a number or text into an ordinal such as 1st, 3rd, 28th, -2.1th, nth, and so on.

What's New in Data Model 3.0
What's new in Data Model 3.0 is summarized under the following headings:
v Accessing the Data Model

v Available DSCs

v Metadata Model (MDM)

v Samples

Accessing the Data Model
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New connection properties. Two new custom connection properties have been introduced, MR Init
Overwrite, which controls whether existing data is overwritten, and MR Init Native Schema, which
controls whether native objects in the database should be exposed without any interpretation.

Data Link Properties dialog box. The Advanced tab of the dialog box has been amended to allow the
setting of the two new connection properties described in the previous paragraph.

IBM SPSS Text Analytics for Surveys (STAfS). A new section in the DDL describes how to import data
from an mrInterview RDB database into STAfS, which is a text coding application that can be used to
analyze responses to open-ended questions.

Available DSCs

Quantum DSC. This DSC can now be used to read Quantum files.

In2data DSC. This new DSC can be used to read case data and metadata from an In2data database (.i2d)
file.

Metadata Model (MDM)

Support for label styles. A LabelStyle property has been added to a number of objects, providing
support for presentation styles for labels. This property complements the Style property introduced for
version 2.10, which supports presentation styles for controls. IArray is an example of a class that has the
LabelStyle property.

Presentation of elements for interview scripting. A Presentation property has been added to IElements
to make accessible the elements hierarchy that is required by mrScriptMetadata for interview scripting.
An Inline property has also been added to IElements to specify whether the elements in the object will be
presented inline or as a sub-list.

Creating and validating MDM object names. An IsValidName method has been added to IDocument
and IDocumentInfo to allow a string to be tested to see whether it contains a valid name for an MDM
object. A MakeName method has been added to IDocument, IDocumentInfo, ITypes, and IElements to
create a valid name of an MDM object from the value of a string. The implementation of MakeName on
ITypes and IElements ensures that the object name is unique within the collection that the method is
called for.

Samples

The main changes and additions to the Data Model samples are:
v CreatePaperRouting.mrs. This new sample script opens an .mdd file and creates a paper routing based

on the Fields collection. Any previous paper routing is overwritten. Use this script to enable .mdd files
created in mrStudio (using web routing) to be opened in mrPaper.

What's New in Data Model 2.10
What's new in Data Model 2.10 is summarized under the following headings:
v Available DSCs

v Working with the Case Data Model

v Reference

v Accessories

v What's New in the Metadata Model (MDM)

Available DSCs
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Changes in this section include:
v mrRoutingScript MDSC. This new MDSC translates the routing section of an MDM document into the

routing section of an interviewing script. The internal name of this DSC is mrRoutingScriptDsc.
v SPSS SAV DSC. Changes include the creation of one variable rather than multiple variables for text

variables, and alterations to the way that SPSS SAV DSC deals with the SQL DELETE command.
v Quanvert DSC. Information about sublevel variables is now placed at the end of their parent's field

collections rather than at the beginning.

Working with the Case Data Model

The Evaluate component now accepts the @ and # characters in expressions. This change has been made
primarily to allow the Table Object Model to process element manipulation identifiers of the form
[@#][0-9]*; for example, #31 for element 31 or @2 for the element two places on from the current
element. See evParsePositionIdentifiers in ParseOptions.

Reference

Data Model 2.10 introduces a standard way to invoke components that make changes to an existing
MDM Document, so it is no longer necessary to hard-code the component's interface into applications.
This new functionality consists of the IMetadataTransform interface in the MDSC type library, which can
be used by components to refer to the MDM Document to be changed, and a CanTransform value that can
be added to the Description registry key for an MDSC’s Metadata class showing whether or not
theIMetadataTransform interface is supported. In addition, mrDscReg has been extended to provide
information about these transformation components. See IMDSCCapability.Transform and
IMDSCCapability.CanTransform for details.

Accessories
v MDM Label Manager. This is a new accessory with Data Model 2.10. It enables you to configure the

contexts, label types and language properties of .mdd files for use in mrTranslate and other applications
such as the Questionnaire Viewer.

v MDM2Quantum. Changes include support for various features available with mrInterview 3, and
reporting of mismatches between data types when importing a data map.

What's New in the Metadata Model (MDM)

Page object. A new Page object provides the ability to create Page routing items, that is, a group of
questions to be asked together, sometimes referred to as a multiask. See IPage.

Support for Styles. A Styles property has been added to a number of objects, providing support for
presentation styles. See:
v IArray
v IClass
v ICompound
v IElementInstance
v IElements
v IGrid
v IMDMField
v IPage
v IVariable2

Support for Layout Templates. A Templates property has been added to a number of objects, providing
support for layout templates. See:
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v IArray
v IClass
v ICompound
v IDocument
v IGrid
v IMDMField
v IPage
v IVariable2

A new property, IsDocumentValid, has been added to the Document object. See IDocument.

A new Filter property has been added to the Categories object, to control what is included in the
Categories collection. By default, categories with expressions are excluded from categories on sDataField
variables. See ICategories.

What's New in Data Model 2.9
What's new in Data Model 2.9 is summarized under the following headings:
v Working with the Metadata Model

v Working with the Case Data Model

v Available DSCs

v Reference

v Samples

v What's New in the Metadata Model (MDM)

Working with the Metadata Model

The main changes in this section include:
v MDM Tutorial. The MDM Tutorial has been revised and updated and now covers working with Visual

Basic .NET 2003.

Working with the Case Data Model

The main changes in this section include:
v System Variables. A number of new system variables have been added related to the implementation of

CATI in mrInterview, and new values are now valid in the Respondent.Origin variable. A
Respondent.ID system variable has been added for use with IOM.

Available DSCs

The main changes in this section include:
v ADO DSC. This new DSC reads ADO case data and metadata. The internal name of this DSC is

mrADODsc.
v Surveycraft DSC. This new DSC reads Surveycraft case data and metadata. The internal name of this

DSC is mrSCDsc.
v Delimited Text DSC. This new DSC writes tab-delimited, variable length records to a case data file. The

internal name of this DSC is mrCsvDsc.
v SPSS SAV DSC. A number of additions and enhancements have been made to this DSC, including the

ability to specify your own label texts, longer variable names and label texts, file compresssion, a
.sav.ini file for specifying parameters to be used when creating the .sav file, and improvements in the
handling of Japanese texts.
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v Quancept MDSC supports the eval function that may be used to embed expressions in Quancept
scripts, which will not be evaluated until the interview is running. The embedded expressions can be
any expression that is supported by the Evaluate component.

v Although RDB DSC is distributed with Data Model 2.9 it is no longer registered. If you want to use
this DSC rather than RDB DSC 2 then you must register it yourself. Documentation for this DSC is still
provided in the Relational MR Database CDSC section.

Reference

The main changes in this section include:
v A new method, DisplayWizardEx has been added to the DataLinkHelper class, which allows you to

specify that default settings should be ignored. Additionally, a problem has been resolved so that any
columns that named individually on a Select statement are now always bound, even when all columns
are selected. The individual columns are always bound first because the parser accepts * as the last
column selection only. For example:

SELECT person(^region, * WHERE gender={male}) FROM hdata

now generates a column showing each person's region, whereas is earlier versions the column was empty.
v MDM2Quantum Component. This component now provides methods for reading from a .csv file and

for reading from and writing to files in which variables are separated by a character other than a
comma.

Samples

The main changes and additions to the Data Model samples are:
v Museum and Household samples. There are now Surveycraft versions of the Household and Museum

sample data sets. These are installed by default into the \Data\Surveycraft folder.

What's New in the Metadata Model (MDM)

NativeValue property changed to Variant. The data type of the NativeValue property has been changed
from Long to Variant. This change has been implemented by renaming the original NativeValue property
to NV and marking it as hidden, and then adding a new NativeValue property.

Tracking modifications to .mdd files. Every time an .mdd file is saved, the MDM now logs the following
information in the file: the date and time at which the event occurred, the versionset that was selected at
the time the document was saved, the MDM version, and the name of the application that changed the
document. If two or more log entries are identical apart from the timestamp, MDM reports the change
once with the number of times it was repeated rather than repeating the entry each time. See AddUser.
IMDMUsers, IMDMUser, ISaveLogs, and ISaveLog.

Finding the versions in which an object was changed. MDM now provides information about the
versions in which an object was changed. See IVersionsInfo, and IVersionObject.

Accessing the DataCollection system variables. It is now possible to retrieve the values of system
variables without having the load the entire MDM document. See IDocumentInfo.SystemVariables.

Problems with IDocument.Levels corrected. IDocument.Levels now correctly reflects the
Tables/Columns structure of the HDATA in the CDSC.
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What's New in Data Model 2.8.1
What's new in Data Model 2.8.1 is summarized under the following headings:
v Reference

v Available DSCs

v Working with the Case Data Model

v Working with the Metadata Model

v Samples

v What's New in the Metadata Model (MDM)

Reference
v MDM2Quantum Component. This component has been ported to Visual Basic .NET in order to provide

better interaction with browser-based applications. This change should be invisible to users but has the
advantage that developers who use .NET can now use the assembly instead of the COM interop.

v Reference. The documentation of the MDM Manager component has been removed from the Data
Model Reference section. This component has been deprecated in favor of new functionality within the
MDM itself. For examples of using the new MDM functionality that replaces the functionality provided
by the component, see Working with Versions.

Available DSCs

Quanvert DSC. This DSC now provides support for "packed" Quanvert databases.

Working with the Case Data Model
v System Variables. In Data Model 2.8 and earlier, all of the system variables would be present in the

metadata if any of them were in use. However, in Data Model 2.8.1 and later, this is no longer
necessary and it is now possible to have a data set that contains only the ones that are required.

Working with the Metadata Model

Working with Versions. This section replaces the old "Working with the MDM Manager Component"
section and provides equivalent examples using the features built into the MDM itself.

Samples

General mrScriptBasic. A new sample for exporting data to Excel 2000 or later.

What's New in the Metadata Model (MDM)

The changes to the MDM in Data Model 2.8.1 are mostly internal changes to improve performance and
the ability to have some but not all system variables. The only change to the MDM interfaces is a new
replaceChild method on the ITypes class. This new method is not documented in this version of the
Dimensions Development Library.

What's New in Data Model 2.8
What's new in Data Model 2.8 is summarized under the following headings:
v Improved Support for Hierarchical Data

v Market Research Data

v Working with the Metadata Model

v Working with the Case Data Model

v Available DSCs
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v Accessories

v Extending the Data Model

v Reference

v Samples

v Frequently Asked Questions

v What's New in the Metadata Model (MDM)

Improved Support for Hierarchical Data

Many of the changes in Data Model 2.8 have been made to provide improved support for hierarchical
data. The features that support hierarchical data are being phased into the Data Model gradually and will
not be complete until a planned future version of the Data Model that is called Data Model 3.0 in this
documentation.

Data Model 2.8 provides the following support for hierarchical data:
v The ability to return a hierarchical view of the data (in hierarchical HDATA virtual tables) when

reading data from DSCs that support this feature.
v Quanvert DSC provides full support for reading hierarchical data.
v The new OLE DB implementation of the Relational MR Database DSC (RDB DSC 2) can now return a

hierarchical view of all data except unbounded loops (these are loops that have an undefined
maximum number of iterations).

v XML CDSC provides limited support for reading and writing the hierarchical view of the data.

Note that Data Model 2.8 cannot write data when the hierarchical view is being used. This (plus support
for unbounded loops in RDB DSC 2) is planned for Data Model 3.0.

The new hierarchical data features in Data Model 2.8 are utilized by the new browser-based mrTables 2.0
and the mrStudio Tables Option. These products are able to tabulate hierarchical data, including
unbounded loops, when a DSC that supports these features is being used to read the data.

Links to topics that provide further information about the new hierarchical data features are provided
below.

Market Research Data

This section, which provides an introduction to market research data types, how they are handled by the
Data Model, and the terminology used in this documentation, has been revised and expanded. In
particular, the new Loops, Grids, and Levels topic provides a brief introduction to hierarchical data
structures.

Working with the Metadata Model

The main changes in this section include:
v Hierarchical Data in the MDM. This topic has been revised and updated.
v Creating a Quantum Specification Using a Script. This new topic provides an mrScriptBasic example of

using the new MDSC capability of the Quantum DSC to create a Quantum specification.

Working with the Case Data Model

The main changes in this section include:
v Virtual Tables. This topic now provides information about the hierarchical HDATA virtual tables.
v Understanding Hierarchical Data. This new topic walks you through some practical exercises that are

designed to help you understand how the hierarchical HDATA virtual tables work.
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v Your Hierarchical Data Questions Answered. This new topic provides answers to some frequently
asked questions about hierarchical data support in Data Model 2.8.

v SQL Syntax. This section now documents the new TRUNCATE TABLE statement and syntax for
running Hierarchical Queries and Advanced Hierarchical Queries.

v Connection Properties. This topic now documents the new MR Init MDM Version Variable connection
property.

Available DSCs

The main changes to the existing DSCs are:
v Relational MR Database DSC. RDB DSC 2 now supports reading hierarchical data.
v SPSS SAV DSC. There has been a change in the way SPSS SAV DSC handles categories when reading

data in a .sav file.
v Quanvert DSC. Quanvert DSC now provides full support for hierarchical data, including Quanvert

levels projects.
v Quantum DSC. This DSC can now write out a Quantum specification. This means that it is now easy

to create the Quantum specification using a script (for example, a DMS file). In addition, internal
changes have been made in order to improve performance when transferring case data.

v XML DSC. This section now explains XML DSC's support for hierarchical data and provides
step-by-step instructions for using the new CdscHdataTransfer.mrs sample to transfer hierarchical data to
XML.

v QDI/DRS DSC. This DSC now bases the category names on the unique ID, if there is one, and
otherwise on the response text. This means it is easier to link the categories to the responses in the
original data than in previous versions (where categories were given arbitrary names of the form r1, r2,
r3, etc.).

v Log DSC. The Component IDs topic has been updated to reflect new logging IDs introduced in
Dimensions 2.0.

v mrScript MDSC. Summarizes the changes in mrScript MDSC.

Accessories

The changes in this section include:
v MDM2Quantum. Data Model 2.8 comes with a new version of MDM2Quantum.
v Questionnaire Viewer. This section now includes a new topic that contains tips on working with

Word.
v MDM Version Utility. Data Model 2.8 comes with a new version of this accessory.

Extending the Data Model

The changes in this section include:
v Creating a CDSC. The Handling Hierarchical Data section has been revised and updated.

Reference

The following sections have been updated to reflect changes in Data Model 2.8:
v MDM2Quantum Component
v Evaluate Object Reference
v mrScript Interface Reference
v MDM Object Reference
v CDM and General Error Messages
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Samples

The main changes and additions to the Data Model samples are:
v DM Query. This sample application has been modified so that it can display data in hierarchical tables.

However, this means you need to have Data Model 2.8 or later installed. There are two versions of this
sample application, one created in Visual Basic 6 and the other in Visual Basic .NET. An executable file
is now provided for both versions, for the benefit of users who do not have Visual Basic installed.

v MDM Explorer. An improved version of this sample application.
v DSC Explorer. This sample application now displays the Source Properties for registered CDSCs. This

includes both standard properties (such as Can Add, VDATA, etc.) and custom properties (such as Can
Merge Elements and Supports Card Column).

v Household sample data. This new sample data set provides an example of complex hierarchical data.
v Museum sample XML data. The XML version of the Museum sample data now includes a hierarchical

representation of the case data in HDATA tables in addition to the flat VDATA representation.
v CdscHdataTransfer.mrs. This new sample can be used to transfer hierarchical data from one CDSC that

supports HDATA to another (typically XML). For example, you can use this script to transfer data from
a Quanvert levels project to XML or from a relational MR database (using the HDATA-enabled RDB
DSC 2) to XML. The script runs directly against the CDSC interface because HDATA write support has
not yet been added to the IBM SPSS Data Collection OLE DB Provider.

v Sample mrScriptBasic Files. The MDM2Quantum samples now use the new MDSC capability of
Quantum DSC to export a Quantum specification based on the card, column, and punch definitions.
There is also a new sample for exporting data to Excel 2000 or later.

Frequently Asked Questions

This section now contains new material.

What's New in the Metadata Model (MDM)

The changes to the MDM in Data Model 2.8 are extensive and include:

Improved support for hierarchical data. The changes include the following:
v Indices. A new collection of Element (IElementInstance) objects that is generated by the MDM to

facilitate working with the hierarchical (HDATA) view of the case data. This property has been added
to the Array, Grid, Variable (IVariable2), Compound, Class, and VariableInstance objects. See
IArray.Indices.

v CurrentIndexPath. A new read-write string property that defines the current index path. This property
has been added to the Array, Grid, Variable (IVariable2), Compound, Class, and VariableInstance
objects. See IArray.CurrentIndexPath.

v LevelDepth. A new read-only property that returns a number indicating the depth of the level in
which the object is located. This property has been added to the Array, Grid, Variable (IVariable2),
Compound, Class, and Document objects. See IArray.LevelDepth.

v RelativeName. A new read-only property that returns the full name of the object relative to its parent
level (which corresponds to the parent Array or Grid object). This property has been added to the
Array, Grid, Compound, Variable (IVariable2), and Class objects. See IArray.RelativeName.

v FullLabel. A new read-only property that has been added to the Array, Grid, Compound, Variable
(IVariable2), and Class objects. This property is useful when you are working with individual slices of
a loop or grid. See IVariable2.FullLabel.

v Other changes to the IArray class. A new IsGrid property enables you to specify that an Array object
should be presented as a grid by default and the IArray.Elements property now returns an Elements
collection for expanded numeric loops.
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v Treating the Document object as an Array. The Document object can now be cast to IArray, and when
you do this, the name of the array is HDATA. Consequently, "HDATA" is now a reserved word at the
Document level.

Improved support for mrScriptMetadata. The changes include the following new properties and
methods:
v Script. A new read-write property that returns an mrScriptMetadata representation of the object and

enables you to change the object by changing the mrScriptMetadata. This property has been added to
the Document, Array, Grid, Compound, Class, Variable (IVariable2), Elements, and Element
(IElementInstance) objects. See IVariable2.Script.

v AddScript. This new method has been added to the ITypes class and enables you to add objects to the
collection using an mrScriptMetadata script. See .

v ValidateScript. This new method has been added to the IDocument class and enables you to validate
an mrScriptMetadata script for use as a specific object. See IDocument.ValidateScript.

Note that MDM Explorer now displays the Script property in a special pane in the lower right corner of
the MDM Explorer window. This makes it easy to view and change the mrScriptMetadata and is a great
tool for learning mrScriptMetadata.

Axis expressions. The Variable (IVariable2) object has a new IVariable2.AxisExpression property that
defines how the variable is to be tabulated in mrTables 2.0 and the mrStudio Tables Option.

Creating derived variables is easier. Changes to the Variable and Element objects have made it easier to
create derived variables.
v IVariable2.DeriveElements
v IElementInstance.IsDerived

Setting references by name rather than object. A new ReferenceName property has been added to the
Array, Class, Compound, Element (IElementInstance), Elements, Grid, and Variable (IVariable2) objects.
This enables you to set the reference to a template object by name. See IVariable2.ReferenceName.

New IMDMField class. This new class has been introduced to make it easier to handle the Fields and
Types collections in strict programming languages. See IMDMField.

Improved version expression syntax. In a document that does not have any versions, selecting {..},
LATEST, or {LATEST} will return the Document. Similarly LATEST and {LATEST} will now select the most
recent version, regardless whether it is called LATEST or not.

Improvements to the IDocument class. In addition to the changes mentioned above, the following
changes have been made to existing properties and methods:
v Default user context alternatives. In new MDM Documents, the MDM now adds Question as an

alternative to the Analysis user context, and Analysis as an alternative to the Question context. This
means that when texts have been defined in only one of these default user contexts, they will
automatically be available to applications that read from the other default user context. In existing
MDM Documents, the MDM now adds Question as an alternative to the Analysis user context. This
means that question texts in existing mrInterview data sets, will be available to mrTables when no
specific texts have been defined for use in analysis.

v Opening documents. You can now use the Document.Open method to open an in memory XML
document.

v OpenMode. You can now change the open mode from oReadWrite to oRead or oNoSave and from
oRead to oNoSave. However, this is not possible when using the MultiuserDocument object.

In addition the IDocument class has the following new properties and methods:
v IDocument.JoinConflicts.
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v IDocument.FindReferences.
v IDocument.MDMVersion.

Support for script-based routing. The MDM has been extended to provide a framework for the support
for script-based routing. This framework allows for multiple scripts and for scripts of different types,
although it is expected that routing scripts will generally be in mrScriptBasic. Note that although the
framework has been implemented, the feature itself has not been fully implemented yet. The changes
include:
v IDocument.ScriptTypes
v IRouting.Scripts
v IRouting.Script
v IRoutingScripts
v IScript

What's New in the Metadata Model in Data Model 2.7
What's New in the Metadata Model (MDM)

The changes to the MDM in Data Model 2.7 are extensive and include:

Improved support for hierarchical data. Many of the changes in the MDM in Data Model 2.7 are to
provide improved support for hierarchical data. Dimensions is planning a new version of the Data Model
that will provide full support for representing the case data hierarchically. These new features in the
MDM (together with the support that already exists in the CDSC interface) are designed to enable the
development of DSCs that present data hierarchically for use with the planned new version of the Data
Model. For an introduction to hierarchical data in the MDM, see Hierarchical Data in the MDM.

Support for mrScriptMetadata features. Many of the changes in the MDM in Data Model 2.7 are to
provide improved support for existing mrScriptMetadata features and to provide support for new
features that are planned for a future version of the Data Model. For example:
v Variable.RangeExpression. This new property means that you can now use an expression to define the

valid values for a variable like you can in mrScriptMetadata.
v Variable.Validation. This new property can be used to define validation rules for text variables. This

feature is planned for mrScriptMetadata.
v Variable.Precision. This new property can be used to define the number of decimal places for a real

numeric variable. This feature is planned for mrScriptMetadata.
v Elements.Namespace. This new property means that you can now optionally choose to namespace

element names with the name of the parent Elements collection. This feature is planned for
mrScriptMetadata.

Improvements to the DocumentInfo object. This has been changed to support the VersionSets and
SelectedVersions features described in Working With Multiple Versions and has new Open and Close
methods, which make it quicker and easier to use. See Document Information for an example of using
the new Open method.

MDM Explorer. The Dimensions Development Library - March 2003 comes with a new version of MDM
Explorer, which displays many of the new MDM features. For example, you can now open all versions of
an .mdd file.

Integration between the MDM and CDM. The documentation of the integration between the MDM and
the Case Data Model (CDM) has been revised and extended. See MDM Integration and Understanding
the MDM Integration.
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Changing the data type of a variable. You should not attempt to change the data type of a variable in
the metadata after the case data has been synchronized with the metadata. (In mrInterview, the
synchronization of the case data happens during activation.) Generally you will get an error if you
attempt to change a variable's data type. However, a problem in the MDM means that you will not get
an error if you create a new variable using the name of a variable that existed in an earlier version but
which was of a different data type. This can lead to loss of data.

Support for opening multiple versions. You can now open a combination of two or more versions. (This
is sometimes called a superversion.) The changes for this feature include:
v IDocument.Open. The VersionName parameter can now accept a version expression.
v IDocument.CurrentVersion. The current version can be set to a superversion using a version expression.
v IDocument.SelectedVersions. This new property on the Document object returns a SelectedVersions

object, which stores the names of the currently selected versions.
v IDocument.VersionSets. This new property on the Document object returns a VersionSets object, which

you can use to store the version expressions that have already been used to open the Document, so
that they can be reused easily.

v IDocument.EnableMetadataVersionVariable. This new property on the Document object controls
whether the DataCollection.MetadataVersion system variable is to be enabled. For an example of using
this system variable, see Working With Multiple Versions.

Other changes to the Document class. In addition to the changes mentioned above, the Document class
has the following new properties and methods:
v IDocument.Join.
v IDocument.VariableInstance.
v IDocument.MakeInstanceName.

DocumentInfo class. This has been changed to support the VersionSets and SelectedVersions features
described above and has new Open and Close methods that make it easier to use the DocumentInfo
object:
v IDocumentInfo.Open.
v IDocumentInfo.Close.
v IDocumentInfo.SelectedVersions.
v IDocumentInfo.VersionSets.

New features for the Variable object. New functionality has been added to the Variable object through a
new class, called IVariable2. See also Changes to the Variable and Element Classes.

Element class. The IElement class now supports IElementInstance. This means that an Element object
now has the DataSourceProperties, Value, Fixed, and Expression properties of the ElementInstance class.

Creating derived variables is easier. In Data Model 2.6 and earlier, you had to define the expressions for
derived variables on the related VariableInstance objects. New features in Data Model 2.7 mean that this
is no longer necessary (although it is still valid) and changes to the Variable and Element objects have
made it easier to create derived variables.
v IVariable2.Expression
v IVariable2.Expressions
v IElementInstance.Expression

Improved name handling and object look up. When you add an object to the Elements, Types, Fields, or
HelperFields collections, the MDM now checks that the name is valid and unique within the collection.
Note that in previous versions, the MDM would accept an empty name. In addition, you can now look
up an item in these collections using the object's full name.
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v IMDMObject.Name
v IDocument.Fields
v ICompound.Fields
v IClass.Fields
v IField.Elements

New element ordering features. New functionality has been added to the Elements and ElementInstance
classes to provide support for defining and overriding the display order of the elements in a list of
elements. See:
v IElements.Order
v IElements.Fixed
v IElementInstance.Fixed

New namespace feature. The Class, Compound, and Elements classes have a new Namespace property,
which enables you to define whether the full name of the objects contained within the Class, Compound,
or Elements objects are namespaced with the parent object's name. See:
v IClass.Namespace
v ICompound.Namespace
v IElements.Namespace

Orientation of grids and compounds. The Array, Compound, and Grid classes have a new Orientation
property, which enables you to define the default display orientation when the object is displayed in a
grid-like format. See:
v IArray.Orientation
v ICompound.Orientation
v IGrid.Orientation

Range handling. Not only has the new IVariable2 class got a RangeExpression property that lets you set
the minimum and maximum values of a variable using an expression, the new RangeExpression property
on the Ranges class means you can also define the iterations of a numeric loop using an expression. In
addition, the new Range class means you can iterate through the Ranges object using a For Each loop.
See:
v IVariable2.RangeExpression
v IRanges.RangeExpression
v IRanges
v IRange

IGrid class. The Grid class now supports the IArray interface. This means that you can now treat a grid
as an array so that its case data can be handled hierarchically.

VariableInstance class. The VariableInstance class has a new Indexes property, which returns a list of the
iterations for the VariableInstance object. See IVariableInstance.Indexes.

DataSourceProperties. The DataSourceProperties collection, which is an unversioned collection of data
source-specific custom properties, has now been added to the following IArray, IClass, ICompound,
IElements, IGrid, IVariable2. See DataSourceProperties for general information about
DataSourceProperties.

Language XML name. The ILanguage class has a new property that returns the XML name of the
language. See ILanguage.XMLName.
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Iterating through context and language alternatives. You can now use a For Each loop to iterate through
the list of items in the ContextAlternatives and LanguageAlternatives objects. See:
v IContextAlternatives
v ILanguageAlternatives

What's New in the Metadata Model in Data Model 2.6
What's New in the Metadata Model (MDM)

The MDM Object Reference section was not updated in Dimensions Development Library - November
2002. There were no significant changes in the MDM in Data Model 2.5. The changes in Data Model 2.6
include:

Reduced file size and memory usage. Changes to the handling of empty Properties objects has been
improved and will lead to smaller Metadata Document (.mdd) files. As a result, you may notice that your
.mdd files that were created using earlier versions of the Data Model reduce in size by a substantial
amount after saving or activation. Under certain circumstances, you may also find that new .mdd files get
smaller after saving. This is harmless, will lead to improved performance, and does not mean that data
has been lost.

New VariableInstance.DataMaxValue property. This new property on the VariableInstance object has
been added to enable the VariableInstance.EffectiveMaxValue property to be overridden for a specific
DataSource in a locked version. (The VariableInstance.EffectiveMaxValue property now inherits from
the VariableInstance.DataMaxValue property.) The DataMaxValue property is used by the
MDM2Quantum.AllocateCardColPunch method. Note that the DataMaxValue property can store a
different value for each DataSource object in the Document. This is similar to the AliasName property,
which can store a different alias for each DataSource object.

The following Visual Basic code illustrates using the new DataMaxValue property:
Dim MDM As New MDMLib.Document
MDM.Open "C:\Samples\short_drinks.mdd"
Dim HasPunchDSC, i
HasPunchDSC = False
If MDM.DataSources.Count > 0 Then

For i = 0 To MDM.DataSources.Count - 1
If LCase(MDM.DataSources.Item(i).CDSCName) = "mrpunchdsc" Then

Set MDM.DataSources.Current = MDM.DataSources.Item(i)
HasPunchDSC = True
Exit For

Else
HasPunchDSC = False

End If
Next

End If

’ Create a Quantum CDSC DataSource object if one doesn’t already exist
If HasPunchDSC = False Then

Set MDM.DataSources.Current = MDM.DataSources.AddNew("mrPunchDsc", "mrPunchDsc", "short_drinks.dat")
End If
Debug.Print MDM.Variables("Respondent.Serial").EffectiveMaxValue
MDM.Variables("Respondent.Serial").DataMaxValue = 99999
Debug.Print MDM.Variables("Respondent.Serial").DataMaxValue
Debug.Print MDM.Variables("Respondent.Serial").EffectiveMaxValue

The results are:
2147483647
99999
99999

Note that MDM Explorer now shows this property.

What's New in the Metadata Model in Data Model 2.4
What's New in the Metadata Model (MDM)
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MultiUserDocument. The new MultiUserDocument object gives free-threaded read-only access to an
MDM Document. You should use the MultiUserDocument object instead of the Document object if more
than one user may access an MDM Document at the same time. See IDocument.

New clone feature. The MDM now includes a cloning feature that enables you to easily make copies of
MDM objects. See IMDMClone, ICloneOptions, ICloneLanguages, and ICloneLanguage. For an example
of using the feature, see Using The Clone Feature.

New methods. The IDocument class has two new methods: IDocument.CreateObject and
IDocument.CloneObject.

Filtered RoutingItems collection. The RoutingItems collection now includes a new read-write property,
Filter, which enables you to specify the contents of the collection. See IRoutingItems.

Document.Clear. In Data Model 2.3 and earlier, in order to avoid memory leaks it was necessary to call
the Document.Clear method to release the Document when it had been opened in read-write mode.
Improvements in the MDM in Data Model 2.4 mean that this is no longer necessary.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who want to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
ATTN: Licensing
200 W. Madison St.
Chicago, IL; 60606
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© Copyright IBM Corp. 2015. Portions of this code are derived from IBM Corp. Sample Programs.

© Copyright IBM Corp. 2000, 2015. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
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Programming interface information

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
“Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks
of Adobe Systems Incorporated in the United States, and/or other countries.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.
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